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CAPÍTULO 1

Preambulo

Este documento é o guia do usuário original e descreve o programa Quantum GIS. O software e hardware descritos
neste documento são, na maioria dos casos, marcas registradas e são, portanto, sujeito aos requisitos legais. O
Quantum GIS está sujeito à Licença Pública Geral GNU. Encontre mais informações sobre o Quantum GIS na
Página http://www.qgis.org.

Os detalhes, dados, resultados etc. neste documento são escritos e verificados para o melhor conhecimento e
responsabilidade de seus autores e editores. No entanto, erros sobre o conteúdo são possíveis.

Portanto, todos os dados não são susceptíveis de quaisquer direitos ou garantias. Os autores, editores e editoras
não assume qualquer responsabilidade por falhas e suas consequências. Você será sempre bem-vindos para indicar
possíveis erros.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://documentation.qgis.org. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit: http://www.qgis.org/wiki/.

Links neste Documento

Este documento contém links internos e externos. Clicando sobre um link interno move-se dentro do documento,
ao clicar em um link externo abre um endereço de internet. Em formato PDF, links internos e externos são
mostradas em azul e são tratados pelo navegador do sistema. Em formato HTML, o navegador exibe e trata ambos
de forma idêntica.

Usuário, Instalação e Código Guia dos Autores e Editores:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann

Sponsors

The update of this user manual was kindly sponsored by Kanton Solothurn, Switzerland.

Copyright (c) 2004 - 2013 QGIS Development Team

Internet: http://www.qgis.org

Licença deste documento

Permissão é garantida para cópia, distribuição e/ou modificação deste documento sobre os tremos da Licença
de Documentação Livre GNU, Versão 1.3 ou versão mais recente publicada pela Fundação Software Livre; sem
Seções Invariantes, sem textos de Capa e sem textos de Contra-Capa. A cópia da licença é incluida no Apêndice
GNU Licença de Documentação Gratuíta.
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CAPÍTULO 2

Convenções

Este capítulo descreve as coleções de estilos uniformes ao longo do manual. As convenções usadas neste manual
são como se segue:

** Convenções GUI**

Os estilos de convenção GUI tem a intenção de imitar a aparência da GUI. Em geral, o objetivo é usar a aparência
não pairada, para que um usuário possa verificar visualmente a interface gráfica para encontrar algo que se parece
com a instrução no manual.

• Menu Opções: Camada → Adicionar uma camada Raster ou Configurações → Barra de Ferramentas →
Digitalizar

• Ferramenta: Adiciona uma camada Raster

• Botão : [Salvar como padrão]

• Caixa de diálogo Título: Propriedades da camada

• Aba: Geral

• Caixa de seleção: Renderizar

• Botão Raio: Postgis SRID EPSG ID

• Selecionar um Número:

• Selecionar um String:

• Navegue para um arquivo:

• Selecionar uma Cor:

• Barra deslizante:

• Entrada de texto:

Uma sombra indica um componente GUI clicável.

Convenções de Texto ou Teclado

O manual também inclui estilos relacionados ao texto, comandos de teclado e codificação para indicar diferentes
entidades, tais como classes ou métodos. Eles não correspondem a qualquer aparência real.

• Hyperlinks: http://qgis.org

• Combinações de teclas: Pressione: kbd:Ctrl+B, ou seja, pressione e segure a tecla Ctrl e pressione a tecla
B.

• Nome de um arquivo: lakes.shp

• Nome de uma classe: NewLayer

3
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• Método: classFactory

• Servidor: myhost.de

• Texto de Usuário: qgis --help

Lines of code are indicated by a fixed-width font

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

Plataforma específica instruções

Sequências GUI e pequenas quantidades de texto pode ser formatado em linha:Click Arquivo :menuse-
lection:‘QGIS –> Sair para fechar QGIS ‘.

Isso indica que em Linux, Unix e Windows, clique na opção de menu Arquivo primeiro, e depois Encerre no menu
suspenso, enquanto em plataformas Macintosh OSX, clique no QGIS primeira opção do menu, em seguida, Sair
no menu suspenso. Grandes quantidades de texto podem ser formatados como uma lista:

• fazer isso;

• fazer isso;

• fazer outra coisa.

ou como parágrafos.

Fazer isso, isso e isso. Então faça isso, isso e isso, isso e isso, isso e isso, isso e isso.

Fazer isso. Então faça isso e aquilo e isso e aquilo e isso e aquilo e isso e aquilo e isso e isso e aquilo e isso e
aquilo e isso e aquilo.

Imagens que aparecem ao longo do guia do usuário foram criadas em diferentes plataformas, a plataforma é
indicada pelo ícone específico da plataforma no final da legenda da figura.
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CAPÍTULO 3

Preâmbulo

Bem vindo ao mundo maravilhoso dos Sistemas de Informação Geográficas (SIG)!

Quantum GIS (QGIS) é um Sistema de Informação Geográfica de código aberto.O projeto foi concebido em Maio
de 2002 e foi estabelecido como projeto em código fonte em Junho do mesmo ano. Nós trabalhamos duro para
tornar o software SIG (que é tradicionalmente software proprietário e caro) numa perspectiva viável para qualquer
pessoa com acesso básico num computador pessoal. O QGIS roda atualmente na maioria das plataformas Unix,
Windows e Mac OS X. O QGIS é desenvolvido usando o kit de ferramentas Qt (http://qt.digia.com) e C++. Isto
significa que QGIS é bom e fácil de usar e tem uma agradável interface gráfica como usuário (GUI).

QGIS pretende ser um SIG fácil de usar, fornecendo funções e feições comuns. O objetivo inicial era fornecer um
visualizador de dados SIG. O QGIS atingiu o ponto em sua evolução, onde ele está sendo usado por muitos de
seus dados SIG diários de necessidade de visualização. O QGIS suporta um grande número de formatos de dados
raster e vetores, e ainda novos formatos podem facilmente adicionados usando a arquitetura de complementos.

QGIS é liberado sob a licença GNU General Public License (GPL). O desenvolvimento do QGIS sob esta licença
significa que você pode inspecionar e modificar o código-fonte, e garante que você, nosso usuário feliz, sempre
terá acesso a um programa de SIG, que é livre de custo e pode ser livremente modificado. Você deve ter recebido
uma cópia completa da licença com a sua cópia do QGIS, e você também pode encontrá-la no Apêndice GNU
General Public License.

Dica: Up-to-date Documentation
The latest version of this document can always be found in the documentation area of the QGIS website at
http://documentation.qgis.org

3.1 Introdução ao SIG

Um Sistema e Informação Geográfica (SIG) (Mitchell 2005 Referências Bibliográficas e Web) é um conjunto de
programas que permite criar, visualizar, consultar e analisar dados geoespaciais. Dados Geoespaciais se referem
a informações sobre a localização geográfica de uma entidade. Isto muitas vezes envolve o uso de um sistema de
coordenadas geográficas, tal como o valor de latitude e longitude. Os dados espaciais é outro termo usado, pois
são: dados geográficos, dados de SIG, dados de mapas, dados de localização, dados de coordenadas e os dados de
geometria espacial.

Aplicações que utilizam dados geoespaciais executam uma variedade de funções. Produção de mapas é a função
mais fácil de entender de aplicações geoespaciais. Programas de mapeamento levam dados geoespaciais e tornam-
os de uma forma que é visível, geralmente em uma tela de computador ou uma página impressa. Os aplicativos
podem apresentar mapas estáticos (uma imagem simples) ou mapas dinâmicos que são personalizadas pela pessoa
visualiza o mapa através de um programa de computador ou uma página web.

Muitas pessoas assumem erroneamente que as aplicações geoespaciais apenas produzem mapas, mas a análise de
dados geoespaciais é outra função primária de aplicações geoespaciais. Alguns tipos típicos de análise incluem
computação:

1. distância entre localizações geográficas
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2. a quantidade de área (por exemplo, metros quadrados) dentro de uma determinada região geográfica

3. Quais feições geográficas se sobrepõem outras feições

4. A quantidade de sobreposição entre feições

5. O número de localizações a uma certa distância da outra

6. e assim por diante...

Isto pode parecer simplista, mas pode ser aplicado em todos os tipos de formas de várias disciplinas. Os resultados
da análise podem ser mostrados em um mapa, mas muitas vezes são tabulados em um relatório para apoiar decisões
de gestão.

Os fenômenos recentes de serviços baseados em localização promete apresentar todos os tipos de outros recur-
sos, mas muitos serão baseados em uma combinação de mapas e análises. Por exemplo, você tem um celular
que rastreia a sua localização geográfica. Se você tiver o programa certo, o seu telefone pode dizer quais tipos
de restaurantes estão a uma curta distância. Enquanto esta é uma nova aplicação de tecnologia geoespacial, é
essencialmente fazer análise de dados geoespaciais e listar os melhores resultados para você.

3.1.1 Por que tudo isso é tão novo?

Bem, não é. Há muitos novos dispositivos de hardware que estão possibilitando serviços geoespaciais móveis.
Muitas aplicações Open Source Geospatial também estão disponíveis, mas a existência de hardware e software
focada geoespacialmente não é nada de novo. Sistema de Posicionamento Global (GPS) estão se tornando comuns,
mas têm sido utilizados em diversas indústrias por mais de uma década. Da mesma forma, ferramentas de trabalho
de mapeamento e análise têm sido também um grande mercado comercial, focado principalmente em setores como
gestão de recursos naturais.

O que é novo é a forma como o mais recente hardware e software está sendo aplicado e quem está aplicando-o.
Usuários tradicionais de ferramentas de mapeamento e análise foram altamente treinados em Analise SIG ou técni-
cos de mapeamento digital treinados para usar CAD como ferramentas. Agora, as capacidades de processamento
de PCs domésticos e pacotes Open Source Software (OSS) têm permitido um exército de amadores, profissionais,
desenvolvedores web, etc, para interagir com os dados geoespaciais. A curva de aprendizado veio para baixo. Os
custos caíram. A quantidade de saturação tecnológica geoespacial aumentou.

Como são armazenados dados geospaciais? Em suma, existem dois tipos de dados geoespaciais em uso difun-
dido hoje. Isto é, além dos tradicionais dados tabulares que também é amplamente utilizados pelas aplicações
geoespaciais.

3.1.2 Dado Raster

Um tipo de dado geoespacial é o chamado dado raster ou simplismente “um raster”. A forma mais facilmente
reconhecida de dados raster é de imagens de satélite digital ou fotos aéreas. Elevação Sombreada ou modelos
digitais de elevação também são normalmente representados como dados raster. Qualquer tipo de feição do mapa
pode ser representada como dados raster, mas há limitações.

Um raster é uma grade regular formada por células, ou, no caso de imagens, os pixeis. Eles têm um número fixo
de linhas e colunas. Cada célula tem um valor numérico e tem um determinado tamanho geográfico (por exemplo,
30x30 metros de dimensão).

Várias rasters sobrepostos são usados para representar as imagens usando mais do que um valor de cor (isto é,
um raster para cada conjunto de valores de vermelho, verde e azul são combinados para criar uma imagem a
cores). As imagens de satélite também representa dados em várias “bandas”. Cada banda é essencialmente um
raster espacialmente sobreposto separado, em que cada banda tem valores de certos comprimentos de onda de luz.
Como você pode imaginar, um grande raster ocupa mais espaço de arquivo.

Um raster com células menores podem fornecer mais detalhes, mas ocupa mais espaço de arquivo. O segredo é
descobrir o equilíbrio certo entre o tamanho das células para fins de armazenamento e tamanho de célula para fins
de análise ou mapeamento.
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3.1.3 Dado Vetorial

Dados vetoriais também são usados em aplicações geoespaciais. Se você ficou acordado durante as aulas de
trigonometria e de geometria, você já estará familiarizado com algumas das qualidades de dados vetoriais. No seu
sentido mais simples, os vetores são uma forma de descrever um local usando um conjunto de coordenadas. Cada
coordenada refere-se a uma localização geográfica utilizando um sistema de valores de x e y.

Isso pode ser pensado em referência a um plano cartesiano - você sabe, os diagramas de escola que mostravam um
eixo x e y. Você pode tê-los usado para traçar o declínio da poupança ou o aumento dos juros de hipoteca, mas os
conceitos são essenciais para a análise de dados geoespaciais e mapeamento.

Existem várias maneiras de representar essas coordenadas geográficas, dependendo da sua finalidade. Esta é toda
uma área de estudo para outro dia - projeções do mapa.

Dado vetor pode assumir três formatos, cada um progressivamente mais complexos que o anterior.

1. Pontos - Uma coordenada simples (x y) representa localização geográfica discreta

2. Lines - Multiple coordinates (x1 y1, x2 y2, x3 y3, ... xn yn) strung together in a certain order, like drawing
a line from Point (x1 y1) to Point (x2 y2) and so on. These parts between each point are considered line
segments. They have a length and the line can be said to have a direction based on the order of the points.
Technically, a line is a single pair of coordinates connected together, whereas a line string is multiple lines
connected together.

3. Poligonos - Quando as linhas são amarradas juntas por mais de dois pontos, com o último ponto sendo no
mesmo local do primeiro, nós chamamos isso de um polígono. Um triângulo, círculo, retângulo, etc, são
todos os polígonos. A característica chave dos polígonos é que existe uma área fixa no seu interior.
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CAPÍTULO 4

Características

oferece muitas funcionalidades comuns de um SIG fornecidos por recursos básicos e extensões. Como um pe-
queno resumo são apresentados em seis categorias para obter uma primeira visão.

4.1 Visualizar os dados

Você pode ver e sobrepor dados vetoriais e raster em diferentes formatos e projeções sem conversão para um
formato interno ou comum. Os formatos suportados incluem:

• Spatially-enabled tables and views using PostGIS, SpatiaLite and MSSQL Spatial, vector formats supported
by the installed OGR library, including ESRI shapefiles, MapInfo, SDTS, GML and many more, see section
Trabalhando com dados vetoriais.

• Raster and imagery formats supported by the installed GDAL (Geospatial Data Abstraction Library) library,
such as GeoTiff, Erdas Img., ArcInfo Ascii Grid, JPEG, PNG and many more, see section Trabalhando com
dados Raster.

• GRASS raster e dados vetoriais de bancos de dados GRASS (localização / mapset), veja: ref: sec_grass.

• Servidores de dados espaciais na rede como padrão OGC Web Map Service (WMS) ou Web Feature Service
(WFS), veja: ref: working_with_ogc.

• OpenStreetMap data, see section OpenStreetMap.

4.2 Explorar os dados e compor mapas

Você pode compor mapas e explorar interativamente dados espaciais com uma interface gráfica amigável. As
muitas ferramentas úteis disponíveis no GUI incluem:

• Navegador QGIS

• On the fly projection

• Map composer

• Overview panel

• Spatial bookmarks

• Identify/select features

• Edit/view/search attributes

• Feature labeling

• Change vector and raster symbology

• Add a graticule layer - now via fTools plugin and as decoration

9



QGIS User Guide, Versão 1.8

• Decorate your map with a north arrow scale bar and copyright label

• Save and restore projects

4.3 Criar, alterar,gerenciar e exportar dados

Você pode criar, alterar, gerenciar e exportar mapas vetoriais em vários formatos. Dados raster têm de ser impor-
tados para o GRASS para poder alterar e exportá-los para outros formatos. QGIS oferece o seguinte:

• Digitizing tools for OGR supported formats and GRASS vector layer

• Create and edit shapefiles and GRASS vector layers

• Geocode images with the Georeferencer plugin

• GPS tools to import and export GPX format, and convert other GPS formats to GPX or down/upload directly
to a GPS unit (on Linux, usb: has been addedto list of GPS devices)

• Visualize and edit OpenStreetMap data

• Create PostGIS layers from shapefiles with the SPIT plugin

• Improved handling of PostGIS tables

• Manage vector attribute tables with the new attribute table (see section Trabalhando com a Tabela de Atrib-
utos) or Table Manager plugin

• Save screenshots as georeferenced images

4.4 Análise de dados

You can perform spatial data analysis on PostgreSQL/PostGIS and other OGR supported formats using the fTools
Python plugin. QGIS currently offers vector analysis, sampling, geoprocessing, geometry and database manage-
ment tools. You can also use the integrated GRASS tools, which include the complete GRASS functionality of
more than 400 modules (See Section Integração com SIG GRASS). Or you work with SEXTANTE, which provides
powerful a geospatial analysis framework to call native and third party algorithms from QGIS, such as GDAL,
SAGA, GRASS, fTools and more (see section SEXTANTE).

4.5 Publicar mapas na Internet

QGIS can be used to export data to a mapfile and to publish them on the Internet using a webserver with UMN
MapServer installed. QGIS can also be used as a WMS, WMS-C or WFS and WFS-T client, and as WMS or WFS
server (see section Trabalhando com dados OGC).

4.6 Estender a funcionalidade QGIS através de extensões

QGIS pode ser adaptado às suas necessidades com a arquitetura de extensões. QGIS fornece bibliotecas que
podem ser usados para criar extensões. Você pode até mesmo criar novas aplicações com C + + ou Python!

4.6.1 Extensões de núcleo

1. Add Delimited Text Layer (Loads and displays delimited text files containing x,y coordinates)

2. Coordinate Capture (Capture mouse coordinates in different CRS)

3. Gerenciador de Banco de dados (Alteração, edição e visualização de camadas e tabelas; executar consultas
SQL)
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4. Diagram Overlay (Placing diagrams on vector layer)

5. Dxf2Shp Converter (Convert DXF to Shape)

6. GPS Tools (Loading and importing GPS data)

7. GRASS (GRASS GIS integration)

8. GDALTools (Integrate GDAL Tools into QGIS)

9. Georeferencer GDAL (Adding projection information to raster using GDAL)

10. Heatmap tool (Generating raster heatmaps from point data)

11. Interpolation plugin (interpolate based on vertices of a vector layer)

12. Mapserver Export (Export QGIS project file to a MapServer map file)

13. Offline Editing (Allow offline editing and synchronizing with database)

14. OpenStreetMap plugin (Viewer and editor for openstreetmap data)

15. Oracle Spatial GeoRaster support

16. Plugin Installer (Download and install QGIS python plugins)

17. Raster terrain analysis (Raster based terrain analysis)

18. Road graph plugin (Shortest Path network analysis)

19. SPIT (Import Shapefile to PostgreSQL/PostGIS)

20. SQL Anywhere Plugin (Store vector layers within a SQL Anywhere database)

21. Zonal statictics plugin (Calculate count, sum, mean of raster for each polygon of a vector layer)

22. Spatial Query plugin (Makes spatial queries on vector layers)

23. eVIS (Event Visualization Tool)

24. fTools (Tools for vector data analysis and management)

4.6.2 Extensão python externas

QGIS offers a growing number of external python plugins that are provided by the community. These plugins
reside in the official plugins repository, and can be easily installed using the Python Plugin Installer (See Section
Carregar um complemento externo do QGIS).

4.7 Novidades na versão 1.8

Please note that this is a release in our ‘cutting edge’ release series. As such it contains new features and extends
the programmatic interface over QGIS 1.0.x and QGIS 1.7.0. We recommend that you use this version over
previous releases.

This release includes hundreds of bug fixes and many new features and enhancements that will be described in
this manual.

QGIS Browser

A stand alone app and a new panel in QGIS. The browser lets you easily navigate your file system and connection
based (PostGIS, WFS etc.) datasets, preview them and drag and drop items into the canvas.

DB Manager

The DB manager is now officially part of QGIS core. You can drag layers from the QGIS Browser into DB
Manager and it will import your layer into your spatial database. Drag and drop tables between spatial databases
and they will get imported. You can use the DB Manager to execute SQL queries against your spatial database
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and then view the spatial output for queries by adding the results to QGIS as a query layer. You can also create,
edit, delete, and empty tables, and move them to another schema.

Terrain Analysis Plugin

A new core plugin was added for doing terrain analysis (slope, aspect, hillshade, relief and ruggedness index).

New symbol layer types

• Line Pattern Fill

• Point Pattern Fill

• Ellipse renderer (render ellipse and also rectangles, triangles, crosses)

New plugin repository

Note that the old repository is now no longer supported by default; plugin authors are kindly requested to move
their plugins to the new repository. Get the QGIS Plugins list at http://plugins.qgis.org/plugins/.

More new features

• Support for nesting projects within other projects to embed content from other project files

• Group Selected: Option to group layers to a group

• Message log: Lets you keep an eye on the messages QGIS generates during loading and operation

• GUI Customization: Allows setting up simplified QGIS interface by hiding various components of main
window and widgets in dialogs

• Action Tool is now accessible from the map tools toolbar and allows you to click on a vector feature and
execute an action

• New scale selector: select from a list of predefined scales

• Pan To Selected tool: Pans the map to selected feature(s); does not change the zoom level

• Copy and paste styles between layers

• Updated CRS selector dialog

• Define Legend-independent drawing order

• MSSQL Spatial Support - you can now connect to your Microsoft SQL Server spatial databases using QGIS

• Print Composers allows to have multiple lines on legend items using a specified character

• Expression based labeling

• Heatmap Plugin - a new core plugin has been added for generating raster heatmaps from point data

• The GPS live tracking user interface was overhauled and many fixes and improvements were added to it

• The menu was re-organised a little - we now have separate menus for Vector, Raster, Web and many plugins
were updated to place their menus in the new Vector, Raster and Web top level menus

• Offset Curves - a new digitising tool for creating offset curves was added

• New tools in the Vector menu to Densify geometries and Build spatial index

• Export/add geometry column tool can export info using layer CRS, project CRS or ellipsoidal measurements

• Model/view based tree for rules in rule-based renderer

• Improvements in Spatial Bookmarks

• New Plugin metadata in metadata.txt

• Refactored postgres data provider: support for arbitrary key (including non-numeric and multi column),
support for requesting a certain geometry type and/or srid in QgsDataSourceURI

• Added gdal_fillnodata to GDALTools plugin

• Support for PostGIS TopoGeometry datatype
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• Python bindings for vector field symbol layer and general updates to the Python bindings

• Added a Benchmark program

• Added Row cache for attribute table

• UUID generation widget for attribute table

• Added support of editable views in SpatiaLite databases

• added expression based widget in field calculator

• Creation of event layers in analysis lib using linear referencing

• Load/save layer styles in the new symbology renderer from/to SLD document

• QGIS Server can act as WFS Server

• WFS Client support is now a core feature in QGIS

• Option to skip WKT geometry when copying from attribute table

• Support loading of zipped and gzipped layers

• The QGIS test suite now passes all tests on major platforms and nightly tests

• You can set tile size for WMS layers
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CAPÍTULO 5

Introdução

Este capítulo apresenta uma visão geral da instalação do QGIS, alguns exemplos de dados da página web QGIS e
funcionamento inicial de uma simples sessão, visualizando camadas raster e vetoriais.

5.1 Instalação

A instalação do QGIS é muito simples. Pacotes de instalação padrão estão disponíveis para MS Windows e Mac
OS X. Para muitas distribuições de pacotes binários (rpm e deb) ou repositórios para adicionar ao seu gerenci-
ador de instalação são fornecidas. Receba as últimas informações sobre pacotes binários no site do QGIS em
http://download.qgis.org.

5.1.1 Instalação do Código Fonte

If you need to build QGIS from source, please refer to the installation instructions. They are distributed with the
QGIS source code in a file called ‘INSTALL’. You can also find it online at https://github.com/qgis/Quantum-
GIS/blob/master/INSTALL

5.1.2 Intalação de uma mídia externa

QGIS permite definir uma opção de configuração de caminho que substitui o caminho padrão (por exemplo com o
/.qgis no Linux) para a configuração do usuário e força o QSettings a usar este diretório também. Isso permite aos
usuários, por exemplo, levar a instalação do QGIS em uma unidade flash, com todos os plugins e configurações.

5.2 Dados de exemplo

O guia do usuário contém exemplos baseados na amostra de dados.

a instalação do Windows possui uma opção de realizar o download do QGIS com os dados de exemplo. Se
marcada, os dados serão baixados para suas pasta Meus Documentos e colocados em uma pasta chamada “GIS
Database”. Você pode utilizar o windows explorer para mover esta pasta para outra localização. Se você não
selecionar a caixa de seleção para instalar os dados de exemplo durante a instalação inicial do QGIS você pode

• Utilizar dados GIS que você já possui;

• Faça o download dos dados de exemplo no site do QGIS em http://download.qgis.org; ou

• Desinstale o QGIS e reinstale marcando a opção de download de dados, somente se as soluções acima não
forem bem sucedidas.

“| Nix | | OSX | Para GNU / Linux e Mac OSX não há ainda a instalação de pacote de conjunto de dados disponíveis
como rpm, deb ou dmg. Para utilizar o conjunto de dados de exemplo baixe o arquivo “qgis_sample_data”
no formato de arquivo ZIP ou TAR de “http://download.osgeo.org/qgis/data/ e descompacte ou descomprima os
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arquivos no seu sistema. O conjunto de dados do Alasca inclui todos os dados SIG que são usados como exemplos
e imagens deste Guia do Usuário, e também inclui uma pequena base de dados GRASS. A projeção para os
exemplos dos dados é Alaska Albers Equal Area com unidades de pés. O código EPSG é o 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",

DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,

AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],

PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],

UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],

AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

se você pretende usar o QGIS como interface gráfica para o GRASS, você pode encontrar um se-
leção de localizações de amostra (por exemplo, Spearfish ou Dakota do Sul) no site oficial do GRASS
htpp://grass.geo.org/download/data.php.

5.3 Exemplos da Seção

Agora que você possui o QGIs instalado e os dados de amostra disponíveis, nós iremos demonstrar uma ráp-
ida e simples seção de exemplos. Iremos visualizar uma camada vetorial e uma camada de raster. Nós
iremos utilizara camada de raster landcover qgis_sample_data/raster/landcover.img e uma camada vetorial
qgis_sample_data/gml/lakes.gml.

5.3.1 Iniciando QGIS

• Start QGIS by typing: “QGIS” at a command prompt, or if using precompiled binary, using the Appli-
cations menu.

• “| Win | Inicie | qg | usando o menu Iniciar ou atalho no desktop, ou clique duas vezes em um arquivo de
projeto do | qg |.

• Double click the icon in your Applications folder.

5.3.2 Caregando camadas vetoriais e de raster dos dados da amostra

1. Clique no Load Raster ícone.

2. Navegue até a pasta qgis_sample_data/raster, selecione o arquivo de imagem ERDAS landcover.img e clique
[Abrir].

3. Se o arquivo não estiver listado, verifique se a caixa (combobox) do tipo de arquivo na parte inferior está
marcada com o tipo correto, nesse caso “Erdas Imagine Image (*.img, *.IMG)”.

4. Agora clique no ícone “Load Vector”.
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5. O Arquivo deve ser selecionado como tipo de caminho em “Adicionar Camada Vetorial” na caixa de diálogo.
Agora clique em [procurar] para selecionar a camada vetorial.

6. Navegue até a pasta qgis_sample_data/gml, selecione GML para o tipo de arquivo na caixa de combinação
e então selecione o arquivo GML lakes.gml, clique em [Abrir] então na caixa de diálogo “Adicionar vetor”
clique em [Ok].

7. Aplique um pouco de zoom na sua área favorita que contém alguns lagos.

8. Dê um clique duplo na camada lakes na legenda do mapa para abri a caixa de Propriedades.

9. Clique na aba Estilo e selecione azul para cor de preenchimento.

10. Clique na aba Rótulos e marque a caixa “Mostrar Rótulos” para habilitar a rotulagem. Escolha o campo
NAMES como o campo que contém o rótulo.

11. Para melhorar a legibilidade dos rótulos você pode adicionar um buffer branco em torno do rótulo, clicando
em Buffer no rótulo e na lista da esquer escolha o tamanho do buffer como 3.

12. Clique [Aplicar], verifique se o resultado é bom e então clique em [OK].

Como você pode ver é muito fácil visualizar camadas vetoriais e de raster no QGIS. Vamos passar para as seções
seguintes aprendendo mais sobre como a avaliação de funcionalidades. características e configurações e como
usá-las.

5.4 Iniciando e fechando QGIS

Na Seção: “Exemplos” você já aprendeu como iniciar o QGIS. Vamos repetir isso aqui e você verá que o QGIS
também fornece mais opções pela linha de comando.

• Assuming that QGIS is installed in the PATH, you can start QGIS by typing: qgis at a command prompt
or by double clicking on the QGIS application link (or shortcut) on the desktop or in the application menu.

• Start QGIS using the Start menu or desktop shortcut, or double click on a QGIS project file.

• Double click the icon in your Applications folder. If you need to start QGIS in a shell, run /path-to-
installation-executable/Contents/MacOS/Qgis.

“Para encerrar QGIS, clique no menu de opções | nix | | win |: Seleção de Menu: “Arquivo”| OSX |: Seleção de
Menu: QGIS “Encerrar”, ou use o atalho: “Ctrl + Q”.

5.5 Opções da Linha de Comando

QGIS supports a number of options when started from the command line. To get a list of the options, enter
qgis --help on the command line. The usage statement for QGIS is:

qgis --help
Quantum GIS - 1.8.0-Lisboa ’Lisboa’ (exported)
Quantum GIS (QGIS) is a viewer for spatial data sets, including
raster and vector data.
Usage: qgis [options] [FILES]

options:
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
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[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--help] this text

FILES:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Dica: Example Using command line arguments
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on startup
using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Opções da Linha de Comando - “–snapshot”

Esta opção permite que você crie um instantâneo no formato PNG da visualização atual. Isto é bem útil quando
você tem vários projetos e deseja gerar instantâneos de seus dados.

Por padrão ele gera um arquivo PNG com 800x600 pixels. Isso pode ser modificado utilizando os argumentos na
linha de comando “–widht” e “–height”. A nome de arquivo pode ser adicionado depois de “–snapshot”.

Opções da Linha de Comando - “–lang”

Based on your locale QGIS, selects the correct localization. If you would like to change your language,
you can specify a language code. For example: --lang=it starts QGIS in italian localization. A list of
currently supported languages with language code and status is provided at http://hub.qgis.org/wiki/quantum-
gis/GUI_Translation_Progress

Opções da Linha de Comando - “–project”

É possível iniciar o QGIS com um arquivo de projeto existente. Basta adicionar na linha de comando a opção
“–project” seguido pelo nome do projeto e o QGIS irá abrir com todas as camadas carregadas descritas no arquivo
indicado.

Opções da Linha de Comando - “–extent”

“Para iniciar em um ponto específico do mapa utilize esta opção. Você precisa adicionar na caixa delimitadora de
extesão do mapa as coordenadas na seguinte ordem separadas por vírgula :

--extent xmin,ymin,xmax,ymax

Opções da Linha de Comando - “–nologo”

Este argumento de linha de comando esconde a tela inicial do QGIS quando ele é iniciado.

Opções da Linha de Comando - “–noplugins”

Se você tiver problemas ao iniciar o aplicativo com plugins, você pode evitar carregá-los na inicialização. Eles
ainda estarão disponíveis no Gerenciador de Plugins para uso.

Command line option --nocustomization

Using this command line argument existing GUI customization will not be applied at startup.

Opções da Linha de Comando - “–optionspath”

Você pode ter múltiplas configurações e decidir qual usar quando inicializar o QGIS utilizando esta opção. Vá em
:ref: “gui_options” para verificar onde o sistema operacional salva o arquivo de configurações. Atualmente não
há maneira de especificar em qual arquivo será escrito as configurações, portanto, você pode criar uma cópia do
arquivo de configurações original e renomeá-lo.
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Opções da Linha de Comando - “–configpath”

This option is similar to the one above, but furthermore overrides the default path (~/.qgis) for user configuration
and forces QSettings to use this directory, too. This allows users to e.g. carry QGIS installation on a flash drive
together with all plugins and settings.

5.6 Projetos

The state of your QGIS session is considered a Project. QGIS works on one project at a time. Settings are either
considered as being per-project, or as a default for new projects (see Section Opções). QGIS can save the state of

your workspace into a project file using the menu options File → Save Project or File → Save Project As.

Load saved projects into a QGIS session using File → Open Project or File → Open Recent Project.

If you wish to clear your session and start fresh, choose File → New Project. Either of these menu options
will prompt you to save the existing project if changes have been made since it was opened or last saved.

Os tipos de informações salvas em um arquivo de projeto incluem:

• Camadas adicionadas

• Propriedades das Camadas, incluido simbologia

• Projeção do mapa de visualização

• Último ponto visualizado

O arquivo de projeto é salvo no formato XML, por isso, é possível editar o arquivo fora do QGIS se você souber
o que está fazendo.O formato de arquivo foi atualizado várias vezes em comparação com versões anteriores do
QGIS. Arquivos de projeto de versões anteriores do QGIS podem não funcionar mais corretamente. Para ter
certeza disso vá na barra de ferramentas, menu Configurações –>Opções, você pode selecionar:

Prompt to save project changes when required

Warn when opening a project file saved with an older version of QGIS

5.7 Saída

Há várias maneiras de gerar a saída de sua sessão do QGIS. Já discutimos “Projetos” salvando um arquivo de
projeto. Aqui existe exemplos de outras formas de produzir arquivos de saída:

• Menu option File → Save as Image opens a file dialog where you select the name, path and type of image
(PNG or JPG format). A world file with extension PNGW or JPGW saved in the same folder georeferences
the image.

• Menu option File → New Print Composer opens a dialog where you can layout and print the current
map canvas (see Section Compositor de impressão).
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CAPÍTULO 6

Interface do QGIS

When QGIS starts, you are presented with the GUI as shown below (the numbers 1 through 5 in yellow ovals refer
to the six major areas of the interface as discussed below):

Figura 6.1: QGIS GUI with Alaska sample data

Nota: Suas decorações de janela (barra de título, etc) podem parecer diferentes dependendo do seu sistema
operacional e gerenciador de janelas.

A interface QGIS é dividida em cinco áreas:

1. Barra de Menu

2. Barra de Ferraementas

3. Legenda do Mapa

4. Visualização do mapa

5. Barra de Status

Estes cinco componentes da interface gráfica do QGIS serão descritos com maior detalhe dentro da próximas
seções. Mais duas seções apresentarão atalhos de teclado e ajuda de contexto.

6.1 Barra de Menu

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the icons of the corresponding tools
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as they appear on the toolbar, as well as keyboard shortcuts. Keyboard shortcuts can also be configured manually
(shortcuts presented in this section are the defaults), using the [Configure Shortcuts] tool under Settings.

Although most menu options have a corresponding tool and vice-versa, the menus are not organized quite like the
toolbars. The toolbar containing the tool is listed after each menu option as a checkbox entry. Some menu options
only appear, if the corresponding plugin is loaded. For more information about tools and toolbars, see Section
Barra de Ferramentas.

6.1.1 File

Opção de menu Atalho Referência Barra de Ferramentas

Novo Projeto Ctrl+N ver Projetos Arquivo

Abrir Projeto Ctrl+O ver Projetos Arquivo
Abrir projeto recente → ver Projetos

Salvar Projeto Ctrl+S ver Projetos Arquivo

Salvar Projeto com Ctrl+Shift+S ver Projetos Arquivo

Salvar a tela como imagem ver Saída

Novo compositor de impressão Ctrl+P ver Compositor de impressão Arquivo

Gerenciador do compositor ver Compositor de impressão Arquivo
Print Composers → ver Compositor de impressão

Sair Ctrl+Q

22 Capítulo 6. Interface do QGIS



QGIS User Guide, Versão 1.8

6.1.2 Edit

Opção de menu Atalho Referência Barra de
Ferramentas

Desfazer Ctrl+Z ver Digitalização Avançada Digitalização
Avançada

Refazer Ctrl+Shift+Zver Digitalização Avançada Digitalização
Avançada

Recortar Feições Ctrl+X ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Copiar feições Ctrl+C ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Colar feições Ctrl+V ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Adicionar feição Ctrl+. ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Move Feature(s) ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Excluir Selecionado(s) ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Simplificar feições ver Digitalização Avançada Digitalização
Avançada

Adicionar Anel ver Digitalização Avançada Digitalização
Avançada

Adicionar Parte ver Digitalização Avançada Digitalização
Avançada

Excluir Anel ver Digitalização Avançada Digitalização
Avançada

Excluir Parte ver Digitalização Avançada Digitalização
Avançada

Remodelar feições ver Digitalização Avançada Digitalização
Avançada

Curva de deslocamento ver Digitalização Avançada Digitalização
Avançada

Quebras Feições ver Digitalização Avançada Digitalização
Avançada

Mesclar feições
selecionadas

ver Digitalização Avançada Digitalização
Avançada

Merge attr. of selected
Features

ver Digitalização Avançada Digitalização
Avançada

Ferramenta de nós ver Digitalizando uma Camada
Vetorial Existente

Digitalização

Rotacionar pontos com
simbolos

ver Digitalização Avançada Digitalização
Avançada
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After activating Toggle editing mode for a layer, you will find the Add Feature icon in the Edit menu depend-
ing on the layer type (point, line or polygon).

6.1.3 Edit (extra)

Opção de menu Atalho Referência Barra de Ferramentas

Adicionar feição ver Digitalizando uma Camada Vetorial Existente Digitalização

Adicionar feição ver Digitalizando uma Camada Vetorial Existente Digitalização

Adicionar feição ver Digitalizando uma Camada Vetorial Existente Digitalização

6.1.4 View

Opção de menu Atalho Referência Barra de Ferramentas

Panorâmica no Mapa Navegação no Mapa

Mover mapa para seleção Navegação no Mapa

Aproximar Ctrl++ Navegação no Mapa

Afastar Ctrl+- Navegação no Mapa
Selecionar → ver Selecionar e desselecionar feições Atributos

Identificar feições Ctrl+Shift+I Atributos
Medir → ver Medição Atributos

Ver tudo Ctrl+Shift+F Navegação no Mapa

Aproximar à camada Navegação no Mapa

Aproximar à seleção Ctrl+J Navegação no Mapa

Última visualização Navegação no Mapa

Próxima visualização Navegação no Mapa

Zoom Actual Size Navegação no Mapa
Decorações → ver Decorações

Dicas do Mapa Atributos

Novo Favorito... Ctrl+B ver Favoritos Espaciais Atributos

Mostrar Favoritos Ctrl+Shift+B ver Favoritos Espaciais Atributos

Atualizar Ctrl+R Navegação no Mapa
Escala deslizante ver Tilesets Escala quadriculada

6.1.5 Layer

Opção de menu Atalho Referência Barra de Ferramentas
New → ver Creating a new Vector layer Gerenciar camadas
Incorporar camadas e grupos... ver Projetos animados

Adicionar camada vetorial... Ctrl+Shift+V ver Trabalhando com dados vetoriais Gerenciar camadas

Adicionar camada raster Ctrl+Shift+R ver Carregando dados raster no QGIS Gerenciar camadas

Adicionar camada PostGIS Ctrl+Shift+D ver Camadas PostGIS Gerenciar camadas
Continuação na próxima página
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Tabela 6.1 – continuação da página anterior
Opção de menu Atalho Referência Barra de Ferramentas

Adicionar camada SpatiaLite Ctrl+Shift+L ver Camadas SpatiaLite Gerenciar camadas

Add MSSQL Spatial Layer Ctrl+Shift+M see MSSQL Spatial Layers Gerenciar camadas

Adicionar camada WMS Ctrl+Shift+W ver Cliente WMS Gerenciar camadas

Adicionar uma camada a partir de um texto delimitado ver Delimited Text Plugin Gerenciar camadas

Criar uma nova camada GPX ver Complemento GPS Gerenciar camadas

Adicionar Camada Oracle GeoRaster ver Complemento Oracle GeoRaster Gerenciar camadas

Adicionar camada SQL Anywhere ver Complemento SQL Anywhere Gerenciar camadas

Adicionar camada WFS Gerenciar camadas

Copiar estilo ver Aba de Estilo

Colar estilo ver Aba de Estilo

Abrir tabela de Atributos Atributos

Salvar alterações Digitalização

Alternar edição Digitalização
Savar como...
Savar arquivo vetor como... ver Trabalhando com a Tabela de Atributos

Remover Camada(s) Ctrl+D
Definir SRC da(s) Camada(s) Ctrl+Shift+C
Definir o SRC do projeto a partir da camada
Propriedades...
Pesquisa...

Rotular

Adicionar para a Visão Geral Ctrl+Shift+O Gerenciar camadas

Adicionar tudo para a Visão Geral

Remover tudo da Visão Geral

Mostrar todas as camadas Ctrl+Shift+U Gerenciar camadas

Ocultar todas as camadas Ctrl+Shift+H Gerenciar camadas
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6.1.6 Settings

Opção de menu Atalho Referência Barra de
Ferramentas

Painéis → see Painéis e Barra de Ferramentas
Barra de Ferramentas → see Painéis e Barra de Ferramentas
Mudar para o modo de
tela inteira

Ctrl-F

Propriedades do
Projeto ...

Ctrl+Shift+Pver Projetos

SRC Personalizado... ver Sistema de Referência de Coordenadas
Personalizado

Gerenciador de estilos... ver Gerenciador de estilo
Configurar atalhos...
Personalização ... ver Customização
Opções ... ver Opções

Opções de ajuste ...

6.1.7 Plugins

Opção de menu Atalho Referência Barra de Ferramentas

Buscar Complementos Python ver Complementos QGIS

Gerenciar complementos ver Gerenciar Complementos
Terminal Python
GRASS → ver Integração com SIG GRASS GRASS

6.1.8 Vector

Opção de menu Atalho Referência Barra de Ferramentas
Analisar → ver Complemento fTools
Captura de Coordenadas → ver Complemento Captura de coordenadas
Gerenciar dados → ver Complemento fTools
Dxf2Shp → ver Dxf2Shp Converter Plugin Vetor
Geometrias → ver Complemento fTools
Geoprocessing Tools → ver Complemento fTools
GPS → ver Complemento GPS Vetor
Investigar → ver Complemento fTools
Road Graph → ver Compemento Caminho Mais Curto
Consulta Epacial → ver Plugin de Consulta Espacial Vetor
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6.1.9 Raster

Opção de menu Atalho Referência Barra de Ferramentas
Calculadora Raster ver Calculadora Raster
Georeferenciador → ver Complemento Georreferenciador Raster
Mapa de calor → ver Complemento de Mapa de Calor Raster
Interpolação → ver Complemento de Interpolação Raster

Terrain Analysis ver Raster Terrain Analysis Plugin
Estatística por Zonas → see Complemento Estatística Zonal Raster
Projeções → ver :ref:‘label_plugingdaltools
Conversão → ver :ref:‘label_plugingdaltools
Extração → ver :ref:‘label_plugingdaltools
Análise → ver :ref:‘label_plugingdaltools
Miscelânea → ver :ref:‘label_plugingdaltools
Configurações do GdalTools ver :ref:‘label_plugingdaltools

6.1.10 Database

Opção de menu Atalho Referência Barra de Ferramentas
DB manager → ver Complemento DB Manager Base de Dados
eVis → ver Complemento eVis Base de Dados
Edição offline → ver Complemento Edição Offline Base de Dados
Spit → see Complemento SPIT Base de Dados

6.1.11 Web

Opção de menu Atalho Referência Barra de Ferramentas
MapServer Export ... → ver Complemento de exportação do MapServer Web
OpenStreetMap → ver OpenStreetMap OpenStreetMap

6.1.12 Help

Opção de menu Atalho Referência Barra de Ferramentas

Conteúdo da Ajuda F1 Ajuda

What’s This? Shift+F1 Ajuda
Documentação API

Página do QGIS Ctrl+H

Verificar a versão do QGIS

Sobre

Patrocinadores

Please not that for Linux the Menu Bar items listed above are the default ones in KDE window manager. In
GNOME, Settings menu is missing and its items are to be found here:
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Propriedades do Projeto Arquivo
Opções Editar
Configurar Atalhos Editar

Gerenciar estilo Editar

SRC personalizado Editar
Painéis → Exibir
Barra de Ferramentas → Exibir
Mudar para o Modo de Tela Inteira Exibir
Escala deslizante Exibir
Live GPS tracking Exibir

6.2 Barra de Ferramentas

A barra de ferramentas permite o acesso à maioria das mesmas funções dos menus, além de ferramentas adicionais
para interagir com o mapa. Cada item da barra de ferramentas pop-up tem ajuda disponível. Mantenha o mouse
sobre o item e uma breve descrição do propósito da ferramenta será exibido.

Every menubar can be moved around according to your needs. Additionally every menubar can be switched off
using your right mouse button context menu holding the mouse over the toolbars (read also Painéis e Barra de
Ferramentas).

Dica: Restaurar barra de ferramentas
If you have accidentally hidden all your toolbars, you can get them back by choosing menu option Settings →
Toolbars →. If a toolbar disappears under Windows, which seems to be a problem in QGIS from time to time,
you have to remove \HKEY_CURRENT_USER\Software\QuantumGIS\qgis\UI\state in the registry.
When you restart QGIS, the key is written again with the default state, and all toolbars are visible again.

6.3 Legenda do Mapa

The map legend area lists all the layers in the project. The checkbox in each legend entry can be used to show or
hide the layer.

Uma camada pode ser selecionada e arrastada para cima ou para baixo na legenda para mudar a z-ordenação. Z-
ordenação significa que as camadas listadas mais perto do topo da legenda são desenhadas sobre camadas listadas
mais abaixo na legenda.

Layers in the legend window can be organised into groups. There are two ways to do so:

1. Right click in the legend window and choose Add Group. Type in a name for the group and press Enter.
Now click on an existing layer and drag it onto the group.

2. Select some layers, right click in the legend window and choose Group Selected. The selected layers will
automatically be placed in a new group.

To bring a layer out of a group you can drag it out, or right click on it and choose Make to toplevel item. Groups
can be nested inside other groups.

A caixa de seleção de um grupo vai mostrar ou ocultar todas as camadas do grupo com apenas um clique.

The content of the right mouse button context menu depends on whether the selected legend item is a raster or a

vector layer. For GRASS vector layers Toggle editing is not available. See section Digitalizando e editando uma
camada vetorial GRASS for information on editing GRASS vector layers.

Menu botão direito do mouse para camadas raster

• Zoom to layer extent
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• Zoom to best scale (100 %)

• Show in overview

• Remove

• Set Layer CRS

• Set Project CRS from Layer

• Propriedades...

• Rename

• Copy Style

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

Additionally, according to layer position and selection

• Make to toplevel item

• Group Selected

Menu botão direito do mouse para camadas vetor

• Zoom to layer extent

• Show in overview

• Remove

• Set Layer CRS

• Set Project CRS from Layer

• Open attribute table

• Toggle editing (not available for GRASS layers)

• Save as

• Save selection as

• Query

• Show Feature Count

• Propriedades...

• Rename

• Copy Style

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

Additionally, according to layer position and selection

• Make to toplevel item

• Group Selected

Menu botão direito do mouse para grupo de camadas

• Zoom to group
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• Remove

• Set group CRS

• Rename

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

It is possible to select more than one layer or group at the same time by holding down the Ctrl key while selecting
the layers with the left mouse button. You can then move all selected layers to a new group at the same time.

You are also able to delete more than one Layer or Group at once by selecting several Layers with the Ctrl key
and pressing Ctrl+D afterwards. This way all selected Layers or groups will be removed from the layerlist.

6.3.1 Working with the Legend independent layer order

Since QGIS 1.8 there is a widget that allows to define a legend independent drawing order. You can activate it in
the menu Settings → Panels. Determine the drawing order of the layers in the map view here. Doing so makes it
possible to order your layers in order of importance, for example, but to still display them in the correct order (see

figure_layer_order). Checking the control rendering order box underneath the list of layers will cause a revert
to default behavior.

Figura 6.2: Define a legend independent layer order

6.4 Visualização do mapa

This is the “business end” of QGIS - maps are displayed in this area! The map displayed in this window will
depend on the vector and raster layers you have chosen to load (see sections that follow for more information on
how to load layers). The map view can be panned (shifting the focus of the map display to another region) and
zoomed in and out. Various other operations can be performed on the map as described in the toolbar description
above. The map view and the legend are tightly bound to each other - the maps in view reflect changes you make
in the legend area.
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Dica: Ampliando o mapa com a roda do mouse
You can use the mouse wheel to zoom in and out on the map. Place the mouse cursor inside the map area and
roll the wheel forward (away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor
position is the center where the zoom occurs. You can customize the behavior of the mouse wheel zoom using the
Map tools tab under the Settings → Options menu.

Dica: Percorrendo o mapa com as setas e a barra de espaço
Você pode usar as setas do teclado para se deslocar no mapa. Coloque o cursor do mouse dentro da área do mapa
e clique na seta para a direita para pan Leste, seta para a esquerda para pan Oeste, seta para cima para pan Norte e
para baixo seta para deslocar Sul. Você também pode deslocar o mapa utilizando a barra de espaço: basta mover
o mouse enquanto pressiona barra de espaço.

6.5 Barra de Status

A barra de status mostra sua posição atual nas coordenadas do mapa (por exemplo, metros ou graus decimais)
como o ponteiro do mouse é movido através da visualização do mapa. Para a esquerda da tela de coordenadas
na barra de status tem um pequeno botão que irá alternar entre mostrar posição coordenada ou como você está
visualizando as extensões do mapa como pan e zoom in e out.

Next to the coordinate display you find the scale display. It shows the scale of the map view. If you zoom in or out
QGIS shows you the current scale. Since QGIS 1.8 there is a scale selector which allows you to choose between
predefined scales from 1:500 until 1:1000000.

Uma barra de progresso na barra de status mostra o progresso de renderização como cada camada é atraída para
a visualização do mapa. Em alguns casos, como a coleta de estatísticas em camadas raster, a barra de progresso
será usada para mostrar o status de operações demoradas.

If a new plugin or a plugin update is available, you will see a message at the far right of the status bar. On the right
side of the status bar is a small checkbox which can be used to temporarily prevent layers being rendered to the

map view (see Section Renderização below). The icon immediately stops the current map rendering process.

To the right of the render functions you find the EPSG code of the current project CRS and a projector icon.
Clicking on this opens the projection properties for the current project.

Dica: Calculando a escala correta do seu Mapa da tela/visualização
When you start QGIS, degrees is the default unit, and it tells QGIS that any coordinate in your layer is in degrees.
To get correct scale values, you can either change this to meter manually in the General tab under Settings →

Project Properties or you can select a project Coordinate Reference System (CRS) clicking on the CRS status

icon in the lower right-hand corner of the statusbar. In the last case, the units are set to what the project projection
specifies, e.g. ‘+units=m’.
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CAPÍTULO 7

Ferramentas Gerais

7.1 Atalhos de teclado

QGIS provides default keyboard shortcuts for many features. You find them in Section Barra de Menu. Addition-
ally the menu option Settings → Configure Shortcuts allows to change the default keyboard shortcuts and to add
new keyboard shortcuts to QGIS features.

Figura 7.1: Define shortcut options (KDE)

A configuração é muito simples. Basta selecionar uma função da lista e clicar em [Mudar], [Desmarcar] ** ou
** [Marcar como padrão]. Depois de ter encontrado sua configuração, você pode salvar como um arquivo XML
e carregá-la em outra instalação do QGIS.

7.2 Conteúdo da ajuda

Quando precisar de ajuda sobre um tópico específico, você pode acessar a contúdo da ajuda através do: guilabel:
Botão ‘Ajuda’ disponível na maioria dos diálogos - observe que complementos de terceiros podem apontar para
páginas web dedicadas.

7.3 Renderização

Por padrão, o QGIS torna todas as camadas visíveis sempre que a tela do mapa for atualizada. Os eventos que
desencadeiam uma atualização da tela do mapa incluem:

• Adicionar uma camada
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• Pan ou zoom

• Redimensionar a janela do QGIS

• Mudanças na visibilidade de uma camada ou camadas

QGIS permite controlar o processo de renderização de várias formas.

7.3.1 Escala dependente da renderização

Renderização dependente da escala permite que você especifique as escalas mínimas e máxima em que uma
camada será visível. Para definir dependência de escala de renderização, abra o: guilabel: diálogo Propriedades
clicando duas vezes sobre a camada na legenda. Na: guilabel: na guia Geral, defina os valores de escala mínimo

e máximo e clique na : guilabel: caixa de seleção Utilize renderização de escala dependente.

Você pode determinar os valores de escala na primeira ampliação para o nível que você deseja usar e observando
o valor de escala na barra de status do QGIS.

7.3.2 Controlando a renderização do mapa

A renderização do mapa pode ser controlada por vários caminhos:

Suspending Rendering

Para suspender a rendirização, clique o :guilabel: caixa de seleção Renderizar no canto direito inferior da

barra de status. Quando a :guilabel: caixa de seleção Renderizar não estiver marcada, QGIS não redesenhará
a tela em resposta a qualquer evento descrito na Seção: ref:redraw_events. Exemplos de quando você pode querer
suspender a renderização incluem:

• Adicionar muitas camadas e simbolizá-las antes de desenhar

• Adicionar uma ou mais camadas grandes e definir a dependência de escala antes de desenhar

• Adicionar uma ou mais camadas e ampliar para uma visualização especifica antes de desenhar

• Qualquer combinação dos anteriores

Caixa de seleção :guilabel: caixa de seleção Renderizar permite renderização e causa uma atualização imediata
na tela do mapa.

Setting Layer Add Option

Você pode definir uma opção para sempre carregar novas camadas sem desenhá-las. Isto significa que a camada
será adicionada ao mapa, mas a sua caixa visibilidade na legenda será desmarcada por padrão. Para definir esta
opção, escolha a opção do menu :menuselection : Configurações -> Opções -> e clique na: guilabel: Guia

Renderização. Desmarque a : guilabel: caixa de seleção Por padrão novas camadas adicionadas ao mapa
podem ser mostradas. Qualquer camada adicionada ao mapa será desligada (invisível) por padrão.

Parar rendirização

To stop the map drawing, press the ESC key. This will halt the refresh of the map canvas and leave the map
partially drawn. It may take a bit of time between pressing ESC and the time the map drawing is halted.

Nota: No momento não é possível parar de renderização - ela foi desativada na porta qt4 por causa de problemas
e falhas na interface do usuário (UI).
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Updating the Map Display During Rendering

You can set an option to update the map display as features are drawn. By default, QGIS does not display any
features for a layer until the entire layer has been rendered. To update the display as features are read from
the datastore, choose menu option Settings → Options click on the Rendering tab. Set the feature count to an
appropriate value to update the display during rendering. Setting a value of 0 disables update during drawing (this
is the default). Setting a value too low will result in poor performance as the map canvas is continually updated
during the reading of the features. A suggested value to start with is 500.

Influence Rendering Quality

To influence the rendering quality of the map you have 2 options. Choose menu option Settings → Options click
on the Rendering tab and select or deselect following checkboxes.

• Fazer linhas aparecem com menos definição para não peder performance ao renderizar

• Ajustar problemas com polígonos preenchidos incorretamente

7.4 Medição

Medindo obras nos sistemas de coordenadas projetadas (por exemplo, UTM) e dados não projetados. Se o mapa
carregado é definido com um sistema de coordenadas geográficas (latitude / longitude), os resultados da linha ou
a medição da área será incorreta. Para corrigir isso, você precisa definir um sistema de coordenadas adequado
ao mapa (ver secção: ref: label_projections). Todos os módulos de medição também usam as configurações de
encaixe do módulo de digitalização. Isso é útil se você quiser medir ao longo de linhas ou áreas em camadas
vetoriais.

Para selecionar uma ferramenta clique medida em e selecione a ferramenta que deseja usar.

7.4.1 Medição de linha, áreas ou ângulos

QGIS is able to measure real distances between given points according to a defined ellipsoid. To configure
this, choose menu option Settings → Options, click on the Map tools tab and choose the appropriate ellipsoid.
There you can also define a rubberband color and your preferred measurement units (meters or feet) and angle
units (degrees, radians and gon). The tools then allows you to click points on the map. Each segment-length as
well as the total shows up in the measure-window. To stop measuring click your right mouse button.

Figura 7.2: Measure Distance (KDE)

Areas can also be measured. In the measure window the accumulated area size appears. In addition, the
measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance set. (See
Section Definir o valor de tolerância de proximidade para buscar apartir do raio). So if you want to measure
exactly along a line feature, or around a polygon feature, first set its snapping tolerance, then select the layer. Now,
when using the measuring tools, each mouse click (within the tolerance setting) will snap to that layer.
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Figura 7.3: Measure Area (KDE)

Você também pode medir ângulos, selecionando a ferramenta Medida de Ângulo. O cursor se transforma em
forma de cruz. Clique para desenhar o primeiro segmento do ângulo que você deseja medir, em seguida, mover o
cursor para desenhar o ângulo desejado. A medida é exibido em uma caixa de diálogo pop-up.

Figura 7.4: Measure Angle (KDE)

7.4.2 Selecionar e desselecionar feições

A barra de ferramentas do QGIS fornece várias ferramentas para selecionar as feições na tela do mapa. Para
selecionar uma ou mais feições basta clicar sobre | mActionSelect| e selecionar a ferramenta:

• Select single feature

• Feições através de retangulo

• Feições através de poligono

• Feições através de traço livre

• Feição através de raio

To deselect all selected features click on Deselect features from all layers.

7.5 Decorações

As Decorações do QGIS incluem o Rótulo Copyright (direitos autorais), a Seta Norte e a Barra de Escala. Elas
são usadas para ‘decorar’ o mapa adicionando os elementos cartográficos.

Nota: Antes da versão 1.8 do QGIS a mesma funcionalidade era fornecida pelo Complemento Decoração.

7.5.1 Rótulo Copyright

Copyright label adds a Copyright label using the text you prefer to the map.

1. Selecione a partir do menu Exibir → Decorações → Rótulo de Copyright. Abrirá a caixa de diálogo semel-
hante (ver figure_decorations_1).

2. Digite o texto que você deseja colocar no mapa. Pode usar HTML como mostrado no exemplo
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Figura 7.5: The copyright Dialog

3. Escolha a posição da etiqueta da: guilabel: Colocação ‘direito inferior’ caixa suspensa

4. Verifique se a : guilabel: caixa de seleção ‘Ativar Etiqueta Copyright‘está marcada

5. Clique [OK]

In the example above (default) QGIS places a copyright symbol followed by the date in the lower right hand corner
of the map canvas.

7.5.2 Seta Norte

North Arrow places a simple north arrow on the map canvas. At present there is only one style available. You
can adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine
the direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow you have
four options, corresponding to the four corners of the map canvas.

Figura 7.6: The North Arrow Dialog

7.5.3 Barra de Escala

Scale Bar adds a simple scale bar to the map canvas. You control the style and placement, as well as the
labeling of the bar.

QGIS suporta apenas exibir a escala nas mesmas unidades de seu mapa do quadro. Então, se as unidades de suas
camadas estão em metros, você não pode criar uma barra de escala em pés. Da mesma forma, se você estiver
usando graus decimais, você não pode criar uma barra de escala para mostrar a distância em metros.

Para adicionar uma barra de escala:

1. Selecione através do menu: menuselection:Exibir –> Decorações –> Barra de Escala abrirá o diálogo (ver
figure_decorations_3)
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Figura 7.7: The Scale Bar Dialog

2. Escolha a posição do: guilabel: Posição lista suspensa ‘Inferior Esquerda’

3. Escolha o estilo através do: guilabel:estilo de barra de escala lista ‘Marque abaixo’

4. Selecione a cor para a barra: guilabel:Cor da barra‘preta’ ou use a cor preta padrão

5. Defina o tamanho da barra e seu rótulo: guilabel: Tamanho da bar‘30 graus’

6. Verifique se a : guilabel: caixa de seleção ‘Ativar barra de escala‘ está marcada

7. Opcionalmente escolha para ajustar automaticamente a um número redondo quando a tela é redimensionada

: guilabel: se encaixam automaticamente para arredondar o número em redimensionar

8. Clique [OK]

Dica: Settings of Decorations
Quando você salva um projeto .qgs, todas as alterações que tenham sido feitas para Seta Norte, barra de escala e
Rótulo de Copyright serão salvas no projeto e restauradas na próxima vez que você carregar o projeto.

7.6 Ferramentas de anotação

The Text Annotation tools in the attribute toolbar provides the possibility to place formatted text in a balloon
on the QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Double click on the item opens a dialog with various options. There is the text editor to enter the formatted text
and other item settings. E.g. there is the choice of having the item placed on a map position (displayed by a marker
symbol) or to have the item on a screen position (not related to the map). The item can be moved by map position
(drag the map marker) or by moving only the balloon. The icons are part of GIS theme, and are used by default in
the other themes too.

The Move Annotation tool allows to move the annotation on the map canvas.

7.6.1 Anotação de formulário

Additionally you can also create your own annotation forms. The Form Annotation tool is useful to dis-
play attributes of a vector layer in a customized qt designer form (see figure_custom_annotation). It is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see QGIS blog
http://blog.qgis.org/node/143 for more information.
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Figura 7.8: Annotation text dialog

Figura 7.9: Customized qt designer annotation form
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Nota: If you press Ctrl+T while an Annotation tool is active (move annotation, text annotation, form annota-
tion), the visibility states of the items are inverted.

7.7 Favoritos Espaciais

Favoritos espaciais permite que você “marque” uma localização geográfica e volte a ela mais tarde.

7.7.1 Novo Favorito

Para criar um novo favorito:

1. Zoom ou pan na área de interesse.

2. Select the menu option View → New Bookmark or press Ctrl-B.

3. Adicione um nome descritivo para o favorito (no máximo 255 caracteres).

4. Press Enter to add the bookmark or [Delete] to remove the bookmark.

Note que você pode ter vários favoritos com o mesmo nome.

7.7.2 Trabalhando com favoritos

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Geospatial Bookmarks
dialog allows you to zoom to or delete a bookmark. You can not edit the bookmark name or coordinates.

7.7.3 Aproximar para um favorito

From the Geospatial Bookmarks dialog, select the desired bookmark by clicking on it, then click [Zoom To]. You
can also zoom to a bookmark by double-clicking on it.

7.7.4 Deletando um favorito

Para excluir um favorito da: guilabel: diálogo Favoritos Geoespaciais, clique sobre ele e depois em [Excluir].
Confirme sua escolha clicando [OK] ou cancelar a exclusão clicando [Cancelar].

7.8 Projetos animados

If you want to embed content from other project files into your project you can choose Layer → Embed Layers
and Groups.

7.8.1 Incorporando camadas

A seguinte aba permite incorporar camadas de outros projetos:

1. Pressione para olhar para outro projeto do conjunto de dados Alasca.

2. Selecione o arquivo de projeto grassland. Você pode ver o conteúdo do projeto (ver figure_embed_dialog).

3. Press Ctrl and klick on the layers grassland and regions. The layers are embedded in the map legend and
the map view now.
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Figura 7.10: Select layers and groups to embed

Enquanto as camadas incorporadas estão editáveis que você não pode alterar suas propriedades como estilo e
rotulagem.

Removing embedded layers

Right-click on the embedded layer and choose Remove .
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CAPÍTULO 8

Configurações do QGIS

QGIS is highly configurable through the Settings menu. Choose between Panels, Toolbars, Project properties,
Options and Customization.

8.1 Painéis e Barra de Ferramentas

In the Panels→ menu you can switch on and off QGIS widgets. The Toolbars→ menu provides the possibility to
switch on and off icon groups in the QGIS toolbar (see figure_panels_toolbars).

Figura 8.1: The Panels and Toolbars menu

Dica: Activating the QGIS Overview
No QGIS você pode usar uma janela de visualização geral que proporciona uma visualização completa das ca-
madas adiconadas ao projeto. Esta pode ser selecionada na barra de menu :menuselection: Configurações - >
Painéis. Nesta janela de visualização há um retanguloindicando a extenção atual do mapa em sua janela principal.
A janela de visualização geral permite que vocês identifique e determine que área do mapa está sendo visualizada
no momento. Note que os rótulos não são são apresentados na janela de visualização geral, mesmo que as camadas
do mapa tenham sido habilitadas para visualização de seus rótulos. Se você clicar a arrastar o retângulo vermelho
da janela de visualização geral que mostra a extenção visualizada do mapa principal, este último será atualizado
de acordo com a extensão especificada.

Dica: Show Log Messages

Since QGIS 1.8 it’s possible to track the QGIS messages. You can activate Log Messages in the menu Settings
→ Panels and follow the messages in the General and Plugin tab during loading and operation.
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8.2 Propriedades do Projeto

Na janela de propriedades do projeto em Configurações - > Propriedades do Projeto ou :menuselection:
cCnfigurações - > Propriedades do Projeto‘ configura-se suas opções. Isto inclui:

• Na aba General o título do projeto, defina a cor de fundo e de seleção, unidades das camadas, precisão, e a
opção de salvar caminho relativo das camadas podem ser definidas. Vocês pode definir a unidades da cmada
(somente quando a tranformação do CRS está desabilitada) e a precisão de casas decimais a ser considerada.

• A aba CRS Sistema de Referênciade Coordenadas possibilita escolher o CRS para o projeto, e habilitar “on
the fly re-projetion” de camadas matriciais e vetoriais quando utiliza-se camadas de CSR diferrente.

• Na terceira aba :guilabel:Ìdentificadir de camadas‘ pode-se deefinir (ou desabilitar) as camadas que repon-
derão à ferramenta de identificação. (ver parágrafo de Ferramentas de mapa daa sessão :ref: opções de
interface gráfica para habilitar a identificação de múltiplas camadas.)

• A aba OWS Server‘permite definir informações sobre os recursos do QGIS mapserver, a extensão e o CRS,
bem como os recursos WFS. Ativando o |checkbox| :‘guilabel:‘Adicionar geometria WKT à resposta de
informação da feição será possível consultar as camadas WMS.

8.3 Opções

Algumas opções basicas do QGIS podem ser selecionadas usando a caixa de diálogos :gulabel:‘Opções‘. Se-
lecione a opção :menuselection:’Configurações . >’ :menuselection: Opções. As abas onde você pode otizimar
suas configurações são:

8.3.1 Aba Geral

• |chackbox|Apto a salvar projeto quando requerido

• |chackbox|Avisar quando abrir um projeto salvo com uma versão antiga do QGIS

• Change Selection and Background color

• Salvar o estilo do QGIS

• Change the icon theme (choose between ‘default’, ‘classic’ and ‘gis’)

• Definir o tamanho dos ícones entre 16, 24 e 32 pixel.

• Alterar o tamanho do menu

• Definir o clique duplo para ação na legenda (escolher entre ‘abrir propriedade de camada’ e ‘abrir tabela de
atributos’)

• Tornar maiúsculo os nomes de camadas na leganda

• Mostrar nomes de atributos de classificação na legenda

• Criar ícones raster na legenda

• :guilabel:ão exibir tela inicial (splash screen)

• :guilabel:‘Mostrar dicas ao iniciar’

• Abrir resultados identificados numa pequena janela (necessário reiniciar QGIS)

• Abrir opções de ajuste em uma janela flutuante (necessário reiniciar QGIS)

• :guilabel:‘Abrir tabela de atributos em uma janela flutuante‘(necessários reiniciar QGIS)
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• Adicionar uma camada PostGIS com um duplo clique e seleciona no modo estendido

• Adiciona novas camadas ao grupo selecionado

• Copiar geometria em WKT a partir da tabela de atributos

• Comportamento da tabela de atributos (escolher entre ‘Mostrar todas feições’ (padrão), ‘Mostrar feições
selecionadas’ ou ‘Mostrar feições na tela atual’)

• Cache da linha da tabela de atributos

• Represeentação para valores nulos

• Prompt for raster sublayers . Some rasters support sublayers - they are called subdatasets in GDAL.
An example is netcdf files - if there are many netcdf variables, GDAL sees every variable as a subdataset.
The option is to control how to deal with sublayers when a file with sublayers is opened. You have the
following choices:

– ‘Always’: always ask (if there are existing sublayers)

– ‘If needed’: ask if layer has no bands, but has sublayers

– ‘Never’: never prompt, will not load anything

– ‘Load all’: never prompt, but load all sublayers

• Scan for valid items in the browser dock . The ‘Check extension’ option was designed to speed up
the loading of a directory, which can be time-consuming when ‘Check file contents’ is activated and there
are many files (tens or hundreds).

• Scan for contents of compressed files (.zip) in browser dock This option was also designed to speed
up the loading of a directory. You have the following choices:

– ‘Basic Scan’: checks that the extension is supported by one of the drivers

– ‘Full Scan’: opens every file to check it is valid

– ‘Passthru’: don’t use this option it will be removed in the next QGIS version

8.3.2 Aba GDAL

GDAL é uma biblioteca para dados matriciais. Nesta aba pode-se definir qual driver do GDAL será utilizado para
formatos matriciais. Em alguns casos mais de um driver fica disponível.

8.3.3 Aba Plugins

• Adicionar :guilabel: ‘Direções para procurar complementos adicionais C++’.

8.3.4 Aba Renderização

• :guilabel: ‘Por padrão novas camadas adicionadas ao mapa podem ser mostradas’

• Definir Número de feições para desenhar antes de atualizar a visualização.

• Use armazenamento de desenho onde possível para deixar a renderização masi rápida

• Fazer linhas aparecerem com menos definição para não perder performance ao renderizar

• Ajustar problemas com polígonos preenchidos incorretamente
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• :guilabel:‘Use nova geração de símbolos para renderização’

• Definir as configurações pdrão para visualização de rasters: Seleção de banda RGB’, |checkbox| :guil-
abel:‘Use desvio padrão‘ e Melhorar contraste

• Adicionar/Remover Caminhos para encontrar arquivos SVG

Além disso você pode definir quando salvar o caminho para diretório com SVG como absoluto na aba Geral no
menu Configurações - > Propriedades do Projeto.

8.3.5 Aba Ferramentas de mapa

• A configuração do :guilabel: Modo determina qual camada será visualizada na ferramenta de identificação.
Trocando para ‘De cima para baixo’ ou ‘De cima para baixo, parando no primeiro’ ao invés de ‘Camada
atual’ os atributos para todas as camadas identificáveis (ver seção Propriedade do projeto :ref:’sec_projects’
para configurar qual camada será identificável) serão mostradas com a ferramenta de identificação.

• Abrir formulário de feição, se uma feição simples for identificada

• Define :guilabel: Estabelecer um raio para identificar feições e mostrar no mapa

• Definir :guilabel: Elipsoide para cálculo de distância

• Definir :guilabel: Cor da linha de medida

• Definir :guilabel: Casas decimais

• Mandter unidade base

• :guilabel:‘Definir unidade de medida desejada (‘Metros’ ou ‘Pés’)

• :guilabel:‘Definir unidade de ângulo desejada (‘Graus’, ‘Radianos’ ou’Gon’)

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Definir :guilabel: Fator de aproximação/afastamento para ação da roda do mouse

8.3.6 Aba Sobreposições

• Define Placement algorithm for labels, symboly and diagrams (choose between ‘Central point’
(standard), ‘Chain’, ‘Popmusic tabu chain’, ‘Popmusic tabu’ and ‘Popmusic chain’)

8.3.7 Aba Digitalizar

• Definir Linha ao digitalizar Cor da linha e espessura da linha

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’)

• Definir Tolerância de atração padrão em unidades do mapa ou em pixels

• Definir Raio de busca para editar vértice em ‘unidades do mapa’ ou em ‘pixels’

• Mostrar marcadores apenas para feições selecionadas

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’) and vertex
Marker size.

• Suprimir atributos de janelas pop-up depois de cada feição criada

• Reutilizar útimo valor de atributo inscrito
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• Validar geometrias Editando linhas/polígonos complexos com muitos nós pode resultar em renderização
demorada. Isto se deve ao fato de o padrão de validação no QGIS pode demandar muito tempo. Para acelerar
a renderização é possível selecionar geometria de validação GEOS (iniciada no GEO 3.3) ou desligando a
validação da geometria. A validação de geometria GEOS é muito mais rápida, mas a desvantagem é que
apenas o primeiro problema de geometria será relatado.

As próximas 3 opções se referem a ferramenta |mActionOffserCurve| curva de deslocamento na Seção de edição
avançada. Através de várias configurações, é possível influenciar o formato da linha de deslocamento. Tais
opções estão disponíveis a partir do GEOS 3.3 .

• Join style for curve offset

• Segmentos de quadrantes para a curva de deslocamento

• Limite ‘milter’ para o deslocamento da curva

8.3.8 Aba CSR

A aba CSR é dividida em duas. A primeira Permite definir o CSR padrão para novos projetos.

• Defina o SCR e :guilabel:‘Sempre iniciar novos projetos com este SCR.

• |chackbox|Habilitar reprojeção ‘on the fly’ como padrão

A segunda área permite definir o padão para quando uma nova camada é criada, ou quando uma camada sem SCR
é carregada.

• Prompt para Sistema Referencial Cartográfico (SRC)

• Usar o SCR do projeto

• Usar SRC padrão mostrado abaixo

8.3.9 Aba Região

• Sobrepor idioma do sistema e Escolha o idioma a ser usado

• Informação sobre região ativa

8.3.10 Aba Rede

• Usar proxy para acessar a web e define ‘Máquina’, ‘Porta’, ‘Usuário’ e ‘Senha’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy is determined based on the application proxy set using

– Socks5Proxy: Generic proxy for any kind of connection. Supports TCP, UDP, binding to a port (in-
coming connections) and authentication.

– HttpProxy: Implemented using the “CONNECT” command, supports only outgoing TCP connections;
supports authentication.

– HttpCachingProxy: Implemented using normal HTTP commands, it is useful only in the context of
HTTP requests

– FtpCachingProxy: Implemented using an FTP proxy, it is useful only in the context of FTP requests

• Define:menuselection:Configurações de Cache (Pasta e Tamanho)

• Definir Buscar endereço WMS, o padrão é http://geopole.org/wms/search?search=\%1\&type=rss

• Definir Tempo máximo para pedido de rede (ms) - O padrão é 60000
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Figura 8.2: Proxy-settings in QGIS

A Exclusão e inclusão de alguns endereços (URLs) pode feito através da caixa de textp abaixo das configurações
de proxy (ver Figure_Network_tab) pressionando o butão [Adicionar]. Após clique duplo no campo URL criado,
entre o endereço da conexão. O butão [Remover] remove a entrada selecionada.

Se você precisa de informações detalhadas sobre as diferentes configurações de proxy, consulte o manual do
QT-library-documentation no endereço http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Dica: Usando Proxies
Usar proxies poder ser complicados, as vezes. É útil fazer ‘tentativa e erro’ dos tipos de proxies e checar se há
sucessos.

Você pode modificar as opções de acordo com suas necessidades. Algumas mudanças podem necessitar reinicial-
ização do QGIS para que seja efetivada.

• Configurações são salvas em um arquivo de texto em:$HOME?.config/QuantumGIS/qgis.conf

• |osx|Você pode encontrar as configurações em: $HOME/Library/Preferences/org.qgis.qgis.plist

• |win|As configurações são armazenadas no registro sob:

\HKEY\CURRENT_USER\Software\QuantumGIS\qgis

8.4 Customização

A ferramenta de custamização é um novo desenvolvimento no QGIS 1.8. Ela permitirá a (des)ativação de quase
todos os elementos na interface gráfica do QGIS. Isto pode ser muito útil se você possui muitos complementos
instalados qua você não usa e que sobrecarrega a tela.

QGIS Customization is divided into five groups. In Docks you find the dock windows. Dock windows are
applications that can be started and used as a floating, top-level window or embedded to the QGIS main window

as a docked widget (see also Painéis e Barra de Ferramentas). In Menus you can hide entries in the Menu

bar. In the Status Bar features like the coordinate information can be daectivated. In Toolbars you can

(de)activate the toolbar icons of QGIS and in Widgets you can (de)activate dialogs as well as their buttons.
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Figura 8.3: The Customization dialog

With Switch to catching widgets in main application you can click on elements in QGIS you want to be
hidden and find the corresponding entry in Customization (see figure_customization). You can also save your
various different setups for different use cases as well. Before your changes are applied, you need to restart QGIS.
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CAPÍTULO 9

Trabalhando com Projeções

O QGIS permite aos usuários definirem um SRC (Sistema de Referência de Coordenadas global ou ao nível
de projeto para camadas sem um SRC pré-definido. Ele permite também que o usuário defina um sistema de
referência de coordenadas personalizado e suporta “on-the-fly” (OTF) ás camadas de vetore e “raster”. Todas estas
características permitem ao usuário visualizar camadas com diferentes SRC e tê-los sobrepostos corretamente.

9.1 Visão geral do Suporte de Projeções

O QGIS tem suporte à aproximadamente 2.700 SRC conhecidos. Definições de cada um destes SRC são ar-
mazenadas em uma base de dados SQLite, que é instalada com o QGIS. Normalmente você não necessita ma-
nipular estas bases de dados diretamente. Na verdade, isso pode causar falhas no suporte à projeções. SRC
personalizados são arquivados em uma base de dados do usuário. Veja a seção :ref:’sec_custom_projections’ para
informações sobre gerenciamento do seu sistema de referência de coordenadas.

Os SRC disponíveis no QGIS são baseados naqueles definidos pelo “European Petroleum Search Group (EPSG)
e o Institut Geographique National de France (IGNF) e são em grande parte abstraídas da tabela de referência es-
pacial usada em GDAL. Identificadores EPSG estão presentes na base de dados e pode ser usados para especificar
um SRC no QGIS.

Para usar uma projeção OTF, seus dados precisam conter informações sobre seu sistema de referência de coorde-
nadas ou você precisará definir um global , para a camada ou para o projeto. Para camadas Post GIS o QGIS usa a
referência identificada que foi especificada quando a camada foi criada. Para dados suportados por OGR, o QGIS
baseia-se na presença de um formato reconhecido para especificar o SRC. No caso de arquivos “shape”, significa
um arquivo contendo a especificação “Well Known Text” (:index:’WKT’) do SRC. Este arquivo de projeção tem o
mesmo nome base do shapefile e uma extensção prj. Por exemplo, um shapefile nominado :file:’alaska.shp’ deve
ter um arquivo de projeção correspondente nominado :file:’alaska.prj’.

Sempre que você selecionar um novo SRC, as unidades utilizadas pela camada serão automaticamente modificadas
na gia :guilabel:’Geral’ da caixa de diálogo :guilabel:’Propriedades do Projeto’ sob o menu :guilabel:’Editar’
(Gnome, OSX) ou :guilabel:’Configurações’ (KDE, Windows).

9.2 Especificando uma projeção

O QGIS inicia cada novo projeto usando uma projeção global padrão. O SRC global padrão é EPSG:4326 - WGS
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs) e vem pré-definido no QGIS. Este padrão
pode ser alterado usando o botão [Select...] na primeira seção, usado para definir o Sistema de Coordenadas de
Referência Padrão para usar quando inicia-se um novo projeto, como apresentado em figura_projeção_1. Esta
ecolha será salva para ser usada nas seções subsequentes do QGIS.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Edit → Options (Gnome, OSX) or Settings → Options
(KDE, Windows).

The options shown in figure_projection_1 are:
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Figura 9.1: CRS tab in the QGIS Options Dialog

• Prompt for CRS

• Use project CRS

• Use default CRS displayed below

Se você quer definir o sistema de referência de coordenadas para uma certa camada sem informação de
SRC, você pode também fazê-lo na guia :guialabel:’Geral’ da caixa de diálogo propriedades de raster
(veja:ref:’label_generaltab’) e vetor (veja:ref:’vectorgeneraltab’). se sua camada já possui um SRC definido, esta
será mostrada como em :ref:’figura_vetor_propriedades_1’ .

Dica: SRC na Legenda de Mapas

Right-clicking on a layer in the Map Legend (Section Legenda do Mapa) provides two CRS short cuts. Set layer
CRS takes you directly to the Coordinate Reference System Selector dialog (see figure_projection_2). Set project
CRS from Layer redefines the project CRS using the layer’s CRS

9.3 Define On The Fly (OTF) Reprojection

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Há três maneiras de se fazer isso:

1. Selecione :menuselection: ‘Propriedades do projeto’ em ‘Editar’ (Gnome, OSX) ou :menuselec-
tion:’Configurações’ (KDE, Windows) menu.

2. Clique no ícone :sup:’Situação do SRC’ no canto inferior direito da barra de situação.

3. Turn OTF on by default, by selecting the CRS tab of the Options dialog and selecting Enable ‘on the fly’
reprojection by default.

If you have already loaded a layer, and want to enable OTF projection, the best practice is to open the Coordinate

Reference System tab of the Project Properties dialog, select a CRS, and activate the Enable on the fly CRS
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transformation checkbox. The CRS status icon will no longer be greyed-out and all layers will be OTF projected
to the CRS shown next to the icon.

Figura 9.2: Projection Dialog

The Coordinate Reference System tab of the Project Properties dialog contains five important components as
shown in Figure_projection_2 and described below.

1. Enable on the fly CRS transformation - this checkbox is used to enable or disable OTF projection. When
off, each layer is drawn using the coordinates as read from the data source and the components described
below are inactive.When on, the coordinates in each layer are projected to the coordinate reference system
defined for the map canvas.

2. Coordinate Reference System - this is a list of all CRS supported by QGIS, including Geographic, Pro-
jected and Custom coordinate reference systems. To define a CRS, select it from the list by expanding the
appropriate node and selecting the CRS. The active CRS is preselected.

3. Proj4text - este é o string SRC usado pelo mecanismo de projeção Proj4. Este texto é somente leitura e
fornecido apenas com propósito de informação.

4. Filter - if you know the EPSG code, the identifier or the name for a Coordinate Reference System, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

5. SRCs recentemente usados - se você tem SRCs que costuma usar em seus trabalhos de diários de SIG,
estes serão mostrados na tabela abaixo do Diálogo de Projeções. Clique em um destes abaixo para selecionar
o SRC associado.

Dica: Diálogo Propriedades do Projeto
Se você abrir a caixa de diálogo :guilabel:’Propriedades do projeto’ do menu :menusection:’Editar’ (Gnome,
OSX) ou :menuselection:’Configurações (KDE, Windows), você precisará clicar na guia :guilabel:’Sistema de
Referência de Coordenadas’ para ver as configurações de SRC.

Abrindo a caixa de diálogo pelo ícone :guilabel:’Situação do SRC’ vai apresentar automaticamente a guia
:guilabel:’Sistema de Referência de Coordenadas’ para a frente das demais.
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9.4 Sistema de Referência de Coordenadas Personalizado

Se o QGIS não fornece o sistema de coordenadas que você precisa, você pode definir um SRC personalizado.para

definir um SRC, selecione :guilabel:’SRC Personalizado’ do menu :menuselection:’Editar’ (Gnome, OSX) ou
:menuselection:’Configurações (KDE, Windows). SRCs personalizados são armazenados na base de dados do
usuário do QGIS. Além do seu SRC personalizado, este banco de dados também contém os marcadores espaciais
e outros dados personalizados.

Figura 9.3: Custom CRS Dialog

Defining a custom CRS in QGIS requires a good understanding of the Proj.4 projection library. To begin, refer to
the Cartographic Projection Procedures for the UNIX Environment - A User’s Manual by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf ).

Este manual descreve o uso da proj.4 e utilitários de linha de comando relacionados. Os parâmetros cartográficos
usados proj.4 são descritos no manual do usuário, e são os mesmos utilizados pelo QGIS.

A caixa de diálogo :guilabel:’Definição de um Sistema de Referência de Coordenadas Personalizado’ requer
somente dois parâmetros para definir um SRC personalizado:

1. um nome descritivo e

2. o parâmetro cartográfico no formato PROJ.4.

54 Capítulo 9. Trabalhando com Projeções

ftp://ftp.remotesensing.org/proj/OF90-284.pdf


QGIS User Guide, Versão 1.8

Para criar um novo SRC, clique no botão :sup:’Novo’ e entre com um nome descritivo e os parâmetros do

SRC. Depois disso você pode salvar sei SRC clicando no botão :sup:’Salvar’.

Observe que o item :guilabel:’Parâmetros’ deve começar com um bloco +proj=, para representar o novo sistema
de referência de coordenadas.

Você pode testar seus parâmetros SRC para ver se eles dão resultados razoáveis clicando no botão [Calcular]
dentro do bloco :guilabel:’Teste’ e colando seus parâmetros de SRC no campo :guilabel:’Parâmetros’. Depois
entre com um valor conhecido de latitude e longitude em WGS 84 nos campos :guilabel:’Norte’ e guilabel:’Leste’
respectivamente. Clique em [Calculate] e compare os resultados com os valores conhecidos em seus sistema de
referência de coordenadas.
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CAPÍTULO 10

Navegador QGIS

The QGIS Browser is a new panel in QGIS that lets you easily navigate in your database. You can have access
to common vector files (e.g. ESRI shapefile or MapInfo files), databases (e.g.PostGIS or MSSQL Spatial) and
WMS/WFS connections. You can also view your GRASS data (to get the data into QGIS see Integração com SIG
GRASS).

Figura 10.1: Qgis browser as a standalone application to view metadata, preview and attributes

Use o navegador QGIS para visualizar seus dados. A função de arrastar e soltar facilita a inserção de dados no
mapa e na legenda de mapa.

1. Ativar Navegador QGIS: Botão direito do mouse na barra de ferramentas e clique | caixa |: guilabel:
browser.

2. Arraste o painel para a janela de legenda.

3. Clique no: guilabel: guia Navegador Aba.

4. Procure em sua base de dados e escolha a pasta de shapefile qgis_sample_data.

5. Pressione o: kbd: Tecla Shift e clique em airports.shp e alaska.shp.

6. Pressione o botão esquerdo do mouse e arraste e solte os arquivos para a tela do mapa.
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7. Clique com o botão direito do mouse em uma camada e escolha: guilabel: Definir CRS projeto da camada.
Para mais informações veja: ref: label_projections.

8. Click on Zoom Full to make the layers visible.

Também é possível executar o Navegador QGIS como um aplicativo independente.

Iniciar navegador qgis

• Type in “qbrowser” at a command prompt.

• Inície o navegador QGIS usando o menu Iniciar ou atalho no desktop, ou clique duas vezes em um
arquivo de projeto QGIS.

• QGIS browser is not available yet from your your Applications folder. However it can eas-
ily be made available. In Finder use Go → Go to map... and use it to find the folder
/Applications/QGIS.app/Contents/MacOS/bin. Use the key combination option -
command and drag qbrowser.app while holding down the left mouse button to the Applications folder.
This will create a link that you can use to start QGIS browser.

In figure_browser_standalone_metadata you can see the enhanced functionality of Qgis browser. The Param tab
provides the details of your connection based datasets like PostGIS or MSSQL Spatial. The Metadata tab contains
general information about the file (see Aba Metadado). With the Preview tab you can have a look at your files
without importing them into your QGIS project. It’s also possible to preview the attributes of your files in the
Attributes tab.
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CAPÍTULO 11

Trabalhando com dados vetoriais

11.1 Formatos de dados suportados

QGIS uses the OGR library to read and write vector data formats (GRASS vector and PostgreSQL support is
supplied by native QGIS data provider plugins),including ESRI Shapefiles, MapInfo and Microstation file formats;
PostGIS, SpatiaLite, Oracle Spatial databases and many more. The vector data can also be loaded in read mode
from zip and gzip archives into QGIS. At the date of this document, 69 vector formats are supported by the
OGR library (see OGR-SOFTWARE-SUITE Referências Bibliográficas e Web). The complete list is available at
http://www.gdal.org/ogr/ogr_formats.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries or the GDAL/OGR installation of your OS was not build to support the format you want to
use. Only those formats that have been well tested will appear in the list of file types when loading a vector into
QGIS. Other untested formats can be loaded by selecting *.*.

Procedimentos com dados vetoriais GRASS são descritos na Seção Integração com SIG GRASS.

This section describes how to work with several common formats: ESRI Shapefiles, PostGIS layers and SpatiaLite
layers. Many of the features available in QGIS work the same, regardless of the vector data source. This is by
design and includes the identify, select, labeling and attributes functions.

11.1.1 Shapefiles ESRI

O formato de arquivo vetorial padrão usado pelo QGIS é o Shapefile ESRI. O suporte é fornecido pela Livraria
OGR Simple Feature ( http://www.gdal.org/ogr/ ).

Um shapefile consiste na verdade de um conjunto de vários arquivos. Os três seguintes são necessários:

1. .shp arquivo que contém as formas vetoriais.

2. .dbf arquivo que contém os atributos no formato dBase..

3. .shx arquivos indicadores.

Shapefiles também podem incluir um arquivo com a extensão .prj que contém as informações de pro-
jeção. Embora seja muito útil um arquivo de projeção, não é obrigatória. Um conjunto de dados
shapefile pode conter arquivos adicionais. Para mais detalhes veja a especificação técnica ESRI em:
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Carregando um Shapefile

Para carregar um shapefile, inicie o QGIS e clique no botão Adicionar camada vetorial da barra de ferramentas
ou simplesmente digite Ctrl+Shift+V. Isso fará com que surja uma nova janela (see figure_vector_1).
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Figura 11.1: Add Vector Layer Dialog

From the available options check File. Click on button [Browse]. That will bring up a standard open file dialog
(see figure_vector_2) which allows you to navigate the file system and load a shapefile or other supported data

source. The selection box Filter allows you to preselect some OGR supported file formats.

Você também pode selecionar o tipo de codificação para o shapefile, se desejar.

Figura 11.2: Open an OGR Supported Vector Layer Dialog

Ao selecinar um shapefile a partir da lista e clicando em [Abrir] o QGIS o carregará. A Figure_vector_3 exibe o
QGIS depois de carregar o arquivo alaska.shp.

Dica: Cores das camadas
Quando você adiciona uma camada ao mapa, é atribuída uma cor aleatória. Na adição de mais de uma camada de
uma vez, são atribuídas cores diferentes para cada camada.

Uma vez carregado, você pode aplicar zoom em todo o shapefile usando as ferramentas de navegação do mapa.
Para alterar o estilo de uma camada, abra a caixa de diálogo Propriedades da camada clicando duas vezes no
nome da camada ou clicando com o botão direito do mouse sobre o nome na legenda e escolha Propriedades a
partir do menu pop-up. Consulte a Seção Aba de Estilo para mais informações sobre a definição da simbologia
das camadas vetoriais.

Dica: Carregando camadas e armazenando projetos em unidades externas no OS X
No OS X, unidades portáteis que são armazenadas além do disco rígido principal não aparecem no File →Open
Project ‘como esperado. Para resolver isso estamos trabalhando em uma forma mais nativa do OS X com caixa
de diálogo abrir/salvar. Como alternativa, você pode digitar ‘/Volumes’ no campo Nome do arquivo e pressione
:kbd:‘Voltar. Depois, você pode navegar para unidades externas ou armazenadas em rede.
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Figura 11.3: QGIS with Shapefile of Alaska loaded

Melhorando o Desempenho do Shape

Para melhorar o desempenho do desenho de um shapefile, você pode criar um índice espacial. Um índice espacial
irá melhorar a velocidade do zoom e visão panorâmica. Os índices espaciais utilizados pelo QGIS estão na
extensão .qix.

Siga estes passos para criar o índice:

• Carregue um shapefile.

• Abra a caixa de diálogo Propriedades da camada clicando duas vezes sobre o nome do shapefile na legenda
ou com o botão direito do mouse e escolha Propriedades a partir do menu pop-up.

• Na guia :guilabel:’Geral’, clique no botão [Criar índice espacial].

Problema ao carregar um arquivo shape .prj

Se você carregar um arquivo shapefile .prj no QGIS e o sistema não é capaz de ler a referência de coordenadas
a partir desse arquivo, você tem que definir a projeção adequada manualmente dentro guia :Guilabel:’Geral’ da
caixa de diálogo Propriedades da camada. Isto é devido ao fato de que arquivos .prj muitas vezes não fornecem
os parâmetros de projeção completos, conforme usado no QGIS e listados na guia CRS.

Por essa razão, se você criar um novo shapefile no QGIS, dois arquivos de projeção diferentes são criados. Um
arquivo .prj com os parâmetros limitados de projeção, compatível com o software ESRI, e um arquivo .qpj,
fornecendo os parâmetros completos dos CRS usados. Se o QGIS encontra um arquivo .qpj, ele será usado em
vez do arquivo prj.

11.1.2 Carregando uma camada MapInfo

To load a MapInfo layer, click on the Add Vector Layer toolbar button or type Ctrl+Shift+V, change the

file type filter Filter : to ‘Mapinfo File [OGR]’ and select the MapInfo layer you want to load.

11.1.3 Carregando uma camada ArcInfo Binary

To load an ArcInfo binary coverage, click on the Add Vector Layer toolbar button or press Ctrl+Shift+V to

open the Add Vector Layer dialog. Select Directory. Change to Filter to ‘Arc/Info Binary Coverage’.
Navigate to the directory that contains the coverage files and select it.
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Da mesma forma, você pode carregar arquivos vetoriais baseados em um diretório no formato UK National Trans-
fer, bem como os formatos TIGER do Census Bureau US.

11.1.4 Camadas PostGIS

Camadas PostGIS são armazenados em um banco de dados PostgreSQL. As vantagens do PostGIS são a indexação
espacial, filtragem e recursos de consulta. Usando o PostGIS, funções vetoriais, como selecionar e identificar
permitem um trabalho com mais precisão do que com camadas OGR no QGIS.

Criando uma conexão armazenada

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Name: A name for this connection. Can be the same as Database

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf

• Host: Name of the database host. This must be a resolvable host name the same as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Port number the PostgreSQL database server listens on. The default port is 5432.

• Database: Name of the database.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speedups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. Following options are
available:

– desabilitar: apenas tentar uma conexão SSL não criptografada

– permitir: tentar uma conexão não-SSL, se isso falhar, tente uma conexão SSL

– preferir (por padrão): tentar uma conexão SSL, se isso falhar, tentar uma conexão não-SSL;

– requer: só tentar uma conexão SSL.

• Username: User name used to login to the database.

• Password: Password used with Username to connect to the database.

Opcionalmente você pode ativar as seguintes caixas de seleção:

• Salvar nome do usuário

• Salvar Senha

• Apenas olhar na tabela geometry_columns

• :guilabel:‘Apenas olhar no esquema ‘público’

• Também listar tabelas sem geometrias

• Usar metadados atribuidos da tabela
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Uma vez que todos os parâmetros e as opções estão configuradas, você pode testar a conexão clicando no botão
[Testar Conexão].

Dica: QGIS Configurações do Usuário e Segurança
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk. Your
customized settings for QGIS are stored based on the operating system:

• , as configurações são armazenadas no arquivo .qgis/ em seu diretório home.

• , as configurações são armazenadas no registro.

Carregando uma camada PostGIS

Uma vez que você tem uma ou mais conexões definidas, você pode carregar as camadas do banco de dados
PostgreSQL. Claro que isso exige ter dados no PostgreSQL. Consulte a Secção Importação de dados no Post-
greSQL para entender sobre a importação de dados para o banco de dados.

Para colocar uma camada no PostGIS, execute os seguintes passos:

• If the Add PostGIS layers dialog is not already open, click on the Add PostGIS Layer toolbar button.

• Escolha a conexão a partir da lista drop-down e clique em [Conectar].

• Marque ou desmarque Listar tabelas sem geometrias

• Optionally use some Search Options to define which features to load from the layer or use the [Build
query] button to start the Query builder dialog.

• Encontre a camada(s) que deseja adicionar na lista de camadas disponíveis.

• Selecione-a clicando sobre ela. Você pode selecionar várias camadas pressionando a tecla Shift enquanto
clica. Consulte a Seção Ferramenta de Consulta para obter informações sobre como usar o Query Builder
PostgreSQL para melhor definição da camada.

• Clique no botão [Add] para adicionar a camada ao mapa.

Dica: Camadas PostGIS
Normalmente uma camada PostGIS é definida por um caminho na tabela. A partir da versão 0.9.0 em diante,
o QGIS permite carregar camadas que não têm um caminho na tabela geometry_columns. Isto inclui ambas as
tabelas e exibições. A definição de uma visão espacial fornece um meio poderoso para visualizar seus dados.
Consulte o manual do PostgreSQL para obter informações sobre a criação de pontos de vista diversos.

Alguns detalhes sobre as camadas PostgreSQL

Esta seção contém alguns detalhes sobre como o QGIS acessa camadas do PostgreSQL. Na maioria das vezes
o QGIS simplesmente deve fornecer-lhe uma lista de tabelas do banco de dados que podem ser carregadas, e
carregá-las mediante solicitação. No entanto, se você tiver problemas para carregar uma tabela do PostgreSQL no
QGIS, as informações abaixo podem ajudá-lo a entender as mensagens do QGIS e dar-lhe orientações para alterar
a tabela de PostgreSQL ou ver definições para permitir o QGIS carregá-la.

O QGIS requer que as camadas PostgreSQL contenham uma coluna que pode ser usada como uma chave única
para a camada. Para tabelas, isso geralmente significa que a tabela precisa de uma chave primária, ou uma coluna
com uma restrição exclusiva sobre ela. No QGIS, esta coluna tem de ser do tipo int4 (um inteiro de 4 bytes).
Alternativamente, a coluna ctid pode ser usada como chave primária. Se uma tabela não tem esses itens, a coluna
oid será usado em seu lugar. O desempenho será melhorado se a coluna é indexada (note que as chaves primárias
são automaticamente indexadas pelo PostgreSQL).
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Se a camada PostgreSQL é um ponto de vista, a mesma exigência existe, mas as vistas não têm chaves primárias
ou colunas com restrições exclusivas sobre ela. Neste caso o QGIS vai tentar encontrar uma coluna na vista que
é derivada de uma coluna da tabela adequada. Ele faz isso ao analisar o ponto de vista de definição do SQL. No
entanto, existem vários aspectos do SQL que o QGIS ignora, estes incluem o uso de apelidos da tabela e colunas
que são gerados por funções SQL.

Se uma coluna adequada não for encontrada, o QGIS não irá carregar a camada. Se isto ocorrer, a solução é alterar
o ponto de vista de forma que ele inclui uma coluna adequada (um tipo de int4 com uma chave primária ou com
uma única restrição, de preferência, indexados).

11.1.5 Importação de dados no PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, such as the SPIT plugin, or the command line
tools shp2pgsql or ogr2ogr.

Complemento SPIT

QGIS comes with a core plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to
load multiple shapefiles at one time and includes support for schemas. See Section Complemento SPIT for more
information.

shp2pgsql

PostGIS includes a utility called shp2pgsql that can be used to import shapefiles into a PostGIS enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Isso cria uma nova camada chamada lakes_new no banco de dados gis_data. A nova camada terá um
identificador de referência espacial (SRID) de 2964. Consulte a Seção Trabalhando com Projeções para mais
informações sobre os sistemas de referência espacial e projeções.

Dica: Exportando conjuntos de dados do PostGIS
Assim como a ferramenta de importação shp2pgsql, há também uma ferramenta para exportar conjuntos de dados
PostGIS como shapefiles: pgsql2shp. Este é enviado dentro de sua distribuição PostGIS.

ogr2ogr

Junto ao shp2pgsql e ao SPIT existe uma outra ferramenta para a insersão de dados geográficos no PostGIS:
ogr2ogr. Esta é parte da instalação do GDAL.

Para importar um shapefile no PostGIS, faça o seguinte :

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres \
password=topsecret" alaska.shp

Isto irá importar o shapefile alaska.shp para o banco de dados PostGIS postgis usando o usuário postgres com
a senha topsecret no servidor myhost.de.

Note que o OGR deve ser construído com PostgreSQL para suportar PostGIS. Você pode ver isso digitando

ogrinfo --formats | grep -i post
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Se você gosta de usar o comando PostgreSQL COPY em vez do método padrão INSERT INTO, você pode

exportar a seguinte variável no ambiente (pelo menos disponível no e ):

export PG_USE_COPY=YES

O ogr2ogr não cria índices espaciais como faz o shp2pgsl. Você precisa criá-los manualmente, normalmente
usando o comando SQL CREATE INDEX como um passo extra (como descrito na próxima seção melhorando o
Desempenho).

melhorando o Desempenho

Retrieving features from a PostgreSQL database can be time consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on
each layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed
up spatial searches of the data (GiST index information is taken from the PostGIS documentation available at
http://postgis.refractions.net).

The syntax for creating a GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Observe que para grandes tabelas, a criação do índice pode levar um longo tempo. Uma vez que o índice é
criado, você deve realizar um VACUUM ANALYZE. Consulte a documentação do PostGIS (PostGIS-PROJECT
Referências Bibliográficas e Web) para mais informações.

A seguir um exemplo de criação de um índice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

11.1.6 Camadas vetoriais que ultrapassam 180° de longitude

Many GIS packages don’t wrap vector maps, with a geographic reference system (lat/lon), crossing the 180 de-
grees longitude line (http://postgis.refractions.net/documentation/manual-1.4/ST_Shift_Longitude.html). As re-
sult, if we open such map in QGIS, we will see two far, distinct locations, that should show near each other. In
Figure_vector_4 the tiny point on the far left of the map canvas (Chatham Islands), should be within the grid, right
of New Zealand main islands.

A workaround is to transform the longitude values using PostGIS and the ST_Shift_Longitude function This
function reads every point/vertex in every component of every feature in a geometry, and if the longitude coordi-
nate is < 0° adds 360° to it. The result would be a 0° - 360° version of the data to be plotted in a 180° centric map.
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Figura 11.4: Map in lat/lon crossing the 180° longitude line

Figura 11.5: Crossing 180° longitude applying the ST_Shift_Longitude function

Uso

• Importar dados para o PostGIS (Importação de dados no PostgreSQL), utilizando, por exemplo, o comple-
mento PostGIS Manager ou o complemento SPIT

• Use a interface de linha de comando PostGIS para emitir o seguinte comando (este é um exemplo onde a
“TABLE” é o nome real da sua tabela no PostGIS)

gis_data=# update TABLE set the_geom=ST_Shift_Longitude(the_geom);

• Se tudo correu bem, você deve receber uma confirmação sobre o número de feições que foram atualizadas,
então você vai ser capaz de carregar o mapa, veja a diferença (Figure_vector_5)

11.1.7 Camadas SpatiaLite

A primeira vez que você carregar dados de um banco de dados SpatiaLite, comece clicando no botão

:sup: Adicionar Camada SpatiaLite na barra de ferramentas ou selecione a opção :menuselection:’Adicionar
Camada SpatiaLite ... no menu Camada ou digitando Ctrl+Shift+L. Isso fará com que surja uma janela, que
permitirá você se conectar a um banco de dados SpatiaLite já identificado no QGIS, que você pode escolher no
menu suspenso ou para definir uma nova conexão para um novo banco de dados. Para definir uma nova conexão,
clique em [New] e use o navegador de arquivos para apontar para o banco de dados SpatiaLite, que é um arquivo
com extensão .sqlite.

If you want to save a vector layer to SpatiaLite format you can do this by right clicking the layer in the legend.
Then click on Save as.., define the name of the output file, select ‘SpatiaLite’ as format and the CRS. Also you can
select ‘SQLite’ as format, and then add SPATIALITE=YES in the OGR data source creation option field. This
tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.
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QGIS also supports editable views in SpatiaLite.

Criando uma nova camada SpatiaLite

Se você quiser criar uma nova camada SpatiaLite, consulte a seção Criando uma nova camada SpatiaLite.

Dica: Gestão complementos de dados SpatiaLite
For SpatiaLite data management you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or DB
Manager (core plugin, recommended). They can be downloaded and installed with the Plugin Installer.

11.1.8 MSSQL Spatial Layers

QGIS also provides native MS SQL 2008 support. The Add MSSQL Spatial Layer is part of the new toolbar
button or available in the MS SQL node in the QBrowser tree, providing drag and drop import support.

11.2 Janela de Propriedades de Vetor

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
popup menu.

Figura 11.6: Vector Layer Properties Dialog

11.2.1 Aba de Estilo

|simbologia|Desde|qg|1.4.0 uma nova simbologia foi integrada paralelamente para melhorar e finalmente substi-
tuir a antiga simbologia. |qg|1.8 agora usa a nova simbologia como padrão, tal qual garante uma variedades de
melhorias e novas funções.

Uma descrição da antiga simbologia está disponível na seção Simbologia Antiga.
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Existem três tipos de símbolos: Símbolos de marcação (para pontos), símbolos de linhas (para linhas) e símbolos
de preenchimento e contorno (para polígonos). Símbolos podem ser de uma ou mais camadas. É possivel definir a
cor de um símbolo e esta cor é então definida para toda as camadas do símbolo. Algumas camadas podem ter suas
cores bloqueadas - em casos que a cor não pode ser alterada. Isto é útil quando você define a cor de um símbolo
multicamadas. Da mesma forma, é possivel definir a espessura dos símbolos de linha, assim como o tamanho e
rotação dos simbolos de marcação.

Tipos de símbolos de camada disponíveis

• Camadas de Ponto

– Marcador de Fonte: Renderização com uma fonte.

– Marcador Simples. Renderização com um marcador do tipo hardcoded.

– Marcador SVG: Renderização com uma imagem SVG.

– Marcador Elipse: Renderizado com vetores de elipse derivados de atributos.

– **Marcador do Campo Vetor”: Renderização com campos de vetores derivados de atributos.

• Camadas tipo Linhas

– Decoração de Linhas: Adicione uma decoração de linha, ex: uma seta para indicar a direção da linha.

– Linha tipo Marcador: Uma linha renderizada a partir da repetição de um símbolo do tipo marcador.

– Linha Simples: Renderização normal de uma linha (com cor, espessura e estilo de pena).

• Camada de Polígonos

– Preenchimento tipo Centróide: Preenche o centróide de um polígono com a marcação tipo hard-
coded.

– Preenchimento SVG: Preenche um polígono com um símbolo SVG.

– Preenchimento Simples. Renderização usual de um polígono (com cor, padrão de preenchimento e
contorno definidos).

– Preenchimento tipo Padrão de Linha: Preenche um polígono com um padrão de linha.

– Preenchimento tipo Padrão de Ponto: Preenche um polígono com um padrão de ponto.

– Contorno: Decoração de Linha: Adiciona uma decoração de linha, ex: uma linha para indicar uma
direação de linha.

– Contorno:Linha de Marcador: Utilize um marcador do tipo hardcoded como contorno de linha.

– Contorno: Linha Simples. Define espessura, cor e estilo de pena como contorno de linha.

Rampas de Cor

As rampas de cor servem para definir a abrangência de cores que podem ser utilizadas durante a criação de
renderizadores. A cor do símbolo será definida pela rampa de cores.

Existem três tipos de rampas de cor:

• Gradiente: Linha gradiente de uma cor até outra.

• Randômica: Cores randômicas geradas por um local específico do espaço de cores.

• Cor Brewer: Criar área de cor para um esquema de cor e um número definido de classes de cor.

Rampas de cores podem ser definidas no: guilabel: Rampa de cor da aba: guilabel: Gerenciador de Estilo clicando
no botão [Adicionar] e, em seguida, escolher um tipo de rampa de cores (ver seção vector_style_manager).

Estilos

A style groups a set of various symbols and color ramps. You can define your prefered or frequently used symbols,
and can use it without having to recreate it everytime. Style items (symbols and color ramps) have always a name
by which they can be queried from the style. There is at least one default style in QGIS (modifiable) and the user
can add further styles. In the lower part of the Style tab there are four buttons for managing styles: Use [Restore
Default Style] to get back to your default settings, [Save As Default] to save your style as default, [Load Style...]
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to get to your own styles and [Save Style] to save your own styles. Layer styles can also be transferred from one

layer to another layer. Activate a layer and choose Layer → Copy style and switch to another layer. Then

choose Layer → Paste style.

Renderizando

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized (called unique color in the old symbology), graduated and rule-based. There
is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The categorized
and graduated renderer can be created by specifying a symbol and a color ramp - they will set the colors for
symbols appropriately. Trabalhando com a Nova Geração de Simbologia

In the Style tab you can choose one of the five renderers: single symbol, categorized, graduated, rule-based and
point displacement. For each data type (points, lines and polygons) vector symbol layer types are available (see
vector_symbol_types). Depending on the chosen renderer, the symbology Depending on the chosen renderer,
the Style tab provides different following sections. The new generation symbology dialog also provides a [Style
Manager] button which gives access to the Style Manager (see Section Gerenciador de estilo). The Style Manager
allows you to edit and remove existing symbols and add new ones.

Dica: Seleção e mudança de simbolos multiplos
The New Generation Symbology allows to select multiple symbols and right click to change color, transparency,
size, or width of selected entries.

Renderizando Simbolo Individual

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, that can be adjusted in the Style tab, depend partially on the type of the layer, but all types share
the following structure. In the top left part of the tab, there is a preview of the current symbol to be rendered. In
the bottom part of the tab, there is a list of symbols already defined for the current style, prepared to be used via
selecting them from the list. The current symbol can be modified using the [Change] button below the preview,
which opens a Symbol Properties dialog, or the [Change] button right of the preview, which opens an ordinary
Color dialog.

Figura 11.7: Single symbol line properties

No guia: guilabel: Estilo você pode definir além de uma camada de transparência em geral também usar a unidade
de milímetros ou mapa para a escala de tamanho. No botão [Avançado] junto com o botão [Salvar como estilo],
você pode usar dados definidos pela escala de tamanho e rotação. Aqui o menu :menuselection: níveis de símbolo
-> permite ativar e definir a ordem pela qual as camadas de símbolos são processados (se o símbolo é constituído
por mais do que uma camada).

Depois de ter feito as alterações necessárias, o símbolo pode ser adicionado à lista de símbolos de estilos atuais
(usando o botão ** [Salvar como estilo] ) e então facilmente ser usado no futuro. Além disso, você pode usar
o botão **[Salvar Estilo] para salvar o símbolo como um arquivo de estilo de camada QGIS (.qml) ou arquivo
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SLD (. sld). Atualmente na versão 1.8 SLD podem ser exportados a partir de qualquer tipo de renderizador: sím-
bolo, categorizado, graduado ou baseado em regras, mas quando a importação de um SLD, um único símbolo ou
renderizador baseado em regras é criado. Isso significa que os estilos categorizados ou graduados são convertidos
com baseado em regra. Se você quer preservar esses renderizadores, você tem que ficar com o formato QML. Por
outro lado, pode ser muito útil, por vezes, para ter esta maneira fácil de converter estilos baseado em regra.

Renderizador Categorizado

O Rendirizador Categorizado é usado para processar todos os recursos a partir de uma camada, usando um único
símbolo definido pelo usuário, sua cor reflete o valor do atributo de uma feição selecionada. A guia: guilabel:
estilo permite que você selecione:

• O Atributo (Usando a coluna listagem)

• Simbolo (usando a aba Simbolo)

• As cores (usando rampa de cores lista box)

O botão [Avançado] no canto inferior direito da caixa de diálogo, permite definir os campos que contenham
informações de rotação e tamanho de escala. Para maior comodidade, a lista na parte inferior da guia, elenca os
valores de todos os atributos selecionados no momento em conjunto, incluindo os símbolos que serão renderizados.

The example in figure_symbology_2 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Figura 11.8: Categorized Symbolizing options

You can create a custom color ramp choosing New color ramp... from the Color ramp dropdown menu. A dialog
will prompt for the ramp type: Gradient, Random, ColorBrewer, then each one has options for number of steps
and/or multiple stops in the color ramp. See figure_symbology_3 for an example of custom color ramp.

Figura 11.9: Example of custom gradient color ramp with multiple stops
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Renderização Graduada

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol, whose
color reflects the classification of a selected feature’s attribute to a class.

Figura 11.10: Graduated Symbolizing options

Like Categorized Renderer, it allows to define rotation and size scale from specified columns.

Análogo a renderização categorizada, a :guilabel: aba Estilo permite que voce selecione:

• O Atributo (Usando a coluna listagem)

• O simbolo (usando o botão Propriedades do Simbolo)

• As cores (usando a lista de rampas de cores)

Adicionalmente, voce pode especificar o numero de classes e também o modo como classificar os recursos dentro
das classes (usando o Modo lista). Os modos disponíveis são:

• Intervalo igual

• Quartil

• Quebras Naturais (Jenks)

• Desvio padrão

• Quebras suaves

The listbox in the bottom part of the Style tab lists the classes together with their ranges, labels and symbols that
will be rendered.

The example in figure_symbology_4 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Renderizador baseado em regras

O renderizador baseado em regras é utilizado para renderizar todas as feições de uma camada utilizando símbolos
baseados em regras, cujas cores refletem a classificação do atributo de uma feição selecionada para uma classe.
As regras são baseadas em declarações SQL. A janela permite agrupar as regras através de filtros e escala e você
pode decidir se quer habilitar níveis de símbolos ou usar somente a primeira regra correspondente.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by clicking on it or click on ‘+’ and click on the new rule. Then press the

[Edit] button. In the Rule properties dialog you can define a label for the rule. Press the button to open the
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Expression builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to
be searched. To add an attribute to the Field calculator Expression field, double click its name in the Fields and
Values list. Generally you can use the various fields, values and functions to construct the calculation expression
or you can just type it into the box (see Calculadora de campo).

Figura 11.11: Rule-based Symbolizing options

Deslocamento de ponto

O renderizador de deslocamento de ponto oferece a visualização de todas as feições de uma camada de pontos,
mesmo se eles tem a mesma localização. Para para isso, os símbolos dos pontos são postos em um círculo de
deslocamento ao redor de um símbolo.

Figura 11.12: Point displacement dialog

Propriedades de Símbolos

The symbol properties dialog allows the user to specify different properties of the symbol to be rendered. In the
bottom left part of the dialog, you find a preview of the current symbol as it will be displayed in the map canvas.
Above the preview is the list of symbol layers. To start the Symbol properties dialog, click the [ Change...]
button in the Style tab of the Layer Properties dialog.
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The buttons allow adding or removing layers, changing the position of layers, or locking layers for color changes.
In the right part of the dialog, there are shown the settings applicable to the single symbol layer selected in the

symbol layer list. The most important is the Symbol Layer Type combobox, which allows you to choose
the layer type. The available options depend on the layer type (Point, Line, Polygon). The symbol layer type
options are described in section vector_symbol_types. You can also change the symbol layer properties in the
right part of the dialog. For example if you have chosen an SVG marker for a point layer it is now possible to
change its color using Color button.

Figura 11.13: Line composed from three simple lines

11.2.2 Gerenciador de estilo

O Gerenciador de Estilo é um pequeno aplicativo auxiliar, que lista os símbolos e as rampas de cores disponíveis
em um estilo. Ele também permite adicionar e/ou remover itens. Para iniciar o Gerenciador de estilo, clique no
menu Propriedades → Gerenciador de estilo. Alternativamente acesse via aba : Estilo.

Figura 11.14: Style Manager to manage symbols and color ramps

11.2.3 Simbologia Antiga

Nota: QGIS 1.8. still supports the usage of the old symbology, although it is recommended to switch to the new
symbology, described in section vector_new_symbology, because the old symbology will be removed in one of
the next releases.
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Se você quer ou precisa voltar à antiga simbologia voce clica no botão [Simbologia Antiga] na aba Estilo do aba
Propriedades da Camada.

Você também pode tornar a antiga simbologia em padrão, desativando : guilabel: Utilize nova simbologia
para renderização na aba: guilabel: Renderização em: menuselection: Configurações -> | mActionOptions |:
menuselection: Opções.

A simbologia antiga do QGIS suporta os seguintes renderizadores:

• Símbolo único - um estilo único é aplicado a cada objeto na camada.

• Símbolo Graduado - objetos na camada são mostrados com diferentes símbolos classificados por valores
de um campo em particular.

• Cores contínuas - objetos na camada são apresentadas com uma variação de cores classificadas pelo valor
numérico em um campo específico.

• Valor único - objetos são classificados através de valores únicos de um campo especificado com cada valor
tendo um símbolo diferente.

To change the symbology for a layer, simply double click on its legend entry and the vector Layer Properties
dialog will be shown.

Opções de Estilo

Nessa janela você pode estilizar a sua camada vetorial. Dependendo da opção de renderização selecionada, você
terá a possibilidade de também classificar suas feições no mapa.

Pelo menos as seguintes opções de estilo se aplicam para quase todos os renderizadores:

• Fill style - Style for filling. Beside the given brushes you can select Fill style: ‘Texture’ and click

the button for selecting your own texture file. Currently the fileformats *.jpeg, *.xpm, and *.png
are supported.

• Cor de Preenchimento - cor de preenchimento das feições.

• Opções de Linha

– Estilo de Linha - Estilo de caneta para linha da feição. Você também pode definir Sem linha.

– Cor da linha - cor da linha da feição.

– Largura da linha - largura das feições.

Uma vez que você aplicour um estilo à sua camada você também pode salvar o estilo de sua camada para um
arquivo a parte (com a extensão: file:. *.qml). Para fazer isso, use o botão [Save Style...]. Não é preciso dizer que
[Load Style...] carrega seu arquivo de estilo salvo.

Se você deseja usar sempre um estilo particular, sempre que a camada é carregada, use o botão [Salvar Como
Padrão] para fazer o seu estilo padrão. Além disso, se você fizer alterações para o estilo mas não gostou do
resultado, use o botão [Restore Default Style] para reverter para o seu estilo padrão.

Transparência de vetor

QGIS allows to set a transparency for every vector layer. This can be done with the slider Transparency

inside the Style tab. This is very useful for overlaying several vector layers.

11.2.4 Aba rótulos

|rótulos| Assim como para à simbologia | qg | 1.8 fornece atualmente um antigo e um novo motor de rotulagem
em paralelo. A aba: guilabel: Rótulos ainda contém a antiga rotulagem. A nova rotulagem é implementada como
um aplicativo principal e irá substituir as funções da antiga aba de rótulos em uma das próximas versões.

Recomendamos mudar para a nova rotulagem, descrita na seção :ref:’vector_new_labeling’.
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The old labeling in the Labels tab allows you to enable labeling features and control a number of options related
to fonts, placement, style, alignment and buffering. We will illustrate this by labeling the lakes shapefile of the
QGIS sample dataset:

1. Load the Shapefile alaska.shp and GML file lakes.gml in QGIS

2. Zoom in a bit to your favorite area with some lake

3. Make the lakes layer active

4. Open the Layer Properties dialog

5. Click on the Labels tab

6. Check the Display labels checkbox to enable labeling

7. Choose the field to label with. We will use Field containing label NAMES

8. Enter a default for lakes that have no name. The default label will be used each time QGIS encounters a
lake with no value in the NAMES field.

9. If you have labels extending over several lines, check Multiline labels?. QGIS will check for a true line
return in your label field and insert the line breaks accordingly. A true line return is a single character \n,
(not two separate characters, like a backlash \ followed by the character n). To insert line returns in an
attribute field configure the edit widget to be text edit (not line edit).

10. Clique [Aplicar].

Agora temos rótulos. Como eles se aparecem? Eles são, provavelmente, grandes demais e estão mal posicionados
em relação ao símbolo do marcador para os lagos.

Selecione a entrada Fonte e use os botões [Fonte] e [Cor] para definir a fonte e a cor. Você também pode alterar
o ângulo e o posicionamento do rótulo de texto.

Para alterar a posição do texto relativa à feição:

1. Beneath the Basic label options change the placement by selecting one of the radio buttons in the Placement
group. To fix our labels, choose the Right radio button.

2. the Font size units allows you to select between Points or Map units.

3. Clique [Aplicar] para ver as alterações sem fechar o diálogo.

As coisas estão melhores, mas os rótulos são ainda muito perto do marcador. Para corrigir isso, podemos usar as
opções Afastamento, que fica na parte inferior do menu. Aqui podemos adicionar afastamentos para as direções
X e Y. Adicionando um deslocamento de 5 X irá afastar os rótulos do marcador e torná-los mais legíveis. É claro
que se o seu marcador ou fonte é maior, mais deslocamento será necessário.

O último ajuste que faremos é para criar um ‘Buffer‘nos rótulos. Isto significa apenas colocar um pano de fundo
em torno deles para fazê-los sobressair. Para gerar um Buffer para os rótulos de lagos:

1. Clique na : guilabel: Buffer de rótulos para habilitar os buffers de rótulos.

2. Escolha um tamanho para o buffer usando a caixa de rotação.

3. Escolha uma cor clicando em [Cor] e escolhendo a sua favorita a partir do seletor de cores. Você também
pode definir alguma transparência para o buffer se você preferir.

4. Clique [Aplicar] para ver se você gosta das alterações.

Se você não gostar dos resultados, ajuste as configurações e, em seguida, teste novamente clicando [Aplicar].

Um buffer de 1 ponto parece dar um bom resultado. Observe que você também pode especificar o tamanho do
buffer em unidades do mapa se isso funcionar melhor para você.

As opções avançadas dentro da aba: guilabel: Rótulo permitem que você controle a aparência dos rótulos us-
ando atributos da camada. As opções começando com Definidos por dados permitem que você defina todos os
parâmetros para os rótulos usando campos na camada.
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Note that the Label tab provides a preview-box where your selected label is shown.

11.2.5 Nova Rotulagem

A nova aplicação | mActionLabeling |: sup: Rotulagem fornece rotulagem inteligente para camadas vetoriais de
pontos, linhas e polígonos e requer apenas alguns parâmetros. Esta nova aplicação irá substituir a atual rotulagem
QGIS, descrita na seção: ref: vector_labels_tab e suporta também camadas transformadas on-the-fly.

Utilizando a Nova Rotulagem

1. Inicie o QGIS e carregue uma camada vetorial de ponto, linha ou polígono.

2. Ative a camada na legenda e clique no ícone | mActionLabeling |: sup: ícone ‘Rotulagem’ no menu da barra
de ferramentas do QGIS.

Rotulando camadas de pontos

First step is to activate the Label this layer checkbox and select an attribute column to use for labeling. Click

if you want to define labels based on expressions. After that you can define the text style and the scale-based
visibility in the Label settings tab (see Figure_labels_1 ). Choose the Advanced tab for the label placement and the
labeling priority. You can define if every part of a multipart feature is to be labeled here. With the wrap label on
character function you can define a character for a line break in the labels. The Data defined settings tab provides
you with the attribute-based definition of Font properties, Buffer properties and Position.

Figura 11.15: Smart labeling of vector point layers

Rotulando camadas de linhas

O primeiro passo é ativar a opção :guilabel: ‘Rotule esta camada‘ na aba: guilabel:Configurações de rótulos
e selecione uma coluna de atributo para ser usada para a rotulagem. Aqui você também pode definir rótulos com
base em expressões. Depois disso, você pode definir o estilo de texto e a visibilidade baseada na escala. Outras
opções de rotulagem estão disponíveis através da aba :guilabel: Avançado. Você pode definir o posicionamento e
a distância do rótulo, um posicionamento relacionado à orientação da linha e a prioridade da rotulagem. Além
disso, você pode definir se cada parte de uma linha composta de várias partes deve ser rotulada, se as linhas
serão fundidas para evitar rótulos duplicados e, se é adicionado um símbolo de direção (ver Figure_labels_2_).
Também é possível suprimir a rotulagem de feições e cobrir rótulos em caracteres. Use :guilabel: ‘Configurações
definidas por dados para configurações baseadas em atributos ou conexão à banco de dados.

Rotulando camadas de polígonos

O primeiro passo é ativar a opção : guilabel: ‘Rotular esta camada‘ e selecionar uma coluna de atributo a ser
usada para a rotulagem. Aqui você também pode definir rótulos com base em expressões. Em Configurações
de rótulos defina o estilo de texto e a visibilidade baseada na escala (ver Figure_labels_3). Use a aba Avançado
para o posicionamento do rótulo, distância e prioridade de rotulagem. Defina aqui se cada parte de uma feição de
várias partes deve ser rotulada, suprima a rotulagem de feições e rótulos cobertos por caracteres. Use: guilabel:
configurações de dados definidos para configurações baseadas em atributos ou banco de dados de conexão à base.
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Figura 11.16: Smart labeling of vector line layers

Figura 11.17: Smart labeling of vector polygon layers

Alterar mecanismos de configurações

Além disso, você pode clicar no botão [Mecanismo de Configurações] e selecione o método de pesquisa, usado
para encontrar a melhor colocação de etiquetas. Disponível é Chain, Popmusic Tabu, Popmusic Chain, Popmusic
Tabu Chain e FALP.

Figura 11.18: Dialog to change label engine settings

Além disso, o número de opções que podem ser definidos para os recursos de ponto, linha e polígonos, e você pode
definir se deseja mostrar todas os rótulos (incluindo rótulos coincidentes) e opções de rótulos para a depuração.

** Palavras-chave para usar em colunas de atributo de rótulação **

Há uma lista de palavras-chave com suportadas, que podem ser utilizadas para a colocação de rótulos em colunas
de atributos definidas.
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• For horizontal alignment: left, center, right

• For vertical alignment: bottom, base, half, top

• **Cores podem ser especificados em notação svg **, por exemplo # ff0000

• ** para negrito, sublinhado e itálico riscado **: 0 = falso 1 = verdadeiro

A combination of key words in one column also works, e.g.: base right or bottom left.

11.2.6 Aba Campos

Within the Fields tab the field attributes of the selected dataset can be manipulated. The buttons New Column

and Delete Column can be used, when the dataset is Editing mode.

At the moment only columns from PostGIS layers can be removed and added. The OGR library supports to add
and remove columns, if you have a GDAL version >= 1.9 installed.

Edição de Widget

Figura 11.19: Dialog to select an edit widget for an attribute column

Na aba de orientação: guia Campos você também encontra uma coluna ‘‘ Edição de Widget ‘‘. Esta coluna pode
ser utilizada para definir os valores ou uma variedade de valores que são permitidos para serem adicionados à
coluna da tabela de atributos específicos. Se você clicar no botão ** [Editar Widget] **, uma janela se abre, onde
você pode definir diferentes elementos. Estes elementos são:

• ** Edição Linha **: um campo de edição que permite a inserção de texto simples (ou restritor para números
de atributos numéricos).

• Classificação: Exibe uma caixa de combinação com os valores utilizados para a classificação, se você tiver
escolhido “valores únicos” como o tipo de legenda na: guia ‘Estilo ‘da caixa de diálogo Propriedades.

• Tamanho: Permite definir valores numéricos de um tamanho específico. A edição do Widget pode ser um
controle deslizante ou uma caixa de rotação.

• ** Valores únicoss **: O usuário pode selecionar um dos valores já utilizados na tabela de atributos. Se
editável é ativado, uma linha de edição é mostrada com suporte para autocompletar, caso contrário, uma
caixa de combinação é utilizada.

• ** Nome do Arquivo **: Simplifica a seleção, adicionando uma janela de seleção de arquivos.
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• ** Mapa de Valor **: uma caixa de combinação com itens pré-definidos. O valor é armazenado no atributo,
a descrição é mostrada na caixa de combinação. Você pode definir valores manualmente ou carregá-los a
partir de uma camada ou um arquivo CSV.

• ** Enumeração **: Abre uma caixa de combinação com valores que podem ser usados dentro no tipo de
colunas. Atualmente é suportado apenas por provedores de postgres.

• ** Imutável **: A coluna de atributo imutável é somente leitura. O usuário não é habilitado para modificar
o conteúdo.

• ** oculto **: Uma coluna de atributo oculto é invisível. O usuário não é capaz de ver o seu conteúdo.

• ** Caixa de seleção **: Exibe uma caixa de seleção e você pode definir qual atributo é adicionado na coluna
quando a caixa de seleção é ativada ou não.

• ** Edição de texto **: Isto abre um campo de edição de texto que permite que várias linhas sejam utilizadas.

• ** Calendário **: Abre um widget de calendário para introduzir uma data. Tipo de coluna deve ser de texto.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

11.2.7 Guia Geral

The General tab is essentially like that of the raster dialog. There are several options available:

• Change the display name of the layer

• Set a display field to be used for the Identify Results dialog

• Define a certain Edit User Interface for the vector layer written with the Qt Creator IDE and tools at
http://qt.digia.com/Product/Developer-Tools/

• Create a Spatial Index (only for OGR supported formats)

• Add an Init function for the layer. They will overwrite existing QGIS widget initializations, if applied

• Update Extents information for a layer

• View or change the projection of the specific vector layer, clicking on Specify CRS

Furthermore you can activate and set Use scale dependent rendering, define provider specific options (e.g.
encoding) and with the [Query Builder] button you can create a subset of the features in the layer that will be
visualized (also refer to section Seleção).

11.2.8 Aba Metadado

The Metadata tab contains general information about the layer, including specifics about the type and lo-
cation, number of features, feature type, and the editing capabilities. The Extents section, providing layer extent
information, and the Layer Spatial Reference System section, providing information about the CRS of the layer.
This is a quick way to get information about the layer.

Additionally you can add/edit a title for the layer and some abtract information. These information will be saved
in the QGIS project file for following sessions and will be used for QGIS server.
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Figura 11.20: General tab in vector layers properties dialog

Figura 11.21: Metadata tab in vector layers properties dialog
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11.2.9 Guia de Ações

QGIS fornece a capacidade de executar uma ação com base nos atributos de um recurso. Isso pode ser usado
para executar qualquer número de ações, por exemplo, a execução de um programa com argumentos construídos
a partir dos atributos de um recurso ou passar parâmetros ao uma ferramenta de comunicação web.

Figura 11.22: Overview action dialog with some sample actions

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are devided into 6 types and can be used like this:

• Generic, Mac, Windows and Unix actions start an external process,

• Python actions execute a python expression,

• Generic and Python actions are visible everywhere,

• Mac, Windows and Unix actions are visible only on the respective platform (i.e. you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them clicking on [Add default actions]. An
example is performing a search based on an attribute value. This concept is used in the following discussion.

** Definição de Ações **

Attribute actions are defined from the vector Layer Properties dialog. To define an action, open the vector Layer
Properties dialog and click on the Actions tab. Select ‘Generic’ as type and provide a descriptive name for the
action. The action itself must contain the name of the application that will be executed when the action is invoked.
You can add one or more attribute field values as arguments to the application. When the action is invoked any
set of characters that start with a % followed by the name of a field will be replaced by the value of that field.
The special characters %% will be replaced by the value of the field that was selected from the identify results or
attribute table (see using_actions below). Double quote marks can be used to group text into a single argument to
the program, script or command. Double quotes will be ignored if preceded by a backslash.

Se você tem os nomes de campo que são substrings de outros nomes de campo (por exemplo,‘‘ col1‘‘ e col10
), você deve indicar, cercando o nome do campo (e do %caráter) entre colchetes (por exemplo, [%col10] ).
Isso impedirá que o campo com nome %Col10 seja confundido com o campo de nome %col1 com um 0 no
final. Os suportes serão removidos por QGIS quando se substitui no valor do campo. Se você deseja que o campo
substituído seja cercado por colchetes, utilizar um segundo conjunto da seguinte maneira: [[% Col10]].
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Using the Identify Features tool you can open Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by using preceeding the derived field name by (Derived).. For example, a point layer has an X and Y field and
the value of these can be used in the action with %(Derived).X and %(Derived).Y. The derived attributes
are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

No primeiro exemplo o navegador Konqueror é acionado e passa a abrir uma URL. A URL executa uma pesquisa
no Google sobre o valor do campo nam de nossa camada vetorial. Note que a aplicaçao ou script acionado pela
ação deve estar no caminho ou você deve fornecer o caminho completo. Para ter certeza, poderíamos reescr-
ever o primeiro exemplo como:‘‘ / opt/kde3/bin/konqueror http://www.google.com/search?q =% nam‘‘. Isto irá
assegurar que a aplicação konqueror será executado quando a ação é invocado.

O segundo exemplo utiliza a notação % % que não depende de um campo específico para o seu valor. Quando
a ação é invocada, o % % será substituído pelo valor do campo selecionado na identificação de resultados ou na
tabela de atributos. ** Utilizando Ações **

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the popup menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the actions. Click on the action you
wish to invoke.

Se você está invocando uma ação que usa a notação%%, clique com o botão direito sobre o valor do campo no
painel :guilabel: Identificar resultados ou na Tabela Atributo que você deseja passar para o aplicativo ou script.

Aqui está outro exemplo que puxa os dados de uma camada vetorial e os insere em um arquivo usando o bash e o
comando‘‘eco‘‘ (por isso só vai funcionar no|nix| ou talvez no|osx|). A camada em questão tem campos para um
nome da espécie taxon_name , latitude lat e longitude long . Eu gostaria de ser capaz de fazer uma seleção
espacial das localidades e exportar esses campos de valores em um arquivo de texto para o registro selecionado
(mostrado em amarelo na área do mapa do QGIS). Aqui é a ação para atingir este objectivo:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Depois de selecionar algumas localidades e executar a ação em cada um, a abertura do arquivo de saída irái mostrar
algo como isto:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Como um exercício, criamos uma ação que faz uma pesquisa no Google sobre o a camada lagos. Primeiro,
precisamos determinar o URL necessário para realizar uma pesquisa sobre a palavra-chave. Isso póde ser realizado
facilmente indo ao Google e realizando uma pesquisa simples, em seguida, pegar a URL na barra de endereços do
seu navegador. A partir deste pequeno esforço, vemos que o formato é: http://google.com/search?q=qgis , onde
QGIS é o termo de pesquisa. Armado com esta informação, podemos prosseguir:

1. Verifique se a camada lagos está carregada.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend or right-click and choose
Properties from the popup menu.

3. Click on the Actions tab.

4. Digite um nome para a ação, por exemplo ‘‘ Google Search ‘‘.

5. Para a ação, precisamos fornecer o nome do programa externo a ser executado. Neste caso, podemos usar o
Firefox. Se o programa não estiver em seu caminho, você precisará fornecer o caminho completo.
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6. Seguindo o nome da aplicação externa, adicione a URL usada para fazer uma pesquisa no Google, mas não
inclua o termo de busca: ‘‘ http://google.com/search?q=‘‘

7. O texto no campo de ação será mostrado como este: ‘‘ firefox http://google.com/search?q =‘‘

8. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert Field] button.

9. From the drop-down box The valid attribute names for this layer select ‘NAMES’ and click [Insert
Field].

10. Your action text now looks like this: firefox http://google.com/search?q=%NAMES

11. Para finalizar a ação clique no botão** [Inserir ação] **.

A ação é completada e está pronta para usar. O texto final da ação deve ser semelhante a este:

firefox http://google.com/search?q=%NAMES

Agora podemos utilizar a ação. Feche a: aba de diálogo: ‘Propriedades da camada ‘ e aplique um zoom em uma
área de interesse. Certifique-se que a camada lagos está ativa e identifique um lago. Na caixa o resultado que
você poderá visualizar que a nossa ação está visível:

Figura 11.23: Select feature and choose action

Quando clicamos sobre a ação, ela faz o Firefox e navegar para o URL
http://www.google.com/search?q=Tustumena. Também é possível adicionar outros campos de atributo para
essa açao. Para isso basta um + ao final do texto de ação, selecionar outro campo e clicar em [Inserir Campo).
Nesse exemplo não temos outro campo disponível para efetuarmos a busca.

Você pode definir múltiplas ações para uma camada e cada uma vai aparecer na caixa de diálogo: guilabel:
Identificar resultados.

Você pode pensar em todos os tipos de usos para as ações. Por exemplo, se você tem uma camada de pontos
que contém as localizações de imagens ou fotos, juntamente com um nome de arquivo, você pode criar uma ação
para lançar um visualizador para exibir a imagem. Você também pode usar ações para lançar relatórios baseados
na web para um campo de atributo ou combinação de campos, especificando-as da mesma forma que fizemos no
nosso exemplo de busca Google.

Nós também podemos fazer exemplos mais complexos, por exemplo, sobre como usar ações em ** Python **.

Normalmente, quando nós criamos uma ação para abrir um arquivo com uma aplicação externa, podemos usar
caminhos absolutos, ou, eventualmente, caminhos relativos, no segundo caso, o caminho é relativo ao local do
arquivo executável do programa externo. Mas quando, precisamos usar caminhos relativos, em relação à camada
selecionada (um arquivo com base um, como um shapefile ou SpatiaLite)? O código a seguir irá fazer o truque:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
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layerpath = layer.source() if layer.providerType() == ’ogr’ else \
(qgis.core.QgsDataSourceURI(layer.source()).database() \
if layer.providerType() == ’spatialite’ else None);
path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Temos que basta lembrar que a ação é um dos tipo * Python * e pode ser modificada as variáveis no * comando *
e * imagerelpath * para atender as necessidades.

Mas o que dizer se o caminho relativo precisa ser relativo ao arquivo de projeto (salvo)? O código da ação Python
seria:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) \
if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Outro exemplo de ações usando Python nos permite adicionar novas camadas ao projeto. O exemplo a seguir,por
exemplo, irá adicionar ao projeto um vetor e raster , respectivamente,. O nome dos arquivos a serem adicionados
ao projeto e o nome a ser dado à camada são controlados aos dados(filename e layname são o nome das colunas
da tabela de atributo do vetor onde a ação será criada):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’, ’ogr’)

Para adicionar um raster (uma imagem tif, neste exemplo) utiliza-se:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]’)

11.2.10 Aba Ligações

A guia :Uniões:‘Joins‘ permite que você realize a união de tabelas de atributos carregadas previamente ao
projeto e carregalas a sua camada vetorial. Você necessita definir as colunas chaves para unir camadas, unir campo
e campo alvo. O QGIS atualmente suporta a união de tabelas em formato não espacial suportados pelo OGR,texto
delimitado e provenientes do PostgreSQL (Veja figure_joins_1).

Adicionalmente, o adicionar ligação de vetor permite:

• Cache join layer in virtual memory

• Create attribute index on the join field

11.2.11 Diagrams Tab

The Diagrams tab allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).

The current core implementation of diagrams provides support for piecharts and text diagrams. Text values of
different data columns are displayed one below the other with a circle or a box and dividers. Diagram size is based
on a fixed size or on linear scaling according to a classification attribute. The placement of the diagrams interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition to
chart positions can be fixed by the users hand.
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Figura 11.24: Join an attribute table to an existing vector layer

Figura 11.25: Vector properties dialog with diagram tab
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We will demonstrate an example and overlay the alaska boundary layer a text diagram showing some temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see Section Dados de
exemplo).

1. Primeiro clique no ícone | mActionAddOgrLayer |: Adicionar Camada Vetorial , procure nos exemplos da
pasta conjunto de dados de amostra e carregue as duas camadas de arquivo vetorial: arquivo: alaska.shp e:
arquivo: climate.shp.

2. Dê um clique duplo na camada clima na legenda do mapa para abrir a aba de diálogo ‘Propriedades da
camada ‘.

3. Click on the Diagrams tab, activate Display diagrams and from Diagram type combobox select
‘Text diagram’

4. As Background color we choose a light blue and set a fixed size to 18 mm.

5. Placement could be set to AroundPoint.

6. No diagrama procuramos exibir os valores das três colunas ‘‘ T_F_JAN ‘‘, ‘‘ T_F_JUL ‘‘ e ‘‘ ‘‘
T_F_MEAN. Primeiro selecione ‘‘ T_F_JAN ‘‘ como atributo e clique no botão verde ** [+] ** , então
‘‘ T_F_JUL ‘‘ e ‘‘ ‘‘ finalmente T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can now adapt the chart size, or change the attribute colors by double clicking on the color values in
the attribute field. Figure_diagrams_2 gives an impression.

9. Finalmente, clique em [Ok].

Figura 11.26: Diagram from temperature data overlayed on a map

Additionally in the Settings → Options dialog, there is a Overlay tab where it is possible to select the placement
algorithm of the diagrams. The central point method is a generic one, the others use algorithms of the PAL library.
They also consider diagram objects and labels in different layers. Also see section Diagram Overlay Plugin for
additional diagram features.

11.3 Edição

QGIS supports various capabilities for editing OGR, PostGIS and SpatiaLite vector layers.

Nota: The procedure for editing GRASS layers is different - see Section Digitalizando e editando uma camada
vetorial GRASS for details.

Dica: Edição em uso corrente

Esta versão do QGIS não segue o mesmo caminho caso alguém mais estiver editando uma feição ao mesmo tempo
que a edição que você estiver fazendo. No caso a ultima pessoa a salvar sua edição é a que estará habilitada ou
dada como salvo pelo programa.
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11.3.1 Definir o valor de tolerância de proximidade para buscar apartir do raio

Antes de editar os vértices , devemos definir a tolerância de proximidade e valores de raio de que nos permitam
uma ótimização na edição das geometrias e das camadasvetoriais .

Tolerância de Proximidade

A tolerância de Proximidade e a distancia que o QGIS utiliza para procurar o vértice mais proximo e /ou segui-
mento que se deseja conectar quando você estabelecer um novo vértice ou mover um vértice já existente. Se não
estiver nos limites de tolerância o QGIS vai posicionar o vértice onde o botão do mouse for solto, ao invés de
aproximá-lo a um vértice e/ ou seguimento já existente. A configuração da tolerância de proximidade influência
todas as ferramentas que trabalham com tolerância.

1. A general, project wide snapping tolerance can be defined choosing Settings → Options. On Mac: go
to QIS → Preferences..., on Linux: Edit → Options. In the Digitizing tab you can select between to
vertex, to segment or to vertex and segment as default snap mode. You can also define a default snapping
tolerance and a search radius for vertex edits. The tolerance an be set either in map units or in pixels.
The advantage of choosing pixels, is that the snapping tolerance doesn’t have to be changed after zoom
operations. In our small digitizing project (working with the Alaska dataset), we define the snapping units
in feet. Your results may vary, but something on the order of 300ft should be fine at a scale of 1:10 000
should be a reasonable setting.

2. A layer based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).

Note that this layer based snapping overrides the global snapping option set in the Digitizing tab. So if you need
to edit one layer, and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer which
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

Figura 11.27: Edit snapping options on a layer basis

Pesquisa de Raio

Pesquisa de raio e a diatancia que o QGIS utiliza para buscar o vertice mais proximo quendo você clica no mapa.
Caso não esteja dentro dos limites da pesquisa de raio, o QGIS não encontrará e não selecionará nenhum vértice
para edição e irá notificar com um aviso de alerta Tolerância de aproximar e pesquisa de raio são definidas em
unidades do mapa ou em pixel, então pode ser necessário experimentar ambas para definir a utilização apropriada.
Especificando uma tolerância muito grande o QGIS poderá aproximar a um vértice errado, especialmente se o
número de vértice em que esteja trabalhando estiver em grande número e muito próximo um do outro. Definindo
uma pesquisa de raio muito pequena pode não encontrar nada para mover.

A pesquisar o raio para edição de vértice em unidades da camada pode ser definida na aba Digitalizar em Config-
urações –> Opções mesmo local onde é definido a forma geral de tolerância de proximidade do projeto.
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11.3.2 Ampliação e Visão panorâmica

Antes de editar uma camada você deve ampliar a sua área de interesse. Isso evita a espera, enquanto todos os
marcadores de vértice são renderizadospor toda camada.

Alem de usar o |mAaction| sup: Panorâmica e Sup Aproximar / Afastar ícones da barra de ferramentas
com o mouse, a navegação pode ser feito também com a rolagem do mouse, as setas ea barra de espaço.

Zoom e Viisão panorâmica com a rolagem do mouse

No processo de Digitalização é possível utilizar o mouse clicand clicando e arrastando a visualização panorâmica
e também utilizar o recurso de rolagem do mouse para aproximar e afastar a visualização do mapa. Para aproximar
o local posicione o cursor do mouse na área do mapa e gire a rolagem para frente para aproximar e para trás para
afastar. A posição do cursor do mouse será o ponto central da área de interesse ampliada. É possível também
customizar o comportamento da ação da roda do mouse utilizando; Ferramentas de Mapa no :menuselection:
Configurações —-> ‘ :menuselection: Opções.

Panaramica com as teclas de Seta

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area and
click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north and down arrow key
to pan south.

Você também pode usar a barra de espaço para fazer com que temporariamente o mouse para mover então Movi-
mentos mapa. Aa teclas PgUp e PgDown do teclado fazem a exibição para aproximar ou afastar sem interromper
a digitalização.

11.3.3 Edição Topológica

Além de opções de alinhamento baseados camada também pode definir algumas funcionalidades topológicas na
aba Opções de Proximidade.... Caixa de dialogo . menuselection: Configurações (ou menuselection: Arquivo
) Menu . Você pode Definir na| caixa de seleção| Na aba Habiliar edição topológica e /ou para as camadas de
polígonos, você pode ativar a coluna | caixa de seleção| Na Aba Evitar int o que evita a intersecção de novos
polígonos.

Ativar a edição topologica

A opção .Na aba: Habilitar edição topológica serve para editar e limites em comum em um mosaico de polí-
gonos. O QGIS detecta um limite em comum em um mosaico de polígono sendo somente necessário mover o
vértice enquanto o QGIS toma conta em atualizar o outros limites.

Evitando Intersecção de novos polígonos.

A segunda opção topológica chamada :guilabel:‘Avoid Int. Coluna evita sobreposição no mosaico de polí-
gonos. É um bom recurso para digitalização rápida de polígonos adjacentes. Caso já exista no projeto um polí-
gono é possível, com esta função, digitalizar o segundo fazendo com que ambos se intersectem e o QGIS “corta”
o segundo para um limite em comum com o primeiro. A vantagem esta em os usuários não precisarem digitalizar
todos os vértices do limite comum.
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11.3.4 Digitalizando uma Camada Vetorial Existente

Como padrão o QGIS carrega camadas somente para leitura, isto é uma forma de segurança evitando a edição
acidental de uma camada com o deslize do mouse. De qualquer forma, é possível escolher a edição de qualquer
camada contanto que o arquivo fornecido seja suportado e (se o arquivo não for somente leitura). A edição da
camada é mais versátil quando for utilizado base de dados PostgreSQL/PostGIS.

Em geral a edição de camadas vetoriais é dividida em uma barra de digitalização e uma
barra de Ferramentas avançadas descrita na seção .ref:sec_advanced_edit. Você poderá sele-
cionar e desmarcar tanto em:menuselection:‘Configurações –> Barra de Ferramentas –> Us-
ando as ferramentas de digitalização básicas que você pode realizar as seguintes funções:

Ícone Função Ícone Função

Alternar Edição Adicionar feições: captura de ponto

Adicionar feições: captura de linha Adicionar feições: captura de polígono

Mover feição Ferramenta de nó

Excluir selecionado(s) Recortar feições Recortar feições

Copiar feições Colar feições

Salvar alterações

Tabela de Edição: Barra de ferramentas básicas de edição vetorial.

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for that layer.

Como uma forma alternativa é possível usar o botão Alternar Edição :sup: Alternar edição da barra de dig-
italização para começar ou para sair do modo de edição. Uma vez que a camada estiver em modo de edição
marcadores irão aparecer nos vértices e botões adicionais na barra de edição estarão disponíveis para o uso.

Dica: Salvar Regularmente

Lembre-se de clicar em :sup:‘Salvar Edição regularamente ‘permitindo que as alterações recentes sejam sal-
vas, e também confirmando que a fonte de dados aceite todas as alterações.

Adicionando Feições

Você podera utilizar os icones :sup Adicionar Recurso , :sup:‘Adicionar Recurso ou :sup:‘Adicionar
Recurso os icones da barra de ferramentas para colocar o curso do QGIS em modo de digitalização.

Para cada feição é necessário primeiro digitalizar a geometria para então inserir os atributos. Para digitalizar a
geometria, clique com o botão esquerdo do mouse na área do mapa para criar o ponto inicial da sua nova feição.

For lines and polygons, keep on left-clicking for each additional point you wish to capture. When you have
finished adding points, right-click anywhere on the map area to confirm you have finished entering the geometry
of that feature.

A janela de atributos seja exibida, permitindo que seja inserido as informações para a nova feição. Fig-
ure_edit_2_mostrar a configuração de atributos de um novo rio fictício no Alasca Na Aba Dgitalizar no menu

menuselection: Configurações –> Opções e é possível também habilitar :guilabel:Suprimir atributos de janelas

pop-up depois de cada feição criada :guilabel:Reutilizar último valor de atributo inscrito

Com o ícone :sup: Mover Feição da barra de ferramentas é possível movimentar as feições existentes.

Dica: Tipos de valores de atributos

11.3. Edição 89



QGIS User Guide, Versão 1.8

Figura 11.28: Enter Attribute Values Dialog after digitizing a new vector feature

For editing the attribute types are validated during the entry. Because of this, it is not possible to enter a number
into the text-column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the
attributes in a second step within the Attribute table dialog.

Ferramenta de nó

Tanto para PostgreSQL/PostGIS quanto para camadas base em arquivo shape, a :sup:‘Ferramenta de Nós
possui a capacidade para manipular os vértices das feições de uma forma similar aos programas de CAD. É
possível de uma forma simples selecionar múltiplos vértices de uma única vez e movimentá-los, adicionar ou
excluí-los todos juntos. A ferramenta de nós opera também com a projeção “on the fly” ligada e suporta a edição
topológica de feições. Esta ferramenta é, ao contrário de outras ferramentas no QGIS, permanente, então quando
alguma operação for executada, a seleção continua ativada para esta feição e ferramenta. Caso a ferramenta de
nós não encontrar nenhuma feição um aviso sera exibido.

É importante selecionar as propriedades :menuselection:‘Configurações –> :menuselection: Opções–> :guil-
abel:Encontrar Raio|selectnumber|para um número maior que zero.(i.e. 10).De outra forma o QGIS não estará
apto a informar qual o vértice está sendo editado.

Dica: Marcadores de Vértice
A versão atual do QGIS suporta três tipos de marcadores de vértice – Círculo semi transparente , cruz e nenhum.
Para alterar o estilo de marcador escolha em :menuselection:Opções do menu Configurações e Clique na aba
Digitalizar e selecione a entrada apropriada.

Operações Básicas

Inicie ativando a|mActionNodeTool| :sup: Ferramentas de nós e selecionando um recurso clicando sobre ele.
Caixas vermelhas aparecerão em cada vértice desse recurso.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Adicionar vértices: Para adicionar um vértice basta clicar duas vezes perto de uma borda e um novo vértice
aparecerá na borda perto do cursor. Note que o vértice aparece na borda, e não na posição do cursor, por
isso, tem de ser transferida, se necessário.
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• Excluir vértices:Após selecionar vértices para exclusão, clique natecla :kbd: Delete Não é possível utilizar

a :sup: Ferramenta de nós para deletar uma feição completa; QGIS o número mínimo de vértices para o

tipo de feição que esteja trabalhando. Para deletar uma feição completa utilize a ferramenta :sup:Excluir
Seleção.

• Mover Vértices:Selecione todos os vértices que desejar mover. Clique em um vértice selecionado ou em
uma borda e arraste na direção que desejar movimentar. Todos os vértices selecionados irão ser movimen-
tados juntos. Caso estiver habilitada a seleção toda pode pular para o vértice ou linha mais próximo.

Cada alteração executada com a ferramenta de nós sera armazenada como uma entrada separada no diálogo de
refazer. Lembre-se que todas as operações suportam a edição topológica quando estiver ligada. A projeção “on
the fly” também é suportada e a ferramenta de nós fornece tooltips para identificar um vértice ao passar o ponteiro
sobre ele.

Cortar, Copiar e Colar feições

Feições selecionadas podem ser recortadas, copiadas e coladas entre camadas do mesmo projeto do QGIS contanto

que a camada de destino estejam selecionadas como :sup: Alternar edição previamente.

Features can also be pasted to external applications as text: That is, the features are represented in CSV format
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

Como exemplo,iremos copiar alguns lagos para a nova camada:

1. Coloque a camada que você deseja copiar (camada de origem)

2. Carregar ou criar a camada que você deseja copiar (camada alvo)

3. Iniciar a edição para a camada alvo

4. Ative a camada de origem clicando na legenda

5. Utilize o :sup: Selecionar uma Feição Simples ferramenta para selecionar o recurso (s) sobre a camada
de origem

6. Clique no :sup: Funções de cópia ferramenta

7. Faça a camada de destino ativa cilcando sobre a legenda .

8. Clique no :sup: Colar Recursos

9. Para a edição e salvar as alterações

O que acontece se a fonte e alvo de camadas têm esquemas diferentes (nomes de campos diferentes e tipos não são
a mesma coisa)?|qg| povoa o que corresponde e ignora o resto.Se você não se importar com os atributos que estão
sendo copiados para a camada de destino, não importa como você criar os campos e tipos de dados.Se você quer
ter a certeza de que tudo-função e seus atributos-que são copiados, certifique-se que os sistemas correspondem.

Dica: ** Congruência de Recursos colados **

Se a sua fonte e as camadas de destino usar a mesma projeção, então as características colados terá geometria
idêntica à camada de origem.No entanto, se a camada de destino é uma projeção diferente, então | qg | não pode
garantir a geometria é idêntica.Isto é simplesmente porque existem pequenos erros de arredondamento envolvidos
na conversão entre projeções.
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Excluindo recursos selecionados

Se deseja excluir um polígono inteiro, nós podemos fazer isso, selecionando primeiro o polígono usando o nor-

malmente :sup: ferramente Seleção de Recurso Único Você pode selecionar vários recursos para a elimi-

nação.Depois de ter o conjunto de seleção, use o :sup: ferramenta de Excluir para excluir od recursos.

O :sup: ferramenta de Recortar feiçõesna barra de ferramentas de digitalização também pode ser utilizado para
eliminar características.Isso efetivamente exclui o recurso, mas também coloca-lo em uma “área de transferência

espacial. Então nós cortamos o recurso para excluir. :sup:ferramenta de Colar feiçõespara colocá-lo de volta,
dando-nos a capacidade de desfazer de um nível.Recortar, copiar e colar os trabalhos sobre as características
escolhidas no momento, o que significa que pode operar em mais de um de cada vez.

Dica: ** Suporte Supressão de recursos **

Quando editar arquivo do tipo shape ESRI, a exclusão de feições somente funciona se o QGIS estiver vinculado
a uma GDAL versão 1.3.2 ou maior. As versões disponíveis para download OS X e Windows estão elaboradas
usando GDAL 1.3.2 ou superior.

Salvando Camadas editadas

Quando uma camada estiver em modo de edição, qualquer alteração permanece na memória do QGIS. Portanto
não estão imediatamente salvas na fonte de dados ou disco rígido. Caso queira salvar a edição para a camada

em uso, mas deseja seguir editando sem sair do modo de edição basta clicar no botão :sup:Salvar alterações.
Quando sair do modo de edição a partir de|mActionToggleEditing| :sup:‘Alternar edição(ou sair do QGIS), será
perguntado se deseja salvar ou scartar a edição.

If the changes cannot be saved (e.g. disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Dica: Integridade dos dados

É sempre uma boa ideia fazer um backup de sua fonte de dados antes de iniciar a edição. Enquanto autores
do QGIS fizemos todos os esforços para preservar a integridade de seus dados, não oferecemos garantia a este
respeito.

11.3.5 Digitalização Avançada

Ícone Função Ícone Função

Desfazer Refazer

Simplificar feições Adicionar anel

Adicionar parte Excluir anel

Excluir Parte Remodelar Feição

Deslocamento da curva Quebrar feições

Mesclar feições selecionadas
|mAçãoRotacionarpontoscom-
símbolo|

Rotacionar pontos com
símbolo

Mesclar Atributos dos recursos
selecionados

Tabela Edição avançada: Barra de ferramentas da edição vetorial avançada
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Desfazer e Refazer

A ferramenta de :sup:Desfazer e :sup: Refazer permite utilizar as operações de desfazer e refazer nas
operações de edição vetorial. . Existe também uma ferramenta acoplável que exibe todas as operações do histórico
desfazer/refazer (veja a Figura_edit_3) Esta ferramenta não é exibida como padrão do sistema, mas pode ser
exibida a partir de um clique direito na barra de ferramentas e ativando a caixa de seleção Desfazer/Refazer. De
qualquer forma desfazer/refazer esta ativa mesmo que a ferramenta não seja exibida.

Figura 11.29: Redo and Undo digitizing steps

Quando desfazer for o estado de todas as feições e atributos serão revertidos para o estado anterior a uma operação
acontecer. Modificando outras operações que não forem as normais da adição vetorial (modificações feitas por um
complemento por exemplo), podem ou não ser revertidas, dependendo de como as alterações foram executadas.

Para utilizar a ferramenta de histórico do recurso de desfazer/refazer clique para selecionar uma operação na lista
de histórico; todas as feições serão revertidas ao estado que estavam depois de a operação selecionada.

Simplificar feições

A ferramenta :sup: Simplificar Feições permite reduzir o número de vértices de uma feição de uma forma que
a geometria não altere. É necessário selecionar a feição, que será destacada por uma banda de cor avermelhada
e uma barra deslizante aparecerá. Movendo a barra, a banda vermelha modifica mostrando como a feição será
simplificada. Clicando em [OK] a nova geometria simplificada será armazenada. Caso a feição não estiver apta a
simplificação (Múltiplos polígonos por exemplo) um aviso será exibido.

Adicionar anel

É possível criar polígonos em anel usando o ícone :sup: Adicionar Anel na barra de ferramentas. Isto
significa que dentro de uma área existente é possível digitalizar outros polígonos, o que ocorre como um “buraco”,
portanto, somente a área entre os limites de outra e dentro de polígonos mantém um polígono de anel.

Adicionar parte

Pode-se :sup Adicionar Parte de polígonos a multipolígonos selecionados. A nova parte do polígono precisa
ser digitalizada na parte externa do multi polígono selecionado.

Excluir anel

A ferramenta de :sup: permite excluir um polígono de anel dentro de uma área existente. Esta Ferramenta
funciona somente com camadas de polígonos. A ferramenta pode ser utilizada em feições de polígono ou em
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multipolígonos, contudo não altera nada quando utilizada no exterior de um polígono. Antes de selecionar os
vértices de uma parte, ajuste a tolerância para edição de vértices.

Excluir Parte

A ferramenta :sup: Excluir Parte permite excluir parte de multi feições(excluir polígonos de uma feição
de multi polígonos por exemplo). Entretanto ela não exclui a ultima parte da feição, a ultima parte permanece
intocável. Esta ferramenta trabalha com todas as geometrias multi partes de ponto, linha e polígono. Antes de
selecionar os vértices de uma parte, ajuste a tolerância para edição de vértices.

Remodelar Feição

É possível remodelar feições de linha e polígono usando o ícone da barra de ferramentas :sup: Remodelar
Feições Ele substitui parte ma linha ou polígono da primeira a ultima intersecção com a linha original. Em alguns
casos com polígonos pode levar à resultados inesperados. Este recurso é muito útil quando existe a necessidade em
substituir pequenas partes de um polígono, não é preciso uma grande reformulação em remodelar linhas entretanto,
não é permitido cruzar anel de polígonos originando assim um polígono inválido.

Pode-se, por exemplo, editar limites de um polígono com esta ferramenta. Primeiro, clique dentro de uma área
do polígono próximo ao ponto onde deseja-se adicionar o novo vértice. Em seguida cruze o limite e adicione o
vértice fora do polígono. Para finalizar dê um clique direito dentro da área do polígono.

Nota: A ferramenta de remodelar pode alterar a posição de partida de um anel ou de uma linha poligonal fechada.
Assim, o ponto representado ‘duas vezes’ não será mais o mesmo. Isto pode não ser um problema para a maioria
das aplicações, mas é algo a considerar.

A ferramenta de Deslocamento da Curva

The Offset Curve tool is a new editing tool. It creates parallel shifts of lines and polygon rings. The tool can
be applied to the edited layer (the geometries are modified) or also to background layers (creates copies of the
lines / rings and adds it to the the edited layer). It is thus ideally suited for the creation of distance line layers.The
displacement is shown at the bottom left of the taskbar.

Quebrar feições

Você pode dividir recursos usando o :sup: Quebrar Feições ícone na barra de ferramentas. Basta desenhar
uma linha através do recurso que você deseja dividir.

Mesclar feições selecionadas

A Ferramenta :sup: Mesclar Feições Selecionadas permite mesclar características que têm fronteiras comuns
e os mesmos atributos.

Mesclar atributos de recursos selecionados

A ferramenta de :sup: Mesclar Atributos de Feições Selecionadas permite mesclar atributos de feições com
limites e atributos em comum sem mesclar seus limites.
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Rotacionar pontos com símbolo

A Ferramenta :sup: Rotacionar Pontos com Símbolos esta em uso atualmente pelo mecanismo da antiga
simbologia. Ele permite alterar a rotação de símbolos pontuais na tela do mapa, caso tenha definido na coluna de
rotação na tabela de atributos da camada de pontos na aba: Estilo na aba Propriedade da Camada. De outra forma
a ferramenta estará inativa.

Figura 11.30: Rotate Point Symbols

Para alterar a rotação, selecione uma feição de ponto na tela do mapa e rotacione mantendo pressionado o botão
esquerdo do mouse. Uma seta vermelha com um valor de rotação será visualizado (veja a Figura_4). Quando você
soltar o botão esquerdo do mouse novamente o valor será atualizado na tabela de atributos.

Nota: Caso mantenha pressionada a tecla Control a rotação será executada em passos de 15 graus.

11.3.6 Creating a new Vector layer

QGIS allows to create new Shapefile layers and new SpatiaLite layers. Creation of a new GRASS layer is sup-
ported within the GRASS-plugin. Please refer to section Criando uma nova camada vetorial GRASS for more
information on creating GRASS vector layers.

Criando Uma nova Camada do tipo Shape

Para criar uma nova camada Shape para edição, selecione Novo–> :menuselection:Camada do tipo Shape...no
menu menuselection: Camada da barra de ferramentas. A caixa de diálogo: Nova Camada Vetorial será ex-
ibida como mostra a Figure_edit_5. Escolha o tipo de camada (ponto, linha ou polígono) e o SRC (Sistema de
Referência de Coordenadas).

Note that QGIS does not yet support creation of 2.5D features (i.e. features with X,Y,Z coordinates).

Para completar a criação de uma nova camada do tipo shape, adicione os atributos desejados clicando no botão
[Add] e especificando um nome e um tipo para os atributos. A primeira coluna id” é adicionada como padrão

mas pode ser removida. Apenas a tributos do Tipo: Número Inteiro ,Tipo: Número Decimal , e
:guilabel: Tipo: Dados de texto são suportados. são suportados. Como uma forma adicional e de acordo com o
tipo de atributo é possível também definir a espessura e precisão de uma nova coluna de atributos. Satisfeito com
os atributos clique em [ok] forneça um nome para o arquivo Shape QGIS irá automaticamente adicionar a extensão
.shp ao nome específico.Uma vez que a camada for criada ela será adicionada ao mapa e é possível editá-la como
descrito na seção:ref: sec_edit_existing_layer‘acima.

Criando uma nova camada SpatiaLite

Para criar uma nova camada SpatiaLite para edição, selecione Novo–> :menuselection:Camada SpatiaLite...
no menu Camada‘da barra de ferramentas. A caixa de diálogo ‘Nova Camada Vetorialr erá exibida como mostra
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Figura 11.31: Creating a new Shapefile layer Dialog

a Figure_edit_6.

First step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done with

the browse button to the right of the database field. Then add a name for the new layer and define the layer

type and the EPSG SRID. If desired you can select to Create an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the according column type and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend and you can edit it in the same
way as described in Section Digitalizando uma Camada Vetorial Existente above.

Further management of SpatiaLite-Layers can be done with the DB Manager see Complemento DB Manager.

11.3.7 Trabalhando com a Tabela de Atributos

A tabela de atributos exibe feições de uma camada selecionada. Cada linha na tabela de atributos representa uma
feição do mapa e cada coluna contém um pouco de informação particular a camada. Feições na tabela podem ser
pesquisadas, selecionadas, movimentadas ou mesmo editadas.

Para abrir a tabela de atributos para uma camada vetorial, ative a camada clicando nela na legenda do mapa. Então,
a partir do menu principal :menuselection: Camada‘a opção |mActionOpenTable| :menuselection:‘Abrir tabela
de atributos‘do menu. Também é possível, a partir de um clique com o botão direito do mouse sobre a camada e
selecionar |mActionOpenTable| :menuselection:‘Abrir tabela de atributos da janela de menu.

Este procedimento abrirá uma nova janela que exibe as feições doas atributos da camada (figure_attributes_1). O
número de feições e o numero de feições selecionadas são mostrados no título da tabela de atributos.

Selecionar feições na tabela de atributos

Cada linha selecionada na tabela de atributos exibe o atributo de uma feição da selecionada na camada. Caso
a seleção de feições na janela principal for modificada, a seleção é também atualizada na tabela de atributos.
Igualmente, caso a seleção de linhas na tabela de atributos for alterada, a seleção de feições na janela principal
será atualizada.
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Figura 11.32: Creating a New SpatiaLite layer Dialog

Figura 11.33: Attribute Table for Alaska layer
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Linhas podem ser selecionadas clicando no número de linhas ao lado esquerdo da linha. Múltiplas linhas podem
ser marcadas mantendo pressionada a tecla Control. A seleção Contínua contínua pode ser executada segu-
rando a tecla :kbd:‘Shift e clicando em vários cabeçalhos de linha no lado esquerdo da linha. Todas as linhas entre
a posição do cursor e a linha são selecionadas. Movimentando a posição do cursor na tabela de atributos, clicando
em célula na tabela, não modifica a seleção da linha. Alterando a seleção no menu não movimenta a posição do
cursor na tabela de atributos.

A tabela pode ser ordenada por qualquer coluna clicando no cabeçalho da coluna. Uma pequena seta indica o
ordenamento (apontando para baixo significa valores decrescentes da linha ao topo para baixo).

For a simple search by attributes on only one column the Look for field can be used. Select the field (column)
from which the search should be performed from the dropdown menu and hit the [Search] button. The matching
rows will be selected and the total number of matching rows will appear in the title bar of the attribute table, and

in the status bar of the main window. For more complex searches use the Advanced search button , which
will launch the Search Query Builder described in Section Ferramenta de Consulta.

Para exibir apenas registros selecionados utilize a caixa de seleção Mostrar apenas selecionado(s). Para busca

de registros selecionados somente, use a caixa de seleção Buscar apenas selecionado(s). A caixa de seleção

:guilabel: :Sensível ao caractere. permite selecionar “case sensitive”. Os outros botões no rodapé esquerdo da
janela da tabela de atributos proporcionam as seguintes funcionalidades:

• Desselecionar tudo também com Ctrl+U

• :sup:Mover seleção para o topo também com Ctrl+T

• :sup::Inverter seleçãotambém com :kbd:‘Ctrl+S

• Copiar linhas selecionadas para área de tranferência também com Ctrl+C

• Aproximar o mapa às linhas selecionadas também com Ctrl+J

• Pan map to the selected rows also with Ctrl+P

• Toggle editing mode to edit single values and to enable functionalities described below also with Ctrl+E

• Excluir recursos selecionados também com Ctrl+D

• Nova coluna‘para camadas de PostGIS e para as camadas OGR com a versão GDAL> = 1.6 também com :kbd:‘Ctrl+W

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 also with Ctrl+L

• Abrir Calculadora campo ‘também com :kbd:‘Ctrl+I

Dica: Ir geometria WKT

Se você quiser usar os dados de atributos em programas externos (como Excel) utilizar o botão :sup:‘Copiar
linhas selecionadas para clipboard. Você pode copiar as informações sem geometrias vetoriais, se você desativar

:menuselection:‘Configurações –> Opções –> Guia geral :guilabel: Copiar Geometria na representação WKT
representação do atributo ‘tabela.

Salvar recursos selecionados como nova layer

As feições selecionadas podem ser salvas como qualquer formato vetor OGR suportado e também transformado
para outro sistema de referência de coordenadas (SRC). Abra o menu da camada com o botão direito do mouse
e clique em menuselection:Salvar seleção como –>para definir o nome do arquivo de saída, seu formato e CRS
(veja a seção :ref:‘label_legend)Também é possível especificar as opções para criação de OGR dentro da caixa de
diálogo.
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Trabalhando com tabelas de atributos não espaciais

O QGIS permite também carregar tabelas não espaciais.Isto inclui atuais tabelas suportadas por OGR, textos
delimitados e provedor PostgreSQL. As tabelas podem ser usadas para busca de campos ou apenas para pesquisas
em geral e editadas usando a visualização da tabela. Quando você carrega a tabela que você vai vê-lo no campo

lenda. Ele pode por exemplo ser aberto com o Atributo de Tabela Aberta da ferramenta e, em seguida, é editável
como qualquer outra tabela de atributos da camada.

Como exemplo, você pode usar colunas da tabela não espacial para definir valores de atributos ou um intervalo de
valores que estão autorizados a ser adicionado a uma camada de vetor específico durante a digitalização. Dê uma
olhada na edição de ferramentas na seção Aba Campos para maiores informações.

11.4 Ferramenta de Consulta

A Ferramenta de Consulta permite você definir um subgrupo de uma tabela, utilizando cláusulas SQL como
WHERE, e exibir o resultado na janela de mapas. O resultado da consulta pode ser salvo como uma nova camada
vetorial.

11.4.1 Consulta

Open the attribute table choosing Open Attribute Table from the menu bar. Click on the [Advanced Search] but-
ton to open the Query builder. For example, if you have a towns layer with a population field you could
select only larger towns by entering population > 100000 in the SQL box of the Query builder. Fig-
ure_attributes_2 shows an example of the Query builder populated with data from a PostGIS layer with attributes
stored in PostgreSQL. The Fields, Values and Operators sections help the user to construct the SQL-like query.

Figura 11.34: Query Builder

A opção Campos contém todas as colunas de atributos pesquisáveis da tabela. Para adicionar uma coluna de
atributos ao campo Cláusula onde SQL, clique duplo no nome do. atributo em Campos. Você pode utilizar
campos variados, valores e operadores para construir uma consulta ou simplesmente digitá-los.
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A Lista de Valores apresenta os valores de um atributo da tabela. Para relacionar todas os valores possíveis de um
atributo, selecione o atributo na guia de Campos e clique na opção [Tudo]. Para relacionar os primeiros 25 valores
únicos de uma coluna de atributos, selecione a coluna de atributos na guia Campos e clique em [Amostra]. Para
adicionar um valor à Cláusula onde SQL, clique duplo no valor desejado.

The Operators section contains all usable operators. To add an operator to the SQL where clause field, click the
appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), logical operators (AND,
OR, ...) are available.

O botão [Testar] apresenta um resultado na caixa de mensagem com o número de feições que satisfazem a
condição da consulta elaborada. A opção [Limpar] limpa todo texto da consulta no campo Cláusula onde SQL.
As opções [Salvar] e [Carregar] permitem armazenar e recuperar consultas SQL. A opção [OK] confirma a op-
eração, fechando a janela e selecionando as feições que satisfazem a condição da consulta. A opção [Cancelar]
fecha a janela sem alterações na seleção atual.

Dica: Modificando as definições da Camada
Você pode alterar as definições de uma camada após seu carregamento a partir de uma consulta SQL utilizada
para defini-la. Para isto, abra as Propriedades da camada com um clique duplo na camada a ser alterada, e
na guia :guilabel: Geral clique na [Ferramenta de Consulta]. Para mais informações, veja a Seção Janela de
Propriedades de Vetor.

11.4.2 Seleção

Com o QGIS, é possível também selecionar feições para visualização utilizando uma interface de consulta semel-
hante à utilizada na seção Ferramenta de Consulta. Na seção acima, o objetivo da ferramenta de consulta é
destacar,em amarelo, todas as feições selecionadas pelo critério de filtragem. As demais feições não selecionadas
não mudam sua aparência.

Outra possibilidade é fazer uma seleção pelo botão direito sobre a camada da legenda e escolhendo a opção
Pesquisar... Se você realizar uma consulta SQL nesta opção, apenas as feições selecionadas são exibidas na
janela do mapa. Feições que não atendem à condição da consulta não são exibidas na janela do mapa. A mesma
função está disponível na guia Geral nas Propriedades da Camada. Você pode encontrar a **[Ferramenta de
Consulta]**abaixo e à direita da caixa de diálogo. O método de seleção descrito acima pode ser utilizado com
todos os formatos de dados vetoriais.

11.4.3 Salvar feições selecionadas como uma nova camada

As feições selecionadas podem ser salvas como uma nova camada vetorial, dentre os formatos suportados pelo
padrão OGR, podendo também serem transformadas para outro Sistema de Referência de Coordenadas (SRC).
Basta clicar sobre a camada com o botão direito do mouse e no menu clique em Salvar seleção como...→ para
definir o arquivo de saída, seu formato e SRC (veja Seção Legenda do Mapa). Ainda é possível especificar opções
de criação OGR na caixa de diálogo.

11.5 Calculadora de campo

O botão Calculadora de Campo na tabela de atributos permite realizar cálculos com base na em um atributo existente
ou funções definidas. Exemplo: para calcular o comprimento ou área da geometria das feições. Os resultados
podem ser gerados para uma nova coluna de atributos ou usados para atualizar valores de uma coluna já existente.

Você tem que deixar a camada vetorial em modo de edição e, após isso, clicar no ícone da calculadora de campo
para abrir o diálogo (veja a figure_attributes_3). Na caixa de diálogo, você tem primeiro que selecionar o que se
quer para atualizar somente estas, criar um novo campo de atributos onde os resultados do cálculo serão adiciona-
dos ou atualizados em um campo existente.
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Figura 11.35: Field Calculator

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_3). For example, if you choose a field width of 10 and a field
precision of 3 it means you have 6 signs before the dot, then the dot and another 3 signs for the precision.

A Lista de funções contem funções assim como os campos e valores. Visualize a função de ajuda na Ajuda
de função selecionada. Em Expessão, você pode ver o cálculo das expressões que você criar com a Lista de
funções. Para os operadores mais utilizados, veja Operadores.

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally
you can use the various fields, values and functions to construct the calculation expression or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side opens the Field Values list with the
unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provides several functions. In Operators
you find mathematical operators. Find Math for mathematical functions. The Conversions group contains func-
tions that convert one data type to another. The String group provides functions for data strings. In the Geometry
group you find functions for geometry objects. With Record group functions you can add a numeration to your
data set. To add a function to the Field calculator Expression box, click on the > and then doubleclick the function.

A short example illustrates how the field calculator works. We want to calculate the length of the railroads
layer from the QGIS sample dataset:

1. Load the Shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Clique em Alternar modo de edição e abra a caixa de diálogo Calculadora de Campo.

3. Marque a caixa de seleção Criar um novo campo para calcular em um novo campo.

4. Digite comprimento como Nome do arquivo de Saida, (número decimal) real como Tipo de
arquivo de saida e defina a Espessura do campo de saida com 10 e a Precisão de 3.
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5. Now click on function length in the Geometry group to add it as $length into the Field calculator
expression box and click [Ok].

6. Você pode agora encontrar a nova coluna ‘‘comprimento‘‘na tabela de atributos.

The available functions are listed below.

column name "column name" value of the field column name
’string’ a string value
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed
a OR b a or *b* is true
a AND b a and *b* is true
NOT a inverted truth value of a
sqrt(a) square root of a
sin(a) sinus of a
cos(a) cosinus of b
tan(a) tangens of a
asin(a) arcussinus of a
acos(a) arcuscosinus of a
atan(a) arcustangens of a
to int(a) convert string a to integer
to real(a) convert string a to real
to string(a) convert number a to string
lower(a) convert string a to lower case
upper(a) convert string a to upper case
length(a) length of string a
atan2(y,x) arcustangens of y/x using the signs of the two

arguments to determine the quadrant of the result
replace(*a*, replacethis, withthat) replace this with that in string a
regexp_replace(a,this,that) replace the regular expression this with that
substr(*a*,from,len) len characters of string *a* starting from from

(first character index is 1)
a || b concatenate strings a and b
$rownum number current row
$area area of polygon
$perimeter perimeter of polygon
$length length of line
$id feature id
$x x coordinate of point
$y y coordinate of point
xat(n) X coordinate of the point of an n-th line (indeces

start at 0; negative values refer to the line end)
yat(n) y coordinate of the point of an n-th line (indeces

start at 0; negative values refer to the line end)
a = b a and b are equal
a != b and a <> b a and b are not equal
a >= b a is larger than or equal to b
a <= b a is less than or equal to b
a > b a is larger than b
a < b a is smaller than b
a ~ b a matches the regular expression b
a LIKE b a equals b
a ILIKE b a equals b (without regard to case-sensitive)
a |wedge| b a raised to the power of b
a * b a multiplied by b
a / b a divided by b
a + b a plus b
a - b a minus b
+ a positive sign
- a negative value of a

102 Capítulo 11. Trabalhando com dados vetoriais



QGIS User Guide, Versão 1.8

O menu da calculadora de campo Lista de funções com a Ajuda de função selecionada , Operadores e Ex-
pressão* também estao disponíveis na aba Estilo da propriedades do layer através da opção de renderização

baseada em regra e na expressao baseada em rótulo na aplicação Labeling.
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CAPÍTULO 12

Trabalhando com dados Raster

12.1 Trabalhando com dados raster

This Section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including Arc/Info Binary Grid, Arc/Info ASCII Grid, GeoTIFF, Erdas Imagine and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

Na data deste documento, mais de 100 formatos raster são suportados pela biblioteca GDAL
(ver GDAL-SOFTWARE SUITE-: ref: literature_and_web). A lista completa está disponível no
http://www.gdal.org/formats_list.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries or the GDAL installation of your OS was not built to support the format you want to use.
Only those formats that have been well tested will appear in the list of file types when loading a raster into QGIS.
Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Trabalhando com dados raster GRASS é descrito na Seção : ref:sec_grass.

12.1.1 O que são dados raster?

Dados raster em SIG são matrizes de células distintas, que representam características sobre, acima ou abaixo da
superfície da terra. Cada célula na grade raster é do mesmo tamanho, e as células são geralmente retangulares
(no QGIS serão sempre retangulares). Conjuntos de dados raster típicos incluem dados de sensoriamento remoto,
como fotografias aéreas ou imagens de satélite e dados modelados como uma matriz de elevação.

Ao contrário dos dados vetoriais, dados raster, normalmente, não tem um registro de banco de dados associado
para cada célula. Eles são georreferenciados por sua resolução de pixel e as coordenadas x/y de um pixel de canto
da camada raster. Isto permite com que o QGIS posicione os dados corretamente na tela do mapa.

QGIS faz uso de informações georreferenciados dentro da camada (por exemplo: index: GeoTiff ) ou em um
arquivo de mundo adequado para exibir corretamente os dados.

12.1.2 Carregando dados raster no QGIS

Raster layers are loaded either by clicking on the Load Raster icon or by selecting the Layer → Add Raster
Layer menu option. More than one layer can be loaded at the same time by holding down the Control or Shift
key and clicking on multiple items in the dialog Open a GDAL Supported Raster Data Source.

Uma vez que uma camada for carregada na legenda do mapa, você pode clicar sobre o nome da camada com o
botão direito do mouse para selecionar e ativar feições específicas da camada ou para abrir uma caixa de diálogo
para definir as propriedades raster para a camada.

Menus do Botão direito do mouse para camadas raster
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• Aproximar a camada a sua extensão

• Zoom to Best Scale (100%)

• Show in Overview

• Remover

• Set Layer CRS

• Set Project CRS from Layer

• Properties

• Rename

• Copy Style

• Add New Group

• Expandir tudo

• Fechar tudo

• Update Drawing Order

12.2 Diálogo propriedades Raster

Para visualizar e definir as propriedades de um camada, clique duas vezes no nome da camada na legenda do mapa
ou clique com o direito no nome da camada e escolha: guilabel: Propriedades a partir do menu de contexto:

Isso irá abrir o :guilabel: Diálogo Propriedades da camada Raster , (see figure_raster_1).

There are several tabs on the dialog:

• Estilo

• Transparência

• Mapa de cores

• Geral

• Metadata

• Pirâmides

• Histograma

12.2.1 Tabela Estilo

QGIS can render raster layers in two different ways:

1. Banda simples - uma banda da imagem é renderizada em escala de cinza ou em falsa cor ou Despadronizar.

2. Três bandas de cores - três bandas da imagem serão processadas, cada banda que representa o componente
vermelho, verde ou azul, que irá ser utilizado para criar uma imagem a cores.

Em ambos os tipos de renderização você pode inverter a saída de cores utilizando o : guilabel: caixa de seleção
Inverter mapa de cores.

Renderizar banda simples

Esta seleção oferece duas possibilidades para escolher. Na primeira você pode selecionar qual banda você gostaria
de usar para renderização (se o conjunto de dados tem mais de uma banda).

A segunda opção oferece uma seleção de tabela de cores disponíveis para renderizar.

The following settings are available through the dropdownbox Color map
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Figura 12.1: Raster Layers Properties Dialog

• Grayscale (default)

• Pseudocolor

• Freak Out

• Mapa de cores

When selecting the entry ‘Colormap’ from Color map combobox, the tab Colormap becomes available.
For more information see Mapa de cores.

QGIS pode restringir os dados exibidos para mostrar apenas as células cujos valores estão dentro de um determi-
nado número de desvios padrão da média para a camada.

Isto é útil quando você tem uma ou duas células com valores anormalmente elevados em uma grade raster que
estão tendo um impacto negativo sobre a renderização do raster. Esta opção só está disponível para imagens em
pseudocores e despadronizadas.

Três bandas de cor

Esta seleção oferece-lhe uma ampla gama de opções para modificar a aparência da sua camada raster. Por exemplo,
você poderia mudar a ordem de cor-bandas do padrão RGB para outra qualquer.

Também a escala de cores está disponível.

Dica: Visualizando uma banda simples do Raster Multibanda
Se você quiser ver uma banda única (por exemplo Vermelho) de uma imagem multibanda, você pode pensar que
iria definir as faixas verde e azul para “não informado”. Mas esta não é a maneira correta. Para apresentar a banda
Vermlho, defina o tipo de imagem em tons de cinza, em seguida, selecione Vermelho, como a banda de usar para
Cinza.

Realce do contraste

Nota: When adding GRASS rasters the option Contrast enhancement will be always set to automatically to
stretch to min max regardless if the Quantum GIS general options this is set to another value.

12.2. Diálogo propriedades Raster 107



QGIS User Guide, Versão 1.8

12.2.2 Aba transparência

QGIS has the ability to display each raster layer at varying transparency levels. Use the transparency slider to
indicate to what extent the underlying layers (if any) should be visible though the current raster layer. This is
very useful, if you like to overlay more than one rasterlayer, e.g. a shaded relief map overlayed by a classified
rastermap. This will make the look of the map more three dimensional.

Além disso, você pode inserir um valor raster, que deve ser tratada como NODATA. Isto pode ser feito manual-

mente ou com o : sup: ícone Adicionar valores a partir da exibição.

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example we want to set the water of our example raster file landcover.tif to a transparency of 20 %.
The following steps are neccessary:

1. Carregar o arquivo raster:file:landcover.

2. Open the Properties dialog by double-clicking on the raster name in the legend or by right-clicking and
choosing Properties from the popup menu.

3. Selecione o :guilabel: Aba Transparência

4. Clique o :sup: Botão Adicionar valores manualmente. Uma nova linha irá aparecer na lista de pixel.

5. Adicione o valor raster (usamos 0 aqui) e ajuste a transparencia para 20%.

6. Pressione o botão [Apply] e dê uma visualizada no mapa.

Você pode repetir os passos 4 e 5 para ajustar mais valores personalizados de transparência.

As you can see this is quite easy to set custom transparency, but it can be quite a lot of work. Therefore you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

12.2.3 Mapa de cores

The Colormap tab is only available, when you have selected a singleband rendering within the Style tab (see
Tabela Estilo).

Three ways of color interpolation are available:

1. Discrete

2. Linear

3. Exact

The button [Add Entry] adds a color to the individual color table. Button [Delete Entry] deletes a color from the
individual color table and the [Sort] button sorts the color table according to the pixel values in the value column.
Double clicking on the value-column lets you insert a specific value. Double clicking on the color-column opens
the dialog Select color where you can select a color to apply on that value. Further you can also add labels for
each color but this value won’t be displayed when you use the identify feature tool.

You can also click on the button Load color map from band, which tries to load the table from the band (if it has any).

And you can use the buttons Load color map from file or Export color map to file to load an existing color table or to
save the defined color table for other sessions.
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The block Generate new color map allows you to create newly categorized colormaps. You only need to select

the number of entries and press the button Classify. Currently only one Classification mode is
supported - ‘Equal interval’

12.2.4 Aba Geral

The General tab displays basic information about the selected raster, including the layer source and display name
in the legend (which can be modified). This tab also shows a thumbnail of the layer, its legend symbol, and the
palette.

Além disso escala dependente de visibilidade pode ser definido neste guia. Você precisa verificar a caixa de
seleção e definir uma escala adequada, onde seus dados serão exibidos na tela do mapa.

Também o sistema de coordenadas de referência (CRS) é impresso aqui como um PROJ.4-string. Isso pode ser
modificado pressionando o botão [Especifique...].

12.2.5 Aba Metadata

A :guilabel: Aba Metadata exibe uma riqueza de informações sobre a camada raster, incluindo estatísticas sobre
cada banda na camada atual. As estatísticas estão reunidas em uma ‘necessidade de saber’, por isso pode muito
bem ser que uma estatística de dada camada ainda não tenha sido coletadas.

This tab is mainly for information. You cannot change any values printed inside this tab.

12.2.6 Aba Pirâmides

Camadas raster de grandes resoluções podem retardar a navegação no QGIS. Com a criação de cópias de baixa
resolução dos dados (pirâmides), o desempenho pode ser melhorado consideravelmente, o QGIS seleciona a res-
olução mais adequado para usar dependendo do nível de zoom.

Você pode ter acesso de escrita no diretório onde os dados originais são armazenados para construir pirâmides.

Several resampling methods can be used to calculate the pyramids:

• Average

• Nearest Neighbour

Ao habilitar a caixa de seleção : guilabel: construir pirâmides internamente se possível o QGIS tenta construir
pirâmides internamente.

Favor notar que construir pirâmides pode alterar o ficheiro original de dados e uma vez criados, eles não podem
ser removidos. Se você deseja preservar uma versão “não-piramidal” do seu raster, faça uma cópia de segurança
antes de construir pirâmides.

12.2.7 Aba Histograma

The Histogram tab allows you to view the distribution of the bands or colors in your raster. It is generated
automaticaly when you open Histogram tab. All existing bands will be displayed together. You can save the

histogram as an image with the button.

12.3 Calculadora Raster

The Raster Calculator in the Raster menu (see figure_raster_2) allows to perform calculations on basis of existing
raster pixel values. The results are written to a new raster layer with a GDAL supported format.
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Figura 12.2: Raster Calculator

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions or you can just type it into the box.

Na seção Result layer é necessário definir a camada de saída. Em seguida, pode definir a extensão da área de
cálculo com base em uma camada raster de entrada ou com base em coordenadas X, Y e em colunas e linhas para
definir a resolução da camada de saída. Se a camada de entrada tem uma resolução diferente, os valores serão
redefinidos com o algoritmo vizinho mais próximo.

The Operators section contains all usable operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox the result layer will automatically added to the legend area and can
be visualized.

12.3.1 Examples

Convert elevation values from meter to feet

Creating an elevation raster feet from a raster in meter, you need to use the conversion factor for meters to feet:
3.28. The expression is:

elevation@1 * 3.28

Using a mask

If you want to mask out parts of a raster, because you are only interested in elevations above 0 meter, you can use
following expression to create a mask and apply the result to a raster in one step.

(elevation@1 >= 0) * elevation@1

For every cell greater than or equal to 0, set its value to 1, otherwise set it to 0. This creates the mask on the fly.
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CAPÍTULO 13

Trabalhando com dados OGC

13.1 Trabalhando com dados OGC

QGIS suporta WMS e WFS como fontes de dados.

13.1.1 O que é dados OGC

A Open Geospatial Consortium (OGC), é uma organização internacional com mais de 300 organizações com-
erciais, governamentais, sem fins lucrativos e de pesquisa em todo o mundo. Seus membros desenvolvem e
implementam normas para conteúdo geoespacial e de serviços, processamento de dados SIG e intercâmbio.

Descrevendo um modelo de dados básico para feições geográficas de um número crescente de especificações são
desenvolvidos para atender necessidades específicas de localização interoperabilidade e tecnologia geoespacial,
incluindo SIG. Mais informações podem ser encontradas em http://www.opengeospatial.org/.

Especificações OGC importantes são:

• WMS — Web Map Service

• WFS — Web Feature Service

• WCS — Web Coverage Service

• CAT — Web Catalog Service

• SFS — Simple Features for SQL

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations
and data stores. QGIS can now deal with three of the above specifications, being SFS (through support of the
PostgreSQL / PostGIS data provider, see Section Camadas PostGIS), WFS and WMS as a client.

13.1.2 Cliente WMS

Resumo do suporte WMS

QGIS atualmente pode agir como um cliente WMS que entende servidores WMS 1.1, 1.1.1 e 1.3. Ele tem
particularmente sido testados com servidores de acesso público, tais como DEMIS.

Servidores WMS atuam sobre os pedidos do cliente (por exemplo QGIS) para um mapa raster com uma extensão
dada, conjunto de camadas, estilo de simbolização e transparência. O servidor WMS então consulta suas fontes de
dados locais, rasteriza o mapa, e envia de volta para o cliente em um formato raster. Para o QGIS isso normalmente
seria no formato JPEG ou PNG.

WMS é genericamente um REST (Transferência de Estado Representacional) serviço em vez de um serviço Web
completamente fundido. Como tal, você pode realmente ter o URLs gerados pelo QGIS e usá-los em um navegador
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da Web para recuperar as mesmas imagens que o QGIS usa internamente. Isto pode ser útil para solução de
problemas, pois existem várias marcas de servidores WMS no mercado e todos eles têm sua própria interpretação
do padrão WMS.

Camadas WMS podem ser adicionadas simplesmente, desde que você saiba a URL para acessar o servidor WMS,
você tem uma conexão útil para esse servidor, e o servidor HTTP entende como mecanismo de transporte de
dados.

Selecionando servidor WMS

A primeira vez que você usar o recurso de WMS, não há servidores definidos.

Comece clicando no : sup: botão Adicionar camada WMS dentro da barra de ferramentas, ou através do
:menuselection: menu Camada –> Adicionar Camada WMS ....

O diálogo: guilabel: ‘Adicionar camada(s) de um servidor‘ para adicionar camadas do servidor WMS aparecerá.
Você pode adicionar alguns servidores para jogar clicando no botão [Adicionar servidores padrões] Isto irá
adicionar dois servidores de demonstração de WMS para você usar, os servidores WMS do DM Solutions Gmap
e Lizardtech server. Para definir um servidor WMS novo no guia: guilabel: Camadas, selecione o botão [Novo].
Em seguida, insira os parâmetros para se conectar ao servidor WMS desejado, conforme listado na table_OGC_1:

Nome Um nome para essa conecção. Este nome será usado nas conexões de servidor
caixa suspensa para que você possa distingui-lo de outros servidores WMS.

URL URL do servidor que fornece os dados. Este deve ser um nome de host resolvido,
o mesmo formato que você usaria para abrir uma conexão telnet ou ping em um
host.

Usuário Usuário para o acesso em servidor WMS seguro. Este parâmetro é opcional.
Senha Senha para uma autenticação básica no servidor WMS. Este parâmetro é opcional.

Ignorar GetMap URI Ignorar GetMap URI relatados em recursos, usar determinado URI do campo
URL acima.

Ignorar GetFeatureInfo
URI relatados em
recursos

Ignorar GetMap URI relatados em recursos , usar determinado URI do campo
URL acima

Tabela OGC 1: Parâmtros de coneção WMS

If you need to set up a proxy-server to be able to receive WMS-services from the internet, you can add your
proxy-server in the options. Choose menu Settings → Options and click on the tab Network & Proxy. There you

can add your proxy-settings and enable them by setting the Use proxy for web access. Make sure that you

select the correct proxy type from the Proxy type dropdown menu.

Uma vez que a nova conexão de servidor WMS foi criada, ela será preservada para as futuras sessões do QGIS.

Dica: Nas URLs dos servidores WMS
Certifique-se, ao entrar na URL do servidor WMS, que você tem a URL base. Por exemplo, você não deve ter
fragmentos pedidos, como request= GetCapabilities ou version=1.0.0 no seu URL.

Carregando camadas WMS

Once you have successfully filled in your parameters you can select the [Connect] button to retrieve the capabil-
ities of the selected server. This includes the Image encoding, Layers, Layer Styles and Projections. Since this is
a network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the left bottom of
the WMS dialog.

Sua tela deve agora visualizar como na figure_OGR_1, que mostra a resposta fornecida pelo servidor WMS DM
Solutions GMap.
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Figura 13.1: Dialog for adding a WMS server, showing its available layers

Codificação de imagem

A: guilabel: Codificação da Imagem a secção agora lista todos os formatos que são suportados pelo cliente e
servidor. Escolha um de acordo com suas exigências de precisão de imagem.

Dica: Codificação de imagem
Você encontrará tipicamente que um servidor WMS oferece-lhe a escolha de codificação de imagem JPEG ou
PNG. JPEG é um formato de compressão com perdas, enquanto PNG reproduz fielmente os dados raster bruto.

Use JPEG se você espera que os dados WMS sejam fotográficos na natureza e / ou você não se importa de alguma
perda na qualidade da imagem. Este trade-off normalmente reduz em cinco vezes a necessidade de transferência
de dados em comparação com PNG.

Use PNG, se você quiser representações precisas dos dados originais, e não se importa com o aumento dos requi-
sitos de transferência de dados.

Opções

The Options field provides a text field where you can add a Layer name for the WMS-layer. This name will be
presented in the legend after loading the layer.

Below the layer name you can define Tile size, if you want to set tile sizes (eg. 256x256) to split up the WMS
request into multiple requests.

A: guilabel: Limite de feição para GetFeatureInfo define quais feições do servidor serão consultadas.

Se você selecionar um WMS da lista um campo com a projeção padrão, fornecido pelo mapserver, aparecerá. Se
o botão [Mudar ...] estiver ativo, você pode clicar nele e mudar a projeção padrão do WMS para outro SRC,
fornecidos pelo servidor WMS.

Ordem de camada

A guia: guilabel: Ordem de camada lista as camadas selecionadas disponíveis a partir do servidor WMS atual
conectado. Você pode notar que algumas camadas são expansíveis, isso significa que a camada pode ser exibida
em uma escolha de estilos de imagem.

Você pode selecionar várias camadas de uma vez, mas apenas um estilo de imagem por camada. Quando várias
camadas são selecionados, elas serão combinadas e transmitidas para o servidor WMS QGIS de uma só vez.

Dica: Ordenação de camada WMS
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Camadas WMS disponibilizadas por um servidor são sobrepostas na ordem listada na seção Camadas, de cima
para baixo da lista. Se você quiser alterar a ordem de sobreposição, você pode usar a guia: guilabel: Ordem de
camada.

Transparência

Nesta versão do QGIS, a: guilabel: transparência global configuração da: guilabel: ‘Propriedades da camada‘é
codificada para ser sempre ligada, sempre que disponível.

Dica: Transparência da camada WMS
A disponibilidade de transparência da imagem WMS depende da codificação utilizada na imagem: PNG e GIF
suportam transparência, enquanto JPEG deixa sem suporte.

Sistema de coordenada de referência

Um Sistema de Referência de Coordenadas (SRC) é a terminologia OGC para uma projeção QGIS.

Each WMS Layer can be presented in multiple CRSs, depending on the capability of the WMS server.

To choose a CRS, select [Change...] and a dialog similar to Figure Projection 3 in Trabalhando com Projeções
will appear. The main difference with the WMS version of the screen is that only those CRSs supported by the
WMS Server will be shown.

Busca de servidor

Within QGIS you can search for WMS-servers. Figure_OGC_2 shows the tab Server Search with the Add Layer(s)
from a Server dialog.

Figura 13.2: Dialog for searching WMS servers after some keywords

As you can see it is possible to enter a search-string in the text field and hit the [Search] button. After a short while
the search result will be populated into the list below the text field. Browse the result list and inspect your search
results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS-list]
button and change back to the tab Layers. QGIS automatically has updated your server list and the selected search
result is already enabled in the list of saved WMS-servers in the Layers tab. You only need to request the list of
layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Basicamente, esta opção é um frontend para o API de http://geopole.org.
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Tilesets

When using WMS-C (Cached WMS) Services like http://labs.metacarta.com/wms-c/Basic.py you are able to
browse through the tab Tilesets given by the server. Additional information like tile size, formats and supported
CRS are listed in this table. In combination with this feature you can use the tile scale slider from the View → Tile
scale slider, which gives you the available scales from the tileserver with nice slider docked in.

Usando a ferramenta de identificação

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Exibindo propriedades

Depois de ter adicionado um servidor WMS, você pode ver suas propriedades clicando sobre ela na legenda, e
selecionando: menuselection: Propriedades. Guia Metadata

The tab Metadata displays a wealth of information about the WMS server, generally collected from the Capabil-
ities statement returned from that server. Many definitions can be cleaned by reading the WMS standards (see
OPEN-GEOSPATIAL-CONSORTIUM Referências Bibliográficas e Web), but here are a few handy definitions:

• Propriedades do servidor

– Versão WMS — A versão WMS suportada pelo servidor.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently QGIS supports the text-plain type.

• Propriedades da camada

– Selecionado — Seja ou não essa camada foi selecionada quando o servidor foi adicionado a este
projeto.

– Visível — Seja ou não essa camada é selecionada como visível na legenda. (Ainda não utilizados
nesta versão do QGIS.)

– Pode identificar — ou não essa camada retornará nenhum resultado quando a ferramenta Identificar
é usada nela.

– Pode ser transparente — ou não essa camada pode ser apresentada com transparência. Esta versão
do QGIS sempre usa a transparência se esta é Sim e a codificação de imagens suporta transparência

– Pode ampliar — Seja ou não essa camada pode ser ampliada pelo servidor. Esta versão do QGIS as-
sume todas as camadas WMS tem este conjunto de Sim. Camadas deficientes podem ser apresentadas
de forma estranha.

– Cascade Count — WMS servers can act as a proxy to other WMS servers to get the raster data for a
layer. This entry shows how many times the request for this layer is forwarded to peer WMS servers
for a result.

– Largura fixa, altura fixa — Seja ou não essa camada fixou dimensões de pixel de origem. Esta
versão do QGIS assume todas as camadas WMS tem este conjunto vazio. Camadas deficientes podem
ser apresentadas de forma estranha.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g. UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.
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– SRC Disponível — As projeções que esta camada pode ser apresentadas pelo servidor WMS. Elas
estão listadas no formato nativo WMS.

– Estilo Disponível — Os estilos de imagem que esta camada pode renderizar pelo servidor WMS.

Limitações do cliente WMS

Nem todas as funcionalidade de cliente WMS possíveis tinham sido incluídas nesta versão do QGIS. Alguns das
mais notáveis exceções seguir.

Editando configurações de camada WMS

Once you’ve completed the Add WMS layer procedure, there is no ability to change the settings. A workaround is
to delete the layer completely and start again.

Autenticação requerida nos servidores WMS

Atualmente públicas acessíveis e seguros os serviços-WMS são suportados. Os servidores-WMS seguros podem
ser acessados por meio da autenticação pública. Você pode adicionar as credenciais (opcional) quando você
adiciona um servidor-WMS. Consulte a seção: ref: ogc-wms-servers para mais detalhes.

Dica: Acessando camadas-OGC seguras
If you need to access secured layers with other secured methods than basic authentication, you could use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found at the
InteProxy manual found on the website http://inteproxy.wald.intevation.org.

Dica: QGIS WMS Mapserver
Para a versão QGIS 1.7.0 tem sua própria implementação de um WMS 1.3.0 Mapserver. Leia mais sobre isso no
capítulo: ref: label_qgisserver.

13.1.3 Clientes WFS e WFS-T

No QGIS, uma camada WFS se comporta muito bem como qualquer camada de vetor. Você pode identificar e
selecionar as feições e visualizar a tabela de atributos. Desde a edição QGIS 1.6 (WFS-T) também é suportado.

Em geral, a adição de uma camada WFS é muito semelhante ao procedimento utilizado com WMS. A diferença é
que não há servidores padrão definidos, por isso temos de acrescentar o nosso.

Carregando uma camada WFS

Como exemplo, vamos usar o DM Solutions servidor WFS e exibir uma camada. A URL é:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clique no : sup: ferramenta Adicionar Camada WFS na barra de ferramentas Camadas, o diálogo:
guilabel: aparece ‘Adiciona camada WFS de um Servidor ‘

2. Click em [Novo]

3. Enter ‘DM Solutions’ as name

4. Entre com a URL (ver acima citada)

5. Clique [OK]

6. Choose ‘DM Solutions’ from the Server Connections combobox

7. Clique [Conectar]

8. Aguarde a lista de camadas a ser preenchida

9. Select the Parks layer in the list
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10. Clique [Aplicar] para adicionar a camada para o mapa

Note-se que as configurações de proxy definidas em suas preferências também são reconhecidas.

Figura 13.3: Adding a WFS layer

Você vai notar o progresso do download é visualizado no canto inferior esquerdo da janela principal do QGIS.
Uma vez que a camada é carregada, você pode identificar e selecionar uma província ou duas e ver a tabela de
atributos.

Only WFS 1.0.0 is supported. At this point there have not been many tests against WFS versions implemented in
other WFS-servers. If you encounter problems with any other WFS-server, please do not hesitate to contact the
development team. Please refer to Section Listas de Discurssão for further information about the mailinglists.

Dica: Conclusão do servidor WFS
Você pode encontrar mais servidores WFS, usando o Google ou o seu motor de busca favorito. Há um número de
listas com URLs públicas, algumas delas mantidas e algumas não.

13.2 Servidor QGIS

O Servir QGIS é uma fonte aberta WMS 1.3 e WFS 1.0.0 que implementa, além disso, implementa avançados
recursos cartográficos para mapeamento temático. O servidor do QGIS é um aplicativo FastCGI/CGI (Common
Gateway Interface), escrito em C++ que funciona em conjunto com um servidor web (por exemplo, o Apache,
Lighttpd). É financiado pela projeto Orchestra UE, Sany e a cidade de Uster, na Suíça.

It uses QGIS as backend for the GIS logic and for map rendering. Furthermore the Qt library is used for graphics
and for platform independent C++ programming. In contrast to other WMS software, the QGIS Server uses carto-
graphic rules as a configuration language, both for the server configuration and for the user-defined cartographic
rules.

Além disso, o projeto do Servidor QGIS fornece o complemento ‘Publicar na Web’, um complemento para o
QGIS desktop que exporta as camadas atuais e simbologia como um projeto web para o Servidor QGIS (contendo
regras de visualização cartográfica expressas em SLD).

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS. The ‘Publish to Web’ plugin currently supports basic symbolization, with more
complex cartographic visualization rules introduced manually. As the configuration is performed with the SLD
standard and its documented extensions, there is only one standardised language to learn, which greatly simplifies
the complexity of creating maps for the Web.

Em um dos seguintes manuais vamos fornecer um exemplo de configuração para configurar um servidor de QGIS.
Mas, por ora, recomendamos que você leia uma das seguintes URLs para obter mais informações:

• http://karlinapp.ethz.ch/qgis_wms/
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• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

13.2.1 Instalação simples no Squeeze Debian

Neste ponto, vamos dar um exemplo de instalação curto e simples para Squeeze Debian. Muitos outros sistemas
operacionais também oferecem pacotes para o servidor QGIS. Se você tem que construir tudo a partir da fonte,
por favor consulte as URLs acima.

Apart from qgis and qgis-mapserver you need a webserver, in our case apache2. You can install all pack-
ages with aptitude or apt-get install together with other necessary dependency packages. After installation you
should test, if the webserver and qgis server works as expected. Make sure the apache server is running with
/etc/init.d/apache2 start. Open a web browser and type URL: http://localhost. If apache is
up, you should see the message ‘It works!’.

Now we test the qgis server installation. The qgis_mapserv.fcgi is available at
/usr/lib/cgi-bin/qgis_mapserv.fcgi and provides a standard wms that shows the state boundaries
of Alaska. Add the WMS with the URL http://localhost/cgi-bin/qgis_mapserv.fcgi as
described in Selecionando servidor WMS.

Figura 13.4: Standard WMS with USA boundaries included in the qgis server (KDE)

13.2.2 Creating a WMS/WFS from a QGIS project

To provide a new qgis wms/wfs server we have to create a qgis project file with some data. Here we use the
‘alaska’ shapefile from the qgis_sample_dataset. Define the colors and styles of the layers in QGIS and define the
project CRS, if not already done.

Then open the OWS Server tab in the menu Settings → Project Properties and define the general fields under
‘Service Capabilities’. For WMS Capabilities define ‘Coordinate System Restrictions’ and ‘Advertised Ex-

tend’. Additionally you can enable the checkbox Add WKT geometry to feature into response to make the lay-
ers queryable and add a ‘Maximum width’ and height that can be requested. For WFS Capabilities you only
need to select the layers that you want to provide as WFS. Now save the session in a project file alaska.qgs.
To provide the project as a WMS/WFS, we create a new folder /usr/lib/cgi-bin/project with admin
privileges and add the project file alaska.qgs and a copy of the qgis_mapserv.fcgi file - that’s all.

Now we test our project WMS and WFS, add the WMS and WFS as described in Carregando camadas WMS and
Clientes WFS e WFS-T to QGIS and load the WMS. The URL is:
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Figura 13.5: Definitions for a qgis project WMS/WFS server (KDE)

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

13.2. Servidor QGIS 119



QGIS User Guide, Versão 1.8

120 Capítulo 13. Trabalhando com dados OGC



CAPÍTULO 14

Trabalhando com dados GPS

14.1 Complemento GPS

14.1.1 O que é GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find
their exact position anywhere in the world. It is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receivers movement over time. Waypoints, routes and
tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers while routes and
tracks are displayed in linestring layers.

14.1.2 Carregando dados GPS de um arquivo

Existem dezenas de diferentes formatos de arquivo para armazenar dados GPS. O formato que o QGIS usa é
chamado GPX (GPS Exchange Format), que é um formato de intercâmbio padrão e que pode conter qualquer
número de ‘Locais’, ‘Rotas’ e ‘Trilhas’ no mesmo arquivo.

To load a GPX file you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded two buttons with a small handheld GPS
device will show up in the toolbar:

• Create new GPX Layer

• GPS Tools

For working with GPS data we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See Section Dados de exemplo for more infor-
mation about the sample data.

1. Clique na opção :menuselection: Vetor-> :menuselection: GPS->’|gps_importer| ‘Ferramentas GPS para
abrir a caixa:guilabel:Ferramentas de GPS e escolha a aba ‘Carregar arquivo GPX’ (veja figure_GPS_1).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.

Nota: Navegadores GPS permitem armazenar dados em diferentes sistemas de coordenadas. Quando baixar al-
gum arquivo GPX (do navegador GPS ou de algum site da WEB) e for carregá-lo no Quantum GIS, esteja certo de
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Figura 14.1: The GPS Tools dialog window

que os dados estejam em WGS84(latitude/longitude). O Quantum GIS espera que tais dados estejam nesse format,
que são as especificações oficiais do GPS. Para maiores informações, acesse http://www.topografix.com/GPX/1/1/

14.1.3 GPSBabel

Since QGIS uses GPX files you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

14.1.4 Importando dados GPS

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

14.1.5 Descarregando dados GPS de um receptor

QGIS pode utilizar o GPSBabel para descarregar dados diretamente de um receptor GPS para uma nova camada
vetorial no projeto. Para tanto, utilize a opção :guilabel:‘Descarregar do GPS’ da caixa de diálogo de Ferramentas
de GPS (veja Figure_GPS_2). Deve-se selecionar o tipo de receptor GPS, a porta serial a que ele está conectado
(ou USB, caso o receptor tenha esse tipo de suporte ou GPSD para receptores internos aos equipamentos), o tipo
de feição que se queira descarregar, o caminho e nome do arquivo GPX que armazenará os dados e o nome da
camada que será criada no projeto.

Figura 14.2: The download tool
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O tipo de dispositivo GPS indicado na caixa de diálogo, determina a forma como o GPSBabel tenta a comunicação
com o receptor GPS. Caso nenhum dos tipos disponíveis funcione para o receptor que se esteja utilizando, pode-se
criar um novo tipo (veja a seção:ref: ’definindo novos tipos de dispositivos’).

A opção Porta deve ser o nome de arquivo ou outro nome que o sistema operacional utilize para referenciar à porta
física do computador onde o receptor GPS esteja conectado. Pode ser também a opção USB, para os receptores
que disponham desse tipo de comunicação com o computador.

• On Linux this is something like /dev/ttyS0 or /dev/ttyS1

• On Windows it is COM1 or COM2.

Ao se clicar em [OK] os dados serão descarregados do receptor e serão inseridos como uma camada no projeto
do QGIS.

14.1.6 Carregando dados no receptor GPS

É possível carregar dados diretamente de uma camada vetorial do projeto QGIS em um receptor GPS utilizando
a opção:guilabel:Carregar no GPS da caixa de diálogo de Ferramentas de GPS. Para tanto, basta selecionar a
camada que se queira carregar (a qual deve ser referente a um arquivo GPX), qual o tipo de dispositivo GPS e a
porta (ou USB) a que o receptor esteja. Assim como no caso de Descarregar dados do GPS, é possível especificar
um novo tipo de dispositivo, caso nenhuma opção da lista funcione.

Essa ferramenta é muito útil em combinação com as capacidades de edição do QGIS. É possível carregar um
mapa, criar os Waypoints e as rotas e, então, carregá-los no receptor GPS.

14.1.7 Definindo novos tipos de dispositivo

Existem vários tipos de receptores GPS. Os desenvolvedores do QGIS não são capazes de testar todos esses
equipamentos. Caso ocorra a situação em que a comunicação com o receptor não funcione com os tipos listados
nas ferramentas :guilabel:‘ Descarregar do GPS ‘ e/ou :guilabel:‘ Carregar no GPS ‘ é possível definir um tipo
específico. Para tanto, deve-se utilizar o editor de dispositivos, clicando no botão [Editar Dispositivos] nas
funções de carregar ou descarregar dados.

To define a new device you simply click the [New device] button, enter a name, a download command and an
upload command for your device, and click the [Update device] button. The name will be listed in the device
menus in the upload and download windows, and can be any string. The download command is the command that
is used to download data from the device to a GPX file. This will probably be a GPSBabel command, but you can
use any other command line program that can create a GPX file. QGIS will replace the keywords %type, %in,
and %out when it runs the command.

%type será substituido por -w se for para baixar dados de ‘Locais’ (Waypoints), -r se o caso for para baixar
dados do tipo ‘Rota’ (Route) e -t se for para baixar ‘Trilhas’ (Tracklogs). Esses são os comandos utilizados pelo
GPSBabel para baixar o tipo correto de dados.

%in will be replaced by the port name that you choose in the download window and %out will be replaced
by the name you choose for the GPX file that the downloaded data should be stored in. So if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

Os comandos indicados nas linhas de ‘Carregar’ são aqueles utilizados para carregar os dados no dispositivo. As
mesmas palavras-chave são utilizadas, porém %in é substituído pelo nome do arquivo GPS que é utilizado e %out
é substituído pelo nome da porta.

Maiores informações a respeito do GPSBabel e das opções de linha de comando que ele aceita estão disponíveis
em http://www.gpsbabel.org.

Uma vez criado um novo dispositivo, ele aparecerá na lista de dispositivos para carregar e descarregar dados.
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14.2 Rastreio GPS em tempo real

To activate Live GPS tracking in QGIS you need to select Settings → GPS information. You will get a new
docked window on the left side of the canvas.

There are 4 possible screens in this GPS tracking window:

• Cooredenadas da posição GPS e opções para entrar manualmente Vértices e Elementos Vetoriais.

• Apresenta a potência do sinal GPS dos satélites em uso.

• Apresenta a tela de posicionamento polar dos satélites visíveis: indicando a posição e o número dos
satélites.

• GPS options screen (see figure_gps_options).

With a plugged in GPS receiver (has to be supported by your operating system) a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS-receiver from your computer.
For GNU/Linux gpsd support is integrated to support connection to most GPS receivers. Therefore you first have
to configure gpsd properly to connect QGIS to it.

Aviso: Caso pretenda gravar o percurso do rastreio GPS, é necessário dispor de uma camada vetorial (que
aceite linhas) e acionar a edição da mesma para que ela receber a informação do trecho percorrido.

14.2.1 Position and additional attributes

If the GPS is receiving signals from satellites you will see your position in latitude, longitude and altitude
together with additional attributes.

Figura 14.3: GPS tracking position and additional attributes

14.2.2 Força do sinal GPS

Here you can see the signal strenght of the satellites you are receiving signals from.
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Figura 14.4: GPS tracking signal strength

14.2.3 Posiçao polar GPS

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figura 14.5: GPS tracking polar window

14.2.4 Opções GPS

In case of connection problems you can switch between:

• Autodetect

• Internal,

• Serial device

• gpsd (selecting Host, Port and Device your GPS is connected to).

A click on [Connect] again initiates the connection to the GPS receiver.

You can activate Automatically save added features when you are in editing mode. Or you can can activate

Automatically add points to the map canvas with a certain width and color.

Activating Cursor you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows to decide in which way the canvas will be updated. This includes ‘always’,
‘when leaving’ if your recorded coordinates start either to move out of canvas or ‘never’ to keep map extent.

Finally you can activate Log file and define a path and a file where log messages about the gps tracking a
logged.

If you want to set a feature manually you have to go back to Position and click on [Add Point] or [Add track
point].
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Figura 14.6: GPS tracking options window
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CAPÍTULO 15

Integração com SIG GRASS

O complemento GRASS promove o acesso para o SIG GRASS (ver GRASS-PROJECT Referências Bibliográ-
ficas e Web) base de dados e funcionalidades. Isso inclui visualização de camadas raster e vetoriais GRASS,
digitalização de camadas vetoriais, edição de atributos vetoriais, criação de novas camadas vetoriais e análise de
dados 2D e 3D GRASS com mais de 300 modulos GRASS.

Nesta seção, vamos apresentar as funcionalidades do complemento e dar alguns exemplos de gestão e trabalhos
com dados do GRASS. As seguintes características principais são fornecidas com o menu da barra de ferramentas,
quando você inicia o complento GRASS, como descrito na seção: ref: sec_starting_grass:

• Abrir mapset

• Novo mapset

• Fechar mapset

• Adicionar uma camada vetorial do GRASS

• Adicionar uma camada raster do GRASS

• Criar um novo vetor do GRASS

• Editar camada vetorial do GRASS

• Abrir ferramentas GRASS

• Mostrar a região atual do GRASS

• Edita região atual do GRASS

15.1 Iniciando o complemento GRASS

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore click the menu Plugins → Manage Plugins, select
GRASS and click [OK].

Agora você pode começar a carregar camadas raster e vetoriais a partir de um GRASS existente: arquivo: LO-
CALIZAÇÃO (ver seção: ref: sec_load_grassdata). Ou você cria um novo GRASS: arquivo: LOCALIZAÇÃO com
QGIS (ver seção: ref: sec_create_loc) e importa alguns dados raster e vetor (ver Seção: ref: sec_import_loc_data)
para a análise com a caixa de ferramentas GRASS (ver seção: ref: subsec_grass_toolbox).
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15.2 Carregando camadas raster e vetorial GRASS

Com o complemento GRASS, voce pode carregar camadas raster e vetor usando o botão apropriado do menu da
barra de ferramentas. Como exemplo usamos o banco de dados alaska do QGIS (ver seção Dados de exemplo).
Ele inclue uma pequena e simples camada GRASS:arquivo:LOCALIZAÇÃO com 3 camadas vetoriais e 1 camada
raster de elevação.

1. Criar uma pasta nova :arquivo:‘grassdata‘, baixar o conjunto de dados alaska QGIS :ar-
quivo:‘qgis\_sample\_data.zip‘ de http://download.osgeo.org/qgis/data/ e descompacte o arquivo
em:arquivo:grassdata.

2. Iniciar QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. Na barra de ferramentas GRASS. clique no :sup: ícone Abrir mapset para abrir o: arquivo: assistente
MAPSET.

5. Para: arquivo: Gisdbase busque e selecione ou digite o caminho para a pasta recém criada: arquivo: grass-
data.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Clique [OK]. Observe que algumas ferramentas anteriormente desabilitadas na barra de ferramentas
GRASS agora estão habilitadas.

8. Clique em Adicionar camada raster GRASS, escolha o nome do mapa: arquivo: gtopo30 e clique [OK]. A
camada de elevação será visualizada.

9. Clique em : sup: ‘Adicionar camada vetorial GRASS‘, escolha o nome do mapa: arquivo:alaska e
clique: menuselection:OK. O limite da camada vetorial alaska será sobreposto em cima do: arquivo: mapa
GTOPO30. Agora você pode adaptar as propriedades da camada, conforme descrito no capítulo: ref: vec-
tor_properties_dialog, por exemplo, alterar a opacidade, preenchimento e contorno de cor.

10. Também carregar as outras duas camadas vetor :arquivo:‘rivers‘ e :arquivo:‘airports‘ e adaptar as suas
propriedades.

Como você pode ver, é muito simples carregar camadas raster e vetoriais GRASS no QGIS. Consulte as seções
seguintes para editar dados do GRASS e criar um novo :arquivo:‘LOCATION‘. Mais amostras GRASS em:
arquivo: LOCATIONs estão disponíveis no site do GRASS em http://grass.osgeo.org/download/data.php.

Dica: Carregando dados GRASS
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section Iniciando o complemento GRASS.

15.3 Localização e MAPSET GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATION. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics, subregions, or as
workspaces for individual team members (Neteler & Mitasova 2008 Referências Bibliográficas e Web). In order
to analyze vector and raster layers with GRASS modules, you must import them into a GRASS LOCATION (This
is not strictly true - with the GRASS modules r.external and v.external you can create read-only links
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to external GDAL/OGR-supported data sets without importing them. But because this is not the usual way for
beginners to work with GRASS, this functionality will not be described here.).

Figura 15.1: GRASS data in the alaska LOCATION

15.3.1 Criando uma nova Localização GRASS

Como exemplo aqui veja a amostra GRASS :arquivo:‘LOCATION alaska‘, que é projetada em projeção Al-
bers Equal Area, com a unidade pés foi criada para o conjunto de dados da amostra QGIS. Esta amostra
GRASS:arquivo:LOCATION alaska será usada para todos os exemplos e exercícios nos seguintes capítulos rela-
cionados com SIG GRASS. Ela é usada para baixar e instalar o conjunto de dados em seu computador: ref:
label_sampledata).

1. Inicie o QGIS e certifique-se que o complemento GRASS foi carregado.

2. Visualize o :arquivo:‘alaska.shp‘ Shapefile (ver Seção Carregando um Shapefile) da base de dados alaska
QGIS Dados de exemplo.

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Selecione uma pasta existente GRASS base de dados (GISDBASE): arquivo: grassdata ou crie um novo:
arquivo: LOCATION usando um gerenciador de arquivos em seu computador. Então, clique [Próximo].

5. Podemos usar este assistente para criar um novo: arquivo: MAPSET dentro de um já existente: arquivo:
LOCATION ‘(ver seção: ref: sec_add_mapset ) ou para criar um novo: arquivo: Location’. Clique no
botão de rádio | radiobuttonon |: guilabel: ‘Criar nova location ‘(ver figure_grass_location_2).

6. Digite um nome para o: arquivo:‘Location’ - que usamos alasca e clique [Próximo].

7. Defina a projeção, clicando no botão de rádio | radiobuttonon |: guilabel: ‘Projeção’ para habilitar a lista de
projeções.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the projector icon in the lower
right-hand corner of the status bar (see Section Trabalhando com Projeções)).

9. In Filter insert 2964 to select the projection.

10. Clique [Próximo].

11. Para definir a região padrão, temos que digitar no: arquivo: LOCATION limites na direção norte, sul, leste
e oeste. Aqui, basta clicar no botão: guilabel: estabeleça QGIS dimensão atual, para aplicar a extensão da
camada carregada: arquivo: alaska.shp como a extensão da região padrão do GRASS.
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12. Clique [Próximo].

13. We also need to define a MAPSET within our new LOCATION. You can name it whatever you like - we
used demo (When creating a new LOCATION). GRASS automatically creates a special MAPSET called
PERMANENT designed to store the core data for the project, its default spatial extend and coordinate system
definitions (Neteler & Mitasova 2008 Referências Bibliográficas e Web)

14. Confira o resumo para ter certeza que está correto e clique [Fim].

15. O novo: arquivo:LOCATION alaska e dois: arquivo:MAPSETs demo e: arquivo:PERMANENT’ são criados.
O conjunto de trabalho aberto no momento é: arquivo:‘MAPSET demo, como você definiu.

16. Note que algumas das ferramentas na barra de ferramentas GRASS que foram desativadas estão agora
habilitadas.

Figura 15.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

Se isso parecia ser uma série de etapas, não é realmente tão ruim assim e uma maneira muito rápida de criar um:
arquivo: LOCATION ‘. O: arquivo: ‘LOCATION alaska ‘já está pronto para importação de dados (ver seção: ref:
sec_import_loc_data ). Você também pode usar o vetor e dados raster já existentes no GRASS exemplo: arquivo:
‘LOCATION alaska incluído no QGIS alaska conjunto de dados: ref: label_sampledata e avance para a Seção:
ref: label_vectmodel.

15.3.2 Adicionando um novo MAPSET

A user has only write access to a GRASS MAPSET he created. This means that besides access to his own MAPSET,
each user can read maps in other user’s MAPSETs, but he can modify or remove only the maps in his own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (Neteler & Mitasova 2008 Referências Bibliográficas e Web, see Section A ferramenta região
GRASS).

1. Inicie o QGIS e certifique-se que o complemento GRASS foi carregado.

2. Na barra de ferramentas GRASS, clique no ícone | grass_new_mapset |: sup: ‘Novo mapset’ para abrir o:
arquivo: assistente MAPSET.

3. Selecione a pasta GRASS base de dados (GISDBASE): arquivo: grassdata com: arquivo: LOCATION
alaska, onde queremos adicionar mais um: arquivo: MAPSET, chamado teste.

4. Clique [Próximo].
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5. Podemos usar este assistente para criar um novo: arquivo: MAPSET dentro de um já existente: arquivo:
LOCATION ‘ou para criar um completamente novo: arquivo:‘LOCATION’. Clique no botão de rádio |
radiobuttonon |: guilabel: ‘Selecione a localização (ver figure_grass_location_2) e clique [Próximo].

6. Digite o nome: arquivo: texto para o novo:arquivo: MAPSET. Abaixo no assistente, você verá uma lista de
existente: arquivo: MAPSETs e seus proprietários.

7. Clique [Próximo], confira o resumo para se certificar de que está tudo correto e clique [Fim].

15.4 Importando dados para uma localização GRASS

Esta Seção fornece um exemplo de como importar dados vetoriais e raster para o: arquivo: alaska GRASS:
arquivo: LOCATION fornecido pelo conjunto de dados Alaska QGIS. Portanto, usamos uma landcover raster
mapa: arquivo: landcover.img e um GML arquivo vetorial: arquivo: lakes.gml do conjunto de dados QGIS alaska:
ref: label_sampledata.

1. Inicie o QGIS e certifique-se que o complemento GRASS foi carregado.

2. Na barra de ferramentas GRASS, clique no ícone :sup: ‘Abrir MAPSET’ para abrir o:arquivo:assistente
MAPSET.

3. Escolha como base de dados GRASS a pasta: arquivo:grassdata no QGIS conjunto de dados alaska,
como:arquivo:LOCATION alaska, como: arquivo: MAPSET: arquivo: ‘demo’ e clique [OK].

4. Agora, clique no ícone | grass_tools |: sup: ‘Abrir ferramentas GRASS . A caixa de ferramentas GRASS
(ver secção: ref: ‘subsec_grass_toolbox) aparece o diálogo.

5. Para importar o mapa raster: arquivo: landcover.img, clique no módulo: arquivo: r.in.gdal no: guilabel:
Árvore de Módulos guia. Este módulo GRASS permite importar arquivos raster GDAL suportados para o
GRASS: arquivo: LOCATION’. O módulo diálogo para: arquivo‘r.in.gdal aparece.

6. Procure a pasta: arquivo: raster no conjunto de dados QGIS alaska e selecione o arquivo: landcover.img.

7. Como nome de saída raster defina: arquivo:landcover_grass e clique [Rodar]. Em: guilabel:guia ‘Saída’
você vê o comando GRASS atualmente em execução: arquivo:r.in.gdal-o entrada=/path/to/landcover.img
saída=landcover_grass.

8. Quando ele diz Terminou com sucesso clique em [Ver saída]. O: arquivo: landcover_grass camada raster
agora é importado para o GRASS e será visualizada na tela QGIS.

9. Para importar o arquivo vetorial GML: arquivo: lakes.gml, clique no módulo: arquivo: v.in.ogr na guia:
guilabel: Árvore de Módulos. Este módulo GRASS permite importar arquivos vetoriais suportados OGR
para o GRASS: arquivo: LOCATION’. O módulo diálogo para: arquivo: ‘v.in.ogr aparece.

10. Procure a pasta: arquivo: GML no conjunto de dados QGIS alaska e selecione o arquivo:lakes.gml como
arquivo OGR.

11. Como nome de saída vetor defina: arquivo:lakes_grass e clique [Rodar]. Você não precisa se preocupar
com as outras opções neste exemplo. Em guia: guilabel: ‘Saída’ você vê o comando GRASS atualmente
em execução: arquivo:v.in.ogr-o dsn=/path/to/lakes.gml saída=lakes_grass.

12. Quando ele diz Terminado com sucesso clique em [Ver saída]. O: arquivo:lakes _grass camada vetorial é
agora importada para o GRASS e será visualizada na tela QGIS.

15.5 O modelo de dados vetorial do GRASS

É importante compreender o modelo de dados vetor GRASS antes da digitalização.

Em geral, GRASS utiliza um modelo de vetor topológico.
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Isto significa que as áreas não são representadas como polígonos fechados, mas por um ou mais limites. A fronteira
entre duas áreas adjacentes é digitalizada apenas uma vez, e é compartilhada por ambas as áreas. Limites precisam
estar conectados e fechados sem lacunas. Uma área é identificada (e rotulada) pelo ** centróide** da área.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so called ‘layers’ inside one GRASS vector map.
So in GRASS a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully (Although it is possible to mix geometry elements, it is unusual and even in GRASS only used in special
cases such as vector network analysis. Normally you should prefere to store different geometry elements in
different layers.).

É possível armazenar várias “camadas” em um conjunto de dados vetor. Por exemplo, campos, florestas e lagos
podem ser armazenados em um vetor. Floresta adjacente e lago podem compartilhar o mesmo limite, mas eles
têm tabelas de atributos separadas. Também é possível fixar atributos por limites. Por exemplo, a fronteira entre o
lago e floresta é uma estrada, para que possa ter uma tabela de atributos diferentes.

A “camada” de recurso é definida por “camada” dentro do GRASS. “Camada” é o número que define, se houver
mais do que uma camada dentro do conjunto de dados, por exemplo, se a geometria é floresta ou lago. Por
enquanto, ela pode ser apenas um número, no futuro, GRASS também suportará nomes como campos na interface
do usuário.

Attributes can be stored inside the GRASS LOCATION as DBase or SQLITE3 or in external database tables, for
example PostgreSQL, MySQL, Oracle, etc.

Atributos em tabelas de base de dados estão ligados a elementos geométricos usando um valor ‘categoria’.

‘Categoria’ (chave, ID) é um número inteiro ligado a geometrias primitivas, e que é usada como ligação a uma
coluna chave na tabela de base de dados.

Dica: Aprendendo um Modelo Vetor GRASS
A melhor maneira de aprender o modelo Vetor Grass e as suas capacidades é baixar um dos muitos tutoriais
GRASS onde o modelo vetorial é descrito mais profundamente. Veja http://grass.osgeo.org/gdp/manuals.php para
mais informações, livros e tutoriais em várias línguas.

15.6 Criando uma nova camada vetorial GRASS

Para criar uma nova camada vetor GRASS com o complemento GRASS clique no | grass_new_vector_layer |:
sup: Criar novo vetor GRASS ícone da barra de ferramentas. Digite um nome na caixa de texto e você pode
começar a digitalização de geometrias ponto, linha ou polígono, seguindo o procedimento descrito na Seção: ref:
grass_digitizing.

No GRASS, é possível organizar toda sorte de tipos de geometria (ponto, linha e área) em uma camada, porque
o GRASS utiliza um modelo de vetor topológico, assim você não precisa selecionar o tipo de geometria ao criar
um novo vetor GRASS. Isto é diferente de criação Shapefile com QGIS, devido à este usar o modelo vetor de
características simples (ver Seção: ref: sec_create_shape).

Dica: Criando uma tabela de atributos para uma nova camada vetorial GRASS
Se você deseja atribuir atributos a seus recursos de geometria digitalizados, certifique-se de criar uma tabela de
atributos com colunas antes de começar a digitalização (ver figure_grass_digitizing_5).

15.7 Digitalizando e editando uma camada vetorial GRASS

As ferramentas de digitalização para as camadas vetor GRASS são acessadas usando o | grass_edit |: sup:ícone Ed-
itar camada vetorial GRASS na barra de ferramentas. Certifique-se de que você tenha carregado um vetor GRASS
e é a camada selecionada na legenda antes de clicar na ferramenta de edição. Figura figure_grass_digitizing_2
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mostra o diálogo de edição GRASS que é exibido quando você clica na ferramenta de edição. As ferramentas e as
configurações serão discutidas nas seções seguintes.

Dica: Digitalizando polígonos no GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason is, that a topological vector model links attribute information of a polygon always to the centroid and
not to the boundary.

Barra de Ferramentas

Na figure_grass_digitizing_1 você vê os ícones da barra de ferramentas de digitalização Grass fornecido
pelo complemento GRASS. Tabela table_grass_digitizing_1 explica as funcionalidades disponíveis.

Figura 15.3: GRASS Digitizing Toolbar

Ícone Ferramenta Propósito

Novo Ponto Digitaliza novo ponto

Nova Linha Digitaliza nova linha

Nova
Fronteira

Digitaliza novo limite (acaba ao selecionar nova ferramenta)

Novo
Centróide

Digitaliza novo centróide (etiqueta da área existente)

Mova vértice Mova um vértice da linha ou limite existente e identifique nova posição

Adiciona
vértice

Adiciona novo vértice à uma linha existente

Exclua
vértice

Exclua vértice da linha existente (confirme vértice selecionado por outro clique)

Mova
elemento

Mova limite, linha, ponto ou centróide selecionado e clique em nova posição

Dividir linha Dividir uma linha existente em 2 partes

Exclua
elemento

Exclua limite existente, linha, ponto ou centróide (confirme elemento selecionado
por outro clique)

Editar
atributos

Editar atributos do elemento selecionado (note que um elemento pode representar
mais recursos, veja acima)

Fechar Fechar sessão e salvar o estado atual (reconstrói topologia depois)

GRASS Digitalização de Tabela 1: GRASS Ferramentas de Digitalização

Aba Categoria

A: guilabel: guia Categoria permite definir a forma em que os valores da categoria serão atribuídos à um novo
elemento geométrico.

• Modo: qual valor da categoria deve ser aplicado aos novos elementos geométricos.

– Próximo não usado - aplica próximo valor de categoria ainda não usados para elemento geométrico.

– Entrada Manual - defina manualmente o valor de categoria para o elemento geométrico no campo de
entrada ‘Categoria’.

– Sem categoria - Não aplica um valor de categoria ao elemento geométrico. Isto é, por exemplo usado
para os limites da área, pois os valores de categoria são conectados através do centróide.
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Figura 15.4: GRASS Digitizing Category Tab

• Categoria - Um número (ID) está anexo a cada elemento geométrico digitalizado. Ele é usado para conectar
cada elemento geométrico com seus atributos.

• Campo (camada) - Cada elemento geométrico pode ser conectado com várias tabelas de atributos usando
diferentes camadas geométricas GRASS. Número da camada padrão é 1.

Dica: Criando uma ‘camada’ adicional GRASS com QGIS
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab you can create your new table connected to your new layer.

Aba Configurações

A: guilabel: guia Configurações permite que você defina o encaixe em pixels da tela. O limite que define qual
distância para novos pontos de linha ou extremidades são agarrados por nós existentes. Isso ajuda a evitar lacunas
ou oscilações entre fronteiras. O padrão é definido como 10 pixels.

Figura 15.5: GRASS Digitizing Settings Tab

Aba Simbologia

A: guilabel: guia Simbologia permite ver e definir simbologia e definições de cor para vários tipos de geometria e
seu estado topológico (por exemplo limite fechado / aberto).

Aba Tabela

A: guilabel: guia ‘Tabela’ fornece informação sobre a tabela base de dados para uma dada “camada”. Aqui você
pode adicionar novas colunas a uma tabela de atributos existente ou criar uma nova tabela base de dados para uma
nova camada vetorial GRASS (ver Seção: ref: creating_new_grass_vectors).

Dica: GRASS Edita Permissões
You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permissions.
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Figura 15.6: GRASS Digitizing Symbolog Tab

Figura 15.7: GRASS Digitizing Table Tab

15.8 A ferramenta região GRASS

A definição região (janela definindo área de trabalho) no GRASS é importante para trabalhar com camadas raster.
Análise vetorial por padrão não é limitado a quaisquer definições de região definida. Mas todos os rasters recém-
criados terão a extensão espacial e resolução da região GRASS atualmente definidas, independentemente de sua
extensão e resolução originais. A região GRASS atual é armazenada no: arquivo: $ local / $ mapset / WIND
arquivo, e define norte, sul, leste e oeste dos limites, o número de colunas e linhas, a resolução espacial horizontal
e vertical.

É possível ligar/desligar a visualização da região GRASS na tela QGIS usando o : sup: botão‘Mostrar região
GRASS atual‘.

Com o : sup: ícone Edita região atual GRASS você pode abrir um diálogo para mudar a região atual e a
simbologia da região retângulo GRASS na tela QGIS. Digite os novos limites e resolução da região e clique [OK].
Ele também permite selecionar uma nova região interativamente com o mouse na tela QGIS. Portanto, clique com
o botão esquerdo do mouse na tela QGIS, abra um retângulo, feche-o usando o botão esquerdo novamente e clique
[OK].

O módulo GRASS: arquivo:g.region’ fornece muito mais parâmetros para definir ampliação apropriada de uma
região e resolução para sua análise raster. Você pode usar esses parâmetros com a caixa de ferramentas GRASS,
descrito na Seção: ref: ‘subsec_grass_toolbox.
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15.9 A caixa de ferramentas GRASS

A : sup: caixa Abra Ferramentas GRASS fornece GRASS funcionalidades do módulo para trabalhar com
dados dentro de um GRASS selecionado: arquivo: LOCATION’ e: arquivo: ‘MAPSET. Para usar a caixa de
ferramentas GRASS que você precisa para abrir um: arquivo: LOCATION e: arquivo: MAPSET onde você tem
permissão de escrita (geralmente concedido, se você criou o: arquivo: MAPSET). Isto é necessário, porque novos
raster ou camadas vetoriais criados durante a análise precisa ser escrito para o selecionado: arquivo: LOCATION
e: arquivo: MAPSET.

Figura 15.8: GRASS Toolbox and Module Tree

A linha de comando GRASS dentro da caixa de ferramentas GRASS prove o acesso a quase todos os (mais de
330) módulos GRASS através de uma interface de linha de comando. Para oferecer um ambiente de trabalho mais
amigável, cerca de 200 dos módulos GRASS disponíveis e funcionalidades também são fornecidos pelo diálogos
gráficos dentro da caixa de ferramentas do complemento GRASS.

15.9.1 Trabalhando com módulos GRASS

The GRASS Shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 1.8.0 is available in the
GRASS wiki ( http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list).

Também é possível personalizar o conteúdo da Caixa de ferramentas GRASS. Este procedimento é descrito na
Seção: ref: ‘sec_toolbox-customizing’.

Como mostrado na figure_grass_toolbox_1, você pode olhar para o módulo apropriado GRASS usando os temati-
camente agrupados: guilabel: Módulos Árvore ‘ ou o pesquisável: guilabel: ‘Aba Lista de Módulos.

Clicking on a graphical module icon a new tab will be added to the toolbox dialog providing three new sub-tabs
Options, Output and Manual.

Opções

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS Shell and run the module in the command line.

A new feature in QGIS 1.8.0 is the support for a show advanced options button below the simplified module dialog
in the Options tab. At the moment it is only added to the module v.in.ascii as an example use, but will probably
be part of more / all modules in the GRASS toolbox in future versions of QGIS. This allows to use the complete
GRASS module options without the need to switch to the GRASS Shell.
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Figura 15.9: GRASS Toolbox Module Options

Saída

Figura 15.10: GRASS Toolbox Module Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

Figura 15.11: GRASS Toolbox Module Manual

A aba: guilabel: ‘Manual’, mostra a página de ajuda HTML do módulo GRASS. Você pode usá-la para checar
outros parâmetros do módulo e bandeiras ou para obter um conhecimento mais profundo sobre o objetivo do
módulo. No final de cada página do manual do módulo você vê outras ligações para o: arquivo: ‘Índice Principa de
Ajuda’, o: arquivo: ‘Índice Temático’ e o: arquivo: ‘Índice Completo. Estes links fornecem a mesma informação
que se você usar o módulo: arquivo: ‘ g.manual’.
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Dica: Mostra Resultados Imediatamente
Se você quiser exibir os resultados de cálculo imediatamente em sua tela do mapa, você pode usar o botão “Ver
Saída” na parte inferior da aba módulo.

15.9.2 Exemplos de módulos GRASS

Os exemplos seguintes demonstrarão o poder de alguns dos módulos grama.

Criando linhas de contorno

O primeiro exemplo cria um mapa de contorno vetor a partir de um raster de elevação (DEM). Supondo que você
tenha o Alaska: arquivo: LOCATION’configurado como explicado na Seção: ref:‘sec_import_loc_data.

• Primeiro, abra o local clicando no : sup: botão’ Abrir mapset’ e escolha o local Alaska.

• Agora carregue o raster gtopo30 elevação clicando : sup: Adicionar camada raster GRASS’ e sele-
cionando o raster ‘‘gtopo30‘ a partir do local de demonstração.

• Agora, abra a caixa de ferramentas com o : sup: botão ‘Abrir ferramentas GRASS‘.

• Na lista de categorias de ferramentas clique duas vezes: menuselection: Raster -> Gestão de Superfície ->
Gera vetor linhas de contorno.

• Now a single click on the tool r.contour will open the tool dialog as explained above Trabalhando com
módulos GRASS. The gtopo30 raster should appear as the Name of input raster.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Type into the Name for output vector map the name ctour_100.

• Clique [Rodar] para iniciar o processo. Aguarde alguns instantes até que a mensagem Terminado com
sucesso apareça na janela de saída. Então, clique [Ver saída] e [fechar].

Como se trata de uma grande região, vai demorar um pouco para exibir. Depois de terminar a renderização,
você pode abrir a janela de propriedades da camada para alterar a cor da linha para que os contornos apareçam
claramente sobre o raster elevação, como em: ref: vector_properties_dialog.

Zoom Próximo em uma pequena área montanhosa no centro do Alaska. Ao aproximar-se perto você notará que
os contornos tem cantos afiados. GRASS oferece uma ferramenta v.generalize para alterar ligeiramente mapas
vetoriais, mantendo a sua forma geral. A ferramenta usa diversos algoritmos diferentes, com propósitos difer-
entes. Alguns dos algoritmos (por exemplo, Douglas Peuker e redução Vértice) simplificam a linha removendo
alguns dos vértices. O vetor resultante carregará mais rápido. Este processo será usado quando você tem um
vetor altamente detalhado, mas você está criando um mapa de escala muito pequena, de modo que o detalhe é
desnecessário.

Dica: A ferramenta simplificar
Note que o complemento fTools QGIS tem um: menuselection: ‘Simplifique geometrias ->‘ferramenta que fun-
ciona como o GRASS v.generalize algoritmo Douglas-Peuker.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms there is Chaikens which does just that (also Hermite
splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even more
slowly.

• Abra a caixa de ferramentas GRASS e dê um duplo clique nas categorias: menuselection: Vector -> Desen-
volver mapa -> Generalização, em seguida, clique no módulo v.generalize para abrir a janela de opções.

• Check that the ‘ctour_100’ vector appears as the Name of input vector.
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• From the list of algorithms choose Chaiken’s. Leave all other options at their default, and scroll down to the
last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• O processo leva alguns instantes. Uma vez Terminado com sucesso apareça na Janela de saída,
clique [Ver saída] e depois [fechar].

• É possível mudar a cor do vetor para apresentar claramente o fundo matricial e para contrastar com as linhas
de contorno originais. Você notará que as novas linhas de contorno têm cantos mais suaves do que o original,
enquanto permanecer fiel à forma geral de origem.

Figura 15.12: GRASS module v.generalize to smooth a vector map

Dica: Outros usos para r.contour
O procedimento acima descrito pode ser usado em outras situações equivalentes. Se você tem um mapa raster de
dados de precipitação, por exemplo, então o mesmo método será usado para criar um mapa de vetores de linhas
isoietas (chuvas constantes).

Criando um efeito 3D Sombreado

Vários métodos são usados para exibir as camadas de elevação e dar um efeito 3D aos mapas. O uso de linhas de
contorno como mostrado acima é um método popular, muitas vezes escolhido para produzir mapas topográficos.
Outra forma de apresentar um efeito 3D é por sombreamento. O efeito sombreado é criado a partir de uma
(elevação) raster DEM primeiro calculando a inclinação e aspecto de cada célula, em seguida, simulando a posição
do sol no céu e dando um valor de reflectância a cada célula. Assim você tem enfrentando o sol encostas iluminadas
e as encostas de costas para o sol (na sombra) são escurecidas.

• Comece este exemplo por carregar o raster gtopo30 elevação . Inicie a caixa de ferramentas do GRASS e
sob a categoria Raster duplo clique para abrir: menuselection: Análise espacial -> Análise do terreno.

• Então, clique r.shaded.relief para abrir o módulo.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click [Run].

• Quando o processo termina, adicione o raster sombreado ao mapa. Você deve vê-lo exibido em escala de
cinza.

• Para visualizar tanto o sombreamento e as cores do gtopo30 juntos, mude o mapa sombreado abaixo
do mapa gtopo30 na tabela de conteúdos, em seguida, abra o: menuselection: janela de‘Propriedades‘
gtopo30, mude para o: guilabel: guia transparência e defina seu nível de transparência em cerca de 25%.

Agora você deve ter a elevação gtopo30 com o seu mapa de cores e configuração de transparência apresen-
tada acima o tons de cinza mapa sombreado. Para ver os efeitos visuais do sombreamento, desligue o mapa

15.9. A caixa de ferramentas GRASS 139



QGIS User Guide, Versão 1.8

gtopo30_shade em seguida, ligue-o novamente.

Usando a linha de comando GRASS

O complemento GRASS em QGIS é projetado para os novos usuários do GRASS, e não estão familiarizados com
todos os módulos e opções. Como tal, alguns módulos na caixa de ferramentas não mostram todas as opções
disponíveis, e alguns módulos não aparecem em tudo. A linha de comando GRASS (ou console) dá ao usuário
acesso a esses módulos GRASS adicionais que não aparecem na árvore da caixa de ferramentas, e também algumas
opções adicionais aos módulos que estão na caixa de ferramentas com os parâmetros padrão mais simples. Este
exemplo demonstra o uso de uma opção adicional para o módulo r.shaded.relief que foi mostrado acima.

Figura 15.13: The GRASS shell, r.shaded.relief module

O módulo ** r.shaded.relief ** pode ter um parâmetro ‘‘ zmult ‘‘ que multiplica valores de elevação relativos às
unidades de coordenadas XY, de modo que o efeito sombreado é ainda mais pronunciado.

• Carregue o raster elevação gtopo30 como acima, em seguida, inicie a caixa de ferramentas GRASS e
clique na linha de comando GRASS. Na janela, digite o comando r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 e aperte [Enter].

• Após o término do processo vá para: guilabel: guia ‘Buscar’ e dê um duplo clique sobre o novo raster
gtopo30_shade2 para exibir no QGIS.

• As explained above, shift the shaded relief raster below the gtopo30 raster in the Table of Contents, then
check transparency of the colored gtopo30 layer. You should see that the 3D effect stands out more strongly
compared to the first shaded relief map.

Estatísticas Raster em um mapa vetor

O próximo exemplo mostra como um módulo GRASS pode agregar dados raster e adicionar colunas de estatísticas
para cada polígono em um mapa vetor.

• Novamente usando os dados do Alasca, consulte a: ref: sec_import_loc_data para importar o shapefile
árvores do diretório shapefiles no GRASS.

• Now an intermediary step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• Na caixa de ferramentas escolha: menuselection: Vetor -> Gerenciar recursos, e abra o módulo v.centroids.
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Figura 15.14: Displaying shaded relief created with the GRASS module r.shaded.relief

• Enter as the output vector map ‘forest_areas’ and run the module.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed -

in different colors: In the layer Properties window, Symbology tab, choose from Legend type
‘Unique value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology
tab :ref:sec_symbology in the vector section).

• Próximo reabrir a caixa de ferramentas GRASS e abra: menuselection: Vetor -> Atualização de Vetor por
outros mapas.

• Clique no módulo v.rast.stats. Digite gtopo30, e forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [run]. This is a computa-
tionally heavy operation which will run for a long time (probably up to two hours).

• Finalmente abra a tabela de atributos forest_areas, e verifique que várias novas colunas foram adi-
cionadas, incluindo elev_min, elev_max, elev_mean etc para cada polígono florestal.

15.9.3 Trabalhando com o buscador LOCALIZAÇÃO GRASS

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7
you can see the current working LOCATION with its MAPSETs.

Nas janelas esquerda do buscador você pode buscar por todos: arquivo: MAPSETs dentro do atual: arquivo:
‘LOCATION’. A janela direita do navegador mostra algumas meta informações para camadas selecionadas raster
ou vetoriais, por exemplo, resolução, o retângulo envolvente, fonte de dados, tabela de atributos ligados para dados
vetoriais e um histórico de comando.

Figura 15.15: GRASS LOCATION browser
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A barra de ferramentas dentro do: guilabel: guia Busca oferece as seguintes ferramentas para gerenciar o sele-
cionado: arquivo: LOCATION:

• : guilabel:Adicione mapa selecionado à tela

• : guilabel:’Copiar mapa selecionado‘

• :guilabel:’Renomeia mapa selecionado‘

• : guilabel: ‘Exclua mapa selecionado‘

• : guilabel:’Defina região atual de mapa selecionado‘

• : guilabel: Atualizar janela de busca

A guilabel: : Renomeia mapa selecionado e guilabel: : ‘Exclua mapa selecionado‘só trabalha com os
mapas dentro do seu selecionado: arquivo:MAPSET. Todas as outras ferramentas também trabalham com camadas
vetoriais e raster em outro: arquivo: MAPSET.

15.9.4 Personalizando a caixa de ferramentas GRASS

Quase todos os módulos GRASS podem ser adicionados à caixa de ferramentas GRASS. A interface XML está
disponível para analisar os arquivos XML bastante simples, o que configura os módulos de aparência e parâmetros
internos da caixa de ferramentas.

Um exemplo de arquivo XML para gerar o módulo v.buffer (v.buffer.qgm) se parece com isto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the toolbox when you select the module. A more
detailed description for adding new modules, changing the modules group, etc. can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox
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CAPÍTULO 16

OpenStreetMap

Nos últimos anos, o projeto OpenStreetMap (OSM) ganhou popularidade porque, em muitos países, não há dados
geográficos livres, tais como roteiros digitais disponíveis. O objetivo do projeto OSM é criar um mapa livre
editável do mundo a partir de dados GPS, imagem de satélite, fotografia aérea ou de conhecimento local. Para
apoiar este objetivo, o QGIS oferece um plugin que permite que seus usuários trabalhem com dados OSM.

O plugin OpenStreetMap, um plugin nativo do QGIS, oferece as funcionalidades básicas de manipulação de dados
OSM, o que inclui o carregamento de dados, importar, salvar, download, editar e fazer upload de dados de volta
para o servidor OpenStreetMap. Ao implementar o plugin OSM a inspiração foi tirada de editores já existentes de
dados OSM. O objetivo era o de combinar as suas funcionalidades para obter o melhor resultado possível.

A seção a seguir fornece uma breve introdução aos princípios do projeto OSM.

Partes dos parágrafos seguintes são copiadas do site OpenStreetMap em http://www.openstreetmap.org.

16.1 O projeto OpenStreetMap

OpenStreetMap é um projeto para criar um mapa livre editável do mundo. Os mapas são criados usando dados de
dispositivos portáteis de GPS, fotografias aéreas, de outras fontes livres ou simplesmente a partir do conhecimento
local. O projeto foi iniciado porque a maioria dos mapas têm restrições legais ou técnicas para sua utilização,
restringindo as pessoas de usá-los de forma criativa, produtiva ou outras formas alternativas. Ambas as imagens
fundidas e o conjunto de dados vetoriais do OSM estão disponíveis para download sob uma licença Creative
Commons Attribution ShareAlike 2.0.

OpenStreetMap foi inspirado em sites como o Wikipédia - a visualização do mapa (ver Figura_OpenStreetMap_1)
apresenta um proeminente: guilabel: guia Editar e um histórico de revisão completa é mantido. Os usuários
registrados podem enviar registos de trajetos de GPS e editar os dados vetoriais, utilizando as ferramentas de
edição de dados.

Dados primitivos OSM são uma classe de objetos que podem serem armazenados via API no servidor. Os três
tipos de suporte de dados são: Node, Way e Relation.

• Um nó é um par de coordenada de latitude/longitude. É usado como um bloco de construção para as outras
características e como uma característica própria (pontos de interesse), para serem marcados, conforme
necessário.

• Um Caminho é uma lista de pelo menos dois nós que descrevem uma feição linear, tal como uma rua, ou
similar. Os nós podem fazer parte de vários caminhos.

• Uma relação é um grupo de zero ou mais com funções primitivas associadas. Ele é usado para especificar
as relações entre objetos, e também pode modelar um objeto abstrato.

Diversas características lógicas diferentes de um mapa comum “Ponto de interesse”, ‘Estrada’, ‘linha elétrica’,
‘ponto de ônibus’ etc) são definidos por estes primitivos. Características do mapa são bem conhecidos na co-
munidade OSM e são armazenados como etiquetas, com base numa chave e um valor. OSM é normalmente
distribuído em formato XML. Carga XML também é utilizada para a comunicação com o servidor do OSM.
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Figura 16.1: OpenStreetMap data in the web

16.2 QGIS - Conexão OSM

A primeira parte desta seção descreve como dados primitivos OSM são exibidos em camadas vetoriais QGIS.
Como mencionado anteriormente, dados OSM consistem de Nós, Caminhos e Relações. No QGIS, eles são
exibidos em três diferentes tipos de camada: camada de ponto, camada de linha e camada de polígono. Não é
possível remover qualquer uma dessas camadas e trabalhar com as outras.

• Uma Camada de Ponto exibe todas as feições de tipo nó que fica sozinho. Isso significa que apenas nós
que não estão incluídos em qualquer Caminho pertence à camada Ponto.

• Uma Camada de linha exibe as feições OSM de Caminho do tipo que não estão fechados. Isso significa
que, nenhum desses Caminhos inicia e termina com o mesmo Nó.

• Uma Camada de poligono exibe todos os Caminhos que não estão incluídos na camada Linha.

OpenStreetMap tem uns dados mais primitivos além dos três mencionados acima. Isto é chamado ** Relação **.
Não existe propositadamente nenhuma camada vetor para exibir Relaçoes. Uma relação define uma ligação entre
qualquer número de dados primitivos. Depois que um ponto, linha ou polígono é identificado em um mapa, o
complemento mostra uma lista de todas as relações que o recurso identificado faz parte.

Foi um desafio para projetar a conexão entre dados OSM e as ferramentas padrão de edição QGIS. Estas ferramen-
tas são feitas para editar uma única camada vetor por vez, não importa que tipo de feição ele exibe. Isto significa
que se os dados OSM são carregados para QGIS através do complemento, você poderia (teoricamente) editar a
camada de Ponto, camada de Linha ou camada de Polígono com essas ferramentas padrão separadamente.

Uma camada de linha consiste em dois diferentes tipos de recursos OSM, Linha e Nós. Em formato de OSM, uma
Linha é composta de Nós. Se você começar a editar uma única camada linha e mudar a forma de alguma linha,
sua ação afeta não só a Linha OSM, mas também os Nós OSM que fazem parte dela.

Ferramentas de edição padrão QGIS não se comunicam com provedor OSM, que membros de qual linha foi
alterada e como. Ele pode dizer apenas o que é a nova geometria e de qual linha, e isso não é o suficiente
para realizar alterações para o banco de dados OSM corretamente. A camada de linha não saber também os
identificadores dos membros de linha. O mesmo problema ocorre quando você tenta editar a camada de polígono.

Por esta razão, o complemento OSM precisa de suas próprias ferramentas para edição de dados OSM. Enquanto
que são utilizados, as camadas OSM podem ser alteradas corretamente. O Complemento ferramentas de edição
consiste em ferramentas para Ponto, Linha Polígono, e criação de Relações , deletar e mover.
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Nota: Para criar uma conexão entre o complemento OSM e ferramentas de edição padrão, as mudanças no código
fonte QuantumGIS seria necessário.

16.3 Instalação

O complemento OpenStreetMap é um complemento nativo do QGIS. O complemento ‘OpenStreetMap’ pode ser
instalado via Gerenciador de Complementos como descrito na seção: ref: Carregando complementos nativos.

16.4 Interface básica do usuário

The first time the OSM plugin is started (and after the first data are loaded), several new OSM plugin icons appear
in the QGIS toolbar menu together with new dock windows as shown in figure_OpenStreetMap_2.

Figura 16.2: OSM plugin user interface

16.4.1 Ferramenta de feições OSM

A ferramenta de feições OSM ajuda a identificar as feições do OSM. Ela mostra informações básicas sobre o tipo
de recurso e identificador, bem como informações sobre quem mudou um recurso, e quando. A ferramenta de
feições OSM também fornece todas as ferramentas de edição (na parte superior da mesma). Mais informações
sobre essas ferramentas podem ser encontrados nas seções abaixo. A ferramenta é inicialmente desabilitada. E
ativada depois do carregamento bem-sucedido de alguns dados OSM.

16.4.2 Ferramenta Desfazer/Refazer OSM

Este menu OSM desfazer / refazer é usado para desfazer e refazer ações de edição. Ele consiste não só num
clássico menu desfazer e refazer , mas também mostra uma lista com uma breve descrição das ações de edição
que foram feitas. O menu OSM desfazer / refazer é inicialmente fechado. Você pode visualizá-lo através de um
botão no menu feições do OSM.
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16.4.3 Icones do menu barra de ferramenta

OSM Carregar do arquivo é usado para carregar dados de um arquivo XML especial OpenStreetMap.

:sup:’Mostrar / Esconder Gerenciador de Feições OSM‘ é usado para mostrar ou ocultar o menu de botões
das feições OSM. O Menu de feições OSM é um painel que ajuda na identificação de feições OSM e na edição de
dados OSM.

:sup:‘Download de dados OSM’ é usado para baixar dados do servidor do OpenStreetMap.

Upload de dado OSM é usado para upload de alterações (no dado existente).

Importa dado para camada é usado para importar dados para a camada vetorial. Pelo menos uma camada de vetor
deve ser carregada e os dados OSM atuais devem ser selecionados.

Salvar OSM para arquivo é usado para salvar dados OSM de volta para o arquivo XML.

Informações mais detalhadas sobre todos os menus, botões e diálogos podem ser encontradas nas seções apropri-
adas desta seção complemento de acordo com a sua funcionalidade (edição, identificação, etc.).

16.5 Carregando dado OSM

A primeira ação que deve ser feita após iniciar o complemento OSM é abrir dados de um arquivo OSM. Dados
OSM podem ser importados, de arquivo shapefile ou baixado diretamente do servidor OpenStreetMap. Aqui
estamos focando o primeiro método mencionado.

To load data from a file use the Load OSM from file icon. If there is no such button, maybe someone disabled
OpenStreetMap toolbar in your QGIS installation. You can enable it again selecting Settings → Toolbars →
OpenStreetMap.

Figura 16.3: Load OSM data dialog

O propósito desses elementos é explicado a seguir.

OpenStreetMap file to load: Click on the button to select the file:.osm file you want to load data from.

Adicionar colunas para etiquetas: Esta opção determina uma conexão entre OSM e dados do QGIS. Cada feição
de dados OSM tem algumas etiquetas (pares de chaves e valores), que definem as propriedades da feição. Cada
característica de uma camada de vetor QGIS também tem seus atributos (chave e valor). Com esta opção, você
pode definir quais as propriedades dos objetos OSM devem estar visíveis ao exibir informações detalhadas sobre
as feições do QGIS.
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Substitua dados atuais: Ao marcar esta opção significa que novos dados devem substituir os dados atuais que o
usuário está trabalhando. Camadas de dados atuais serão removidas e novas serão carregadas. Ao carregar dados
OSM, pela primeira vez, esta opção não está ativa, porque não há nada para substituir.

Use custom renderer: This option determines how many details of the map will be used. There are three pre-
defined OSM styles for map displaying. Use ‘Small scale’ if you want to view OSM data at low level, to see all
details and to edit something. If not you can use ‘Medium scale’ or ‘Large scale’. QGIS 1.8.0 doesn’t support
changing the renderer style dynamically.

Clique ** [OK] ** para carregar seus dados. Se esta for a primeira vez que o ficheiro de OSM é carregado, o
complemento deve primeiro analisar o banco de dados. Isso pode demorar alguns segundos ou minutos - isso
depende da quantidade de dados carregados.

16.6 Visualização de dados OSM

Depois que os dados são carregados OSM, você pode identificar características do mapa usando a ferramenta

apropriada. Use a :sup: botão Identificar feição no canto superior esquerdo do menu OSM. Usando esta
ferramenta você pode facilmente explorar todos os objetos do mapa. Quando o cursor do mouse é colocado
sobre um objeto, você pode ver todas as informações sobre ele diretamente no menu feições OSM. Há também
um elástico dinâmico apresentado no mapa a fim de que o utilizador seja capaz de determinar qual a feição está
atualmente identificada.

A Propriedades guia do menu contém de todas as etiquetas de feições. Clicando no: guilabel: guia Relação
mostra uma lista de todas as relações relacionadas com identificação.

Se você quer manter uma feição por um tempo para poder ler suas propriedades e relações, mova o cursor do
mouse simultaneamente, tentando clicar com seu botão esquerdo enquanto estiver sobre o recurso. Processo de
identificação irá parar no próximo clique com o botão esquerdo do mouse.

Por vezes, não há mais do que um recurso em um ponto onde um clique com o botão esquerdo do mouse foi
realizado. Isto acontece especialmente quando se clica em encruzilhadas ou se você não der o suficiente zoom no
mapa. Nesta situação, apenas uma dessas feições é identificada (e marcada com o elástico), mas o complemento
se lembra de todos eles. Então (ainda no modo de pausa), você pode percorrer as características identificadas pelo
botão direito do mouse.

16.7 Editando dados OSM básicos

‘Basic data’ in this context means non-relational OSM features - nodes and ways. If you prefer to examine how
to perform relational editing, skip this section and move on to the next one.

Dados básicos de edição é uma parte fundamental do complemento OSM. É possível alterar a propriedade de
posição, ou a forma de qualquer feição da base vigente. Você pode remover funções ou adicionar novas. Todas
as mudanças em nós e formas são lembradas por desfazer / refazer todas as alterações podem ser facilmente
carregados para o servidor OpenStreetMap.

16.7.1 Mudanças nas etiquetas das feições

Mudança na propriedade/etiqueta de uma feição OSM pode ser feito diretamente na tabela de etiquetas da feição.
A tabela etiquetas de feições básicas podem ser encontrados no menu OSM. Não se esqueça de identificar primeiro
a feição.

If you want to change a tag value, just double-click in the appropriate row of column ‘Value’ and type, or select a

new value. If you want to remove a tag, click in the relevant row, then use the button Remove selected tags on the
right bottom under the table.
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Figura 16.4: Changing an OSM feature tag

Para adicionar novas etiquetas basta digitar a chave e valor na última linha da tabela onde está escrito ‘ <próximo
valor de etiqueta >’ . Observe que você não pode alterar a chave de um par de etiquetas existentes. Conveniente-
mente, há algumas caixas de combinação de todas as chaves de etiquetas existentes e seus valores típicos.

16.7.2 Criar ponto

Para a criação do ponto há uma : sup: botão Criar ponto no menu feição OSM. Para criar alguns pontos, basta
clicar no botão e começar a clicar sobre o mapa. Se o cursor estiver sobre alguma feição do mapa, a feição será
marcada / identificada imediatamente. Se você clicar no mapa quando uma linha ou polígono estiver marcada um
novo ponto será criado diretamente na linha ou polígono, bem como seu novo membro. Se o cursor estiver sobre
um ponto existente, um novo ponto não poderá ser criado. Nesse caso, o complemento OSM irá mostrar a seguinte
mensagem:

Figura 16.5: OSM point creation message

O mecanismo de ajudar um usuário a tocar a linha ou polígono é chamado de ajuste e é ativado por padrão. Se
você quiser criar um ponto muito próximo de alguma linha (mas não sobre ela), você deve desabilitar o ajuste
mantendo o: kbd:pressionar primeiro a tecla Ctrl.

16.7.3 Criar linha

Para a criação da linha, há um : sup: botão Criar linha no menu feições OSM. Para criar uma linha basta clicar
no botão esquerdo do mouse para e começar, clicando no mapa. Cada um de seus Cliques esquerdo é registrado
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como um dos vértices da nova linha. A criação da linha termina quando o primeiro clique com o botão direito do
mouse for realizado. A nova linha irá aparecer imediatamente no mapa.

Nota: A Line with less than two members cannot be created. In such case the operation is ignored.

O ajuste é realizado para todos os vértices do mapa - pontos da camada de vetor Ponto e Linha e todos os nós do
Poligono. O ajuste pode ser desativado mantendo o: kbd: botão ‘Ctrl ‘ precionado.

16.7.4 Criar poligono

Para a criação de polígonos há um |osm_createPolygon | :sup: botão Criar polígono no menu feições OSM.
Para criar um polígono basta clicar com o botão esquerdo e começar, clicando no mapa. Cada um de seus Cliques
esquerdo é gravado como um vértice pertencente ao novo polígono. A criação Polígono termina quando o primeiro
clique com o botão direito do mouse é realizado. O novo polígono aparecerá imediatamente no mapa. Polígono
com menos de três vertices não pode ser criado. Em tal caso, a operação é ignorada. O Ajuste de aproximação é
realizado para todos os vértices do mapa - pontos (de camada de vetor Ponto) e todo poligono linhas e vértices.
Ajuste de aproximação pode ser desativado mantendo a: kbd: tecla‘Ctrl‘.

16.7.5 Feição de Mapa em movimento

Se você deseja mover uma feição (não importa o tipo) por favor use o :sup: botão‘Mover feição‘ a partir do
menu feições OSM. Depois, você pode navegar pelo mapa (feições serão identificadas de forma dinâmica quando
você passar por cima delas) e clique sobre a feição que você deseja mover. Se uma feição errada for selecionada
após o seu clique, não mova do lugar. Repita o clique com botão direito do mouse até que a feição correta seja
identificada. Quando a seleção é feita e você mover o cursor, você não poderá mudar sua decisão que foi movida.
Para confirmar a mudança, clique no botão esquerdo do mouse. Para cancelar o movimento, clique em outro botão
do mouse.

Se você estiver movendo uma feição que está ligada a outras feições, essas conexões não serão danificadas. Outras
feições só irá se adaptar a uma nova posição de uma feição movida.

Ajuste de aproximação também é suportado nesta operação, isto significa:

• Ao mover uma entidade independente (que não faz parte de qualquer linha / polígono) ponto, ajuste de
aproximação a todos os segmentos do mapa e vértices é realizado.

• Ao mover um ponto que é membro de algumas linhas / polígonos, o ajuste de aproximação a todos os
segmentos do mapa e vértices é realizado, exceto para os vértices de pontos mestre.

• Ao mover uma linha / polígono, o ajuste de aproximação a todos os vértices mapa é realizado. Note que o
complemento OSM tenta encaixar só para os 3 vértices mais próximos ao cursor de uma linha transferida
/ polígono, caso contrário, a operação seria muito lenta. O Ajuste de aproximação pode ser desativado por
exploração :kbd:‘Ctrl‘durante a operação.

16.7.6 Remover feições do mapa

Se você quiser remover uma feição, você deve primeiro identificá-la. Para remover uma feição identificada, use
o |osm_removeFeat : sup: botão Remover esta feição no menu feição OSM. Ao remover uma linha / polígono,
a linha / polígono propriamente dito é excluído, assim ocorrerá para todos os pontos de seus vértices que não
pertencem a nenhuma outra linha / polígono.

Ao retirar um ponto que é membro de algumas linhas / polígonos, o ponto é eliminado e as geometrias de linhas /
polígonos mestres são alteradas. A geometria nova mestra resultante, possuirá menos vértices do que a antiga.

Se a feição mestre era um polígono com três vértices, a sua nova geometria tem apenas dois vértices. E como não
pode existir polígono com apenas dois vértices, como descrito acima, o tipo de feição é automaticamente alterada
para a Linha.
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Se a feição mestre era uma linha com dois vértices, e sua nova geometria tem apenas um vértice. Como não pode
existir uma linha com apenas um vértice, o tipo de feição será automaticamente alterada para ponto.

16.8 Edição de relações

Graças a existência de relações de OSM podemos juntar feições OSM em grupos e dar-lhes propriedades comuns
- de tal forma que podemos modelar qualquer objeto do mapa possível: fronteiras de uma região (como o grupo
de formas e pontos), rotas de ônibus, etc cada membro de uma relação tem sua função específica. Há um suporte
muito bom para as Relações OSM em nosso complemento. Vamos ver como examinar, criar, atualizar ou remover.

16.8.1 Examinando relações

Se você quiser ver as propriedades de relações, identifique primeiro um de seus membros. Depois que abrir o:
guilabel: guia Relações no menu feição OSM. No topo da página, você pode ver uma lista de todas as relações da
feição identificada como parte. Por favor, escolha o que você quer examinar e olhe para as informações abaixo.
Na primeira tabela chamada ‘Etiqueta relação’ você encontra as propriedades da relação selecionada. Na tabela
chamada ‘membros relação’ você vê uma breve informação sobre os membros de relação. Se você clicar em um
membro, o complemento abrirá um menu elástico sobre ele no mapa.

16.8.2 Criação de relação

Existem 2 caminhos para criar uma relação:

1. Você pode usar o : sup: botão Criar relação no menu feição OSM.

2. Você pode criá-lo a partir do: guilabel:guia ‘Relação‘ do menu feição OSM usando o : sup: botão
Adicionar relação.

Em ambos os casos, uma caixa de diálogo irá aparecer. Para o segundo caso, a feição que está identificada é auto-
maticamente considerada o membro relação em primeiro lugar, de modo que o diálogo é previamente preenchido
um pouco. Ao criar uma relação, por favor, selecione o seu primeiro tipo. Você pode selecionar um dos tipos de
relação predefinidos ou escrever o seu próprio tipo. Depois que preencher as etiquetas relações e escolher seus
membros.

Se você já selecionou um tipo de relação, tente usar o : sup: botão gerar etiquetas. Ele irá gerar etiquetas
típicas para o seu tipo de relação. Então, espera-se que introduza valores para as chaves. A escolha dos membros
relação pode ser feita escrevendo identificadores membros, tipos e funções ou usando o | osm_identify|: sup:
ferramenta Identificar e clicando no mapa.

Finalmente, quando tipos, etiquetas e membros são escolhidos, o diálogo pode ser submetido. Nesse caso, o
complemento cria uma nova relação para você.

16.8.3 Alterando a relação

Se você quiser alterar uma relação existente, identifique-a primeiro (seguindo os passos acima escritos na Seção:

ref: examining_relation). Depois disso, clique no : sup: botão Editar relação. Você vai encontrá-lo no menu
feição OSM. Uma nova caixa de diálogo aparece, quase a mesmo que surge para a ação “relação criar”. O diálogo
é pré-preenchido com informações sobre as relações dadas. Você pode alterar as etiquetas relação, membros ou
até mesmo o seu tipo. Depois de apresentar o diálogo de suas alterações serão cometidos.
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16.9 Baixando dados OSM

To download data from OpenStreetMap server click on the Download OSM data button. If there is no such button,
the OSM toolbar may be disabled in your QGIS instalation. You can enable it again at Settings → Toolbars →
OpenStreetMap . After clicking the button a dialog occurs and provides following functionalities:

Figura 16.6: OSM download dialog

Extensão: Especifique uma área para download de dados a partir de intervalos de latitude e longitude em graus.
Porque há alguma restrição do servidor OpenStreetMap da quantidade de dados que podem ser baixados, os
intervalos não deve ser muito grandes. Informações mais detalhadas sobre a especificação extensão permitida é
mostrado após clicar no | osm_questionMark |: sup: ‘Ajuda ‘ botão à direita.

Baixar para: Aqui você deverá escrever um caminho para o arquivo onde os dados serão armazenados. Se você

não se lembra a estrutura do seu disco, não entre em pânico. O botão de navegação vai te ajudar.

Abrir dados automaticamente após baixar: Determina, se o processo de baixar deve ser seguido para carregar
o processo de dados ou não. Se você prefere não carregar os dados agora, você pode fazê-lo mais tarde usando o

: sup: botão Carregar OSM do arquivo.

Substituir os dados atuas: Esta opção só está ativa se : guilabel: Dados abertos automaticamente após
baixar estiver marcada. Selecionar esta opção significa que os dados baixados devem substituir os dados atuais
que estamos trabalhando agora. Camadas de dados atuais serão removidas e novas serão carregadas. Ao iniciar o
QGIS e baixar dados OSM pela primeira vez, esta opção é inicialmente inativa, porque não há nada para substituir.

Use custom renderer: This option is active only if the Open data automatically after download checkbox
is checked. It determines how many details will be in the map. There are three predefined OSM styles for map
displaying. Use ‘Small scale’ if you want to view OSM data at low level, to see all details and to edit something.
If not you can use ‘Medium scale’ or ‘Large scale’. QGIS 1.8.0 does not support changing the renderer style
dynamically.

Clique o botãa [Baixar] para iniciar o processo de baixar.

Um diálogo do progresso continuamente informará sobre o quanto de dados já foi baixado. Quando ocorrer um
erro durante o processo de baixar, uma caixa de diálogo dirá porquê. Quando a ação for concluída com sucesso,
tanto as caixas de diálogo do progresso e do diálogo de download irão fechar-se.
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16.10 Subindo dados OSM

Note that the upload is always done on current OSM data. Before opening the OSM Upload dialog, please be sure
that you really have the right active layer with OSM data.

To upload current data to the OSM server click on the Upload OSM data button. If there is no such button, OSM
toolbar in your QGIS installation is disabled. You can enable it again in Settings → Toolbars → OpenStreetMap .
After clicking the [Upload] button a new dialog will appear.

Figura 16.7: OSM upload dialog

No topo da caixa de diálogo, você pode verificar, se você esta carregando os dados corretos. Haverá um nome curto
de um banco de dados atual. Na tabela, você encontrará informações sobre quantas mudanças irão ser carregadas.
As estatísticas são apresentadas separadamente para cada tipo de feição.

Na caixa “Comentário sobre as alterações” , você pode escrever uma breve informação sobre o significado de sua
operação de upload. Basta registrar a breve mudança de dados que você fez ou deixar a caixa vazia. Faça login
na ‘conta OSM’ para que o servidor possa autenticar você. Se você não tem uma conta no servidor de OSM, é o
melhor momento para criar uma em http://www.openstreetmap.org. Finalmente usar ** [Upload] ** para começar
uma operação de upload.

16.11 Salvando dados OSM

To save data from a current map extent to an XML file click on the Save OSM to file button. If there is no such
button, the OSM toolbar in your QuantumGIS installation is probably disabled. You can enable it again in Settings
→ Toolbars → OpenStreetMap. After clicking on the button a new dialog appears.
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Figura 16.8: OSM saving dialog

Selecionar as feições que você deseja salvar em arquivo XML e o arquivo em si. Use a ** [OK] ** para iniciar a
operação. O processo irá criar um arquivo XML, em que os dados OSM de sua extensão atual do mapa estão rep-
resentados. A versão OSM do arquivo de saída é de 0.6. Elementos de dados OSM (<node>, <way>, <relation>)
não contêm informações sobre suas changesets e UIDs. Esta informação não é obrigatória, no entanto, ver DTD
para OSM XML versão 0.6. No arquivo de saída OSM elementos não são ordenados.

Note-se que não apenas dados da tela de extensão atual são salvos. No arquivo de saída os polígonos e linhas
inteiras são gravados, mesmo os que apenas tiveram uma pequena parte visível na extensão de tela atual. Para
cada linha / polígono salvos, todos os nós de seus membros também serão salvos.

16.12 Importar dados OSM

To import OSM data from an opened non-OSM vector layer follow this instructions. Choose current OSM data

by clicking on one of their layers. Click on the Import data from a layer button. If there is no such button, someone
has probably disabled the OpenStreetMap toolbar in your QGIS installation. You can enable it again in Settings
→ Toolbars → OpenStreetMap.

Depois de clicar no botão a seguinte mensagem poderá aparecer:

Figura 16.9: OSM import message dialog

In such case there is no vector layer currently loaded. The import must be done from a loaded layer - please load a
vector layer from which you want to import data. After a layer is opened, your second try should give you a better
result (don’t forget to mark the current OSM layer again):

Use o diálogo submeter para iniciar o processo de importação de dados OSM. Rejeite caso você não tem certeza
que deseja importar alguma coisa.
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Figura 16.10: Import data to OSM dialog
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CAPÍTULO 17

SEXTANTE

17.1 Introdução

Este capítulo apresenta o complemento SEXTANTE, o conjunto de ferramentas de análise espacial mais poderoso
do QGIS. SEXTANTE é um ambiente de geoprocessamento que pode ser utilizado para aplicar algorítmos nativos
do QGIS ou desenvolvido por terceiros, de modo a facilitar e aumentar a produtividade das suas tarefas de análise
espacial.

Nas seções seguintes, vamos analisar como usar os elementos gráficos do SEXTANTE e tirar o máximo de proveito
de cada um deles

17.1.1 Elementos básicos da GUI SEXTANTE

There are four basic elements in the SEXTANTE GUI, which are used to run SEXTANTE algorithms for different
purposes. Choosing one tool or another will depend on the kind of analysis that is to be performed and the
particular characteristics of each user and project. All of them (except for the batch processing interface, which is
called from the toolbox, as we will see) can be accessed from the SEXTANTE menu item (you will see more than
four entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter).

• Caixa de ferramentas SEXTANTE (SEXTANTE toolbox). O elemento principal da GUI SEXTANTE, é
usado para executar um único algoritmo ou executar um processo em lote com base no referido algoritmo.

Figura 17.1: SEXTANTE Toolbox

• Modelador gráfico SEXTANTE (SEXTANTE modeler). Vários algoritmos podem ser combinados grafica-
mente usando o modelador para definir um fluxo de trabalho, ou seja, a criação de um único processo que
envolve vários sub-processos

155



QGIS User Guide, Versão 1.8

Figura 17.2: SEXTANTE Models

• Gerenciador SEXTANTE.de histórico (SEXTANTE history and log) Todas as ações realizadas usando qual-
quer um dos elementos acima referidos são armazenados em um ficheiro de histórico que pode ser facil-
mente reproduzido mais tarde utilizando o gestor de histórico

Figura 17.3: SEXTANTE History

• Gerenciador SEXTANTE de interface de processamento em lote (SEXTANTE batch process). Essa inter-
face permite que você execute processos em lote, além de automatizar a execução de um algoritmo único
em vários conjuntos de dados.

Ao longo das próximas seções, vamos analisar cada um desses elementos em detalhes.
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Figura 17.4: SEXTANTE Batch Processing

17.2 Caixa de ferramentas SEXTANTE

17.2.1 Introdução

A Caixa de ferramentas é o principal elemento da GUI SEXTANTE, é o elemento que provavelmente você mais
usará em seus projetos. Ela mostra uma lista com todos os algoritmos disponíveis, agrupados em blocos diferentes,
é o principal ponto de acesso para executá-los em processos unitários ou em lote, ou seja, envolvendo várias
execuções de um mesmo algoritmo em diferentes conjuntos de entradas.

Figura 17.5: SEXTANTE Toolbox

The toolbox contains all the algorithms available, divided into groups. Each group represents a so-called ‘algo-
rithm provider’, which is a set of algorithms coming from the same source, for instance, from a third-party ap-
plication with geoprocessing capabilities. Some of this groups represent algorithms from one of such third-party
applications (like SAGA, GRASS or R), while other contain algorithms directly coded along with SEXTANTE
elements, not relying on any additional software. Currently, these providers all reuse code from already exist-
ing QGIS plugins (more specifically, from the fTools vector library shiped along with QGIS and the contributed
mmqgis plugin that you can install using the Plugin Manager), making them more useful, since they can be exe-
cuted from elements such as the modeler or the batch processing interface, which we will soon describe.

Additionally, two more providers can be found, namely ‘Models’ and ‘Scripts’. This providers include user-
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created algorithms, and allow you to define your own workflows and processing tasks. We will devote a full
section to them a bit later.

Na parte superior da caixa de ferramentas, você pode encontrar uma caixa de texto. Para reduzir o número de
algoritmos mostrados na caixa de ferramentas e tornar sua busca mais fácil, você pode inserir qualquer palavra
ou frase na caixa de texto referente ao algoritimo desejado. Observe que, enquanto você digita, o número de
algoritmos na caixa de ferramentas é reduzido a apenas aqueles que contêm o texto que foi introduzido.

Para executar um algoritmo, basta clicar duas vezes sobre o seu nome na caixa de ferramentas.

17.2.2 Janela de algoritmos

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to the next one is
shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).

Figura 17.6: Parameters Dialog

Esta janela é usada para definir os valores de entrada que o algoritmo precisa para ser executado. Ela mostra uma
tabela onde os valores de entrada e os parâmetros de configuração estão a ser definidos. Obviamente que a janela
tem um teor diferente de acordo com os requisitos do algoritmo a ser executado. No lado esquerdo, o nome do
parâmetro é mostrado. No lado direito o valor do parâmetro pode ser definido.

Apesar do número e tipo de parâmetros dependerem das características do algoritmo, a estrutura é semelhante
para todos eles. Os parâmetros que se encontram na janela podem ser de um dos tipos que se seguem.

• Camada raster, para selecionar em uma lista de todas as camadas (atualmente abertas) no QGIS. O sele-
tor contém também um botão em seu lado direito, para permitir que você selecione arquivos de camadas
atualmente não carregadas no QGIS.

• Camada vetorial, para selecionar em uma lista de todas as camadas carregadas no QGIS. As camadas não
carregadas no QGIS podem ser selecionadas, bem como no caso de camadas raster, porém apenas se o
algoritmo não necessitar da seleção de um campo a partir da tabela de atributos da camada. Neste caso,
apenas as camadas abertas podem ser selecionadas, para recuperar os campos da tabela em uma lista.

Você verá um botão seletor para cada camada vetorial. Se o algoritmo não necessita de várias delas, irá ser
capaz de ativar apenas uma. Se o botão correspondente a um vetor de entrada é alterado, o algoritmo será
executado interativamente em cada uma de suas características. Vamos ver mais sobre este tipo de execução,
no final desta seção.

• A table, to select from a list of all the ones available in QGIS. Non-spatial tables are loaded into QGIS like
vector layers, and in fact they are treated as such by the program. Currently, the list of available tables that
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you will see when executing a SEXTANTE algorithm that needs one of them is restricted to tables coming
from files in DBase (.dbf) or Comma-Separated Values (.csv) formats.

• Opção para escolher em uma lista de seleção de opções possíveis.

• Valor numérico, a ser introduzido na caixa de texto. Você vai encontrar um botão ao seu lado. Clicando sobre
ele, você verá uma caixa que permite a digitação de uma expressão matemática, de modo que você pode
usá-la como uma calculadora à mão. Algumas variáveis úteis relacionadas com dados carregados no QGIS
podem ser adicionado à sua expressão, de modo a permitir selecionar um valor derivado de qualquer uma
destas variáveis, tais como a cellsize (resolução espacial) de uma camada ou a coordenada mais setentrional
de outra.

Figura 17.7: Number Selector

• Faixa de valores, com valores mínimo e máximo a ser introduzido em duas caixas de texto.

• Sequência de texto, a ser introduzido em uma caixa de texto.

• Campo, para escolher a tabela de atributos de uma camada vetorial ou uma tabela selecionando algum
parâmetro.

• A Coordinate Reference System (CRS). You can type the EPSG code directly in the text box, or select it
from the CRS selection dialog that appear when you click on the button on the right-hand size

• A extent, to be entered by four number representing its xmin, xmax, ymin, ymax limits. Clicking on the
button on the right-hand side of the value selector, a pop-up menu will appear, giving you two option: to
select the value from a layer or the current canvas extent, or to define it by dragging directly onto the map
canvas.

Figura 17.8: SEXTANTE Extent

Se selecionar a primeira opção, você verá uma janela como a seguinte.
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Figura 17.9: SEXTANTE Extent List

Se a opção selecionada for a segunda, a janela de parâmetros vai esconder-se, portanto, você pode clicar e
arrastar na tela. Depois de ter definido o retângulo selecionador, a janela vai reaparecer, contendo os valores
na caixa de texto de extensão.

Figura 17.10: Extent Drag

• Lista de elementos (camadas raster, vetoriais ou tabelas), para selecionar a partir da lista dos elementos
disponíveis no QGIS. Para fazer a seleção, clique no pequeno botão no lado esquerdo da linha que corre-
sponde a uma janela como a seguinte.

• Pequena tabela para ser editada pelo usuário. Estas tabelas são usadas para definir os parâmetros de proced-
imentos como pesquisa, convolução, entre outros em tabelas.

Clique no botão à direita para ver a tabela e editar os seus valores.

Dependendo do algoritmo, o número de linhas pode ser modificado ou não, usando os botões ao lado direito
da janela.

You will find a [Help] button in the lower part of the parameters dialog. If a help file is available, it will be
shown, giving you more information about the algorithms and detailed descriptions of what each parameter does.
Unfortunately, most algorithms lack good documentation, but if you feel like contributing to the project, this would
be a good place to start.

Nota sobre projeções

SEXTANTE — and also most of the external applications whose algorithms are available from SEXTANTE —
does not perform any reprojection on input layers and assumes that all of them are already in a common coordinate
system and ready to be analized. Whenever you use more than one layer as input to an algorithm, whether vector
or raster, it is up to you to make sure that they are all in the same coordinate system.
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Figura 17.11: Multiple Selection

Figura 17.12: Fixed Table
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Note that, due to QGIS’s ‘on-the-fly’ reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common coor-
dinate system. That reprojection should be done manually and then use the resulting files as input to SEXTANTE.
Also note that the reprojection process can be performed with SEXTANTE, which incorporates tools to do so.

17.2.3 Objetos de dados gerados por algoritmos do SEXTANTE

Os objetos de dados gerados pelo SEXTANTE podem ser de qualquer um dos tipos seguintes:

• Camada raster

• Camada vetorial

• Tabela de dados

• Arquivo HTML (usado para texto e resultados gráficos)

Todos eles são salvos em arquivos no computador (não existem resultados que sejam guardados na memória),
e a janela de parâmetros irá conter uma caixa de texto correspondente a cada uma dessas saídas, onde você
pode digitar o caminho da pasta de saída para salvá-la. Um caminho da pasta de saída contém as informações
necessárias para salvar o objeto resultante em algum lugar. No caso mais usual, você vai salvá-lo em um arquivo,
mas a arquitetura do SEXTANTE permite qualquer outra forma de armazenámento. Por exemplo, uma camada
do tipo vetorial pode ser armazenada em um banco de dados ou mesmo enviada para um servidor remoto usando
um serviço WFS-T. Embora procedimentos como estes ainda não estão implementados, o SEXTANTE já está
preparado para lidar com eles, e esperamos adicionar suporte a novos tipos de armazenamento de saída em algum
dos próximos recursos.

Para selecionar um caminho de saída, basta clicar no botão ao lado direito da caixa de texto. Isso vai abrir uma
janela para salvar o arquivo, onde você pode selecionar o caminho desejado para o arquivo. As extensões de
arquivos suportados são exibidos no seletor de formato de arquivo da caixa de diálogo, dependendo do tipo de
produto e do algoritmo.

The format of the output is defined by the filename extension. The supported formats depend on the ones supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it if you are directly
typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones,
a default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended
to the filepath and the file format corresponding to that extension will be used to save the layer or table.

If you do not enter any filename, the result will be saved as a temporary file and in the corresponding default file
format, and will be deleted once you exit QGIS (take care with that in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
SEXTANTE menu), and in the General group you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e. myfile.shp) when executing an
algorithm.

Apart from raster layers and tables, SEXTANTE also generates graphics and texts as HTML files. These results
are shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced
by SEXTANTE during the current session, and can be shown at any time by selecting in menu SEXTANTE →
SEXTANTE results viewer.

Algumas aplicações externas podem ter arquivos (sem restrições de extensão particulares) como saída, eles podem
não pertencer a nenhuma das categorias acima. Esses arquivos de saída não serão processados pelo QGIS, pois
na maioria das vezes correspondem a formatos de arquivos ou elementos não suportados pelo QGIS. Este é, por
exemplo, o caso com arquivos LAS usadas para dados LiDAR. Os arquivos são criados, mas você não vai ver nada
de novo na área de trabalho do QGIS.

Para todos os outros tipos de saídas, você vai encontrar uma caixa de seleção que pode ser usada para informar ao
SEXTANTE se você deseja ou não que o arquivo de saída seja inserido no projeto.

O SEXTANTE não suporta saídas opcionais, ou seja sempre que um algoritmo for executado, será produzido algo,
entretanto você pode desmarcar a caixa de seleção correspondente, caso não esteja interessado em determinado
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produto, o que faz salvar os resultados em um arquivo temporário (que será excluído uma vez que você sair do
QGIS)

17.2.4 Configurando o SEXTANTE

Como já foi mencionado, o menu de configuração permite o acesso a uma nova janela onde é possível configurar
como o SEXTANTE funcionará. Os parâmetros de configuração são estruturados em blocos separados que você
pode selecionar no lado esquerdo da janela.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for SEXTANTE layers (that is, layers generated by using algorithms from any of the SEXTANTE
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so SEXTANTE can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas, it
will be rendered with that style.

Rendering stlyes can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles. You will see a dialog like the one shown
next.

Figura 17.13: Rendering Styles

Select the style file (.qml) that you want for each output and press [OK].

Other configuration parameters in the General group are explained below:

• Use filename as layer name. The name of each resulting layer created by SEXTANTE is defined by the
algorithm generating it. In some cases, a fixed name might be used, that meaning that the same name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice, that, if the output is saved to a temporary file, the filename
of this temporary file is usually long and meaningless one intended to avoid collision with other already
existing filenames.

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an
algorithm, only its selected features will be used. If the layer has no selected features, all of them will be
used.

Apart from the General block in the settings dialog, you will also find one for each algorithm provider. They
contain an Activate item that you can use to make algorithms appear or not in the toolbox. Also, some algo-
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rithm providers have their own configuration items, that we will explain later when covering particular algorithm
providers.

17.3 Modelador gráfico do SEXTANTE

17.3.1 Introdução

O modelador gráfico permite a criação de modelos complexos usando uma interface simples e de fácil utilização.
Quando se trabalha com SIGs, a maioria das operações de análise não são isoladas, mas constituem parte de uma
cadeia de operações. Usando o modelador gráfico, uma cadeia de processos pode ser acondicionada em um único
processo, por isso é mais fácil e mais conveniente para a execução de um processo único. Não importa quantos
passos e algoritmos diferentes sejam necessários, o modelo é executado como um algoritmo único, poupando
tempo e esforço, especialmente para modelos maiores, que envolem muitos processos.

The modeler can be opened from the SEXTANTE menu, but also from the toolbox. In the Modeler branch of the
algorithms tree you will find a group named Tools, which contains an entry called Create new model.

O modelador tem uma área de trabalho, onde a estrutura do modelo e o fluxo de trabalho representados são
mostrados.

Figura 17.14: Modeler

A criação de um modelo envolve duas etapas:

1. Definition of necessary inputs*. These inputs will be added to the parameters window, so the user can set
their values when executing the model. The model itself is a SEXTANTE algorithm, so the parameters
window is generated automatically as it happens with all the algorithms included in SEXTANTE.

2. Definition of the workflow. Using the input data of the model, the workflow is defined adding algorithms
and selecting how they use those inputs or the outputs generated by other algorithms already in the model.

17.3.2 Definição das entradas

O primeiro passo para criar um modelo é definir as entradas necessárias. Os elementos seguintes encontram-se na
aba Inputs ao lado esquerdo da janela do modelador:

• Raster layer (Camada raster)

• Vector layer (Camada vetorial)

• String (Campo de texto)
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• Table field (Campo de tabela)

• Table (Tabela)

• Numerical Value (Valor numérico)

• Boolean Value (Valor booleano)

Double-clicking on any of them, a dialog is shown to define its characteristics. Depending on the parameter itself,
the dialog will contain just one basic element (the description, which is what the user will see when executing the
model) or more of them. For instance, when adding a numerical value, as it can be seen in the next figure, apart
from the description of the parameter you have to set a default value and a range of valid values.

Figura 17.15: Model Parameters

Para cada entrada adicionada, um novo elemento é adicionado à tela do modelador.

Figura 17.16: Model Parameters

17.3.3 Definição do fluxo de trabalho

Once the inputs have been defined, it is time to define the algorithms to apply on them. Algorithms can be found
in the Algorithms tab, grouped much in the same way as they are in the toolbox.

To add an algorithm, double-click on its name. An execution dialog will appear, with a content similar to the
one found in the execution panel that SEXTANTE shows when executing the algorithm from the toolbox. the one
shown next correspond to the SAGA ‘Convergence index’ algorithm, the same one we saw in the section dedicated
to the SEXTANTE toolbox.

Como você pode ver, existem algumas diferenças. Em vez do campo de saída usado para definir o arquivo e
extensão da camada de saída, é exibido uma caixa de texto simples. Pois a camada gerada pelo algoritmo é
apenas um resultado temporário que será usada como a entrada de um outro algoritmo e não deve ser mantido
como resultado final. Se o campo for deixado em branco, o SEXTANTE interpretará que o resultado é final, e o
único texto que o usuário fornecerá será a descrição para a saída, que será exibida ao utilizador quando executar o
modelo.

A seleção do valor de cada parâmetro é também um pouco diferente, uma vez que existem diferenças importantes
entre o ambiente do modelador e da caixa de ferramentas. Vamos ver como introduzir os valores para cada tipo de
parâmetro.
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Figura 17.17: Model Parameters

Figura 17.18: Model Parameters
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• Camadas (raster e vetoriais) e tabelas. São selecionadas a partir de uma lista, mas neste caso, os valores
possíveis não são as camadas ou tabelas carregadas atualmente no projeto do QGIS, mas a lista de entradas
do modelo, ou outras camadas ou tabelas geradas por algoritmos já adicionado ao modelo.

• Valores numéricos. Valores numéricos podem ser introduzidos diretamente na caixa de texto. Mas esta
caixa de texto também é constituida por uma lista, que pode ser utilizado para selecionar qualquer uma das
entradas de valores numéricos do modelo. Neste caso, o parâmetro terá o valor introduzido pelo utilizador
durante a execução do modelo.

• Campo de texto. Como no caso de valores numéricos, textos podem ser digitados diretamente nos campos
de textos, além de ser possível selecionar uma sequência de entradas.

• Table field. The fields of the parent table or layer cannot be known at design-time, since they depend of the
selection of the user each time the model is executed. To set the value for this parameter, type the name of
a field directly in the textbox, or use the list to select a table field input already added to the model. The
validity of the selected field will be checked by SEXTANTE at run-time.

Once all the parameter have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, which provide
objects that are used as inputs for that algorithm.

Figura 17.19: Model Parameters

Os elementos podem ser arrastados para uma posição diferente dentro da tela do modelador, para mudar a forma
como a estrutura do módulo é apresentado e torná-la mais clara e intuitiva. As ligações entre os elementos são
atualizadas automaticamente.

You can run your algorithm anytime clicking on the [Run] button. However, in order to use it from the toolbox, it
has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

17.3.4 Salvando e carregando modelos

Use the [Save] button to save the current model and the [Open] one to open any model previously saved. Model
are saved with the .model extension. If the model has been previously saved from the modeler window, you will
not be prompted for a filename, since there is already a file associated with that model, and it will be used.

Antes de salvar um modelo, é necessário digitar um nome e um grupo para ele, usando as caixas de texto na parte
superior da janela.

Models saved on the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, SEXTANTE searches the
models folder for files with .model extension and loads the models they contain. Since a model is itself a
SEXTANTE algorithm, it can be added to the toolbox just like any other algorithm.
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The models folder can be set from the SEXTANTE configuration dialog, under the Modeler group.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just as you add any other algorithm.

Em alguns casos, o SEXTANTE pode não ser capaz de carregar um modelo, isto ocorre caso ele não possa
encontrar todos os algoritmos incluídos em seu fluxo de trabalho. Se você já usou um algoritmo como parte do
modelo, ele deve estar disponível (isto é, ele deve aparecer na caixa de ferramentas), possibilitando carregar esse
modelo. Desativar um provedor de algoritmos na janela de configurações SEXTANTE torna todos os algoritmos
deste provedor inutilizáveis pelo modelador, o que pode causar problemas ao carregamento de modelos. Por isso,
Tenha isso em mente quando você tiver problemas para carregar ou executar modelos.

17.3.5 Editando um modelo

É possível editar um modelo já existente, redefinindo o fluxo seu de trabalho e as relações entre os algoritmos e
os elementos que constituem o modelo.

Se você clicar em um algoritmo na tela que apresenta o modelo, você verá um menu de contexto, como mostrada
a seguir:

Figura 17.20: Modeler Right Click

Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only
if there are no other algorithms dependind on it. That is, if no output from the algorithm is used in a different one
as input. If you try to remove an algorithm that has others depending on it, SEXTANTE will show you a warning
message like the one you can see below:

Figura 17.21: Cannot Delete ALG

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

17.3.6 Ativando e desativando algoritmos

Algoritmos podem ser desativados no modelador, para que eles não sejam executados durante a execução do
modelo. Isso pode ser útil para testar apenas uma determinada parte do modelo, ou quando você não precisa de
todas as saídas que são geradas.
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To deactivate an algorithm, right-click on its icon in the model canvas and select the Deactivate option. You will
see that the algorithm is represented now with a red label under its name indicating that is not active.

Figura 17.22: Deactivate

Todos os algoritmos dependentes (diretamente ou indiretamente) do algoritmo desativado, também aparecem
como inativo, já que não podem ser executados.

To activate an algorithm, just right–click on its icon and select the Activate option.

17.3.7 Editando arquivos de ajuda dos modelos e meta-informações

You can document your models from SEXTANTE. Just click on the [Edit model help] button and a dialog like
the one shown next will appear.

Figura 17.23: Help Edition

No lado direito, você verá uma página HTML simples, estruturada usando a descrição dos parâmetros de entrada e
saídas do algoritmo, juntamente com alguns itens adicionais, como uma descrição geral do modelo ou o seu autor.
A primeira vez que você abrir o editor de ajuda todas essas descrições são vazias, mas você pode editá-las usando
os elementos do lado esquerdo da janela. Basta selecionar um elemento da parte superior e escrever sua descrição
na caixa de texto abaixo.

A Ajuda do modelo é salva em um arquivo na mesma pasta do arquivo do próprio modelo. Você não tem que se
preocupar em salvá-lo, uma vez que o salvamento é feito automaticamente.
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17.3.8 Sobre os algoritmos disponíveis

Você pode notar que alguns algoritmos que podem ser executados a partir da caixa de ferramentas não aparecem
na lista dos algoritmos disponíveis quando está projetando um modelo. Para ser incluído em um modelo, um
algoritmo deve ter uma semântica correta, de modo a ser adequadamente ligado a outro, no fluxo de trabalho. Se
um algoritmo não tem tal semântica bem definida (por exemplo, se o número de camadas de saída não se pode ser
definido antecipadamente), então não é possível utilizá-lo dentro de um modelo e, assim, não aparecem na lista
que você pode encontrar na janela do modelador.

Additionaly, you will see some algorithms in the modeler that are not found in the toolbox. This algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tools is really useful within a model, but
outside of that context, it doesn’t make too much sense.

17.3.9 modelos SEXTANTE de código Python

This feature is temporarily unavailable

Junto com a guia que contém o projeto gráfico do modelo, você vai encontrar uma outra contendo um script Python
que executa a mesma tarefa que o próprio modelo. Usando esse código, você pode criar um script (vamos explicar
mais tarde neste mesmo manual) e modificá-lo para incorporar ações e métodos não disponíveis no modelador
gráfico, como repetidores ou frases recorrentes.

Esse recurso também é uma forma muito prática de aprender a usar o SEXTANTE do console de scripts e apren-
der a como criar algoritmos para o SEXTANTE usando código Python, para que você possa usá-lo como uma
ferramenta de aprendizagem, quando começar a criar seus próprios scripts SEXTANTE.

Você vai encontrar um botão abaixo do campo de texto que contém o código Python. Clique sobre ele para criar
um novo caminho para esse código, sem ter que copiar e colá-lo no editor de script SEXTANTE.

17.4 Interface SEXTANTE de processamento em lote

17.4.1 Introdução

Os algoritmos SEXTANTE (incluindo modelos) podem ser executado como um processo descontínuo. Isto é, eles
podem ser executados usando mais de um conjunto de entradas, ou seja, podem executar algoritmos tantas vezes
quanto necessário. Isso é útil ao processamento de grandes quantidades de dados, uma vez que não é necessário
iniciar o algoritmo muitas vezes a partir da caixa de ferramentas.

To execute an algorithm as a batch process, right-click on its name in the toolbox and select the Execute as batch
process option in the pop-up menu that will appear.

Figura 17.24: Batch Processing Right Click

17.4.2 Tabela de parâmetros

A execução de um processo em lote é semelhante ao realizado em processos de execução única de um algoritmo.
Os valores dos parâmetros têm que ser definidos, mas, neste caso, é necessário mais de um valor para cada
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parâmetro, um para cada vez que o algoritmo tem de ser executado. Os valores são introduzidos usando uma
tabela como a mostrada a seguir.

Figura 17.25: Batch Processing

Cada linha desta tabela representa uma execução do algoritmo, e cada célula contém o valor de um dos parâmetros.
É semelhante à janela de parâmetros vista quando executamos um algoritmo da caixa de ferramentas, mas com
um arranjo diferente.

Por padrão, a tabela contém apenas duas linhas. Você pode adicionar ou remover linhas usando os botões na parte
inferior da janela.

Once the size of the table has been set, it has to be filled with the desired values.

17.4.3 Preenchendo a tabela de parâmetros

Para a maioria dos parâmetros, definir seu valor é fácil. Basta digitar o valor ou selecione-o na lista de opções
disponível, dependendo do tipo de parâmetro.

As principais diferenças são encontradas para os parâmetros que representam as camadas ou tabelas, e para saídas.
Quanto às camadas de entrada e tabelas, quando um algoritmo é executado como parte de um processo em lote
esses elementos de dados de entrada são levados diretamente dos arquivos, e não a partir do conjunto de camadas
e tabelas já inseridos no projeto atual do QGIS. Por esta razão, qualquer algoritmo pode ser executado como um
processo em lote, mesmo que não existam elementos de dados abertos e o algoritmo não possa ser executado a
partir da caixa de ferramentas.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button on
the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If the
input parameter represents a single data object and several files are selected, each one of them will be put in a
separate row, adding new ones if needed. If it represents a multiple input, all the selected files will be added to a
single cell, separated by semicolons (;).

Objetos de dados de saída são sempre salvos em arquivos e, ao contrário, da execução de um algoritmo da caixa
de ferramentas, não é permitida sua execução para economizar tempo. Você pode digitar o nome diretamente ou
usar a janela de seleção de arquivos que aparece ao clicar no botão que o acompanha.

Depois de selecionar o arquivo, uma nova janela é mostrada para permitir o autocompletar de outras células na
mesma coluna (com o mesmo parâmetro).

If the default value (‘Do not autocomplete’) is selected, SEXTANTE will just put the selected filename in the
selected cell from the parameters table. If any of the other options is selected, all the cells below the selected one
will be automatically filled based on a defined criteria. This way, it is much easier to fill the table, and the batch
process can be defined with less effort.
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Figura 17.26: Batch Processing Save

O preenchimento automático pode ser feito simplesmente adicionando números correlativos ao conjunto de ar-
quivos selecionado, ou acrescentando o valor de outro campo na mesma linha. Isto é particularmente útil para
nomear os dados de saída de acordo com os elementos de entrada.

Figura 17.27: Batch Processing File Path

17.4.4 Execução do processo em lote

To execute the batch process once you have introduced all the necessary values, just click on [OK]. SEXTANTE
will show the progress of the global batch process in the progress bar in the lower part of the dialog.

17.5 Using SEXTANTE from the console

17.5.1 Introdução

O console permite que usuários avançados possam aumentar sua produtividade e realizar operações complexas,
que não podem ser realizadas usando qualquer um dos outros elementos do GUI SEXTANTE. Modelos que en-
volvem vários algoritmos podem ser definidos usando a interface de linha de comando e operações adicionais, tais
como loops e frases condicionais podem ser adicionados para criar fluxos de trabalho mais flexíveis e poderosos.

Não existe nenhum console SEXTANTE no QGIS, mas todos os comandos SEXTANTE estão disponíveis e
embutido no console Python em vez de estarem no QGIS. Isso significa que é possivel incorporar os comandos
de trabalho em consoles e conectar algoritmos SEXTANTE para todos os outros recursos disponíveis (incluindo
métodos da API do QGIS).

The code that you can execute from the Python console, even if it does call any SEXTANTE method, can be
converted into a new SEXTANTE algorithm that you can later call from the toolbox, the graphical modeler or any
other SEXTANTE component, just like you do with any other SEXTANTE algorithm. In fact, some algorithms
that you can find in the toolbox, like all the ones in the mmqgis group, are simple scripts.

Neste capítulo, vamos ver como usar o console SEXTANTE Python do QGIS, além de como escrever seus próprios
algoritmos usando Python.
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17.5.2 Iniciando o console SEXTANTE Python

A primeira coisa que você tem a fazer é importar as funções SEXTANTE com a seguinte linha:

>>> import sextante

Agora, há, basicamente, apenas uma coisa (interessante) que você pode fazer com o console SEXTANTE: a
execução de um algoritmo. Isso é feito usando o método runalg(), que tem o nome do algoritmo a ser executado
como seu primeiro parâmetro e, em seguida, um número variável de parâmetros adicionais, dependendo dos
requisitos do algoritmo. Então a primeira coisa que você precisa para executar é saber o nome do algoritmo. Esse
não é o nome que você vê na caixa de ferramentas, mas sim o nome de linha de comando único. Para encontrar o
nome certo para o seu algoritmo, você pode usar o método algslist(), Digite a seguinte linha no console:

>>> sextante.alglist()

Você verá algo como isso.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Essa é uma lista de todos os algoritmos disponíveis, ordenados por ordem alfabética, juntamente com seus corre-
spondentes nomes de linha de comando.

É possível usar um campo de texto como parâmetro para este método. Em vez de retornar a lista completa de
algoritmo, ele só irá exibir aqueles que incluem esse campo. Se, por exemplo, você está procurando um algoritmo
para calcular inclinação de um MDE, digite alglist("slope") para obter o seguinte resultado:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Este resultado pode mudar dependendo dos algoritmos que estão disponíveis.

It is easier now to find the algorithm you are looking for and its command-line name, in this case
saga:slopeaspectcurvature.

Uma vez que é conhecido o nome da linha de comando do algoritmo, a próxima coisa a ser feita é saber
a sintaxe correta para executá-lo. Isso significa saber quais os parâmetros que são necessários e na or-
dem em que eles têm que ser passados, ao chamar o método runalg()‘. o SEXTANTE tem um
método para descrever um algoritmo em detalhes, o qual pode ser usado para
obter uma lista de parâmetros, que necessitam de um algoritmos e as saídas
que irá gerar. Para fazer isso, você pode usar o método ‘‘alghelp(nome do
algoritmo). Use o nome de linha de comando do algoritmo, e não o nome descritivo completo.

Se for chamado o método saga:slopeaspectcurvature como parâmetro, você terá a seguinte descrição.
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>>> sextante.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Now you have everything you need to run any algorithm. As we have already mentioned, there is only one single
command to execute algorithms: runalg(). Its syntax is as follows:

>>> sextante.runalg{name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

Dependendo do tipo de parâmetro, os valores são introduzidos de forma diferente. O próximo passo é uma revisão
rápida de como introduzir os valores para cada tipo de parâmetro de entrada

• Para usar camadas raster, vetoriais ou tabelas. Basta usar um campo de texto com o nome que identifica
o objeto de dados (o nome que tem na lista de camadas do projeto em execução QGIS) ou o nome do
arquivo (se a camada correspondente não estiver aberta no QGIS, ela será aberta, mas não adicionada à tela
do mapa). Se você tiver uma instância de um objeto que representa a camada QGIS, você também pode
passá-lo como parâmetro. Se a entrada for opcional e você não desejar usar qualquer objeto de dados, use
None.

• Seleção. Se um algoritmo tem um parâmetro de seleção, o valor do parâmetro que deve ser introduzido deve
usar um valor inteiro. Para saber as opções disponíveis, você pode usar o comando algoptions, como
mostrado no exemplo a seguir:

>>> sextante.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

Neste caso, o algoritmo tem um dos referidos parâmetros, com 7 opções. Observe que a ordenação é iniciada
em zero.

• Entradas múltiplas. O valor é um conjunto de caracteres com descritores de entrada separados por ponto
e vírgula. Tal como no caso de camadas únicas ou tabelas, cada descritor de entrada pode ter o nome do
elemento de dados, ou o caminho do seu arquivo.

• Campos de tabelas para XXX. Utilize um conjunto de caracteres com o nome do campo a ser usado. Este
parâmetro é sensível a maiúsculas.

• Fixed Table. Type the list of all table values separated by commas and enclosed between quotes. Values
start on the upper row and go from left to right. You can also use a 2D array of value representing the table.

• CRS. Enter the EPSG code number of the desired CRS.

• Extent. You must use a string with xmin, xmax, ymin and ymax values separated by commas.

Parâmetros Booleanos, campo de caracteres de arquivos e numérico não precisam de explicações adicionais.

Parâmetros de entrada, tais como o grupo de valores booleanos, os valores numéricos apresentam valores por
padrão. Para usá-los, use o método None na entrada do parâmetro correspondente.
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Para objetos de saída de dados, digite o caminho de arquivo a ser utilizado para salvá-lo, da mesma forma que é
feito a partir da caixa de ferramentas. Se você quiser salvar o resultado em um arquivo temporário, use None. A
extensão do arquivo determina o formato do arquivo. Se você digitar uma extensão de arquivo não incluída entre
as que são suportados pelo algoritmo, será utilizado o formato de arquivo padrão para esse tipo de saída, bem
como à sua extensão correspondente anexado ao conjunto de arquivos de dados.

Ao contrário de quando um algoritmo é executado a partir da caixa de ferramentas, as saídas não são adicionadas
à tela do mapa, se você executar esse mesmo algoritmo no console Python. Se você desejar adicionar uma saída
para à tela, você tem que fazê-lo manualmente após a execução do algoritmo. Para fazer isso, você pode usar os
comandos da API QGIS, ou use um dos métodos úteis fornecidas pelo SEXTANTE para tal tarefa.

The runalg() method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the filepaths of those outputs as values. To add all the outputs generated by an algorithm, pass that
dictionary to the loadFromAlg() method. You can also load an individual layer passing its filepath to the
load() method.

17.5.3 Criando scripts e executando-os na caixa de ferramentas

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed by SEXTANTE. You can find a Create new script under the tools group in
the script algorithms block of the toolbox. Double click on it to open the script edition dialog. That’s where you
should type your code. Saving the script from there in the scripts folder (the default one when you open the
save file dialog), with .py extension, will automatically create the corresponding algorithm.

O nome do algoritmo (que você vai ver na caixa de ferramentas) é criado a partir do nome do arquivo, removendo
a sua extensão e substituindo os underlines por espaços em branco.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output
ret_slope = sextante.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = sextante.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
sextante.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Como você pode ver, envolve três algoritmos, todos eles provenientes do provedor SAGA. O último deles calcula
o TWI, mas precisa de uma camada de encostas e uma camada de acumulação de fluxo. Nós não temos estes, mas
já que temos o MDE, podemos calculá-los por meio dos algoritmos SAGA correspondentes.

A parte do código onde esse processamento ocorre não é difícil de entender se você leu as seções anteriores
deste capítulo. As primeiras linhas, no entanto, precisam de alguma explicação adicional. Elas fornecem ao
SEXTANTE as informações que precisa para transformar seu código em um algoritmo que pode ser executado a
partir de qualquer um de seus componentes, como a caixa de ferramentas ou o modelador gráfico.

These lines start with a double Python comment symbol and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that SEXTANTE supports in its scripts, their syntax and some examples.

• raster. Camada raster

• vector. Camada Vetorial

• table. Tabela

• number. Um valor numérico. Um valor padrão deve ser fornecido. Por exemplo, depth=number 2.4

• string. Um campo de texto. Tal como no caso de valores numéricos, um valor por padrão deve ser
adicionado. Por exemplo, name=string Victor
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• boolean. Um valor booleano. Adicione True ou False depois de definir o valor padrão. Por exemplo,
verbose=boolean True

• multiple raster. Conjunto de camadas raster de entrada.

• multiple vector. Conjunto de camadas vetoriais.

• field. Um campo na tabela de atributos de uma camada vetorial. O nome da camada tem que ser
adicionada depois do parâmetro campo. Por exemplo, se você tem declarado um vetor de entrada com
mylayer=vector, você poderia usar myfield=field mylayer para adicionar um campo á ca-
mada, como parâmetro.

• folder. Pasta

• file. Nome do arquivo

O nome do parâmetro é o nome que será mostrado para o usuário quando o algoritmo for executado, é também o
nome da variável para usar no código do script. O valor digitado pelo usuário para esse parâmetro será atribuído
a uma variável com esse nome.

When showing the name of the parameter to the user, SEXTANTE will edit it to improve its appearance, replacing
low hyphens with blankspaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Camadas e valores de tabelas são seqüências contendo o conjunto de arquivos do objeto correspondente. Para
transformá-los em um objeto QGIS, você pode usar a função sextante.getObjectFromUri(). Várias en-
tradas também têm um valor de seqüência, que contém os caminhos de arquivos de todos os objetos selecionados,
separados por ponto e vírgula.

As saídas são definidas de uma maneira semelhante, utilizando-se as seguintes tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the use has not entered any output filename.

Quando for declarado uma saída, o SEXTANTE vai tentar adicioná-la ao QGIS uma vez que o algoritmo for
concluído. Essa é a razão por que, embora o método runalg() não carrega as camadas que produz, a camada
TWI final será carregada, uma vez que for salvo o arquivo digitado pelo usuário, que é o valor correspondente ao
campo de saída.

Não use a o método load() em algoritmos, mas apenas quando se trabalha com a linha de console. Se a camada
é criada como saída de um algoritmo, que deve ser declarado como tal. Caso contrário, você não será capaz de usar
adequadamente o algoritmo no modelador, pois corre o risco de sua sintaxe (como definido pelas tags, explicado
acima) não coincidir com o que o algoritmo realmente produz.

Saídas ocultas (números e textos) não têm um valor. Em vez disso, é o usuário quem tem que atribuir um valor a
eles. Para isso, basta definir o valor de uma variável com um nome para declarar a saída. Por exemplo, se você
usou esta declaração,

##average=output number

a seguinte linha irá definir o valor da saída para 5:

average = 5
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Além das tags para os parâmetros e as saídas, você também pode definir o grupo em que o algoritmo será mostrado,
usando a tag group.

Se o algoritmo leva um longo tempo para processar, é uma boa idéia informar ao usuário. Você tem um progresso
global chamado progress, com dois métodos disponíveis: setText(text) e ‘‘setPercentage(percent)‘ para
modificar o texto de progresso e a barra de progresso.

Several examples are provided with SEXTANTE. Please, check them to see real examples of how to create algo-
rithms using this feature of SEXTANTE. You can right-click on any script algorithm and select Edit script to edit
its code or just to see it.

17.5.4 Documentando seus scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.6 Gerenciador de histórico SEXTANTE

17.6.1 Histórico SEXTANTE

Toda vez que for executado algum algoritmo no SEXTANTE, as informações sobre o processo são armazenadas
no gerenciador de histórico SEXTANTE. Junto com os parâmetros utilizados, também são salvos a data e hora da
execução.

Desta forma, facilmente podemos acompanhar e controlar todo o trabalho que foi desenvolvido usando o SEX-
TANTE, além de facilitar a reprodução de processos.

O gerenciador de histórico SEXTANTE consiste em um conjunto de entradas de registro agrupadas de acordo
com sua data de execução, tornando mais fácil encontrar informações sobre um algoritmo executado a qualquer
momento.

Figura 17.28: History
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Informações sobre o processo são mantidas como uma expressão de linha de comando, mesmo se o algoritmo
tiver sido iniciado a partir da caixa de ferramentas. Isso o torna útil também para aqueles que sabem como usar a
interface de linha de comando, já que podem chamar um algoritmo usando a caixa de ferramentas e, em seguida,
verificar o gerenciador de histórico para ver como é que o mesmo algoritmo pode ser chamado a partir da linha de
comando.

Além de exibir as entradas no registro, os processos podem ser re-executado, simplesmente clicando duas vezes
sobre a entrada correspondente.

Along with algorithm executions, SEXTANTE communicates with the user using the other groups of the registry,
namely Errors, Warnings and Information. In case something is not working properly, having a look at the Errors
might help you to see what is happening. If you get in contact with a SEXTANTE developer to report a bug or
error, the information in that group will be very useful for him to find out what is going wrong.

When executing third party algorithms, this is usually done calling their command-line interfaces, which com-
municate with the user using the console. Although that console is not shown, a full dump of it is stored in the
Information group each time you run one of those algorithms. If, for instance, you are having problems executing
a SAGA algorithm, look for an entry name ‘SAGA execution console output’ to check all the messages generated
by SAGA and try to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to Warning in case they detect potential problems from that data, in order to warn you about them.
Make sure you check those messages in case you are having unexpected results.

17.7 Configurando aplicativos externos

17.7.1 Introdução

O SEXTANTE pode ser extendido usando aplicativos adicionais, chamando-os de dentro do SEXTANTE. Atual-
mente, GRASS, SAGA, OTB (Orfeo Toolbox) e R são suportados, juntamente com alguns outros aplicativos que
fornecem funcionalidades de análise de dados espaciais. Algoritmos que dependem de uma aplicação externa são
geridos por seu próprio provedor de algoritmos.

Este capítulo irá mostrar-lhe como configurar o SEXTANTE para incluir esses aplicativos adicionais, e expli-
caremos ainda algumas características particulares dos seus algoritmos. Depois de ter configurado corretamente
os aplicativos, você será capaz de executar algoritmos externos de qualquer componente SEXTANTE por meio
da caixa de ferramentas ou do modelador gráfico, assim como se faz com qualquer outro geoalgoritmo do SEX-
TANTE.

Por padrão, todos os algoritmos que dependem de um aplicativo externo, ou seja, que não são disponibilizado com
o QGIS não estão habilitados no programa. Você pode habilitá-los na janela de configurações do SEXTANTE.
Antes de ativá-los, certifique-se de que o aplicativo correspondente já está instalado em seu sistema. A habilitação
de um provedor de algoritmos sem ter o programa correspondente instalado no sistema permitirá que os algoritmos
apareçam na caixa de ferramentas, mas um erro será exibido quando você tenta executá-los.

Isto porque os procedimentos característicos dos algoritmos (necessário para criar a janela de diálogo de parâmet-
ros e dar ao SEXTANTE as informações necessárias sobre o algoritmo) estão incluídos em cada aplicativo do
SEXTANTE. Isto é, eles fazem parte do SEXTANTE, então você os têm em sua instalação SEXTANTE, mesmo
que você não tenha instalado outro software qualquer. Entretanto, a execução do algoritmo, precisa dos códigos
binários do software externo para ser instalado em seu sistema.

Notas sobre os formatos de arquivos

Ao usar um software externo, abrindo um ficheiro no QGIS não significa que ele se comportará assim como no
outro software. Na maioria dos casos, ele pode ler o que você abriu no QGIS, mas em alguns outros, isso pode
dar incompatibilidade de tipo de arquivo. Ao usar bancos de dados ou formatos de arquivos incomuns, seja para
camadas raster ou vetoriais, alguns problemas podem surgir. Se isso acontecer, tente usar formatos de arquivos
conhecidos, que você tem certeza de que são aceitos por ambos os programas, e verifique a saída do console (na
na janela de histórico de registros) para saber mais sobre o que está acontecendo de errado.
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Using GRASS raster layers is, for instance, one case in which you might have trouble and not be able to complete
your work if you call an external algorithm using such a layer as input. For this reason, these layers will not
appear as available to SEXTANTE algorithms (we are currently working on solving this, and expect to have it
ready soon).

Você deve, no entanto, não encontrar problemas sobretudo com camadas vetoriais, pois o SEXTANTE converte
automaticamente do formato de arquivo original para um aceito pelo aplicativo externo antes de passar a camada
para ele. Isso adiciona um tempo de processamento extra, que pode ser significativo se a camada tem um tamanho
grande, por isso não se surpreenda se for preciso mais tempo para processar uma camada em uma conexão com
banco de dados do que uma camada de tamanho similar armazenada em um shapefile.

Provedores que não usam aplicativos externos podem processar qualquer camada que pode ser aberta no QGIS.

Regarding output formats, raster layers can be saved as TIFF (.tif) files, while vector layers are saved as
shapefiles (.shp). These have been chosen as the ‘lingua franca’ between supported third party applications and
QGIS. If the output filename that you select is not one of the above, it will be modified, adding the corresponding
suffix, and the default file format will be used.

No caso de GDAL, o número de formatos de saída suportados é maior. Quando você abre a janela de seleção
de arquivos, você verá que existem mais formatos (e suas extensões correspondentes disponíveis). Para mais
informações sobre quais formatos são suportados, consulte a documentação GDAL.

Notas sobre seleção de camadas vetoriais

By default, when an external algorithm takes a vector layer, it will use all its features, even if a selection exist
in QGIS. You can make an external algorithm aware of that selection by checking the Use selected features in
external applications item in the General settings group. When you do so, each time you execute an external
algorithm that uses a vector layer, the selected features of that layer will be exported to a new layer, and the
algorithm will work with that new layer instead.

Note que se esta opção for selecionada, uma camada com nenhuma seleção vai se comportar como uma camada
com todos os seus componentes selecionados, e não como uma camada vazia.

17.7.2 SAGA

Algoritmos SAGA podem ser executados a partir do SEXTANTE, se você tinver o SAGA instalado em seu sistema
e configurar o SEXTANTE corretamente para que ele possa encontrar os qrquivos executáveis do SAGA. Em
particular, linhas de comando são necessárias para executar algoritmos SAGA. Os códigos binários do SAGA não
estão incluídos no SEXTANTE, então você tem que baixar e instalar o software manualmente. Visite o site do
SAGA para mais informações. a versão do SAGA 2.0.8 é necessária.

Once SAGA is installed, and if you are running Windows, open the SEXTANTE configuration dialog. In the
SAGA block you will find a setting named SAGA Folder. Enter the path to the folder where SAGA is installed.
Close the configuration dialog and now you are ready to run SAGA algorithms from SEXTANTE.

No caso se você estiver usando Linux, não há necessidade de configurar isso, verá que não existe essa configuração
de pasta. Em vez disso, deve se certificar de que o aplicativo SAGA está devidamente instalado e sua pasta,
adicionada no ambiente PATH do Linux. Para confirmar, basta abrir um console e digitar o comando saga_cmd
para verificar se o aplicativo SAGA pode ser encontrado.

Sobre as limitações do sistema SAGA

A maior parte dos algoritmos SAGA que requerem várias camadas raster de entrada, exigem que elas tenham o
mesmo sistema de projeção. Ou seja, para cobrir a mesma área geográfica e tenham uma mesma resolução espacial
(cellsize). Ao chamar algoritmos SAGA do SEXTANTE, você pode usar qualquer camada, independentemente da
sua resolução espacial (cellsize) e extensão, de forma individual. Quando múltiplas camadas raster são utilizados
como entrada para um algoritmo SAGA, o SEXTANTE irá adaptá-los a um sistema de coordenadas comum e, em
seguida, passará ao SAGA (a menos que o algoritmo SAGA não possa operar com camadas de diferentes sistemas
de projeção).
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A definição do sistema de projeção comum é controlado pelo usuário, você vai encontrar vários parâmetros no
grupo SAGA da janela de configuração para definí-lo. Existem duas maneiras de definir o sistema de grid de
destino:

• Setting it manually. You define the extent setting the values of the following parameters:

– Reamostragem min X

– Reamostragem max X

– Reamostragem min Y

– Reamostragem max Y

– Reamostragem da resolução espacial (cellsize)

Observe que o SEXTANTE irá reprojetar as camadas de entrada,na mesma medida, mesmo que não se
sobreponham.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cellsize of the target layer is the maximum of all cellsizes of the input layers.

Para algoritmos que não usam múltiplas camadas do tipo raster, ou para aquelas camadas que não precisam de
um sistema de projeção único de entrada, esses parametros serão executados sem reprojeção antes de chamar o
SAGA.

Limitações para multiplas bandas de camadas

Unlike QGIS, SAGA has no support for multiband layers. If you want to use a multiband layer (such as
an RGB or multispectral image), you first have to split it into singlebanded images. To do so, you can use
the ‘SAGA/Grid - Tools/Split RGB image’ algorithm (which creates 3 images from an RGB image) or the
‘SAGA/Grid - Tools/Extract band’ algorithm (to extract a single band).

Limitações na resolução espacial (cellsize)

O SAGA pressupõe que camadas raster têm a mesma cellsize no eixo X e Y. Se você está trabalhando com uma
camada com valores diferentes para seus cellsizes horizontal e vertical, você pode obter resultados inesperados.
Neste caso, uma mensagem de advertência será adicionada ao log SEXTANTE, o que indica que uma camada de
entrada pode não estar adequada para ser processada pelo SAGA.

Carregando

Quando o SEXTANTE chama o SAGA, ele faz isso usando a interface de linha de comando, passando assim
um conjunto de comandos para executar toda a operação requerida. O SAGA mostra seu progresso, escrevendo
informações para o console, que inclui a porcentagem de processamento já realizado, juntamente com o conteúdo
adicional. Esta saída é filtrada pelo SEXTANTE e usada para atualizar a barra de progresso durante a execução
do algoritmo.

Both the commands sent by SEXTANTE and the additional information printed by SAGA can be logged along
with other SEXTANTE log messages, and you might find them useful to track in detailed what is going on when
SEXTANTE runs a SAGA algorithm. You will find two settings, namely Log console output and Log execution
commands to activate that logging mechanism.

A maioria dos outros provedores que usam uma aplicação externa e são chamados através de linhas de comandos
tem opções semelhantes, de modo que você vai encontrá-los, bem como em outros lugares na lista de configurações
do SEXTANTE.
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17.7.3 R and R scripts

A integração da linguagem R com o SEXTANTE é diferente do SAGA em que não há um conjunto de algoritmos
predefinido que pode rodar (com exceção de alguns exemplos). Em vez disso, você deve escrever seus scripts
e chamar os comandos R, e de uma forma muito semelhante ao que vimos no capítulo dedicado aos scripts
SEXTANTE. Este capítulo mostra a sintaxe para usar e para chamar os comandos de R no SEXTANTE além de
como usar objetos SEXTANTE (camadas, tabelas) nestes scripts.

The first thing you have to do, as we saw in the case of SAGA, is to tell SEXTANTE where you R binaries are
located. You can do so using the R folder entry in the SEXTANTE configuration dialog. Once you have set that
parameter, you can start creating your own R scripts and executing them.

Mais uma vez, esta configuração é diferente no Linux, e você só tem que ter certeza de que a pasta R está incluído
no ambiente PATH. Para isso você pode começar apenas digitando R no console, e assim R está pronto para uso.

Para adicionar um novo algoritmo que usa uma função R (ou um script R mais complexo que você desenvolveu e
que você gostaria de ter disponível a partir do SEXTANTE), você tem que criar um arquivo de script que informa
ao SEXTANTE como proceder com essa operação e inserir os comoandos correspondentes em R.

Script files have the extension .rsx and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings
group (available from the SEXTANTE settings dialog), just like you do with the folder for regular SEXTANTE
scripts.

Vamos dar uma olhada em um arquivo muito simples de script, que chama o método R spsample para criar
uma grade aleatória dentro do limite dos polígonos em uma dada camada do polígono. Este método pertencem ao
pacote maptools‘. Uma vez que quase todos os algoritmos que você gostaria de
incorporar ao Sextante vai usar ou gerar dados espaciais, conhecimento de
pacotes espaciais como ‘‘maptools e, especialmente, sp, é obrigatório.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

As primeiras linhas, que começam com um sinal de duplo comentário Python (##), informa ao SEXTANTE as
entradas do algoritmo descrito no arquivo e as saídas que ele vai gerar. Eles trabalham exatamente com a mesma
sintaxe que os scripts SEXTANTE que já vimos, para que não sejam descritos aqui novamente. Verifique a seção
correspondente para obter mais informações.

When you declare an input parameter, SEXTANTE uses that information for two things: creating the user interface
to ask the user for the value of that parameter and creating a corresponding R variable that can be later used as
input for R commands.

No exemplo acima, estamos declarando uma entrada do tipo vetorial chamado polyg. Ao executar o algo-
ritmo, o SEXTANTE vai abrir em R a camada selecionada pelo usuário e armazená-lá em uma variável também
chamado polyg. Assim, o nome de um parâmetro é também o nome da variável que podemos usar em R, ex-
ceto para o valor do parâmetro (portanto, você deve evitar o uso de palavras reservadas ao R como nomes de
parâmetro).

Elementos espaciais, tais como vetores e camadas raster são lidos usando os comandos readOGR() e
readGDAL() (você não tem que se preocupar em acrescentar os comandos para o seu arquivo de descrição,
o SEXTANTE vai fazer isso) e armazená-las como objetos ‘‘Spatial*DataFrame‘. Campos de tabelas são ar-
mazenados como texto contendo o nome do campo selecionado.

Tabelas são abertas usando o comando read.csv(). Se uma tabela inserida pelo usuário não está no formato
CSV, será convertida antes de importá-la para R.

Sabendo disso, podemos agora compreender a primeira linha do nosso script de exemplo (a primeira linha que não
começa com um comentário Python).
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pts=spsample(polyg,numpoints,type="random")

A variável polygon já contém um objeto SpatialPolygonsDataFrame, para que possa ser usado para
chamar o método spsample, assim como um numpoints, o que indica o número de pontos a serem adiciona-
dos para a grade de amostra criada.

Como declaramos uma saída vetorial, chamada out, temos que criar uma variável chamada out e criar nela um
grupo de objetos Spatial*DataFrame‘ (neste caso, um ‘‘SpatialPointsDataFrame). Você
pode usar qualquer nome para as variáveis intermediárias. Apenas certifique-se que a variável que armazena o
resultado final tem o mesmo nome que você usou para declará-la, e contém um valor adequado.

Neste caso, o resultado obtido a partir do método spsample tem que ser convertido em um objeto explicito
SpatialPointsDataFrame, uma vez que é em si mesmo um objeto da classe ppp, o que não é aceitável em
uma classe a ser enviada para o SEXTANTE.

If you algorithm does not generate any layer, but a text result in the console instead, you have to tell SEXTANTE
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithms that performs a normality test on a given field (column)
of the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

A saída da última linha é impressa, mas a saída da primeira não é (assim como as saídas de outras linhas de
comando adicionadas automaticamente pelo SEXTANTE não serão).

Se o seu algoritmo cria qualquer tipo de gráfico (usando o método plot(), adicione a seguinte linha:

##showplots

This will cause SEXTANTE to redirect all R graphical outputs to a temporary file, which will be later opened once
R execution has finished.

Ambos, os gráficos e os resultados do console serão mostrados no gerenciador de resultados do SEXTANTE.

Para mais informações, consulte os arquivos de script fornecidos com o SEXTANTE. A maioria deles são bastante
simples e vai lhe ajudar muito a entender como criar as seus próprios scripts.

17.7.4 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

Por padrão, o SEXTANTE tenta configurar uma conexão com o GRASS usando a distribuição GRASS que vem
junto com QGIS. Isso deve funcionar sem problemas na maioria dos sistemas, mas se você tiver problemas, é
necessário fazer isso manualmente. Além disso, se você quiser usar uma versão do GRASS diferente, é possivel
alterar essa configuração e apontar o caminho para a pasta onde essa outra versão se encontra. o GRASS 6.4 é
necessário para os algoritmos funcionarem corretamente.

Se você estiver executando o QGIS no Linux, só tem que se certificar de que o GRASS está instalado corretamente,
e que ele pode ser executado sem problemas a partir de um console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If this is the behaviour you prefer, just check the Use min covering
region option in the GRASS configuration parameters.

GRASS includes help files describing each algorithm. If you set the GRASS help folder parameter, SEXTANTE
will open them when you use the [Show help] button from the parameters window of the algorithm.
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O último parâmetro que tem que ser configurado está relacionada com o mapset. O mapset é necessário para
executar o GRASS.O SEXTANTE cria um mapset temporário para cada execução. Você tem que informar ao
SEXTANTE se os dados que você está trabalhando são geográficos (latitude/longitude) ou coordenadas projetadas.

17.7.5 GDAL

Nenhuma configuração adicional é necessária para executar algoritmos GDAL, uma vez que ele já é incorporado
ao QGIS e o SEXTANTE pode inferir sua configuração.

17.7.6 Orfeo ToolBox

Os algoritmos Orfeo Toolbox (OTB) podem ser executados a partir do SEXTANTE, desde que você tenha instalado
o OTB em seu sistema e configurado corretamente o SEXTANTE para que ele possa encontrar todos os arquivos
necessários (linha de comando, ferramentas e bibliotecas). Observe que os códigos binários do OTB não estão
incluídos no SEXTANTE, então você tem que baixar e instalar o software manualmente. Visite o site do OTB
para mais informações.

Once OTB is installed, start QGIS, open the SEXTANTE configuration dialog and configure OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block you will find all settings related to OTB. First ensure that
algorithms are enabled.

Em seguida, configure o caminho para a pasta onde o OTB (linha de comando ferramentas e bibliotecas) estão
instalados:

• usually OTB applications folder point to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin

• if you use OSGeo4W installer, than install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder

17.7.7 TauDEM

To use this provider you need to install TauDEM command line tools.

Windows

Please visit TauDEM homepage for installation instructions and precompiled binaries for 32bit and 64bit systems.
IMPORTANT: you need TauDEM 5.0.6 executables, version 5.2 currently not supported.

Linux

Não existem pacotes para a distribuição Linux, então você deve compilar o TauDEM manualmente. Como Tau-
DEM usa MPICH2, primeiro tem que instalá-lo usando algum gerenciador de pacotes de aplicativos. TauDEM
também funciona bem com OpenMPI, assim é possível usá-lo em vez de MPICH2.

Download TauDEM 5.0.6 source code and extract files in some folder.

Open linearpart.h file and add after line

#include "mpi.h"

adicione uma nova linha com

#include <stdint.h>

para obter sucesso
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#include "mpi.h"
#include <stdlib.h>

Save changes and close file. Now open tiffIO.h, find line #include "stdint.h" and replace quotes ()
with <>, so you’ll get

#include <stdint.h>

Salve as alterações e feche o arquivo. Crie um diretório cd de armazenamento para ele

mkdir build
cd build

Configure a sua compilação com o comando

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

e então compile

make

Finalmente, instale o TauDEM em /usr/local/bin, execute

sudo make install
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CAPÍTULO 18

Compositor de impressão

The print composer provides growing layout and printing capabilities. It allows you to add elements such as the
QGIS map canvas, legend, scalebar, images, basic shapes, arrows and text labels. You can size, group, align and
position each element and adjust the properties to create your layout. The layout can be printed or exported to
image formats, Postscript, PDF or to SVG (export to SVG is not working properly with some recent Qt4 versions.
You should try and check individual on your system). You can save the layout as template and load it again in
another session. See a list of tools in table_composer_1:

ícone Finalidade ícone Finalidade

Carregar um modelo de impressão Salvar como modelo de impressão

Exportar para formato de imagem Exportar para PDF

Exportar como SVG Imprimir ou exportar para Postscript

Ver tudo Aproximar

Afastar Atualizar visualização

Desfazer ultima modificação Restaurar ultima modificação

Adicionar novo mapa Adicionar imagem ao leiaute

Adicionar rótulo (texto) Adicionar legenda

Adicionar barra de escala Adicionar formas básicas

Adicionar seta Adicionar tabela de atributos

Selecionar/mover item na tela do compositor Mover conteúdo do mapa

Agrupar itens Desagrupar itens

Elevar itens selecionados Abaixar itens selecionados

Mover itens selecionados para o topo Mover itens selecionados para a base

Alinhar itens selecionados à esquerda Alinhar itens selecionados à direita

Alinhar itens selecionados ao centro Alinhar itens selecionados na vertical

Alinhar itens selecionados ao topo Alinhar itens selecionados á base

Tabela 1 Compositor: Ferramentas do compositor de impressão

Todas as ferramentas do compositor de impressão estão disponíveis nos menus e em forma de ícones na barra de
ferramentas. A barra de ferramentas pode ser desativada e ativada pressionando o botão direito do mouse sobre
ela.
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18.1 Abrir um novo modelo no Compositor de impressão

Antes de começar a trabalhar com o compositor de impressão, você precisa carregar algumas camadas raster e
vetoriais na tela do mapa QGIS e adaptar as suas propriedades conforme seja mais conveniente. Depois que

tudo esteja processado e a simbologia estiver ao seu gosto, clique no icone Novo compositor de impressão na barra de
ferramentas ou selecione Arquivo → Novo Compositor de impressão.

18.2 Usando o Compositor de Impressão

Ao abrir o compositor de impressão surgirá uma tela em branco na qual você pode adicionar a tela atual do projeto
QGIS, legenda, barra de escala, imagens, formas básicas, norte e texto. A Figure_composer_1 mostra a visão

inicial do compositor de impressão com uma caixa ativada Grade para alinhamento , antes de quaisquer
elementos serem inseridos.

Figura 18.1: Print Composer

O compositor de impressão apresenta três guias:

• The Composition tab allows you to set paper size, orientation, the print quality for the output file in dpi and

to activate snapping to a grid of a defined resolution. Please note, the Snap to grid feature only works,

if you define a grid resolution > 0. Furthermore you can also activate the Print as raster checkbox. This
means all elements will be rastered before printing or saving as Postscript of PDF.

• The Item Properties tab displays the properties for the selected map element. Click the Select/Move item

icon to select an element (e.g. legend, scalebar or label) on the canvas. Then click the Item Properties tab
and customize the settings for the selected element.

• A guia:guilabel:’Histórico de comandos‘ exibe um histórico de todas as alterações aplicadas ao leiaute do
compositor de impressão. Com um clique do mouse sobre um dos itens é possível desfazer ou refazer os
passos de configuração do leiaute.

You can add multiple elements to the composer. It is also possible to have more than one map view or legend or
scalebar in the print composer canvas. Each element has its own properties and in the case of the map, its own
extent. If you want to remove any elements from the composer canvas you can do that with the Delete or the
Backspace key.
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18.3 Adicionando um mapa atual do QGIS ao compositor de im-
pressão

Click on the Add new map toolbar button in the print composer toolbar, to add the QGIS map canvas. Now drag a
rectangle on the composer canvas with the left mouse button to add the map. To display the current map, you can
choose between three different modes in the map Item Properties tab:

• Rectangle is the default setting. It only displays an empty box with a message ‘Map will be printed here’.

• Cache renders the map in the current screen resolution. If case you zoom in or out the composer window,
the map is not rendered again but the image will be scaled.

• Render means, that if you zoom in or out the composer window, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache é o modo padrão de visualização de mapas do compositor de impressão.

You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element select the map element, click the Move item content icon and move the
layers within the map element frame with the left mouse button. After you found the right place for an element,
you can lock the element position within the print composer canvas. Select the map element and click on the right

mouse button to Lock the element position and again to unlock the element. You can lock the map element also

activating the Lock layers for map item checkbox in the Map dialog of the Item Properties tab.

Nota: QGIS is now able to show labels from the new labeling plugin also in the map composer, but it is not yet
scaled correctly. So it might be necessary to switch back to the standard labeling in some cases.

18.3.1 Map item properties tab — Map and Extents dialog

Caixa de diálogo Mapa

The Map dialog of the map Item Properies tab provides following functionalities (see figure_composer_2):

Figura 18.2: Map Dialog

• The Preview area allows to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. Click on the [Update preview] button to apply changes to the map view.

• The Map area allows to resize the map element specifying the width and height or the scale. The field

Rotation allows to rotate the map element content clockwise in degrees. Note, a coordinate frame
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can only be added with the default value 0. Furthermore you can enable the checkboxes Lock layers for

map items and Draw map canvas items.

Se você mudar a visão sobre a tela do mapa QGIS pelo zoom ou alterar as propriedades vetoriais ou raster, é
possível atualizar a visualização do mapa no compositor de impressão, selecionando o elemento do tipo mapa e
clicando no botão [Update preview].

Caixa de diálogo Extensão

The Extents dialog of the map item tab provides following functionalities (see Figure figure_composer_3)):

Figura 18.3: Extents Dialog

• The Map extent area allow to specify the map extent using Y and X min/max values or clicking the [Set to
map canvas extent] button.

If you change the view on the QGIS map canvas by zooming or panning or changing vector or raster properties,
you can update the print composer view selecting the map element in the print composer and clicking the [Update
preview] button in the map Item Properties tab (see Figure figure_composer_2 a)).

18.3.2 Map item properties tab — Grid and General options dialog

Caixa de diálogo grid

The Grid dialog of the map Item Properties tab provides following functionalities (see Figure_composer_4):

Figura 18.4: Grid Dialog

• A opção Mostrar grid permite a sobreposição de uma grade no mapa. Você pode especificar para ser
aplicado o tipo de linha sólida ou cruz. Além disso, é possível definir um intervalo para as direções X e Y,
e a largura usada entre as linhas X e Y da grade.

• A opção Desenhar anotações permite adicionar coordenadas para o quadro do mapa. As anotações
podem ser desenhadas dentro ou fora da estrutura do mapa. A direção das anotações pode ser definida
como horizontal, vertical, horizontal e vertical, ou ao limite das linhas. E, finalmente, você pode definir
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a cor da grade, a fonte das anotações, a distância das anotações ao quadro do mapa, além da precisão das
coordenadas desenhadas.

Caixa de diálogo opções gerais

The General options dialog of the map Item Properties tab provides following functionalities (see Fig-
ure_composer_5):

Figura 18.5: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the map canvas. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to the
other print composer items.

18.4 Adicionando outros elementos ao Compositor de Impressão

Além de adicionar uma tela com o mapa atual do QGIS ao compositor de impressão, também é possível adicionar,
mudar a posição, mover e personalizar uma legenda, barra de escala, imagens e elementos de rotulagem.

18.4.1 Label item properties tab - Label and General options dialog

To add a label, click the Add label icon, place the element with the left mouse button on the print composer
canvas and position and customize their appearance in the label Item Properties tab.

Caixa de diálogo rótulo

The Label dialog of the label item tab provides following functionalities:

• The Label dialog offers to add text labels to the composer canvas. You can define the horizontal and vertical
alignment, select font and font color for the text and it is possible to define a text margin in mm.

Caixa de diálogo opções gerais

The General options dialog of the label Item Properties tab provides following functionalities:

• Here you can define color and outline width for the element frame, set a background color and opacity for
the label. The Position button opens the Set items position dialog and allows to set the map canvas position
using reference points or coordinates. Furthermore you can select or unselect to display the element frame

with the Show frame checkbox. Use the Item ID to create a relationship to other print composer items.
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Figura 18.6: Label Options Dialog

Figura 18.7: General Options Dialog
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18.4.2 Image item properties tab - Picture options and General options dialog

To add an image, click the Add image icon, place the element with the left mouse button on the print composer
canvas and position and customize their appearance in the image Item Properties tab.

Caixa de diálogo opções da figura

The Picture options dialog of the image Item Properties tab provides following functionalities (see fig-
ure_composer_5 a):

Figura 18.8: Picture Options Dialog Dialog

• The Preloaded Images field then shows all pictures stored in the selected directories.

• The Options area shows the current selected picture and allows to define width, height and clockwise

rotation of the picture. It is also possible to add a user specific SVG path. Activating the Sync with map
checkbox synchronizes the rotation of a picture in the QGIS map canvas (i.e. a rotated north arrow) with
the appropriate print composer image.

• A área Buscar pastas permite adicionar e remover pastas com imagens no formato SVC para o banco de
dados de imagens.

Caixa de diálogo opções gerais

The General options dialog of the image Item Properties tab provides following functionalities:

Figura 18.9: General Options Dialog Dialog
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• Here you can define color and outline width for the element frame, set a background color and opacity for
the picture. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to other
print composer items.

18.4.3 Legend item properties tab - General, Legend items and Item option dia-
log

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the print
composer canvas and position and customize their appearance in the legend Item Properties tab.

Caixa de diálogo geral

The General dialog of the legend item tab provides following functionalities (see figure_composer_10):

Figura 18.10: General Dialog

• Here you can adapt the legend title. You can change the font of the legend title, layer and item name. You
can change width and height of the legend symbol and you can add layer, symbol, icon label and box space.
Since QGIS 1.8, you can wrap the text of the legend title to a given character.

Caixa de diálogo itens da legenda

The Legend items dialog of the legend Item Properties tab provides following functionalities (see fig-
ure_composer_11):

• The legend items window lists all legend items and allows to change item order, edit layer names, remove
and restore items of the list. After changing the symbology in the QGIS main window you can click on
[Update] to adapt the changes in the legend element of the print composer. The item order can be changed
using the [Up] and [Down] buttons or with ‘drag and drop’ functionality.

Caixa de diálogo opções gerais

The General options dialog of the legend Item Properties tab provides following functionalities (see fig-
ure_composer_12):

• Here you can define color and outline width for the element frame, set a background color and opacity for
the legend. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. Use the Item ID to create a relationship to other print
composer items.

192 Capítulo 18. Compositor de impressão



QGIS User Guide, Versão 1.8

Figura 18.11: Legend Items Dialog

Figura 18.12: General Options Dialog
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18.4.4 Scalebar item properties tab - Scalebar and General options dialog

To add a scalebar, click the Add new scalebar icon, place the element with the left mouse button on the print
composer canvas and position and customize their appearance in the scalebar Item Properties tab.

Caixa de diálogo barra de escala

The Scalebar dialog of the scalebar Item Properties tab provides following functionalities (see fig-
ure_composer_13):

Figura 18.13: Scalebar Options Dialog

• The Scalebar dialog allows to define the segment size of the scalebar in map units, the map units used per
bar units, and how many left and right segments units from 0 should be used.

• Você pode definir o estilo da barra de escala disponível, como sendo simples ou dupla, o espaçamento da
linha do meio, para cima ou para baixo, além do estilo numérico dos textos.

• Furthermore you can define height, line width, label and box space of the scalebar. Add a unit label and
define the scalebar font and color.

Caixa de diálogo opções gerais

The General options dialog of the scalebar Item Properties tab provides following features (see figure_composer_7
b)):

Figura 18.14: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the scalebar. The [Position and size] button opens the Set items position dialog and allows to set the map
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canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to the
other print composer items.

18.5 Ferramentas de navegação

Para a navegação em mapas, o compositor de impressão fornece quatro ferramentas:

• Aproximar

• Afastar

• Ampliar para exibir tudo

• Atualizar a exibição ‘(se você encontrar o ponto de vista em um estado não identificável)

18.6 Ferramentas para reverter e restaurar

Durante o processo de criação do leiaute, é possível reverter e restaurar as alterações. Isto pode ser feito com as
ferramentas reverter e restaurar:

• Desfazer as ultimas mudanças

• Restaurar as ultimas mudanças

ou clicando com o mouse dentro da guia histórico de comandos (veja figure_composer_9).

Figura 18.15: Command history in the Print Composer

18.7 Adicionando Forma básica e seta

É possível adicionar formas básicas (Elipse, Retângulo, Triângulo) e setas na tela do compositor de impressão.

The Shape dialog allows to draw an ellipse, rectangle, or triangle in the print composer canvas. You can define its
outline and fill color, the outline width and a clockwise rotation.
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Figura 18.16: Shape Dialog

The Arrow dialog allows to draw an arrow in the print composer canvas. You can define color, outline and arrow
width and it is possible to use a default marker and no marker and a SVG marker. For the SVG marker you can
additionally add a SVG start and end marker from a directory on your computer.

Figura 18.17: Arrow Dialog

18.8 Adicionando os valores da tabela de atributos

É possível adicionar partes de uma tabela de atributos de camadas vetoriais na tela do compositor de impressão.

Caixa de diálogo tabela

The Table dialog of the attribute table item tab provides following functionalities (see figure_composer_20):

• The Table dialog allows to select the vector layer and columns of the attribute table. Attribute columns can
be sorted and you can define to show its values ascending or descending.

• É possível definir o número máximo de linhas a serem exibidas e se os atributos são exibidos apenas para
as características visíveis da tela atual do compositor.

• Além disso, é possível definir as características de grade da tabela e a fonte do cabeçalho e conteúdo.

Caixa de diálogo opções gerais

The General options dialog of the attribute table item tab provides following functionalities (see fig-
ure_composer_21):

• Here you can define color and outline width for the element frame, set a background color and opacity
for the table. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. Use the Item ID to create a relationship to the other print
composeritems.
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Figura 18.18: Table Dialog

Figura 18.19: General Options Dialog
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18.9 Elevar, abaixar e alinhar elementos

As funcionalidades de elevar ou abaixar os elementos são encontradas no menu suspenso elevar itens selecionados.
Escolha um elemento na tela do compositor de impressão e selecione a funcionalidade correspondente para au-
mentar ou diminuir o elemento selecionado em relação aos outros elementos (ver table_composer_1).

Existem várias funcionalidades de alinhamento disponíveis no menu suspenso Alinhar itens selecionados (ver ta-
ble_composer_1). Para usar uma funcionalidade de alinhamento, primeiramente selecione alguns elementos e,
em seguida, clique no ícone de alinhamento correspondente. Então, todos os elementos selecionados serão alin-
hados dentro de uma caixa delimitadora.

18.10 Criação de saídas

Figure_composer_22 shows the print composer with an example print layout including each type of map element
described in the sections above.

Figura 18.20: Print Composer with map view, legend, scalebar, coordinates and text added

O compositor de impressão permite criar vários formatos de saída, é possível definir a resolução (qualidade de
impressão) e tamanho do papel:

• O ícone Imprimir permite imprimir o leiaute para uma impressora conectada ao computador ou em um
arquivo Postscript dependendo dos drivers de impressoras instalados.

• The Export as image icon exports the composer canvas in several image formats such as PNG, BPM, TIF,
JPG,...

• O ícone :sup:’Exportar como PDF‘salva a tela do compositor de impressão definida diretamente como
PDF.

• O ícone :sup:’Exportar como SVG ‘ salva a tela do compositor de impressão como um SVG (Scalable
Vector Graphic).
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Nota: Atualmente a saída SVG é muito básica. Isto não é um problema do QGIS, mas um problema da biblioteca
Qt underlaying. Esperamos que possa ser resolvido em versões futuras.

18.11 Salvar e carregar um leiaute no compositor de impressão

With the Save as template and Load from template icons you can save the current state of a print composer session
as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in File → Composer Manager allows to add a new com-
poser template or to manage already existing templates.

Figura 18.21: The Print Composer Manager
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CAPÍTULO 19

Complementos

19.1 Complementos QGIS

O QGIS foi concebido para trabalhar com uma arquitetura de complementos. Isto permite que muitas novas
feições/funções seja adicionadas. Muitas destas feições já estão atualmente inclusas (complementos internos que
já vêm com o QGIS) e complementos externos, que você pode adicionar sob demanda.

• Complementos Internos são mantidos pelo time de desenvolvimento do QGIS e estão presentes na sua
distribuição QGIS. Eles são escritos em uma ou duas linguagens C++ ou Python. Mais informações sobre
complementos internos podem ser vistas na Seção Usando Complementos Internos

• Complementos Externos são atualmente escritos em linguagem Python. Eles estão armazenados no
repositório Oficial do QGIS e podem ser adicionados a partir de Instalador de Complementos Python. Mais
informações sobre os complementos externos podem ser vistas na Seção Carregar um complemento externo
do QGIS.

19.1.1 Gerenciar Complementos

Gerenciar complementos em geral significa carregar ou descarregar estes usando o Gerenciador de Complementos.
Complementos externos podem ser instalados e diretamente ativados ou desinstalados usando-se o Instalados de
Complementos Python. Para desativar ou reativar complementos externos, o Gerenciador de Complementos deverá
ser usado novamente.

Carregar um complemento interno

Para carregar um complemento interno use o menu principal Complementos → Gerenciar Complementos

The Plugin Manager lists all the available plugins and their status (loaded or unloaded), including all core plugins
and all external plugins that have been installed and automatically activated using the Python Plugin Installer (see
Section Carregar um complemento externo do QGIS). Those plugins that are already loaded have a check mark to
the left of their name. Figure_plugins_1 shows the Plugin Manager dialog.

Para habilitar um complemento externo, marque aquele que deseja instalar e clique em [OK]. Ao você sair do
QGIS, uma lista de complementos instalados será salva, para na sua próxima seção do QGIS ser carregada nova-
mente.

Dica: Complementos quedrados
If you find that QGIS crashes on startup, a plugin may be at fault. You can stop all plugins from loading by editing
your stored settings file (see Opções for location). Locate the plugins settings and change all the plugin values to
false to prevent them from loading.

For example, to prevent the ‘Delimited text’ plugin from loading, the entry in
$HOME/.config/QuantumGIS/qgis.conf on Linux should look like this: Add Delimited Text
Layer=false.
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Figura 19.1: Plugin Manager

Do this for each plugin in the [Plugins] section. You can then start QGIS and add the plugins one at a time from
the Plugin Manager to determine which plugin is causing the problem.

Carregar um complemento externo do QGIS

External QGIS plugins are written in Python. They are by default stored in either the ‘Official’ QGIS Repository,
or in various other external repositories maintained by individual authors. The ‘Official’ QGIS Repository is added
by default in Python Plugin installer.

Detailed documentation about the usage, minimum QGIS version, homepage, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, they might be available with the external plugins themselves. In general it is not included in this
manual.

Nota: Updates of core python plugins may be available in this repository as external overlays.

Nota: fTools, Mapserver Export e o Instalador de Complmentos são complementos Python, mas eles são também
parte da fonte do QGIS e são automaticamente carregados e habilitados no Gerenciador de Complementos QGIS
(ver Seção Carregar um complemento externo do QGIS).

Currently there are over 150 external plugins available from the ‘Official’ QGIS Repository. Some of these plugins
offer functionality that will be required by many users (for example: providing the user with the ability to view and
edit OpenStreetMap data, or to add GoogleMap layers) while others offer very specialized functions (for example:
Calculate economic pipe diameters for water supply networks).

Estas funcionalidades são bastante úteis para buscar através de todos os complementos externos, fornecendo uma
palavra de busca, escolhendo um nome de repositório e/ou filtrando pela situação do complemento em seu com-
putador (atualmente instalado ou desinstalado). Ações de buscar e filtrar podem ser realizadas a partir do Instalador
de Complementos Python (veja figure_plugins_2).

Dica: Adicionar mais repositórios
To add external author repositories, open the Plugin Installer (Plugins → Fetch Python Plugins), go to the tab
Repositories, and click [Add]. If you do not want one or more of the added repositories, they can be disabled via
the [Edit...] button, or completely removed with the [Delete] button.
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Existe apenas um passo necessário para integrar complementos externos ao QGIS:

• Baixe um complemento externo a partir de um repositório usando o Instalador de Complementos Python
(veja Usando o Instalador de Complementos Python). O novo complemento será adicionado a lista de
complementos disponíveis no Gerenciador de Complementos e ele será automaticamente carregado.

Usando o Instalador de Complementos Python

In order to download and install an external Python plugin, go to Plugins → Fetch Python Plugins. The Plugin
Installer window will appear (figure_plugins_2) with the tab Plugins, containing a list of all locally installed
Python plugins, as well as plugin available in remote repositories.

Figura 19.2: Installing external python plugins

Cada complemento pode estar:

• não instalado - isto significa que o complemento está disponível no repositório, mas não está ainda in-
stalado. Para instalá-lo, selecione o complemento a partir da lista e clique no botão [Instalar/atualizar
complemento].

• novo - isto significa que o complemento foi recentemente adicionado ao repositório.

• instalado - indica que o complemento já está instalado. Se ele estiver disponível em outro repositório, o
botão [Reinstalar complemento] estará habilitado. Se a versão disponível for mais antiga do que a versão
instalada, então, o botão [Desatualizar complemento] aparecerá.

• Atualizável - significa que o complemento está instalado, mas existe uma versão mais atual disponível.
Neste caso, estarão disponíveis os botões [Atualizar complemento] e [Atualizar tudo].

• Inválido - significa que o complemento está instalado, mas está indisponível ou quebrado. A razão será
explicada no campo de descrição do complemento.

Aba Complementos

Para instalar um complemento, selecione-o a partir da lista e clique no botão [Instalar complemento]. O com-
plemento será ativado e instalado no seu PC.

• Linux and other unices

– /share/qgis/python/plugins

– $HOME/.qgis/python/plugins

• Mac OS X

– /Contents/MacOS/share/qgis/python/plugins

– /Users/$USERNAME/.qgis/python/plugins

• Windows
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– C:\Program Files\QGIS\python\plugins

– C:\Documents and Settings\$USERNAME\.qgis\python\plugins

Se a instalação for bem sucedida, uma mensagemn de confirmação aparecerá.

If the installation fails, the reason for the failure will be displayed in a warning dialog. Most often, errors are the
result of connection problems and/or missing Python modules. In the former case you will likely need to wait
before trying the install again, in the latter case, you should install the missing modules relevant to your operating
system prior to using the plugin. For Linux, most required modules should be available via a package manager.
For install instructions in Windows visit the module home page.

If you are using a proxy, you may need to configure it under Edit → Options (Gnome, OSX) or Settings → Options
(KDE, Windows)‘ on the Proxy tab.

O botão [Desinstalar complemento] aparece habilitado se o complemento estiver instalado e não for um com-
plmento interno. Note que se você possuir instalado uma atualização para um complemento interno, você pode
desinstalar esta atualização com **[Desinstalar complemento]**e reverter para a versão padrão entregue com sua
versão do QGIS. Esta versão padrão, por sua vez, não pode ser desinstalada.

Aba Repositórios

The second tab Repositories, contains a list of plugin repositories available for the Plugin Installer. By default,
only the QGIS Official Repository is enabled. You can add several user-contributed repositories, including the
central QGIS Contributed Repository and other external repositories by clicking the [Add ...] button. The added
repositories contain a large number of useful plugins which are not maintained by the QGIS Development Team.
As such, we cannot take any responsibility for them. You can also manage the repository list manually, that is
add, remove, and edit the entries. Temporarily disabling a particular repository is possible by clicking the [Edit
...] button.

Aba Opções

A aba Opções é onde você pode configurar as configurações do Instalador de Complementos. A Verificar por
atualizações ao iniciar‘ marcada fará com que o QGIS verifique por atualizações de complementos sempre ao
iniciar. O ajuste de frequência de verificação de atualizações pode ser feito através do menu de opções e, pode ser
ajustado desde todos os dias até um intervalo mensal. Se um novo complemento ou atualização estiver disponível

para um dos complementos instalados, uma notificação aparecerá na barra de situação. Se a opção Verificar
por atualizações ao iniciar‘ não estiver marcada, a verificação deverá ser feita manualmente quando aberto o
Instalador de Complementos.

Embora o atualizador do instalador de complementos consiga manusear portas diferentes de 80, algumas conexões
de internet porderão causar problemas quando tentar verificar por atualizações, um indicador Buscando por novos
complementos... estará visível na Barra de Situação durante toda a sua seção do QGIS e pode causar o fechamento
do programa. Neste caso, desabilite a caixa de seleção.

Adicionalemente, voc^epode especificar o tipo dos complementos que são mostrados pelo Instalador de Comple-
mentos Python. Sob Complementos permitidos, você pode especificar o que você deseja fazer:

• Only show plugins from the official repository

• Show all plugins except those marked as experimental

• Show all plugins, even those marked as experimental

Dica: Usando complmentos experimentais
Complementos experimentais não são indicados para uso de produção. Estes complementos estão em estágio
inicial de desenvolvimento e podem ser considerados como ferramentas ‘incompletas’. O time de desenvolvimento
do QGIS não recomenda a instalação destes complementos ao menos que você deseje testá-los.
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19.1.2 Provedores de dados

Data Providers are ‘special’ plugins that provides access to a data store. By default, QGIS supports PostGIS layers
and disk-based data stores supported by the GDAL/OGR library. A Data Provider plugin extends the ability of
QGIS to use other data sources.

Os complementos de Provedores de Dados são registrados automaticamente pelo QGIS ao iniciar. Eles não são
gerenciados pelo Gerenciador de Complementos, mas usados atrás das cenas quando um tipo de dado é adicionado
como uma camada do QGIS.
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19.2 Usando Complementos Internos

Ícone Complemento Descrição Manual de referência

Adicionar camada
de texto delimitado

Loads text files containing x,y
coordinates

Delimited Text Plugin

Captura de
coordenadas

Captura a coordenada da posição
do mouse em diferentes SRCs

Complemento Captura
de coordenadas

DB Manager Manage your databases within
QGIS

Complemento DB
Manager

Diagram Overlay Add Diagrams for vectors Diagram Overlay Plugin
sudo apt-get install
gnome-tweak-tool

Conversor
DXF2Shape

Converte arquivos DXF para SHP Dxf2Shp Converter
Plugin

eVis Ferramenta de Visualização de
Evento

Complemento eVis

fTools A suite of vector tools Complemento fTools

Ferramentas GPS Ferramentas para carregar e
importar dados do GPS

Complemento GPS

GRASS GRASS functionality Integração com SIG
GRASS

Ferramentas GDAL GDAL raster functionality Ferramentas do
complemento GDAL

Georreferenciador
GDAL

Georeference Raster with GDAL Complemento
Georreferenciador

Heatmap Create heatmap raster from input
vector points

Complemento de Mapa
de Calor

Interpolação Interpolação com base em pontos
de uma camada vetorial

Complemento de
Interpolação

Exportar para
MapServer

Export a QGIS project file to a
MapServer map file

Complemento de
exportação do
MapServer

Edição Offline Edita offline e sincroniza com
uma base de dados

Complemento Edição
Offline

OpenStreetMap Access OpenStreetMap OpenStreetMap

Georaster Oracle
Spatial

Acessa Georasters Oracle Spatial Complemento Oracle
GeoRaster

Instalador de
complementos

Baixa e instala complementos
python

Usando o Instalador de
Complementos Python

Raster Terrain
Analysis

Compute geomorphological
features from DEMs

Raster Terrain Analysis
Plugin

Menor Distância Shortest path analysis Compemento Caminho
Mais Curto

SPIT Shapefile to PostGIS Import Tool Importação de dados no
PostgreSQL

SQL Anywhere Access SQL anywhere DB Complemento SQL
Anywhere

Consulta Espacial Spatial queries on vectors Plugin de Consulta
Espacial

Zonal Statistics Calculate raster statistics for
vector polygons

Complemento Estatística
Zonal
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19.3 Complemento Captura de coordenadas

O complelemento de captura de coordenadas é fácil de usar e oferece a possibilidade de visualizar as coordenadas
na tela do mapa para dois Sistemas de Coordenadas de Referência (SRC) selecionados.

Figura 19.3: Coordinate Capture Plugin

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative you can also click on the CRS status icon in the lower
right-hand corner of the statusbar.

2. Clique na caixa de seleção Habilitar reprojeção ‘on the fly’ como padrão e selecione um sistema de
coordenada projetado de sua preferência (ver também Trabalhando com Projeções).

3. Load the coordinate capture plugin in the Plugin Manager (see Carregar um complemento interno) and

ensure that the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is
enabled. The coordinate capture dialog appears as shown in Figure figure_coordinate_capture_1.

4. Clique no :sup: ícone Clique para selecionar o SRC e usá-lo para mostrar as coordenadas e selecione
um SRC diferente para uma que voce selecionou acima.

5. Para iniciar a captura de coordenadas, clique em [Iniciar captura]. Agora voce pode clicar onde desejar no
mapa da tela e o complemento irá mostrar a coordenada para o local que voce clicou no SRC selecionado.

6. Para habilitar o rastreamento de coordenada do mouse clique no : sup: ícone mouse rastreamento.

7. Você também pode copiar as coordenadas selecionadas para a área de transferência.

19.4 Complemento DB Manager

The DB Manager Plugin is officially part of QGIS core and intends to replace the SPIT Plugin and the PostGIS
Manager Plugin and additionally to integrate all other database formats supported by QGIS in one user interface.

The DB Manager Plugin provides several features. You can drag layers from the QGIS Browser into the DB
Manager and it will import your layer into your spatial database. You can drag and drop tables between spatial
databases and they will get imported. You can also use the DB Manager to execute SQL queries against your
spatial database and then view the spatial output for queries by adding the results to QGIS as a query layer.

The Database menu allows to connect to an existing database, to start the SQL-window and to exit the DB Manager
Plugin. The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g.
PostGIS 2) to start a TopoViewer. The menu Table allows to create and edit tables and to delete tables and views. It
is also possible to empty tables and to move tables from one to another schema. Finally you can also run Vacuum
Analyze and add Versioning Support to a table.
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Figura 19.4: DB Manager dialog (KDE)

The Tree window lists all existing databases supported by QGIS. With a double-click you can connect to the
database. With the right-mouse button you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry as well as about existing Fields, Constraints and Indexes. It also allows to
run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows all
attributes and the Preview tab renders the geometries as preview.

19.5 Delimited Text Plugin

The Delimited Text plugin allows you to load a delimited text file as a layer in QGIS.

19.5.1 Requirements

To view a delimited text file as layer, the text file must contain:

1. A delimited header row of field names. This must be the first line in the text file.

2. The header row must contain an X and Y field. These fields can have any name.

3. The x and y coordinates must be specified as a number. The coordinate system is not important.

As an example of a valid text file we import the elevation point data file elevp.csv coming with the QGIS
sample dataset (See Section Dados de exemplo):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Some items of note about the text file are:

1. The example text file uses ; (semicolon) as delimiter. Any character can be used to delimit the fields.

2. The first row is the header row. It contains the fields X, Y and ELEV.

3. No quotes (") are used to delimit text fields.

4. The x coordinates are contained in the X field.

5. The y coordinates are contained in the Y field.
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19.5.2 Using the Plugin

To use the plugin you must first enable it as described in Section Gerenciar Complementos.

Click the new toolbar icon Add Delimited Text Layer to open the Delimited Text dialog as shown in fig-
ure_delimited_text_1.

Figura 19.5: Delimited Text Dialog

First select the file (e.g., qgis_sample_data/csv/elevp.csv) to import by clicking on the [Browse]
button. Once the file is selected, the plugin attempts to parse the file using the last used delimiter, in this case a
semicolon (;). To properly parse the file, it is important to select the correct delimiter. To change the delimiter to
tab use \t (this is a regular expression for the tab character).

Once the file is parsed, choose the X and Y fields from the dropdown lists and if available also the WKT field for
the CRS information. Finally enter a Layer name (e.g., elevp ) as shown in figure_delimited_text_1 . To add the
layer to the map, click [OK]. The delimited text file now behaves as any other map layer in QGIS.

19.6 Diagram Overlay Plugin

The Diagram Overlay Plugin allows you to add a graphic overlay to a vector layer (see figure_overlay_1). It
provides additional and not yet implemented features to the Diagrams tab, described in secion Diagrams Tab.

Before starting, the Diagram Overlay Plugin needs to be activated using the Plugin Manager (see Section Carregar
um complemento interno). It will then appear as Overlay tab in the Layer Properties dialog next to the Diagrams
tab.

The Overlay tab provides support for Pie charts, Bar charts and proportional SVG symbols.
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Figura 19.6: Vector properties dialog with overlay tab

Similar to the Diagrams tab, we will demonstrate an example and overlay the alaska boundary layer a piechart
diagram showing some temperature data from a climate vector layer. Both vector layers are part of the QGIS
sample dataset (see Section Dados de exemplo).

1. First click on the Load Vector icon, browse to the QGIS sample dataset folder and load the two vector
shape layers alaska.shp and climate.shp.

2. Double click the climate layer in the map legend to open the Layer Properties dialog.

3. Click on the Overlay tab, activate Display diagrams and select ‘Pie Chart’ from Diagram type
combobox.

4. We want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN. First select
T_F_JAN as Attributes and click the [Add] button, then T_F_JUL and finally T_F_MEAN.

5. Diagram size is based on linear scaling of a classification attribute. We choose T_F_JUL, click on [Find

maximum value] and set size to 20 and Size unit to ‘Millimeter’.

6. Now click [Apply] to display the diagram in the QGIS main window.

7. You can now adapt the chart size, or change the attribute colors double clicking on the color values in the
attribute field. Figure_overlay_2 gives an impression.

8. Finally click [Ok].

Additionally in the Settings → Options dialog, there is a Overlay tab where it is possible to select the placement
algorithm of the diagrams. The ‘Central point’ method is a generic one, the others use algorithms of the PAL
library. They also consider diagram objects and labels in different layers.

19.7 Dxf2Shp Converter Plugin

The dxf2shape converter plugin can be used to convert vector data from DXF to Shapefile format. It requires the
following parameters to be specified before running:

• Input DXF file: Enter path to the DXF file to be converted

• Output Shp file: Enter desired name of the Shapefile to be created
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Figura 19.7: Pie chart diagram from temperature data overlayed on a map

Figura 19.8: Dxf2Shape Converter Plugin
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• Output file type: Specify the geometry type of the output Shapefile. Currently supported types are polyline,
polygon, and point.

• Export text labels: When this checkbox is enabled, an additional Shapefile point layer will be created, and
the associated dbf table will contain information about the “TEXT” fields found in the dxf file, and the text
strings themselves.

19.7.1 Using the Plugin

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see Section Carregar um complemento

interno) and click on the Dxf2Shape Converter icon which appears in the QGIS toolbar menu. The Dxf2Shape
plugin dialog appears as shown in Figure_dxf2shape_1.

2. Enter input DXF file, a name for the output Shapefile and the Shapefile type.

3. Enable the Export text labels checkbox if you want to create an extra point layer with labels.

4. Click [OK].

19.8 Complemento eVis

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) (this section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0)
User’s Guide. American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.) has developed the Event Visualiza-
tion Tool (eVis), another software tool to add to the suite of conservation monitoring and decision support tools for
guiding protected area and landscape planning. This plugin enables users to easily link geocoded (i.e., referenced
with latitude and longitude or X and Y coordinates) photographs, and other supporting documents, to vector data
in QGIS.

eVis agora é automaticamente instalado e habilitado nas novas versões do QGIS, e como acontece com todos
os complementos, ele pode ser desativado e ativado usando o Gerenciador de Complementos (Veja: ref: Geren-
ciar_Complementos).

The eVis plugin is made up of three modules: the ‘Database Connection tool’, ‘Event ID tool’, and the ‘Event
Browser’. These work together to allow viewing of geocoded photographs and other documents that are linked to
features stored in vector files, databases, or spreadsheets.

19.8.1 Navegador de Evento

O módulo Navegador de Evento fornece a funcionalidade para exibir fotografias georreferenciadas que estão
ligadas a características vetoriais exibidas na janela de mapa do QGIS. Dados pontuais, por exemplo, pode ser a
partir de um arquivo vetorial que pode ser introduzido utilizando o QGIS ou pode ser a partir do resultado de uma
consulta a base de dados. O recurso vetor deve ter informações de atributo associado a ele para descrever o local e
o nome do arquivo que contém a fotografia e, opcionalmente, a direção que estava apontada a bússola da câmera
quando a imagem foi adquirida. Sua camada de vetor deve ser carregada no QGIS antes de executar o Navegador
de Evento.

Iniciando o módulo Navegador de Evento

To launch the Event browser module either click on the eVis Event Browser icon or click on Database → eVis →
eVis Event Browser. This will open the Generic Event Browser window.

The Generic Event Browser window has three tabs displayed at the top of the window. The Display tab is used
to view the photograph and its associated attribute data. The Options tab provides a number of settings that can
be adjusted to control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to
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maintain a table of file extensions and their associated application to allow eVis to display documents other than
images.

Entendendo a Janela de Exibição

To see the Display window click on the Display tab in the Generic Event Browser window. The Display window
is used to view geocoded photographs and their associated attribute data.

Figura 19.9: The eVis display window

1. Display window: A window where the photograph will appear.

2. Zoom in button: Zoom in to see more detail. If the entire image cannot be displayed in the display window,
scroll bars will appear on the left and bottom sides of the window to allow you to pan around the image.

3. Zoom out button: Zoom out to see more area.

4. Zoom to full extent button: Displays the full extent of the photograph.

5. ** Janela informações de atributo **: Todas as informações de atributo para o ponto associado com a
fotografia que está sendo visualizada é apresentada aqui. Se o tipo de arquivo que está sendo referenciado
no registro exibido não é uma imagem, mas é de um tipo de arquivo definido no: guilabel: Configurar
aplicações externas guia então quando você clicar duas vezes sobre o valor do campo que contém o caminho
para o arquivo, o aplicativo para abrir o arquivo será lançado para ver ou ouvir o conteúdo do arquivo. Se a
extensão do arquivo é reconhecida os dados dos atributos serão exibidos em verde.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.

7. ** Indicador de Recurso **: Este título indica qual função está sendo exibida e quantos recursos estão
disponíveis para exibição.

Entendendo a janela Opções

1. File path: A dropdown list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path then the checkbox must
be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
about the different options for specifying the file location are noted in the section Especificando o local e o
nome de uma fotografia below.
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Figura 19.10: The eVis Options window

2. ** Campo de exibição rumo bússola **: Uma lista suspensa para especificar o campo de atributo que contém
o rumo associado com a fotografia que está sendo exibido. Se as informações de bússola estão disponíveis,
é necessário clicar na caixa de seleção à esquerda do título do menu suspenso.

3. ** Compensar bússola Configuração **: Deslocamentos bússola pode ser usado para compensar a decli-
nação (ajustar rumos coletados utilizando rumos magnéticos para rumos norte verdadeiro). Clique no |
radiobuttonon |: guilabel: ‘manual’ botão de opção para entrar o deslocamento na caixa de texto ou clique
no | radiobuttonon |: guilabel: ‘Do Atributo ‘botão de opção para selecionar o campo de atributo que contém
os deslocamentos. Para ambas opções, declinações leste deve ser digitado valores positivos e declinações
oeste devem usar valores negativos.

4. Caminho Diretório base: O caminho de base para que o caminho relativo definido no Figure_eVis_2 (A)
será anexado.

5. Substitua o caminho: Se esta opção estiver marcada, somente o nome do arquivo A será anexado ao
caminho de base.

6. Aplicar regra a todos os documentos: Se marcado, as mesmas regras de caminho que são definidas para
as fotografias serão usadas para os documentos não-imagem, como filmes, documentos de texto e arquivos
de som. Se não marcado as regras de caminho só se aplica a fotografias e outros documentos ignorará o
parâmetro Caminho base.

7. Salve as configurações: Se esta opção estiver marcada, os valores dos parâmetros associados serão salvos
para a próxima sessão, quando a janela é fechada ou quando o botão [Salvar] abaixo é pressionado.

8. Redefinir valores: Redefine os valores nesta linha para a configuração padrão.

9. Restaure falhas **: Isso redefinirá todos os campos para suas configurações padrão. Ele tem o mesmo
efeito que clicar em todos os botões **[Redefinir].

10. Save: This will save the settings without closing the Options pane.

Entendendo a janela Configurar Aplicações Externas

1. **Arquivo tabela de referência **: Uma tabela contendo os tipos de arquivos que podem ser abertos usando
eVis. Cada tipo de arquivo tem uma extensão de arquivo e o caminho para um aplicativo poder abrí-lo. Isso
fornece a capacidade de abrir uma ampla gama de arquivos como filmes, gravações sonoras, e documentos
de texto em vez de apenas imagens.

2. Adicionar novo tipo de arquivo: Adicionar um novo tipo de arquivo com uma extensão única e o caminho
para o aplicativo poder abrí-lo.
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Figura 19.11: The eVis External Applications window

3. ** Excluir linha atual **: Exclui o tipo de arquivo em destaque na tabela e definido por uma extensão de
arquivo e um caminho para um aplicativo associado.

19.8.2 Especificando o local e o nome de uma fotografia

O local e o nome da fotografia podem ser armazenados usando um caminho absoluto ou relativo ou um URL
(Uniform Resource Locator em português Localizador-Padrão de Recursos) se a fotografia está disponível em um
servidor web. Exemplos das diferentes abordagens estão listadas na Tabela eVis_exemplos ‘‘ _.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinform.org/testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.test.com/attach.php?attachment_id-12 76

19.8.3 Especificando o local e o nome de outros documentos suportados

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis.
To do this it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon, and is particularly useful for accessing documents from Wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

19.8.4 Usando o Navegador de Evento

When the Event Browser window opens a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided then an arrow
will appear pointing in the direction indicated by the value in the compass bearing display field in the Generic
Event Browser window. The arrow will be centered over the point that is associated with the photograph or other
document.

To close the Generic Event Browser window click on the [Close] button from the Display window.
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19.8.5 Ferramenta ID de Evento

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name
of the file containing the photograph and optionally the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Iniciando o módulo Identificação de Evento

To launch the ‘Event ID’ module either click on the Event ID icon or click on Plugins → eVis → Event ID Tool.
This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Generic
Event Browser window is opened and the photographs on or near the clicked locality are available for display
in the browser. If more than one photograph is available, you can cycle through the different features using the
[Previous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

19.8.6 Conexão com o Base de Dados

The ‘Database Connection’ module provides tools to connect to and query a database or other ODBC resource,
such as a spreadsheet.

eVis pode se conectar diretamente a quatro tipos de bases de dados: Microsoft Access, PostgreSQL, MySQL,
SQLite, e também pode ler a partir de conexões ODBC. Ao ler a partir de uma base de dados ODBC (como uma
planilha do Excel) é necessário configurar o driver ODBC para o sistema operacional que você está usando.

Iniciando o módulo Conexão com a Base de Dados

To launch the ‘Database Connection’ module either click on the appropriate icon eVis Database Connection or click
on Plugins → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Conectar a uma base de dados

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combobox to select the type of database that you want to connect to. If a password or username is
required, that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected “MS Access” as
the database type. If the database resides on your desktop you should enter “localhost”.

Enter the name of the database in the Database Name textbox. If you selected “ODBC” as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established you will need to check that the correct parameters were entered above.

1. Tipo de Base de dados: Uma lista suspensa para especificar o tipo de base de dados que será usado.

2. Base de dados hospedeiro: O nome da base de dados hospedeiro.

3. Port The port number if a MySQL or PostgreSQL database type is selected.

4. Nome da Base de Dados O nome da base de dados.
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Figura 19.12: The eVis Database connection window

5. Conectar Um botão para conectar-se a banco de dados usando os parâmetros definidos acima.

6. Console de Saída A janela do console onde as mensagens relacionadas ao processamento são exibidos.

7. Nome de Usuário: Nome de usuário para uso quando uma base de dados é protegida por senha.

8. Senha: Senha para uso quando uma base de dados é protegida por senha.

9. Consultas pré-definidas: Guia para abrir a janela “Consultas pré-definidas”.

10. **Conexão com a base de dados **: Guia para abrir a janela “Conexão com a Base de dados”.

11. Consulta SQL: Guia para abrir a janela “Consulta SQL”.

12. Ajuda: Exibe a ajuda on line.

13. OK: Fecha a janela principal do “Conexão com a Base de Dados”.

Execução de consultas SQL

Consultas SQL são usadas para extrair informações de uma base de dados ou de recursos ODBC. Em eVis a
saída dessas consultas é uma camada vetorial adicionado à janela de mapa do QGIS. Clique no: guilabel: guia
Consultas SQL para exibir a interface de consulta SQL. Comandos SQL podem ser inseridos nesta janela de texto.
Um tutorial útil em comandos SQL está disponível em http://www.w3schools.com/sql. Por exemplo, para extrair
todos os dados de uma planilha em um arquivo do Excel, ‘‘ Selecione * de [Plan1 $] ‘‘, onde ‘‘ Plan1 ‘‘ é o nome
da planilha.

Click on the [Run Query] button to execute the command. If the query is successful a Database File Selection
window will be displayed. If the query is not successful an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. Janela de Texto de Consulta SQL: Uma tela para escrever consultas SQL.
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Figura 19.13: The eVis SQL query tab

2. Run Query: Button to execute the query entered in the SQL Query Window.

3. Janela Console: A janela console onde as mensagens relacionadas ao processamento são exibidas.

4. Ajuda: Exibe a ajuda on line.

5. OK: Closes the main Database Connection window.

Use the X Coordinate and Y Coordinate comboboxes to select the field from the database that
store the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Dica: Criando uma camada vetorial a partir de uma planilha do Microsoft Excel
When creating a vector layer from a Microsoft Excel Worksheet you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data.This can be caused by deleting the values for these cells
in Excel using the Backspace key. To correct this problem you need to open the Excel file (you’ll need to close
QGIS if there if you are connected to the file to allow you to edit the file) and then use Edit → Delete to remove
the blank rows from the file. To avoid this problem you can simply delete several rows in the Excel Worksheet
using Edit → Delete before saving the file.

Executando consultas pré-definidas

Com consultas predefinidas você pode selecionar consultas previamente escritas e armazenadas no formato XML
em um arquivo. Isto é particularmente útil se você não estiver familiarizado com os comandos SQL. Clique no:
guilabel: guia ‘Consultas Predefinidas’ para exibir a interface de consulta prédefinida.

To load a set of predefined queries click on the Open File icon. This opens the Open File window which is used
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to locate the file containing the SQL queries. When the queries are loaded their titles, as defined in the XML
file, will appear in the dropdown menu located just below the Open File icon, the full description of the query is
displayed in the text window under the dropdown menu.

Selecione a consulta que você deseja executar no menu suspenso e, então clique em: guilabel: guia Consulta SQL
para ver se a consulta foi carregada na janela Consulta. Se for a primeira vez que você estiver executando uma
consulta predefinida ou estiver migrando bancos de dados, você precisa ter certeza de estar conectado ao banco de
dados.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful a
Database File Selection window will be displayed. If the query is not successful an error message will appear in
the Output Console window.

Figura 19.14: The eVis Predefined queries tab

1. ** Abrir Arquivo de Consulta **: Inicia o “Abrir Arquivo”, buscador de arquivos para procurar o arquivo
XML explorando as consultas pré-definidas.

2. ** Consultas predefinidas **: Uma lista suspensa com todas as consultas definidas pelo arquivo consultas
prédefinidas XML.

3. Consulta descrição: Uma breve descrição da consulta. Esta descrição é do arquivo consultas prédefinida
XML.

4. Janela Console: A janela console onde as mensagens relacionadas ao processamento são exibidas.

5. Ajuda: Exibe a ajuda on line.

6. OK: Fecha a janela principal do “Conexão com a Base de Dados”.

Formato XML para consultas predefinidas eVis

As marcas XML lidas por eVis
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Marcas Descrição
Consulta Define o início e o fim de uma instrução de consulta.
Descrição Breve Uma breve descrição da consulta que aparece no menu suspenso eVis.
Descrição Uma descrição mais detalhada da consulta exibida na janela de texto Consulta

Predefinida.
Tipo de Base de
Dados

O tipo base de dados, conforme definido no menu suspenso Tipo de Base de Dados na
guia Conexão Base de Dados.

Porta da Base de
Dados

A porta conforme definido na caixa de texto Porta na guia Conexão com a Base de
Dados.

Nome da Base de
Dados

O nome da base de dados, conforme definido na caixa de texto Nome da Base de Dados
na guia Conexão com a Base de Dados.

Nome de Usuário
da Base de Dados

O nome de usuário da base de dados, conforme definido na caixa de texto Nome de
usuário na guia Conexão com a Base de Dados.

Senha de Base de
Dados

A senha da base de dados, conforme definido na caixa de texto Senha na guia Conexão
com a Base de Dados.

Instrução SQL O comando SQL.
autoconexão A bandeira (“verdadeira” “ou” falsa ”) para especificar se as marcas acima devem ser

usadas para conectar-se automaticamente à base de dados sem executar a rotina de
conexão com a base de dados na guia Conexão com a Base de Dados.

Um exemplo de arquivo XML completo com três consultas é exibido abaixo:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
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<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

19.9 Complemento fTools

O objetivo do complemento python fTools é fornecer recursos para tarefas muito comuns baseadas em vetores de
SIGs, sem a necessidade de softwares adicionais, bibliotecas, ou soluções complexas. Ele fornece um conjunto
cada vez maior de funções de gerenciamento de dados espaciais e análises rápidas e funcionais.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (See Section Carregar um complemento interno). When enabled,
the fTools plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to
Geometry and Geoprocessing Tools, as well as several useful Data Management Tools.

19.9.1 Analysis tools

ÍconeFerramenta Finalidade

Matris de
distância

Medir distâncias entre dois pontos de uma camada, os resultados saem como a)
matriz de distâncias quadrada, b) matriz de distância linear, ou c) Síntese de
distâncias. Pode limitar distâncias com as características mais próximas de k.

Soma de
comprimento
de linhas

Calcular a soma total dos comprimentos das linhas para cada polígono de uma
camada vetorial do tipo polígono.

Pontos no
polígono

Conta o número de pontos que existem em cada polígono de uma camada de entrada
do tipo vetorial poligonal.

Lista valores
únicos

Listar todos os valores exclusivos de um campo de uma camada vetorial de entrada

Estatísticas
básicas

Calcular estatísticas básicas (média, std dev, N, soma, CV) em um campo de
entrada.

Vizinho mais
próximo

Calcular estatísticas com vizinho mais próximo para avaliar o nível de agrupamento
em uma camada vetorial do tipo ponto

Coordenada(s)
média(s)

Calcular o centro médio ponderado normal ou inteiro de uma camada vetorial, ou de
várias feições com base em um campo exclusivo de identificação.

Interseções de
linhas

Localizar cruzamentos entre as linhas, e as feições de uma outra shapefile. Útil para
localizar cruzamentos ou fluxo, ignora cruzamentos de linha com comprimento > 0.

Table Ftools 1: Ferramentas de análise fTools
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19.9.2 Research tools

Ícone Ferramenta Finalidade

Seleção aleatória Selecionar aleatoriamente um número n de recursos, ou n percentual de
recursos

Seleção aleatória
dentro de
subconjuntos

Selecionar aleatoriamente feições dentro de subconjuntos com base em um
campo exclusivo de identificação.

Pontos aleatórios Gerar pseudo-pontos aleatórios sobre uma camada de entrada.

Pontos regulares Gerar uma grade regular de pontos ao longo de uma região determinada e
exportá-los como um shapefile de pontos.

Grade vetorial Gerar uma grade do tipo linha ou polígono com base no espaçamento da grade
especificado pelo usuário.

Selecionar pela
localização

Selecionar feições com base na sua localização em relação a uma outra
camada, para formar uma nova seleção, adicionar ou subtrair da seleção atual.

Polígono a partir da
extensão da camada

Criar uma camada com um único polígono retangular a partir da extensão de
uma camada de entrada raster ou vetorial.

Tabela fTools 2: Ferramentas de Pesquisa fTools

19.9.3 Geoprocessing tools

Ícone Ferra-
menta

Finalidade

Forma(s)
convexa(s)

Criar o mínimo de forma(s) convexas em uma camada de entrada, ou com base em um
campo de ID.

Buffer(s) Criar buffer(s) em torno de feições com base em distâncias, ou em um campo de
distância.

Interseção Intersectar sobreposição de camadas de forma que a saída contém áreas onde ambas as
camadas se cruzam.

União Sobreposição de camadas de forma que a saída contém a interseção e não-interseção de
áreas.

Diferença
simétrica

Sobreposição de camadas de forma que a saída contém tanto as áreas que não se
intersectam da entrada e das camadas de diferença.

Cortar Sobreposição de camadas de forma que a saída contém áreas que se cruzam a camada
de corte.

Diferença Sobreposição de camadas de forma que a saída contém áreas que não cruzam a camada
de corte.

Dissolver Mesclar feições com base no campo de entrada. Todas as feições com valores idênticos
de entrada são combinadas para formar uma única feição.

Tabela fTools 3: Ferramentas de Geoprocessamento fTools
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19.9.4 Geometry tools

Ícone Ferramenta Finalidade

Verificar a validade de
geometrias

Verifica as interseções de polígonos, fechando espaços e corrigindo nós.

Exportar/Adicionar
geometrias de colunas

Adicionar Informações de geometrias vetoriais em camadas do tipo ponto
(xCoord, yCoord), linha (comprimento), ou polígono (área, perímetro).

Centróides de
polígonos

Calcular os centróides reais para cada polígono em uma camada de entrada
do tipo polígono.

Triangulação de
Delaunay

Calcular a triangulação de Delaunay de uma camada vetorial (como do tipo
polígono) de entrada.

Polígonos de Voronoi Calcular polígonos de Voronoi de uma camada vetorial de entrada.

Simplificar
geometrias

Generalizar linhas ou polígonos com o algoritmo de Douglas-Peucker.

Densify geometry Densify lines or polygons by adding vertices

Densificar geometrias Converter feições de várias partes para feições de partes individuais . Cria
polígonos e linhas simples.

Multipartes para
partes simples

Mesclar várias feições para uma única feição multipartes baseada em um
campo exclusivo de identificação.

Polígonos para linhas Converte polígonos para linhas, polígonos multipartes para várias linhas de
partes únicas.

Linhas para polígonos Converte linhas para polígonos, linhas multipartes para polígonos de partes
simples.

Extração de nós Extrair nós de camadas do tipo linhas e polígonos, de forma a resultar
camadas de pontos.

Tabela fTools 4: ferramentas de Geometrias fTools

Nota: A ferramenta Simplificar geometria pode ser usada para remover nós duplicados em linha e geometrias
poligonais, basta definir o parâmetro tolerância de simplificação como 0, isso vai fazer o truque.

19.9.5 Data management tools

ÍconeFerramenta Finalidade

Definir
projeção

Especificar o SRC para o arquivo shape cujo SRC não foi definido.

Unir atributos
por
localização

Unir atributos adicionais a camada vetorial com base na relação espacial. Os
atributos de uma camada vetorial são anexados à tabela de atributos de uma outra
camada e exportados como um shapefile.

Dividir
camada
vetorial

Dividir uma camada de entrada em várias outras camadas distintas com base em um
campo de entrada.

Merge
shapefiles to
one

Merge several shapefiles within a folder into a new shapefile based on the layer type
(point, line, area).

Create spatial
index

Create a spatial index for OGR supported formats.

Tabela fTools 5: ferramentas de gerenciamento de dados fTools
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19.10 Ferramentas do complemento GDAL

19.10.1 O que é o GDALTools?

The GDAL Tools plugin offers a GUI to the collection of tools in the Geospatial Data Abstraction Library,
http://gdal.osgeo.org . These are raster management tools to query, re-project, warp and merge a wide variety
of raster formats. Also included are tools to create a contour (vector) layer, or a shaded relief from a raster DEM,
and to make a vrt (Virtual Raster Tile in XML format) from a collection of one or more raster files. These tools
are available when the plugin is installed and activated.

A Biblioteca GDAL

A biblioteca GDAL consiste em um conjunto de programas de linha de comando, cada uma com uma grande
lista de opções. Usuários familiarisados com a execução de comandos em um terminal podem preferir a linha
de comando, tendo acesso ao conjunto completo de opções. O complemento GDALTools oferece uma interface
intuitiva para as ferramentas, expondo apenas as opções mais populares.

19.10.2 List of GDAL tools

Figura 19.15: The GDALTools menu list

Projections

Warp
(Reproject)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information you can read on the GDAL
website http://www.gdal.org/gdalwarp.html

Assign
projection

This tool allows to assign projection to rasters that already georeferenced but miss projection
information. Also with it help it is possible to alter existing projection definition. Both single
file and batch mode are supported. For more information please visit utility page at GDAL site
http://www.gdal.org/gdalwarp.html

Extract
projection

This utility helps you to extract projection information from an input file. If you want to
extract projection from a whole directory you can use the Batch mode. It creates both .prj
and .wld files.
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Conversion

Rasterize
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided. For
more information see http://www.gdal.org/gdal_rasterize.html

Poly-
gonize

This utility creates vector polygons for all connected regions of pixels in the raster sharing a
common pixel value. Each polygon is created with an attribute indicating the pixel value of that
polygon. The utility will create the output vector datasource if it does not already exist,
defaulting to ESRI shapefile format. See also http://www.gdal.org/gdal_polygonize.html

Translate
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsettings, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html

RGB
to PCT

This utility will compute an optimal pseudo-color table for a given RGB image using a median
cut algorithm on a downsampled RGB histogram. Then it converts the image into a
pseudo-colored image using the color table. This conversion utilizes Floyd-Steinberg dithering
(error diffusion) to maximize output image visual quality. The utility is also desribed at
http://www.gdal.org/rgb2pct.html

PCT
to RGB

This utility will convert a pseudocolor band on the input file into an output RGB file of the
desired format. For more information see http://www.gdal.org/pct2rgb.html

Extraction

Con-
tour

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html you can find more information.

Clip-
per

This utility allows to clip (extract subset) raster using selected extent or based on mask layer
bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analysis

Sieve This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be written
back to the existing raster band, or copied into a new file. For more information see
http://www.gdal.org/gdal_sieve.html .

Near
Black

This utility will scan an image and try to set all pixels that are nearly black (or nearly white)
around the edge to exactly black (or white). This is often used to “fix up” lossy compressed
aerial photos so that color pixels can be treated as transparent when mosaicing. See also
http://www.gdal.org/nearblack.html .

Fill
nodata

This utility fills selection raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the area. On http://www.gdal.org/gdal_fillnodata.html you can
find more information.

Proximity This utility generates a raster proximity map indicating the distance from the center of each
pixel to the center of the nearest pixel identified as a target pixel. Target pixels are those in
the source raster for which the raster pixel value is in the set of target pixel values. For more
information see http://www.gdal.org/gdal_proximity.html .

Grid This utility creates regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, you can choose from
various interpolation methods. The utility is also described on the GDAL website
http://www.gdal.org/gdal_grid.html .

DEM
terrain
models

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a color
relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness map from
any GDAL-supported elevation raster. For more information you can read on
http://www.gdal.org/gdaldem.html

Miscellaneous

Build
Virtual
Raster

This program builds a VRT (Virtual Dataset) that is a mosaic of the list of input gdal datasets.
See also http://www.gdal.org/gdalbuildvrt.html .

Merge This utility will automatically mosaic a set of images. All the images must be in the same
coordinate system and have a matching number of bands, but they may be overlapping, and at
different resolutions. In areas of overlap, the last image will be copied over earlier ones. The
utility is also described on http://www.gdal.org/gdal_merge.html .

Information
This utility lists various information about a GDAL supported raster dataset. On
http://www.gdal.org/gdalinfo.html you can find more information.

Build
Overviews

The gdaladdo utility can be used to build or rebuild overview images for most supported file
formats with one of several downsampling algorithms. For more information see
http://www.gdal.org/gdaladdo.html .

Tile
Index

This utility builds a shapefile with a record for each input raster file, an attribute containing
the filename, and a polygon geometry outlining the raster. See also
http://www.gdal.org/gdaltindex.html .
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19.11 Complemento Georreferenciador

O complemento Georreferenciador permite georreferenciar imagens rasters para um sistema de coordenadas ge-
ográficas ou projetadas (métricas), através da criação de uma nova imagem GeoTiff ou através da adição de um
arquivo world com extensão PRJ à imagem existente. A maneira básica para georreferenciar uma imagem raster
consiste em localizar pontos no arquivo, cujas coordenadas possam ser determinadas com a maior acurácia pos-
sível.

Recursos

Ícone Propósito Ícone Propósito

Abrir Raster Iniciar georreferenciamento

Gerar scrip GDAL Carregar pontos GCP

Salvar pontos GCP como Configurações de transformação

Adicionar ponto Excluir ponto

Mover ponto GCP Movimentar

Aproximar Afastar

Ver a camada Última visualização

Próxima visualização Conectar georreferenciador ao QGIS

Conectar QGIS ao Georreferenciador

Tabela Georreferenciador 1: Ferramentas do georreferenciador.

19.11.1 Procedimento comum

Para inserir as coordenadas – Lat/Long (geográficas) ou X e Y (cartesianas) em pontos selecionados, para realizar
o georreferenciamento da imagem, dois procedimentos podem ser aplicados:

• A própria imagem raster pode algumas vezes fornecer/apresentar interseções entre meridianos e paralelos da
grade, com coordenadas expressas na imagem. Neste caso, pode-se inserir “manualmente” as coordenadas.

• Utilizar camadas já georreferenciados – podendo ser arquivos vetoriais ou raster – que contenham os mes-
mos objetos/feições existentes na imagem que deverá ser georreferenciada. Por exemplo, podemos utilizar
as coordenadas de cruzamentos de vias e também vértices de polígonos, como de edificações ou lotes ur-
banos utilizando-os como pontos (coordenadas) adequados.

O procedimento habitual para o georreferenciamento de uma imagem consiste em selecionar múltiplos pontos no
raster, especificar suas coordenadas e escolher o tipo de transformação mais apropriado para o arquivo. Baseado
nos dados e parâmetros de entrada, o complemento irá computar os parâmetros do arquivo world ou então criar
um novo GeoTIFF. Quanto mais pontos de controle (coordenadas) forem informados, melhor será o resultado do
processo.

O primeiro passo é iniciar o QGIS, carregar o Complemento Georreferenciador (ver Seção Carregar um com-

plemento interno) e clicar no ícone Georreferenciador icon which appears in the QGIS toolbar menu. A caixa de
diálogo Complemento Georreferenciador aparece como mostra a figure_georeferencer_1.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized to-
gether with the data from the GRASS spearfish60 location. You can download the topo sheet here:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.
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Figura 19.16: Georeferencer Plugin Dialog

Entrando com pontos de controle GCPs (Ground Control Points)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Clique em determinado ponto da imagem raster e entre com suas coordenadas X e Y manualmente.

• Clique em um determinado ponto da imagem raster e escolha o botão from map canvas para adicionar
as coordenadas a partir de uma camada já georreferenciada, previamente carregada na tela do QGIS.

• Com o botão é possível mover os pontos GCP em ambas as janelas, caso algum deles esteja no
lugar errado.

3. Continue inserindo os pontos de controle. São necessários no mínimo 4 pontos (espalhados pelas 4 pontas da
imagem), e quanto mais pontos (coordenadas) forem adicionados, melhor será o resultado obtido. Existem
ferramentas adicionais na caixa de diálogo do complemento para usar o zoom e pan na tela a fim de que seja
possível localizar um conjunto de possíveis GCPs.

Figura 19.17: Add points to the raster image

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
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points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP Points and Save GCP Points buttons to manage the files.

Within the GCP table you can click on a column header and therewith enable e.g. numerical sorting. The GCP list
is automatically updated.

Definindo as configurações de transformação

Depois que os pontos GCP estão devidamente adicionados à imagem raster, é necessário definir as configurações
de transformação para o processo de georreferenciamento.

Figura 19.18: Defining the georeferencer transformation settings

Algoritmos de transformação disponíveis

Dependendo da quantidade de pontos de controle capturados, será possível a utilização de diferentes algoritmos de
transformação. A escolha de um desses algoritmos também depende do tipo e da qualidade dos dados de entrada
inseridos e a quantidade de distorção geométrica que se está disposto a introduzir no resultado final.

Atualmente, os seguintes algoritmos estão disponíveis:

• O algoritmo Linear é utilizado para criar um arquivo world, sendo diferentes dos demais uma vez que não
transforma o raster verdadeiramente. Este algoritmo provavelmente não será suficiente para aqueles que
estão trabalhando com imagens digitalizadas.

• A transformação Helmert realiza transformações simples de escala e rotação.

• Os algoritmos Polinomiais 1-3 estão entre os algoritmos mais amplamente aplicados para georreferencia-
mento, cada um diferindo no grau de distorção introduzido para combinar os pontos de controle da fonte e do
destino. Destes, o mais utilizado é o algoritmo de transformação polinomial de segunda ordem, que permite
alguma curvatura. A transformação polinomial de primeira ordem (affine – afim) preserva a colinearidade
e permite apenas escala, translação e rotação.

• O algoritmo Suavizador em Lâminas Finas (Thin Plate Spline – TPS) é um método moderno de geor-
referenciamento, que é capaz de introduzir deformações locais na imagem. Este algoritmo é útil quando se
está georreferenciado arquivos originais de qualidade muito baixa.

• A transformação Projetiva consiste na rotação linear e na translação de coordenadas.
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Definindo o método de reamostragem

The type of resampling you choose will likely depending on your input data and the ultimate objective of the
exercise. If you don’t want to change statistics of the image, you might want to choose ‘Nearest neighbour’,
whereas a ‘Cubic resampling’ will likely provide a more smoothed result.

No QGIS, é possível escolher entre 5 diferentes métodos de reamostragem:

1. Vizinho mais próximo

2. Linear

3. Cúbico

4. Cúbico suavizado

5. Lanczos

Definindo as configurações de transformação

Existem várias opções que devem ser definidas para o arquivo raster (georreferenciado) de saída.

• The checkbox Create world file is only available, if you decide to use the linear transformation type,
because this means that the raster image actually won’t be transformed. In this case, the field Output raster
is not activated, because only a new world-file will be created.

• For all other transformation type you have to define an Output raster. As default a new file ([file-
name]_modified) will be created in the same folder together with the original raster image.

• As a next step you have to define the Target SRS (Spatial Reference System) for the georeferenced raster
(see section Trabalhando com Projeções).

• Também é possível gerar um mapa em pdf e também um Relatório pdf. O relatório inclui informações
sobre os parâmetros de transformação utilizados, além de uma imagem dos resíduos e uma lista com todos
os GCPs e seus erros RMS.

• Além disso, é possível ativar a caixa de diálogo Acertar a definição de saída e definir a resolução dos
pixels do raster de saída. Como padrão, as resoluções horizontal e vertical são iguais a 1.

• A caixa Use 0 para transparência quando necessário pode ser ativada, caso os pixels com valor 0 devam
ser visualizados como transparentes.

• Finalmente, marcando Carregar no QGIS quando concluído, o raster de saída será automaticamente
carregado na tela do QGIS depois que a transformação for concluída.

Mostrando e adaptando as propriedades do raster

Clicando no menu Propriedades do raster dialog in the Settings abrirá a caixa de diálogo com as propriedades do
raster que será georreferenciado.

Configurando o georreferenciador

• É possível definir a visualização ou não das coordenadas GCPs e/ou IDs.

• Podem ser definidas como unidades residuais pixels e unidades do mapa.

• Para o relatório PDF podem ser definidas as margens direita e esquerda e também o tamanho do papel para
o mapa PDF.

• Por último, também pode-se ativar a caixa Mostrar a janela do Georreferenciador ancorada
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Iniciando a transformação

After all GCPs have been collected and all transformation settings are defined, just press the button
Start georeferencing to create the new georeferenced raster.

19.12 Complemento de Interpolação

O Complemento de Interpolação pode ser utilizado para gerar uma interpolação TIN ou IDW de uma camada
de vetores de pontos. É muito simples de lidar e fornece uma interface gráfica de usuário intuitiva para criar
camadas raster interpoladas. (See Figure_interpolation_1). O complemento requer a especificação dos seguintes
parâmetros antes de ser executado:

• Input vector layer: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combobox.

• Atributos da interpolação: Selecione uma coluna de atributo para ser usada na interpolação ou habilite a

opção Usar Coordenada-Z para usar os valores de Z armazenados nas camadas.

• Interpolation Method: Select interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’.

• Número de colunas/linhas: Define o número de linhas e colunas do arquivo raster de saida.

• Arquivo de Saída: Define o nome do arquivo raster de saída.

Figura 19.19: Interpolation Plugin

19.12.1 Using the plugin

1. Inicie o QGIS e carregue uma camada de vetor de pontos (p. ex., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see Section Carregar um complemento interno) and

click on the Interpolation icon which appears in the QGIS toolbar menu. The Interpolation plugin dialog
appears as shown in Figure_interpolation_1.

3. Selecione uma camada de entrada (p. ex., elevp’ |selectstring|) e a coluna (p. ex., ‘‘ELEV‘) para interpo-
lação.

4. Select an interpolation method (e.g. ‘Triangulated Irregular Network (TIN)’), and specify a cellsize of 5000
as well as the raster output filename (e.g., elevation_tin).

232 Capítulo 19. Complementos



QGIS User Guide, Versão 1.8

5. Clique [OK].

6. For the current example, double click elevation_tin in the layer list to open the raster Layer Properties

dialog and select ‘Pseudocolor’ as Color Map in the Symbology tab. Or you can define a new color
table as described in section Trabalhando com dados Raster.

19.13 Complemento de exportação do MapServer

Você pode usar o QGIS para ‘compor’ o seu mapa, adicionando e organizando camadas, simbolizando-as, person-
alizando as cores e, em seguida, criar um arquivo de mapa para o MapServer.

Nota: Currently the plugin only works when you use ‘Old Symbology’ in QGIS. ‘New Symbology’ is not yet
supported.

19.13.1 Criando o arquivo de projeto

O complemento de exportação do MapServer opera em um arquivo de projeto salvo no QGIS e ** não ** sobre o
conteúdo atual da tela do mapa e da legenda. Isto tem confundido um grande número de utilizadores. Conforme
descrito abaixo, antes de você começar a usar o complemento de exportação do MapServer, você precisa organizar
as camadas raster e vetoriais que deseja usar no MapServer e salvar esse status em um arquivo de projeto do QGIS.

Figura 19.20: Arrange raster and vector layers for QGIS project file

Neste exemplo, demonstramos os quatro passos necessários para criar um arquivo de projeto simples, que pode
ser utilizado para criar o arquivo de mapa MapServer. Usamos arquivos raster e arquivos vetoriais a partir do
conjunto de dados amostrais QGIS: ref: label_sampledata.

1. Adicionar a camada raster: file:landcover.tif clicando no ícone Adicionar Camada Raster | mActionAd-
dRasterLayer |: sup:.

2. Adicione os arquivos vetoriais: file: lakes.shp,: file: majrivers.shp e: file: airports.shp a partir do conjunto
de dados amostrais QGIS clicando no ícone Adicionar Camada Vetorial | mActionAddNonDbLayer |: sup:.

3. Change the colors and symbolize the data as you like (for example see figure_mapserver_export_1)

4. Save a new project named mapserverproject.qgs using File → Save Project.
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19.13.2 Criando o arquivo de mapa

Para usar o complemento de exportação a partir do QGIS Mapserver, você precisa habilitar primeiro o comple-
mento de exportação do MapServer usando o Gerenciador de complementos (veja: ref: load_core_plugin).

Figura 19.21: Export to MapServer Dialog

Arquivo de
Mapa

Digite o nome para o arquivo de mapa que esta sendo criado. Você pode usar o botão à direita
para navegar até o diretório onde você deseja que o arquivo do mapa seja criado.

Arquivo de
projeto Qgis

Digite o caminho completo para o arquivo de projeto QGIS (. QGS) que deseja exportar.
Você pode usar o botão à direita para procurar o arquivo de projeto QGIS.

Nome do
mapa

Um nome para o mapa. Este nome é prefixado para todas as imagens geradas pelo
MapServer.

Largura do
mapa

Largura da imagem de saída em pixels.

Altura do
mapa

Altura da imagem de saída em pixels.

Unidades do
Mapa

Unidades de medida utilizadas para a saída.

Tipo de
Imagem

Formato para a imagem de saída gerada pelo MapServer

Modelo da
Web

Caminho completo para o arquivo de modelo MapServer para ser usado com o arquivo de
mapa

Cabeçalho
da web

Caminho completo para o arquivo de cabeçalho do MapServer para ser usado com o arquivo
de mapa

Rodapé da
web

Caminho completo para o arquivo de rodapé do MapServer para ser usado com o arquivo de
mapa

Apenas as entradas: guilabel: arquivo de mapa e: guilabel: arquivo de projeto QGIS são necessárias para criar
um arquivo de mapa, no entanto, omitindo os outros parâmetros, você pode acabar criando um arquivo de mapa
não-funcional, dependendo da sua intenção de uso. Embora o QGIS seja bom em criar um mapa do seu ar-
quivo de projeto, pode exigir alguns ajustes para obter os resultados desejados. Para este exemplo, vamos criar
um arquivo de mapa usando o arquivo de projeto: file: mapserverproject.qgs que acabamos de criar (ver Fig-
ure_mapserver_export_2):

1. Clique no ícone Exportador do MapServer | mapserver_export |: sup: no menu da barra de ferramentas para
iniciar o diálogo MapServer (ver Figure_mapserver_export_2).

2. Digite um nome para o seu novo arquivo de mapa (por exemplo: file: qgisproject.map).
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3. Procure e localize o arquivo de projeto QGIS que você salvou anteriormente (ex.: file: mapserverpro-
ject.qgs).

4. Digite um nome para o mapa (por exemplo, ‘‘ MyMap ‘‘).

5. Digite a largura e a altura para a sua imagem de saída (por exemplo, 600 para a largura e 400 para a altura).

6. Para este exemplo, as camadas são em metros, portanto, mudar as unidades para metros.

7. Escolha: guilabel: ‘png’ para o tipo de imagem.

8. Clique ** [OK] ** para gerar o novo arquivo do mapa: file: qgisproject.map. QGIS mostra o sucesso de
seus esforços.

Figura 19.22: Export to MapServer Succesfull Dialog

Você pode visualizar o arquivo de mapa em qualquer visualizador ou editor de texto. Se você der uma olhada,
você vai notar que a ferramenta de exportação agrega os metadados necessários para habilitar o nosso arquivo de
mapa para WMS.

19.13.3 Solução de problemas

If you get error messages from mapserver like:

loadSymbolSet(): Unable to access file. (./symbols/symbols.txt)

or:

msLoadFontset(): Unable to access file. Error opening fontset ./fonts/fonts.txt.

Isso significa que o arquivo de mapa está solicitando como fontes ou arquivos de símbolo que o Mapserver não
consegue encontrar.

Either comment the lines containing those names in the map file (this is possible if you do not have labels or use
styles from the symbols.txt). Or create those files (see below).

The most simple fonts.txt file (because arial is used in the QGIS generated map files) contains the following
line

# either relative to the map file or a full path:
arial /usr/share/fonts/truetype/msttcorefonts/arial.ttf

The most simple symbols.txt file contains the definition of a circle symbol (because a circle symbol is used
for point layers)

SYMBOLSET
SYMBOL
NAME "circle"
TYPE ellipse
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FILLED true
POINTS
1 1
END
END

END

19.13.4 Testando o arquivo de mapa

Agora podemos testar o nosso trabalho.

Se o arquivo do mapa é acessível para o seu mapserver cgi você pode usar um dos urls do diálogo de sucesso.

Outra opção é usar a ferramenta shp2img para criar uma imagem a partir do arquivo do mapa. O **shp2img **
utilitário é parte do MapServer e FWTools. Para criar uma imagem do nosso mapa:

• Abra uma janela de terminal

• Se você não salvou o arquivo de mapa em seu diretório principal, mude para a pasta onde você salvou.

• Executar ‘‘ shp2img-m qgisproject.map-o MapServer _test.png ‘‘ e exibir a imagem

This creates a PNG with all the layers included in the QGIS project file. In addition, the extent of the PNG will be
the same as when we saved the project. As you can see in figure_mapserver_export_4, all information except the
airport symbols are included.

Figura 19.23: Test PNG created by shp2img with all MapServer Export layers

19.13.5 Usando o arquivo do mapa

If you plan to use the map file to serve WMS requests, you probably don’t have to tweak anything. If you plan to
use it with a mapping template or a custom interface, you may have a bit of manual work to do. To see how easy
it is to go from QGIS to serving maps on the web, take a look at Christopher Schmidt’s 5 minute flash video. He
used an older version of QGIS (version 0.8), but the demo applies equally well to newer versions.
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19.14 Complemento Edição Offline

Para a coleta de dados, que é uma situação comum de trabalhar com um laptop ou um telefone celular offline
em campo. Ao retornar para a rede, as mudanças precisam ser sincronizados com a fonte de dados mestre,
por exemplo, um banco de dados PostGIS. Se várias pessoas estão trabalhando simultaneamente nos mesmos
conjuntos de dados, é difícil de fundir as edições manualmente, mesmo que as pessoas não mudem as mesmas
feições.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

19.14.1 Using the plugin

• Abra algumas camadas de vetor, por exemplo de um PostGIS ou WFS-T datasource

• Salve elas em um projeto

• Press the Convert to offline project icon and select the layers to save. The content of the layers is saved to
SpatiaLite tables.

• Editar as camadas offline.

• After being connected again, upload the changes with the Synchronize button.

Figura 19.24: Create an offline project from PostGIS or WFS layers

19.15 Complemento Oracle GeoRaster

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the OracleGeoRasterPlugin is supported by GDAL, and depends on Oracle’s database product
being installed and working on your machine. While Oracle is proprietary software, they provide their software
free for development and testing purposes. Here is one simple example of how to load raster images to GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

This will load the raster into the default GDAL_IMPORT table, as a column named RASTER.
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19.15.1 Gerenciando conexões

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Section Carregar um comple-
mento interno). The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database

that contains the data. To do this, begin by clicking on the Select GeoRaster toolbar button, it will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Name: Enter a name for the database connection

• Database instance: Enter the name of the database that you will connect to

• Username: Specify your own username that you will use to access the database

• Password: The password associated with your username that is required to access the database

Figura 19.25: Create Oracle connection dialog

Now, back on the main Oracle Spatial GeoRaster dialog window (see Figure_oracle_raster_2), use the drop-down
list to choose one connection, and use the [Connect] button to establish a connection. You may also [Edit] the
connection by opening the previous dialog and making changes to the connection information, or use the [Delete]
button to remove the connection from the drop-down list.

19.15.2 Selecionando um GeoRaster

Uma vez a conexão estabelecida, a janela de subconjunto de dados mostra os nomes de todas as tabelas que contêm
colunas GeoRaster naquele banco de dados no formato de um nome de subconjunto de dados GDAL.

Clique em um dos subconjuntos de dados listados e em seguida clique em [Selecione] para escolher um nome de
tabela. Agora outra lista de subconjunto de dados vai ser mostrada com os nomes de colunas GeoRaster naquela
tabela. É geralmente uma lista pequena, já que a maioria dos usuários não terá mais do que uma ou duas colunas
GeoRaster na mesma tabela.

Clique em um dos subconjuntos de dados e aí clique em [Selecione] para escolher uma das combinações da
tabela/coluna. A janela não mostrará todas as linhas que contêm objetos GeoRaster. Note que a lista de subcon-
junto de dados não mostrará a Tabela de Dados Raster e pares de Raster Id’s.

A qualquer momento a entrada de Seleção pode ser editada a fim de ir diretamente a um GeoRaster conhecido ou
voltar ao início e selecionar outro nome de tabela.

A entrada dos dados de Seleção pode ser também utilizada para introduzir uma cláusula onde no fim
da série de identificação, e.g. geor:scott/tiger@orcl,gdal_import,raster,geoid=. Ver
http://www.gdal.org/frmt_georaster.html para mais informações.
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Figura 19.26: Select Oracle GeoRaster dialog

19.15.3 Mostrando GeoRaster

Finalmente, selecionando um GeoRaster da lista de Tabela de Dados Raster e Raster Id’s, a imagem raster vai
carregar no QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and next time it opens it will keep the same
connection, and will show the same previous list of subdataset making it very easy to open up another image from
the same context.

Nota: GeoRasters que contêm pirâmides serão exibidos mais rapidamente, mas as pirâmides precisam ser geradas
fora do uso de QGIS usando Oracle PL/SQL ou gdaladdo.

The following is example using gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 \
-r nearest 2 4 6 8 16 32

This is an example using PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

19.16 Raster Terrain Analysis Plugin

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (See Figure_raster_terrain_1).

Descrição da análise:
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• Declive: Calcula o ângulo de declive para cada célula em graus (baseado na estimativa da derivada de
primeira ordem).

• Aspecto: Exposição (começando de 0 na direção norte, em graus antihorário).

• Hillshade: Create shaded map using light and shadow to provide a more three-dimensional appearance for
a shaded relief map.

• Ruggedness Index: A quantitative measurement of terrain heterogeneity as described by Riley et al. (1999).
It is calculated for every location, by summarizing the change in elevation within the 3x3 pixel grid.

• Relief: Creating a shaded relief map from digital elevation data. Implemented is a method to choose the
elevation colors analysing the frequency distribution.

Figura 19.27: Raster Terrain Modelling Plugin (slope calculation)

19.16.1 Usando o complemento

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Load the Raster Terrain Analysis plugin in the Plugin Manager (see Section Carregar um complemento
interno)

3. Select an analysis method from menu (e.g. Raster → Terrain Analysis → Slope). The Slope dialog appears
as shown in Figure_raster_terrain_1.

4. Especifique um caminho para o arquivo de saída, e um tipo de arquivo de saída.

5. Clique [OK].

19.17 Complemento de Mapa de Calor

O Complemento do Mapa de Calor permite criar um mapa de calor a partir de um ponto no mapa vetor. Um mapa de
calor é um mapa de bits mostrando a densidade ou magnitude de informações de pontos relacionados. A partir
dos resultados, “pontos quentes” podem ser facilmente identificados.

19.17.1 Ativando o complemento do Mapa de Calor

Primeiro esse complemento central precisa ser ativado usando o Administrador de Complemento (ver
seção’:ref:´carregamento_núcleo_complemento´). Depois o ícone de ativação do mapa de calor |mapa de calor|
pode ser encontrado na Barra de Ferramentas Raster.
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Select from menu View → Toolbars → Raster to activate the Raster Toolbar when it is not yet activated.

19.17.2 Usando o complemento de Mapa de Calor

The Heatmap toolbutton starts the dialog of the Heatmap plugin (see figure_heatmap_2).

A janela apresenta as seguintes opções:

• Input Point Vector dialog: Provides a selection of loaded point vector maps.

• Output Raster: Using the button you select the folder and the name of the output raster the Heatmap
plugin will generate. It is not necessary to give a file extension

• Output Format: Selection of the output format. Although all formats supported by GDAL can be choosen,
GeoTIFF is most in cases the best format to choose.

• Raio: pode ser usado para dar o alcance em metros ou unidade de mapeamento. Quando o raio escolhido é
muito pequeno, você não conseguirá um bom Mapa de Calor. Em lugares onde mais círculos ao redor dos
pontos se contrapôem, pontos quentes mais brilhantes irão ocorrer!

• Decaimento da Proporção: é usado para mostrar com qual proporção o calor desaparece do centro.

– When 0 is given (=minimum) the heat will be concentrated in the centre of given radius and be com-
pletely extinguished at the edge.

– Quando o valor 10 é dado (=máximo) o calor é concentrado na extremidade e completamente extinto
no centro. Valores mais altos são permitidos, mas não tem nenhum efeito.

– When 1 is given the heat is spread evenly over the whole circle.

– Quando uma decaimento de proporção negativa é gerada, você irá criar um Mapa Frio ao invés de um
Mapa de Calor!

Quando a |checkbox: :guilabel: Caixa de verificação avançada é marcada esta permitirá acesso a opções adicionais
avançadas.

• Row and Column, can be used to change the pixelsize of the output raster. More rows and colums means
a smaller pixelsize and the size of the output file will become bigger and processing a bit slower. When
doubling the number of rows this will automatically double the size of Columns and the cell sizes will also
be halved. The area of the output raster will remain the same!

• Tamanho da célula X **e **tamanho da célula Y influencia no tamanho dos pixels do raster de saída e
também muda as linhas e colunas.

A camada de ponto vetor pode ter campos de características que podem ser usados para criar mapas de calor:

• Use raio do campo: o raio se estabelece de um campo de atributos.

• Use peso do campo: o fator peso se estabelece de um campo de atributos.

Quando o raster de saída é dado, o botão [OK] pode ser usado para criar o mapa de calor. O primeiro resultado
será uma superfície cinza que ainda precisará de um tratamento adicional para se transformar em um mapa de
calor.

Aviso: Mudando as propriedades do tamanho do raster
Ao mudar as propriedades de tamanho do raster, você também mudará o resultado produzido. As áreas de
pontos quentes se tornarão maiores.

19.17.3 Criando um Mapa de Calor

Para o exemplo seguinte, nos usaremos o aeroporto de camadas de vetores de ponto QGIS amostra conjunto
de dados (ver Dados de exemplo). Outro excelente tutorial de QGIS para fazer mapas de calor pode ser encontrado
em http://qgis.spatialthoughts.com.
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Na Figure_Heatmap 1_ os aeroportos do Alaska são mostrados.

Figura 19.28: Airports of Alaska

1. Selecione o botão de ferramenta Mapa de Calor. A janela Mapa de Calor começa (ver Figure_Heatmap_2).

2. In field Input Point Vector select airpoirt from the list of point layers loaded in current project.

3. In field Output Raster give the name and location using the button of the output raster. Give the
output raster file the name heatmap_airports to give an file extension is not necessary.

4. No campo Formato Saída selecione GeoTIFF.

5. No campo Raio gera 1000000 metros.

6. O original Decaimento de Proporção de 0.1 está bom.

7. Clique em [OK] para criar e carregar o novo mapa raster (ver Figure_Heatmap_3).

Figura 19.29: The Heatmap Dialog

O resultado depois de carregar o Mapa de Calor não será provavelmente o resultado esperado.Ainda será uma
superfície lisa cinza sem nehuma variação. Primeiro algumas configurações adicionais dessa camada precisam ser
feitas para fazer o Mapa de Calor aparecer.

1. Open the properties dialog of layer heatmap_airports (select the layer heatmap_airports, open
context menu with right mouse button and select Properties).
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Figura 19.30: The heatmap after loading looks like a grey surface

2. Select the Symbology tab.

3. Change Color map from ‘Grayscale’ to ‘Pseudocolor’.

4. Press the [Apply] button.

5. Switch to the Transparency tab and set Global transparency to 40%.

6. Selecione [OK]

O resultado final pode ser visto na Figura_Heatmap_4-.

Figura 19.31: Final result of heatmap created of airports of Alaska

19.18 Compemento Caminho Mais Curto

O complemento Caminho Mais Curto é um complemento C++ para o QGIS, que calcula o caminho mais curto
entre dois pontos em qualquer camada de polilinha e desenha este caminho sobre a rede rodoviária.

Main features:

• calcular o caminho, seu comprimento e a duração das viagens
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Figura 19.32: Road Graph Plugin

• otimizar pelo comprimento ou pelo tempo de viagem

• exportar caminho para uma camada vetorial

• destaque direções de estradas (isso é lento e utilizado principalmente para fins de depuração e para o teste
de configurações)

Como uma camada de estradas que você pode usar qualquer camada de vetor polilinha em qualquer formato
suportado pelo QGIS. Duas linhas com um ponto em comum são consideradas conectadas. Por favor, note que
é necessário para usar SRC da camada como SRC do projeto durante a edição de camada de estradas. Isto é
devido ao fato de recalcular as coordenadas entre diferentes SRC introduzir alguns erros que podem resultar em
descontinuidades, mesmo quando “atração” é usado.

Na tabela de atributos da camada os campos que se seguem podem ser usados:

• velocidade no trecho de estrada — campo numérico;

• direction — any type, that can be casted to string. Forward and reverse directions are correspond to the
one-way road, both directions — two-way road

If some fields don’t have any value or do not exist — default values are used. You can change defaults and some
plugin settings in plugin settings dialog.

19.18.1 Using the plugin

After plugin activation you will see an additional panel on the left side of the main QGIS window. Now make
some definitions to the Road graph plugin settings dialog in the menu Vector → Road Graph.

Selecione um ponto inicial e um final na camada da rede viária e clique em ** [Calcular] **.

19.19 Plugin de Consulta Espacial

O plugin de Consulta Espacial permite fazer uma consulta espacial(selecionar feições) em uma camada com refer-
ência em outra. Este plugin é baseado na biblioteca GEOS e depende de ter uma camada fonte selecionada.

Operações possíveis:

• Contém

• Igual

• Sobrepõe
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• Cruza

• Intersecta

• Disjunto

• Toca

• Dentro

19.19.1 Using the plugin

Como exemplo, queremos encontrar as feições da camada Alaska que contenham aeroportos. Os seguintes passos
são necessários:

1. Inici o QGIS e abra os seguintes vetores:file:regions.shp e airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see Section Carregar um complemento interno) and

click on the Spatial Query icon which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Selecione a camada regions como fonte e a camada airports como referência.

4. Selecione a operação ‘Contém’ e clique em [Apply].

Now you get a list of feature IDs from the query and you have several options as shown in figure_spatial_query_1.

• Clique em Criar camada a partir dos itens selecionados

• Selecione um ID na lista e clique em Criar camada a partir da seleção

• Select the ‘Remove from current selection’ in the field And use the result to .

• adicionalmente você pode Aproximar do Item ou exibir o Registro de mensagens.

Figura 19.33: Spatial Query analysis - regions contain airports

19.20 Complemento SPIT

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins
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menu, check the box next to the SPIT plugin and click [OK]. The SPIT icon will be added to the plugin
toolbar.

To import a shapefile, click on the SPIT tool in the toolbar to open the SPIT - Shapefile to PostGIS Import
Tool dialog. Select the PostGIS database you want to connect to and click on [Connect]. If you want, you can
define or change some import options. Now you can add one or more files to the queue by clicking on the [Add]
button. To process the files, click on the [OK] button. The progress of the import as well as any errors/warnings
will be displayed as each shapefile is processed.

Figura 19.34: Using SPIT Plugin to import Shape files to PostGIS

Dica: Importing Shapefiles Containing PostgreSQL Reserved Words
If a shapefile is added to the queue containing fields that are reserved words in the PostgreSQL database a dialog
will popup showing the status of each field. You can edit the field names prior to import and change any that are
reserved words (or change any other field names as desired). Attempting to import a shapefile with reserved words
as field names will likely fail.

19.21 Complemento SQL Anywhere

SQL Anywhere é um sistema de gerenciamento de banco de dados relacional de propriedade (RDBMS) da Sybase.
SQL Anywhere inclui suporte espacial, incluindo OGC, arquivos shape etc. e construído em funções para exportar
para KML, GML e formatos SVG.

Figura 19.35: SQL Anywhere dialog (KDE)

The SQL Anywhere allows to connect to spatialy enabled SQL Anywhere databases. The Add SQL Anywhere
layer dialog is similar in functionality to the dialogs for PostGIS and SpatiaLite.
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19.22 Complemento Estatística Zonal

With the Zonal Statistics Plugin you can analyze the results of a thematic classification. It allows to calculate several
values of the pixels of a raster layer with the help of a polygonal vector layer (see figure_zonal_statistics). You can
calculate the sum, the mean value and the total count of the pixels that are within a polygon. The plugin generates
output columns in the vector layer with a user-defined prefix.

Figura 19.36: Zonal statistics dialog (KDE)
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CAPÍTULO 20

Ajuda e Suporte

20.1 Listas de Discurssão

QGIS está em desenvolvimento ativo e como tal ele nem sempre funciona como você esperaria. O caminho
preferido para obter ajuda é se juntando à lista de discurssão dos usuários de QGIS. Suas dúvidas chegarão a um
público maior e as respostas beneficiará outros usuários.

20.1.1 Usuários QGIS

Esta lista é utilizada para discurssão do QGIS em geral, bem como sobre questões específicas em relação à in-
stalaçao e uso. Você pode se inscrever na lista de discurssão dos usuário de QGIS visitando a seguinte URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 Lista fossgis-talk

Para o público de língua alemã, o alemão FOSSGIS e.V. fornece a lista de discussão fossgis-talk. Esta lista de
discussão é utilizada para o debate de SIG de código aberto em geral incluindo QGIS. Você pode se inscrever para
a lista fossgis-talk visitando a seguinte URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 Desenvolvedor QGIS

Se você é um desenvolvedor enfrentando problemas de natureza mais técnica, você pode querer se juntar a lista
de discussão qgis-desenvolvedor aqui: http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 Atualizações QGIS

Cada vez que uma atualização é realizada no repositório de código QGIS um email é enviado para esta lista. Se
você quer ser informado das atualizações de todas as mudanças da código base atual, você pode se inscrever nesta
lista: http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 QGIS-trac

Esta lista fornece uma notificação de email relacionado a gerenciamento de projetos, incluindo re-
latórios de bugs, tarefas e solicitações de recursos. Você pode se inscrever para esta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 Equipe da Comunidade QGIS

Esta lista trata de temas como a documentação, ajuda de contexto, guia do usuário, experiência online incluindo
sítios, blog, listas de discussão, fóruns e esforços de tradução. Se você gosta de trabalhar com o guia do usuário,
esta lista é um bom ponto de partida para fazer suas perguntas. Você pode se inscrever para esta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 Equipe de lançamento QGIS

Esta lista inclui tópicos como o processo de lançamento, pacotes binários para vários Sistemas Opera-
cionais e anúncios de novos lançamentos para o mundo em geral. Você pode se inscrever nesta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 Tradução do QGIS

Esta lista trata dos esforços de tradução. Se você gosta de trabalhar na tradução dos manuais ou na interface gráfica
do usuário (GUI), esta lista é um bom ponto de partida para fazer suas perguntas. Você pode se inscrever nesta
lista em: http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 Aprendizado QGIS

Esta lista trata dos esforços de Aprendizado do QGIS. Se você gosta de trabalhar com materiais de aprendizado
do QGIS, esta lista é um bom ponto de partida para fazer suas perguntas. Você pode se inscrever nesta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 Comitê Diretor QGIS

Esta lista é usada para discutir com o Comitê Diretor questões relacionadas com a gestão e direcionamento do
Quantum GIS. Você pode se inscrever nesta lista em: http://lists.osgeo.org/mailman/listinfo/qgis-psc

Você está convidado a se inscrever em qualquer uma das listas. Por favor, lembre-se de contribuir com a lista
respondendo a perguntas e compartilhando suas experiências. Note que os links das listas Atualizações QGIS e
QGIS-trac são projetados apenas para notificação e não destinado a postagens de usuários.

20.2 IRC

Nós também marcamos presença no IRC - visite-nos acessando o canal # qgis em irc.freenode.net. Por favor,
aguarde pela resposta de sua pergunta. Como muitas pessoas no canal estão fazendo outras atividades isso pode
levar um tempo para para perceberem sua pergunta. O suporte comercial para o QGIS também está disponível.
Confira no site: http://qgis.org/en/commercial-support.html para mais informações.

Se você perdeu uma discussão no IRC, não é problema! Nós gravamos todas as discussões para que você possa
acessá-las facilmente. Basta acessar http://logs.qgis.org e ler os registros do IRC.

20.3 Rastreador de Erros

Emquanto a lista de discussão de usuários QGIS é útil para perguntas do tipo “como eu faço XYZ no QGIS” , você
poderá nos informar sobre erros no QGIS. Você pode enviar relatórios de erros usando o Rastreador de Erros do
QGIS em http://hub.qgis.org/projects/quantum-gis/issues. Quando criar uma nova mensagem de erro, por favor,
forneça um endereço de email onde possamos solicitar informações adicionais.
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Por favor, tenha em mente que o erro nem sempre é avaliado com a prioridade que você desejaria (dependendo de
sua gravidade). Alguns erros podem requerer um esforço significativo dos desenvolvedores para solucioná-lo e a
mão de obra não está sempre disponível para isso.

Solicitações de recursos também podem ser enviadas usando o mesmo sistema de mensagem de erros. Por favor,
certifique-se de ter selecionado o tipo de recurso.

Se você encontrou algum erro e conseguiu fixá-lo você pode enviar esta correção também.Novamente, o adorável
sistema de mensagens da redmine em http://hub.qgis.org/projects/quantum-gis/issues faz isso muito bem. Vá em
“correção fornecida” marque e anexe sua correção antes de enviar o erro. Algum desenvolvedores irá analisá-lo
e aplicá-lo no QGIS. Por favor não se assuste se a sua correção não é aplicada de imediato — desenvolvedores
podem estar ocupados com outros compromissos.

20.4 Blog

A comunidade QGIS também mantém um weblog em http://www.qgis.org/planet que tem alguns artigos interes-
santes para usuários e desenvolvedores bem como fornecido por outros blogs da comunidade. Você está convidado
a contribuir no blog do QGIS!

20.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

20.6 Wiki

Por fim, nós mantemos um site wiki em http://hub.qgis.org/projects/quantum-gis/wiki onde você pode encontrar
uma variedade de informações úteis relacionadas com o desenvolvimento em QGIS, planos de lançamento, links
para sites de download, tradução de mensagens, dicas e assim por diante. Confira, há coisas interessantes por lá!
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CAPÍTULO 21

Apêndice

21.1 GNU General Public License

Versão 2, Junho 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Qualquer pessoa tem permissão para copiar e distribuir cópias fiéis deste documento de licença, mas modifica-lo
não é permitido.

Preâmbulo

As licenças para a maioria dos softwares são projetadas para tirar a sua liberdade de compartilhar e modifica-
los. Por outro lado, a GNU (Licença Publica Geral) tem o objetivo de garantir a sua liberdade de compartilhar
e modificar softwares livres para garantir que o software seja gratuito para todos os seus usuários. Estal Licença
Publica Geral se aplica a maioria dos softwares da Fundação de Softwares Livres e a qualquer outro programa cujo
autor venha a utiliza-la. (Outros softwares da Fundaçao de Softwares Livres estão cobertos pela GNU Biblioteca
Licença Publica Geral.) Você pode aplica-la aos seus programas também.

Quando falamos em softwares livres, nos referimos a liberdade, não preço. Nossa Licença Publica Geral é proje-
tada para garantir: que você tenha liberdade de compartilhar cópias do software livre (e cobrar por este serviço, se
desejar) que você recebeu o código fonte ou pode adquirir se quiser; que você possa modificar o software ou usar
partes dele em novos softwares livres; que você saiba que pode fazer tais coisas.

Para proteger os seus direitos nós precisamos fazer restrições que proibem qualquer pessoa a negar a você tais
direitos ou a pedir que se renda a eles.Estas restriçoes se traduzem em certas responsabilidades para você, se você
distribuir ou modificar cópias do software.

Por exemplo, se você distribuir cópias de determinado programa, seja ele gratis ou por uma taxa, você deve dar
aos beneficiários todos os direitos que você tem. Você deve garantir que eles também recebam ou possam acessar
o codigo fonte.E você deve mostrar a eles estes termos para que eles saibam seus direitos.

Nós protegemos seus direitos com dois passos: (1) direitos autorais do software, e (2) oferecemos a você esta
licença que lhe dá a permissão legal para copiar, distruibuir e/ou modificar o software.

Também, para a proteção nossa e de cada autor, nós queremos garantir que todos compreendam que não há garantia
para este software livre. Se o software for modificado por outra pessoa e passado adiante, os beneficiários devem
saber que oque eles tem não é o software original, para que, qualquer problema introduzido por outros não reflita
na reputaçao do autor original.

Por fim, qualquer programa livre é constantemente ameaçado por patentes de softwares. Nós queremos evitar o
risco de que redistribuidores de um programa livre obtenham licenças individuais, fazendo assim do programa
proprietário. Para prevenir isso, nós deixamos claro que qualquer patente deve ser licenciada para o uso livre de
todas as pessoas.

Seguem os precisos termos e condições para cópia, ditribuiçao e modificaçao. TERMOS E CONDIÇÕES PARA
CÓPIA, DISTRIBUIÇAO E MODIFICAÇÃO
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0. Esta licença se aplica a qualquer programa ou outro trabalho que contenha um aviso inserido pelo detentor
dos direitos autorais informando que o mesmo pode ser distribuído sob as condições desta Licença Pública
Geral.O “Programa” abaixo refere-se a qualquer programa ou trabalho, e “trabalho baseado no Programa”
significa tanto o Programa em si como quaisquer trabalhos derivados, de acordo com a lei de direitos au-
torais: isto quer dizer um trabalho que contenha o Programa ou parte dele, tanto originalmente ou com
modificações, e/ou tradução para outros idiomas. (Doravante o processo de tradução está incluído sem
limites no termo “modificação”.) Cada licenciado é mencionado como “você”.

Atividades outras que a cópia, a distribuição e modificação não estão cobertas por esta Licença; elas estão
fora de seu escopo. O ato de executar o Programa não é restringido e o resultado do Programa é coberto ape-
nas se seu conteúdo contenha trabalhos baseados no Programa (independentemente de terem sido gerados
pela execução do Programa). Se isso é verdadeiro depende do que o programa faz.

1. Você pode copiar e distribuir cópias fiéis do código-fonte do Programa da mesma forma que você o recebeu,
usando qualquer meio, deste que você conspícua e apropriadamente publique em cada cópia um aviso de
direitos autorais e uma declaração de inexistência de garantias; mantenha intactas todos os avisos que se
referem a esta Licença e à ausência total de garantias; e forneça a outros recebedores do Programa uma
cópia desta Licença, junto com o Programa.

Você pode cobrar uma taxa pelo ato físico de transferir uma cópia e pode, opcionalmente, oferecer garantia
em troca de pagamento.

2. Você pode modificar sua cópia ou cópias do Programa, ou qualquer parte dele, assim gerando um trabalho
baseado no Programa, e copiar e distribuir essas modificações ou trabalhos sob os termos da seção 1 acima,
desde que você também se enquadre em todas estas condições:

(a) Você tem que fazer com que os arquivos modificados levem avisos proeminentes afirmando que você
alterou os arquivos, incluindo a data de qualquer alteração.

(b) Você tem que fazer com que quaisquer trabalhos que você distribua ou publique, e que integralmente
ou em partes contenham ou sejam derivados do Programa ou de suas partes, sejam licenciados, inte-
gralmente e sem custo algum para quaisquer terceirose, sob os termos desta Licnça.

(c) Se qualquer programa modificado normalmente lê comandos interativamente quando executados, você
tem que fazer com que, quando iniciado tal uso interativo da forma mais simples, seja impresso ou
mostrado um anúncio de que não há qualquer garantia (ou então que você fornece a garantia) e que
os usuários podem redistribuir o programa sob estas condições, ainda informando os usuários como
consultar uma cópia desta Licença. (Exceção: se o Programa em si é interativo mas normalmente não
imprime estes tipos de anúncios, seu trabalho baseado no Programa não precisa imprimir um anúncio.)

Estas exigências aplicam-se ao trabalho modificado como um todo. Se seções identificáveis de tal trabalho
não são derivadas do Programa, e podem ser razoavelmente consideradas trabalhos independentes e sepa-
rados por si só, então esta Licença, e seus termos, não se aplicam a estas seções quando você distribui-las
como trabalhos em separado. Mas quando você distribuir as mesmas seções como parte de um todo que
é trabalho baseado no Programa, a distribuição como um todo tem que se enquadrar nos termos desta Li-
cença, cujas permissões para outros licenciados se estendem ao todo, portanto também para cada e toda
parte independente de quem a escreveu.

Desta forma, esta seção não tem a intenção de reclamar direitos os contestar seus direitos sobre o trabalho es-
crito completamente por você; ao invés disso, a intenção é a de exercitar o direito de controlar a distribuição
de trabalhos, derivados ou coletivos, baseados no Programa.

Adicionalmente, a mera adição ao Programa de outro trabalho não baseado no Programa (ou de trabalho
baseado no Programa) em um volume de armazenamento ou meio de distribuição não faz o outro trabalho
parte do escopo desta Licença.

3. Você pode copiar e distribuir o Programa (ou trabalho baseado nele, conforme descrito na Seção 2) em
código-objeto ou em forma executável sob os termos das Seções 1 e 2 acima, desde que você faça um dos
seguintes:

(a) O acompanhe com o código-fonte completo e em forma acessível por máquinas, que tem que ser
distribuído sob os termos das Seções 1 e 2 acima e em meio normalmente utilizado para o intercâmbio
de software; ou,
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(b) O acompanhe com uma oferta escrita, válida por pelo menos três anos, de fornecer a qualquer um, com
um custo não superior ao custo de distribuição física do material, uma cópia do código-fonte completo
e em forma acessível por máquinas, que tem que ser distribuído sob os termos das Seções 1 e 2 acima
e em meio normalmente utilizado para o intercâmbio de software; ou,

(c) O acompanhe com a informação que você recebeu em relação à oferta de distribuição do código-
fonte correspondente. (Esta alternativa é permitida somente em distribuição não comerciais, e apenas
se você recebeu o programa em forma de código-objeto ou executável, com oferta de acordo com a
Subseção b acima.)

O código-fonte de um trabalho corresponde à forma de trabalho preferida para se fazer modificações. Para
um trabalho em forma executável, o código-fonte completo significa todo o código-fonte de todos os módu-
los que ele contém, mais quaisquer arquivos de definição de “interface”, mais os “scripts” utilizados para se
controlar a compilação e a instalação do executável. Contudo, como exceção especial, o código-fonte dis-
tribuído não precisa incluir qualquer componente normalmente distribuído (tanto em forma original quanto
binária) com os maiores componentes (o compilador, o “kernel” etc.) do sistema operacional sob o qual o
executável funciona, a menos que o componente em si acompanhe o executável.

Se a distribuição do executável ou código-objeto é feita através da oferta de acesso a cópias de algum lugar,
então ofertar o acesso equivalente a cópia, do mesmo lugar, do código-fonte equivale à distribuição do
código-fonte, mesmo que terceiros não sejam compelidos a copiar o código-fonte com o código-objeto.

4. Você não pode copiar, modificar, sub-licenciar ou distribuir o Programa, exceto de acordo com as condições
expressas nesta Licença. Qualquer outra tentativa de cópia, modificação, sub-licenciamento ou distribuição
do Programa não é valida, e cancelará automaticamente os direitos que lhe foram fornecidos por esta Li-
cença. No entanto, terceiros que de você receberam cópias ou direitos, fornecidos sob os termos desta
Licença, não terão suas licenças terminadas, desde que permaneçam em total concordância com ela.

5. Você não é obrigado a aceitar esta Licença já que não a assinou. No entanto, nada mais o dará permissão
para modificar ou distribuir o Programa ou trabalhos derivados deste. Estas ações são proibidas por lei, caso
você não aceite esta Licença. Desta forma, ao modificar ou distribuir o Programa (ou qualquer trabalho
derivado do Programa), você estará indicando sua total aceitação desta Licença para fazê-los, e todos os
seus termos e condições para copiar, distribuir ou modificar o Programa, ou trabalhos baseados nele.

6. Cada vez que você redistribuir o Programa (ou qualquer trabalho baseado nele), os recebedores adquirirão
automaticamente do licenciador original uma licença para copiar, distribuir ou modificar o Programa, su-
jeitos a estes termos e condições. Você não poderá impor aos recebedores qualquer outra restrição ao
exercício dos direitos então adquiridos. Você não é responsável em garantir a concordância de terceiros a
esta Licença.

7. Se, em conseqüência de decisões judiciais ou alegações de infringimento de patentes ou quaisquer outras
razões (não limitadas a assuntos relacionados a patentes), condições forem impostas a você (por ordem
judicial, acordos ou outras formas) e que contradigam as condições desta Licença, elas não o livram das
condições desta Licença. Se você não puder distribuir de forma a satisfazer simultaneamente suas obri-
gações para com esta Licença e para com as outras obrigações pertinentes, então como conseqüência você
não poderá distribuir o Programa. Por exemplo, se uma licença de patente não permitirá a redistribuição,
livre de “royalties”, do Programa, por todos aqueles que receberem cópias direta ou indiretamente de você,
então a única forma de você satisfazer a ela e a esta Licença seria a de desistir completamente de distribuir
o Programa.

Se qualquer parte desta seção for considerada inválida ou não aplicável em qualquer circunstância particular,
o restante da seção se aplica, e a seção como um todo se aplica em outras circunstâncias.

O propósito desta seção não é o de induzi-lo a infringir quaisquer patentes ou reivindicação de direitos de
propriedade outros, ou a contestar a validade de quaisquer dessas reivindicações; esta seção tem como único
propósito proteger a integridade dos sistemas de distribuição de software livres, o que é implementado pela
prática de licenças públicas. Várias pessoas têm contribuído generosamente e em grande escala para os
software distribuídos usando este sistema, na certeza de que sua aplicação é feita de forma consistente; fica
a critério do autor/doador decidir se ele ou ela está disposto a distribuir software utilizando outro sistema, e
um licenciado não pode impor esta escolha.

Esta seção destina-se a tornar bastante claro o que se acredita ser conseqüência do restante desta Licença.
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8. Se a distribuição e/ou uso do Programa são restringidos em certos países por patentes ou direitos autorais,
o detentor dos direitos autorais original, e que colocou o Programa sob esta Licença, pode incluir uma limi-
tação geográfica de distribuição, excluindo aqueles países de forma a tornar a distribuição permitida apenas
naqueles ou entre aqueles países então não excluídos. Nestes casos, esta Licença incorpora a limitação
como se a mesma constasse escrita nesta Licença.

9. A Free Software Foundation (Fundação do Software Livre) pode publicar versões revisadas e/ou novas da
Licença Pública Geral de tempos em tempos. Estas novas versões serão similares em espírito à versão atual,
mas podem diferir em detalhes que resolvem novos problemas ou situações.

A cada versão é dada um número distinto. Se o Programa especifica um número de versão específico desta
Licença que se aplica a ele e a “qualquer nova versão”, você tem a opção de aceitar os termos e condições
daquela versão ou de qualquer outra versão publicada pela Free Software Foundation. Se o programa não
especifica um número de versão desta Licença, você pode escolher qualquer versão já publicada pela Free
Software Foundation.

10. Se você pretende incorporar partes do Programa em outros programas livres cujas condições de distribuição
são diferentes, escreva ao autor e solicite permissão. Para o software que a Free Software Foundation detém
direitos autorais, escreva à Free Software Foundation; às vezes nós permitimos exceções a este caso. Nossa
decisão será guiada pelos dois objetivos de preservar a condição de liberdade de todas as derivações do
nosso software livre, e de promover o compartilhamento e reutilização de software em aspectos gerais.

AUSÊNCIA DE GARANTIA

11. PELO PROGRAMA SER LICENCIADO SEM ÔNUS, NÃO HÁ QUALQUER GARANTIA PARA O
PROGRAMA, NA EXTENSÃO PERMITIDA PELAS LEIS APLICÁVEIS. EXCETO QUANDO EX-
PRESSADO DE FORMA ESCRITA, OS DETENTORES DOS DIREITOS AUTORAIS E/OU TER-
CEIROS DISPONIBILIZAM O PROGRAMA “NO ESTADO”, SEM QUALQUER TIPO DE GARAN-
TIAS, EXPRESSAS OU IMPLÍCITAS, INCLUINDO, MAS NÃO LIMITADO A, AS GARANTIAS
IMPLÍCITAS DE COMERCIALIZAÇÃO E AS DE ADEQUAÇÃO A QUALQUER PROPÓSITO. O
RISCO TOTAL COM A QUALIDADE E DESEMPENHO DO PROGRAMA É SEU. SE O PROGRAMA
SE MOSTRAR DEFEITUOSO, VOCÊ ASSUME OS CUSTOS DE TODAS AS MANUTENÇÕES,
REPAROS E CORREÇÕES.

12. EM NENHUMA OCASIÃO, A MENOS QUE EXIGIDO PELAS LEIS APLICÁVEIS OU ACORDO
ESCRITO, OS DETENTORES DOS DIREITOS AUTORAIS, OU QUALQUER OUTRA PARTE QUE
POSSA MODIFICAR E/OU REDISTRIBUIR O PROGRAMA CONFORME PERMITIDO ACIMA,
SERÃO RESPONSABILIZADOS POR VOCÊ POR DANOS, INCLUINDO QUALQUER DANO EM
GERAL, ESPECIAL, ACIDENTAL OU CONSEQÜENTE, RESULTANTES DO USO OU INCAPACI-
DADE DE USO DO PROGRAMA (INCLUINDO, MAS NÃO LIMITADO A, A PERDA DE DADOS
OU DADOS TORNADOS INCORRETOS, OU PERDAS SOFRIDAS POR VOCÊ OU POR OUTRAS
PARTES, OU FALHAS DO PROGRAMA AO OPERAR COM QUALQUER OUTRO PROGRAMA),
MESMO QUE TAL DETENTOR OU PARTE TENHAM SIDO AVISADOS DA POSSIBILIDADE DE
TAIS DANOS.

Quantum GIS Qt exceção para GPL

Em adição, excepcionalmente, a Equipe de Desenvolvimento QGIS dá a permissão de linkar o código
deste programa com a biblioteca QT, inclusa, mas não limitada as seguintes versões (ambas gratuitas
e comerciais):Qt / Não-Comercial do Windows, Qt / Windows, Qt/X11, Qt / Mac, e Qt / Embedded
(ou com versões modificadas do Qt que usam a mesma licença do Qt) e distribuir combinações rela-
cionadas, incluindo os dois. Você deve obedecer a GNU General Public License em todos os aspectos
para todo o código usado em outra Qt. Se você modificar este arquivo, você pode estender essa ex-
ceção para a sua versão do arquivo, mas você não é obrigado a fazê-lo. Se você não quiser fazer isso,
exclua essa declaração exceção de sua versão.

21.2 GNU Licença de Documentação Gratuíta
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Direitos Autorais 2000, 2001, 2002, 2007, 2008 Free Software Foundation (Fundação do Software
Livre)

<http://fsf.org/>

Qualquer pessoa tem permissão para copiar e distribuir cópias fiéis deste documento de licença, mas modifica-lo
não é permitido.

Preâmbulo

O objetivo desta licença é produzir um manual, compêndio, ou outro documento funcional e útil. “Grátis” no
sentido de liberdade: para garantir a todos a efetiva liberdade de copiar e distribui-la com ou sem modificações,
comercialmente ou não.Secundariamente esta licença preserva ao autor e editor uma maneira de ter crédito pelo
seu trabalho, embora não sejam considerados responsaveis por modificações feitas por outros.

Esta licença é uma espécie de “copyleft”, oque significa que trabalhos derivativos do documento devem ser livres
no mesmo sentido. Ela complementa a GNU (Licença Publica Geral), que é uma licença copyleft projetada para
softwares livres.

Criamos esta Licença para que seja usada em manuais para programas livres, porque programas livres precisam
de documentação livre: um programa livre deveria vir com manuais que ofereçam as mesmas liberdades que o
programa oferece. Mas esta Licença não está limitada a manuais de programas de computador; ela pode ser usada
para qualquer trabalho de texto, independentemente do assunto ou se é publicado como um livro impresso. Nós
recomendamos esta Licença principalmente para trabalhos cujo propósito é instrução ou referência.

1. APPLICABILITY AND DEFINITIONS

Esta licença se aplica a qualquer manual ou outro trabalho, em qualquer meio, que contenha uma nota introduzida
pelo detentor dos direitos autorais dizendo que o documento pode ser distribuído sob os termos desta. Tal nota
garante uma licença mundial, livre de royalties, de duração ilimitada, para usar este trabalho sob as condições aqui
colocadas. O “Documento”, abaixo, se refere a qualquer tal manual ou trabalho. Qualquer membro do público é
um licenciado, e será tratado por “você”. Você aceita a licença se copiar, modificar ou distribuir o trabalho de um
modo que necessite de permissão de acordo com a lei de direitos autorais.

Uma “Versão Modificada” do Documento se refere a qualquer trabalho contendo o Documento ou uma parte deste,
quer seja copiado sem modificações, quer com modificações e/ou traduzido para outra língua.

Uma “Seção Secundária” é um apêndice com nome ou uma seção inicial do Documento que trata exclusivamente
da relação dos editores ou autores do Documento com seu assunto geral (ou temas relacionados) e não contém
nada que possa estar diretamente dentro do assunto geral. Assim, se o Documento é em parte um livro- texto de
matemática, uma Seção Secundária não pode explicar nada de matemática. Tal relação pode ser uma conexão
histórica com o assunto ou com temas relacionados, ou tratar de questões legais, comerciais, filosóficas, éticas ou
políticas com relação a eles.

“Seções Invariantes” são certas Seções Secundárias cujos títulos são designados como sendo de Seções invariantes
na nota que afirma que o Documento é publicado sob esta Licença. Se uma seção não se encaixa na definição acima
de Secundária, então não se permite que seja designada como Invariante. O Documento pode não conter nenhuma
Seção Invariante. Se o documento não identificar quaisquer Seções Invariantes, então não há nenhuma.

“Textos de Capa” são certas passagens de texto que são listada como Textos de Capa Frontal ou Texto de Quarta
Capa, na nota que afirma que o Documento é publicado sob esta Licença. Um Texto de Capa Frontal pode ter no
máximo 5 palavras, e um Texto de Quarta Capa pode ter no máximo 25 palavras.

Uma cópia “Transparente” do Documento significa uma cópia que pode ser lida pelo computador, representada
em um formato cuja especificação esteja disponível ao público geral, que seja apropriada para a imediata revisão
do documento usando-se editores de texto genéricos ou (para imagens compostas de pixeis) programas gráficos
genéricos ou (para desenhos) algum editor de desenhos amplamente disponível, e que seja apropriado para in-
clusão em formatadores de texto ou para tradução automática para uma variedade de formatos apropriados para
inclusão em formatadores de texto. Uma cópia feita em outro formato de arquivo Transparente cuja marcação, ou
ausência desta, foi manipulada para impedir ou desencorajar modificação subseqüente pelos leitores não é Trans-
parente. Um formato de imagem não é Transparente se usado em lugar de qualquer quantidade substancial de
texto. Uma cópia que não é “Transparente” é chamada “Opaca”.

Exemplos de formatos apropriados para cópias Transparentes incluem ASCII puro sem marcação, formato de
entrada Texinfo, LaTex, SGML ou XML usando um DTD publicamente disponível, e HTML padrão simples,
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PostScript ou PDF projetados para modificação por humanos. Exemplos de formatos de imagem transparentes
incluem PNG, XCF e JPG. Formatos Opacos incluem formatos proprietários que podem ser lidos e editados
somente por processadores de texto proprietários, SGML ou XML para os quais o DTD e/ou ferramentas de
processamento não são largamente disponibilizadas, e HTML, Postscript ou PDF gerados automaticamente com
propósito apenas de saída por alguns processadores de texto.

“Página de Título” significa, para um livro impresso, a própria página do título, além das páginas subseqüentes
necessárias para conter, de forma legível, o material que esta Licença requer que apareça na página do título. Para
trabalhos em formatos que não têm uma página de título assim, “Página de Título” significa o texto próximo à
ocorrência mais proeminente do título do trabalho, precedendo o início do corpo do texto.

O “publicador” é qualquer pessoa ou entidade que distribua cópias do Documento para o público.

Uma seção “Intitulada XYZ” significa uma sub-unidade com nome do Documento cujo título ou é precisamente
XYZ ou contém XYZ em parênteses seguindo o texto que traduz XYZ em outra língua. (Aqui XYZ representa
o nome de uma seção específica mencionado acima, tal como “Agradecimentos”, “Dedicatória”, “Apoio”, ou
“Histórico”.) “Preservar o Título” de uma seção assim quando você modifica o Documento significa que ela
continua sendo uma seção “Intitulada XYZ” de acordo com esta definição.

O Documento pode incluir Notas de Garantia em seguida à nota que afirma que esta Licença se aplica ao Docu-
mento. Estas Notas de Garantia são tidas como inclusas por referência nesta Licença, mas somente com relação
às notas de garantia: qualquer outra implicação que estas Notas de Garantia possam ter é anulada e não tem efeito
algum no conteúdo desta Licença.

2. VERBATIM COPYING

Você pode copiar e distribuir o Documento em qualquer meio, comercialmente ou não-comercialmente, desde que
esta licença, as notas de direitos autorais (copyright), e a nota de licença afirmando que esta Licença se aplica ao
Documento sejam reproduzidas em todas as cópias, e que você não inclua outras condições, quaisquer que sejam,
às condições desta Licença. Você não pode usar de medidas técnicas para obstruir ou controlar a leitura ou cópia
futura das cópias que você fizer ou distribuir. Contudo, você pode aceitar compensação em troca das cópias. Se
você distribuir um número suficientemente grande de cópias, você deve também respeitar as condições na seção
3.

Você pode também emprestar cópias, sob as mesmas condições acima mencionadas, e você também as pode
mostrar publicamente.

3. COPYING IN QUANTITY

Se você publicar cópias impressas (ou cópias em um meio que normalmente tem capas impressas) do documento,
em número maior que 100, e a nota de licença do Documento requer Textos de Capa, você deve encadernar as
cópias em capas que carreguem, de forma clara e legível, todos estes Textos de Capa: Textos de Capa Frontal na
capa frontal, e Textos de Quarta Capa na quarta capa. Ambas as capas devem também identificar, de forma clara
e legível, você como o editor das cópias. A capa frontal deve apresentar o título completo com todas as palavras
deste igualmente proeminentes e visíveis. Você pode adicionar outro material nas capas. Cópias com mudanças
limitadas às capas, desde que preservando o título do Documento e satisfazendo estas condições, podem ser
tratadas como cópias literais em outros aspectos.

Se os textos necessários a qualquer uma das capas são demasiado volumosos para serem incluídos de forma
legível, você deve colocar os primeiros listados (quantos couberem razoavelmente) na própria capa, e continuar o
resto nas páginas adjacentes.

Se você publicar ou distribuir cópias Opacas do Documento em número maior que 100, você deve ou incluir uma
cópia Transparente legível por computador juntamente com cada cópia Opaca, ou dizer em, ou juntamente com,
cada cópia Opaca um endereço de rede a partir do qual o público geral possa acessar e obter, usando protocolos
de rede públicos padrão, uma cópia Transparente completa do Documento, livre de material adicionado. Se você
decidir pela segunda opção, você deve seguir passos razoavelmente prudentes, quando começar a distribuir as
cópias Opacas em quantidade, para garantir que esta cópia transparente permanecerá acessível no local indicado
por pelo menos um ano após a última vez que você distribuir uma cópia Opaca (diretamente ou através de seus
agentes ou distribuidor) desta edição ao público.

É solicitado, mas não exigido, que você contate os autores do Documento muito antes de redistribuir qualquer
número grande de cópias, para dar a eles uma chance de lhe fornecer uma versão atualizada do Documento.

4. MODIFICATIONS
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Você pode copiar e distribuir uma Versão Modificada do Documento sob as condições das seções 2 e 3 acima,
desde que você forneça a Versão Modificada estritamente sob esta Licença, com a Versão Modificada no papel de
Documento, permitindo assim a distribuição e modificação da Versão Modificada a quem quer que possua uma
cópia desta. Além disso, você deve executar os seguintes procedimentos na Versão Modificada:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. Liste na Página de Título, como autores, uma ou mais pessoas ou entidades responsáveis pela autoria ou
modificações na Versão Modificada, juntamente com pelo menos cinco dos autores principais do Docu-
mento (todos seus autores principais, se houver menos que cinco), a menos que estes lhe desobriguem desta
exigência.

3. Mencione na Página de Título o nome do editor da Versão Modificada, como seu editor.

4. Preserve todas as notas de direitos autorais (copyright) do Documento.

5. Adicione uma nota apropriada de direitos autorais para suas modificações, adjacente às outras notas de
direitos autorais.

6. Inclua, imediatamente após as notas de direitos autorais, uma nota de licença dando ao público permissão
para usar a Versão Modificada sob os termos desta Licença, na forma mostrada no Adendo abaixo.

7. Preserve naquela nota de licença a lista completa de Seções Invariantes e Textos de Capa requeridos dados
na nota de licença do Documento.

8. Inclua uma cópia inalterada desta Licença.

9. Preserve a seção intitulada “Histórico”, preserve seu título, e adicione a esta um item mencionando pelo
menos o título, ano, novos autores, e editor da Versão Modificada conforme incluído na Página de Título.
Se não houver uma seção intitulada “Histórico” no Documento, crie uma mencionando o título, ano, autores
e editor do Documento como mostrado na Página de Título, em seguida adicione um item descrevendo a
Versão Modificada como mencionado na sentença anterior.

10. Preserve o endereço de rede, se algum, dado no Documento para acesso público a uma cópia Transparente
deste e, da mesma maneira, os endereços de rede dados no Documento para versões prévias nas quais este
se baseia. Estes podem ser colocados na seção “Histórico”. Você pode omitir um endereço de rede para um
trabalho que foi publicado pelo menos quatro anos antes do Documento em si, ou se o editor original da
versão à qual o endereço se refere der permissão.

11. Para qualquer seção intitulada “Agradecimentos” ou “Dedicatória”, preserve o título da seção, e preserve
dentro da seção toda a substância e tom de cada um dos agradecimentos e/ou dedicatórias lá mencionados.

12. Preserve todas as Seções Invariantes do Documento, inalteradas no seu texto e títulos. Números de seção
ou o equivalente não são considerados parte dos títulos das seções.

13. Apague qualquer seção intitulada “Apoio”. Tal seção não ser incluída na Versão Modificada.

14. Não modifique o título de qualquer seção a ser intitulada “Apoio” ou que resulte em conflito com título de
qualquer Seção Invariante.

15. Preserve any Warranty Disclaimers.

Se a Versão Modificada incluir novas seções iniciais ou apêndices que sejam qualificados como Seções Se-
cundárias, e não contiver material copiado do Documento, você pode, a seu critério, tornar algumas dessas ou
todas essas seções em invariantes. Para fazer isso, adicione seus títulos à lista de Seções Invariantes na nota de
licença da Versão Modificada. Estes títulos devem ser distintos de quaisquer outros títulos de seções.

Você pode incluir uma seção intitulada “Apoio”, dado que ela contenha nada além de apoio recebido para sua
Versão Modificada por várias fontes – por exemplo, notas do revisor ou de que o texto foi aprovado por uma
organização como a definição autoritativa de um padrão.

Você pode adicionar uma passagem de até cinco palavras como Texto de Capa Frontal, e uma passagem de até
25 palavras como Texto de Quarta Capa, ao fim da lista de Textos de Capa na Versão Modificada. Somente
uma passagem de Texto de Capa Frontal e uma de Texto de Quarta Capa pode ser adicionado por (ou através
de arranjos feitos por) uma entidade qualquer. Se o Documento já incluir um texto de capa para a mesma capa,
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previamente incluído por você ou por arranjo feito pela mesma entidade em cujo nome você está agindo, você não
pode adicionar outro; mas você pode substituir o antigo, com permissão explícita do editor anterior, que o incluiu.

O(s) autor(es) e editor(es) do Documento, por esta Licença, não dão permissão para seus nomes serem usados
para publicidade ou defesa ou apoio implícito para qualquer Versão Modificada.

5. COMBINING DOCUMENTS

Você pode combinar o documento com outros documentos publicados sob esta Licença, sob os termos definidos
na seção 4 acima para versões modificadas, desde que você inclua na combinação todas as Seções Invariantes de
todos os documentos originais, sem modificações, e as liste como Seções Invariantes de seu trabalho combinado,
na sua nota de licença, e que você preserve todas as Notas de Garantia.

O trabalho combinado somente precisa conter uma cópia desta Licença, e múltiplas Seções Invariantes idênticas
podem ser substituídas por uma única cópia. Se houver múltiplas Seções Invariantes com o mesmo nome, porém
com conteúdos diferentes, torne o título de cada uma destas seções único, adicionando ao fim dele, entre parên-
teses, o nome do autor ou editor original desta seção, se conhecido, ou então um número único. Faça o mesmo
ajuste nos títulos de seção na lista de Seções Invariantes na nota de licença do trabalho combinado.

Na combinação, você deve combinar quaisquer seções intituladas “Histórico” nos vários documentos originais,
formando uma seção intitulada “Histórico”; do mesmo modo, combine quaisquer seções intituladas “Agradeci-
mentos”, e quaisquer seções intituladas “Dedicatória”. Você deve apagar todas as seções intituladas “Apoio”.

6. COLLECTIONS OF DOCUMENTS

Você pode fazer uma coleção consistindo do Documento e outros documentos publicados sob esta Licença, e
substituir as cópias individuais desta Licença, nos vários documentos, por uma única cópia a ser incluída na
coleção, desde que você siga as regras desta Licença para cópias literais de cada documento em todos os outros
aspectos.

Você pode extrair um único documento desta coleção, e distribuí-lo individualmente sob esta Licença, desde que
você insira uma cópia desta Licença no documento extraído, e siga esta Licença em todos os outros aspectos com
relação à cópia literal do documento.

7. AGGREGATION WITH INDEPENDENT WORKS

Uma compilação do Documento ou seus derivados com outros documentos ou trabalhos separados e indepen-
dentes, dentro de ou junto a um volume de um meio de armazenagem ou distribuição, configura um “agregado” se
os direitos autorais resultantes da compilação não forem usados para limitar os direitos legais dos usuários desta
além do que os trabalhos individuais permitem. Quando o Documento é incluído em um agregado, esta Licença
não se aplica aos outros trabalhos no agregado que não forem, por sua vez, derivados do Documento.

Se o requerimento do Texto de Capa da seção 3 for aplicável a estas cópias do documento, então, se o Documento
for menor que metade do agregado inteiro, os Textos de Capa do Documento podem ser colocados em capas que
encerrem o Documento dentro do agregado, ou o equivalente eletrônico das capas se o Documento estiver em
formato eletrônico. Do contrário, eles devem aparecer como capas impressas que envolvam o agregado inteiro.

8. TRANSLATION

Uma tradução é considerada como sendo um tipo de modificação, então você pode distribuir traduções do Docu-
mento sob os termos da seção 4. A substituição de Seções Invariantes por traduções requer permissão especial dos
detentores dos direitos autorais, embora você possa incluir traduções de algumas ou todas as Seções Invariantes
juntamente às versões originais destas. Você pode incluir uma tradução desta Licença, e todas as notas de licença
no Documento, e qualquer Nota de Garantia, desde que você também inclua a versão original em Inglês desta
Licença e as versões originais das notas de licença e garantia. Em caso de discordância entre a tradução e a versão
original desta Licença ou nota de licença ou garantia, a versão original prevalecerá.

Se uma seção no Documento for intitulada “Agradecimentos”, “Dedicatória”, ou “Histórico”, o requerimento
(seção 4) de Preservar seu Título (seção 1) tipicamente exigirá a mudança do título em si.

9. TERMINATION

Você não pode copiar, modifica, sub-licenciar, ou distribuir o Documento à exceção do modo expressamente
provido por esta Licença. Qualquer outra tentativa de copiar, modificar, sub-licenciar ou distribuir o Documento é
anulada, e implicará em término automático de seus direitos sob esta Licença.
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However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Além disso, sua licença de um detentor dos direitos autorais é permanentemente reinstalada se o detentor nofiticar
você da violação por motivos razoáveis, esta é a primeira vez que você recebeu noticias da violação desta licença
de qualquer detentor e você remedia a violaçao anteriormente a 30 dias após ter recebido a notícia.

O término dos seus direitos sobre esta seção nao finaliza a licença de partes que receberam cópias de você sobre
esta licença. Se seus direitos terminaram a não foram permanentemente reinstalados, o recebimento de uma cópia
ou parte do mesmo material nao dá a você o direito de usá-lo.

10. FUTURAS REVISÕES DESTA LICENÇA

A Fundação do Software Livre pode publicar novas, revisadas versões do GNU de tempos em tempos. A nova
versão será similar a presente versão, mas pode diferir em detalhes para encaminhar novos problemas ou preocu-
pações. Veja http://www.gnu.org/copyleft/.

Para cada versão da Licença é dado um número de versão distinto. Se o Documento especificar que uma versão
particular desta Licença “ou qualquer versão posterior” se aplica a ele, você tem a opção de seguir os termos e
condições tanto daquela versão específica, ou de qualquer versão posterior que tenha sido publicada (não como um
rascunho) pela Free Software Foundation. Se o Documento não especificar um número de versão desta Licença,
você pode escolher qualquer versão já publicada (não como rascunho) pela Free Software Foundation. Se o
Documento especificar que um procurador pode decidir quais versões futuras desta licença pode ser usada, uma
afirmação pública do procurador de aceitação de uma versão permanentemente autoriza você a escolher essa
versão para o documento.

11. RELICENCIAMENTO

“Massive Multiauthor Collaboration Site” (ou “Site MMC”) significa que qualquer servidor da World Wide Web
que publica trabalhos protegidos por direitos autorais e também oferece facilidades importantes para qualquer
pessoa para editar essas obras. Um wiki público que qualquer um pode editar, está um exemplo de um servidor. A
“Massive Multiauthor Collaboration” (ou “MMC”) contidos no site significa que qualquer conjunto de trabalhos
protegidos por direitos autorais, assim, publicado no site da MMC.

“CC-BY-SA” significa Creative Commons Attribution-Share Alike 3.0 publicado pela Creative Commons Corpo-
ration, uma corporação sem fins lucrativos com sede principal em San Francisco, Califórnia, bem como futuras
versões de copyleft da licença publicada pela mesma organização.

“Incorporar”significa publicar ou republicar um Documento, por inteiro ou em partes, como parte de outro docu-
mento.

O MMC é “elegível para um novo licenciamento” se está licenciado sob esta Licença, e se todas as obras que foram
publicadas pela primeira vez sob esta licença em outro lugar que este MMC e, posteriormente, incorporadas no
todo ou em parte para o MMC, (1) não tinha textos cobertos ou seções invariantes, e (2) foram assim incorporados
antes de 1 de novembro de 2008.

O operador de um site MMC pode republicar uma MMC contido no site sob CC-BY-SA no mesmo local, a
qualquer momento, antes de 1 de agosto de 2009, desde que o MMC é elegível para um novo licenciamento.

ADDENDUM: Como usar esta Licença em seus documentos

Para usar esta Licença num documento que você escreveu, inclua uma cópia da Licença no documento e ponha as
seguintes notas de copyright e licenças logo após a página de título:

Copyright © ANO SEU NOME. É concedida permissão para copiar, distribuir e / ou modificar este
documento sob os termos da GNU Free Documentation License, Versão 1.3 ou qualquer versão poste-
rior publicada pela Free Software Foundation; sem Secções Invariantes, sem Textos de Capa Frontal,
e sem volta Textos de Capa. Uma cópia da licença é incluída na seção intitulada “GNU Free Docu-
mentation License”.

Se você tiver Seções Invariantes, Textos de Capa Frontal e Textos de Capa Traseira, substitua a linha”com ...
Textos” por esta:
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com as Seções Invariantes sendo LISTA SEUS TÍTULOS, com os Textos de Capa sendo LISTA, e
com os textos de Contra-Capa sendo LISTA.

Se você tiver Seções Invariantes, sem Textos de Capa, ou alguma outra combinação dos três, mesclar essas duas
alternativas para se adequar a situação.

Se o documento contiver exemplos não triviais de código de programas, nós recomendamos a publicação desses
exemplos em paralelo sob a sua escolha de licença de software livre, como a GNU General Public License, para
permitir seu uso em software livre.
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